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1 PackEdge

1.  Introduction

1.1.  Copyright Notice
© Copyright 2023 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by GlobalVision. ArtProof and ScanProof are registered
trademarks of GlobalVision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Raymonde de Larochelaan 13

B – 9051 Gent

info.eur@esko.com
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2.  Working with Files
You can store and retrieve different file types on your system.

Each file has a unique name to identify the file. The file name contains an extension (such as GRS) that
is automatically assigned to the file by the system, depending on its file type.

2.1.  Create Documents

If you make New (blank) files to create a new file, you will abandon your current file. You will have the
opportunity to save your work first.

When you create new files, you will be asked to set up the document. You can keep the default setup
parameters and, if necessary, always change the Document Setup later.

Use Document Setup to determine:

• The size of the file's borders,
• The margins,
• The file's orientation (portrait or landscape),
• The units of measure (for the Measurement tools),
• The (Automation Engine) job in which your document will be saved.

Note:

The Document Setup changes are saved with the file. When you exit and log back into the
application, the default settings are reinstalled.

2.2.  Read Back File Contents

Open a file that has already been created, to modify the file or use its objects within another file.

Attention:

• If you open a file, the contents of the file will replace your current job.

You will have the opportunity to save your current work first.

• If you open a Palette file (with another file open on screen), the color palette (from the newly
opened file) will replace the displayed file's color palette.
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Note:

When opening a file coming from Automation Engine, that has an “approved” state, a message
will be shown. When saving the file after editing, the Approval state will be reset. This
behaviour can be switched on or off in the Files tab.

If you want to use the contents of a file within another job use Place... or Place Inside... of the File
menu.

2.3.  Import Files

You can import files using Open from the File menu. The file will be opened and can be edited. If you use
Place or Place Inside from the File menu, the file is placed in the currently active window.

Depending on the file type that you want to open, you can define options specific for that file type.

Tip:

When you load a PostScript file, group the file's objects as soon as you load the file, to make it
easier to manipulate the objects in future work (the objects are selected in red when the file is
loaded).

When you import scanned images or 1-bit data, the image or data is constructed as multiple objects
that have been linked into a single entity.

2.4.  Save Your Work to a File

Use Save or Save As to save files to the native formats of the system.

To save files other than in native format, you have to export the file to a different format.

To save your work and quit the application, use Exit. If you performed some modifications on the file
before you click Exit you will have the opportunity to save these modifications.

Note:

When opening a file coming from Automation Engine, that has an “approved” state, a message
will be shown. When saving the file after editing, the Approval state will be reset. This
behaviour can be switched on or off in the File tab of the Preferences.

2.5.  Work with Image Files

You can use Esko CT, TIFF, JPEG, PSD and EPS files to integrate images when you create and design.
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2.6.  File Types

The file types used by the system include:

Esko Native formats

• GRS = native format file
• PDF= Adobe Portable Document Format
• PAL = Color Palette file (native format)
• PLA = Plato native format file (Plate Editor)
• PDFPLA = Plato PDF file
• GRQ = Esko QuickStep format
• GRO = Esko (non-editable) output format
• CT = Esko CT file format
• EPF = Esko Prep File
• LP = Esko line art pixel format
• LC = Esko line art contour format
• TXT = ASCII text (only) text

Native fomats of older applications:

• GRI= Imposition sheet format

DTP formats:

• PS= Adobe PostScript file
• EPS= Encapsualted PostScript File
• TIF= TIFF (tagged image file format) file
• DCS= Desktop Color Separations file

CAD Formats:

• ArtiosCAD= ArtiosCAD native format
• CFF2
• DDES
• BAG = Studio Toolkit for Flexibles native file format
• Collada files
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3.  View and Measure

3.1.  Viewing a Job

3.1.1.  Use Layout Windows

You create or modify a job withPackEdge in a layout window. Each layout window displays the name of
the file in the title bar at the top of the window.

To select the active layout window, click inside the window. The title bar is highlighted to indicate the
active window, where all manipulations and modifications will originate. Layout windows that have
dimmed title bars are inactive.

You can move and resize the layout windows (even if they are inactive). When you position the cursor on
the window's borders, the cursor changes to indicate how the window can be modified.

To move the active window, position the cursor in the title bar. Click, hold and drag the window to the
appropriate position.

To resize the active window vertically or horizontally, position the cursor in the dimmed edge of the
window. The 'horizontal', 'vertical', or 'scale' cursor appears, depending on where you positioned the
cursor in the layout window's border.

Click, hold and drag to resize the window vertically, horizontally. To scale the active window, position
the cursor in a dimmed corner of the window. Click, hold and drag to scale the window to the
appropriate size.

3.1.2.  Display Layout Windows

Display the layout windows to use as you create or modify a job. You can display 1, 2 (vertically or
horizontally), or 3 layout windows and you can define the display modes for each.

The display mode determines how objects will appear: as contours, filled or exactly as they will be
printed.

When you work with multiple layout windows, the layout windows are interconnected, enabling you
to measure, perform two-point positioning, and modify objects that cannot be located close to each
other.

For example, with a 3 Window layout, you can use Viewport to zoom into the appropriate area in two of
the windows.
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Attention:

These options are for display only, and do not affect your final output.

3.1.3.  Use Zooming and Panning

Use Zoom and Pan view to display the active window in a variety of ways, making it easier for you to
design or modify a job.

You can use View tools to:

• Zoom in and zoom out of the active window

• View a portion of the active window with the Viewport

• Pan the active window

You can use the View menu to:

• Zoom in and zoom out of the active window

• Display the previous view of the active window

• Display the entire active window after you have used another view option with Total View

You can also zoom in and out by entering a zoom percentage value in the Status bar.

Note:

• These options are for display only, and do not affect your final output.
• The zoom is based on the center of the crosshair.
• The default zoom percentage is 96 % to provide a display of the page borders (with some

margin).
• The zoom percentage is updated each time you use a View option. When you use Total View

from the View menu, the zoom percentage returns to the default value of 96%.

3.2.  Use Measuring Tools

Use Measure, measure point (right icon) to measure:

• The distance between two points,
• The distance between a point and the center of the crosshair,
• The perimeter of an object.

Use Measure, measure object (left icon) to measure:

• A single object's horizontal and vertical starting point, and the object's height, width, and angle if
the object has four square corners (and has been rotated),

• The dimensions of the bounding box that encloses an object (or objects),
• Vertical and horizontal starting points, width, height, and angle.
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3.3.  Welcome to Viewer

Benefits of using Viewer
Viewer is a very accurate separation viewer with a lot of extra production tools. It eliminates the need
for separated proofs and will help you to avoid bad plate-making.

Fly-out menu options
A number of settings can be found in the Fly-out menu, by clicking the arrow at the top right of the
dialog.

Show in All Windows

Use this to apply the Viewer preview settings to all the open windows (when you used several windows).

Merge Similar Inks

This option affects how a separation containing objects with different halftone information is
displayed in the separation list.

Leave it off to display a separate entry for each different halftone setting (as shown below at left), or
select it to display different halftone settings of the same separation as one entry (as shown below at
right).
 

 

Default

Click Default to use the Default Press Setting. For more information, see Define Press Settings on page
19

Manage Press Settings...

Click this option to create, duplicate, edit or delete Press Settings. See Define Press Settings on page
19.

3.4.  Define Press Settings

Before you can start working with Viewer in a meaningful way, you should define your Press Settings.
Without basic information on the properties of the press you are using, Viewer cannot simulate
accurately.
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You can open the Press Settings window by selecting Press Settings... in the fly-out menu

3.4.1.  The Default Press Settings

In the list of Press Settings, there is always one Press Setting called Default, which you can edit but not
delete.

You can select it by clicking on Default in the Viewer dialog’s fly-out menu, and edit it using Press
Settings...

3.4.2.  Creating a Press Setting

To create a Press Setting in Viewer:

1. Select Press Settings... in the fly-out menu .
2. Click New... in the Press Settings dialog.
3. Enter the name of the new press setting in the New dialog.
4. Click OK

3.4.3.  Copying a Press Setting

To copy (duplicate) a Press Setting:

1. Select it in the Press Settings dialog.
2. Click the Copy... button.
3. Give it a new Name.
4. Change its parameters as you wish (see The Press Settings in Detail on page 21).
5. Click OK.

3.4.4.  Editing a Press Setting

To edit a Press Setting:

1. Select it in the Press Settings dialog.
2. Click the Modify... button.
3. Change its parameters as you wish (see The Press Settings in Detail on page 21).
4. Click OK.

3.4.5.  Deleting a Press Setting

To delete a Press Setting:

1. Select it in the Press Settings dialog.
2. Click the Delete button.
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3. Confirm that you want to delete it.

Attention:

Deleting Press Settings might also affect other workstations.

3.4.6.  Choosing a Press Setting

• To select a Press Setting, click on it in the Viewer dialog’s fly-out menu.

3.4.7.  The Press Settings in Detail

First Dot (%)
Specifies which minimal gray value (expressed in %) in the file still will yield a dot on the plate, provided
the RIP and platemaking occur under normal conditions.

Note:

Normal conditions indicate that the DGC must have been set up completely. The value does not
correspond with any measurement that has been made prior or during DGC set up, nor does
it correspond with any densitometer measurement on plate or on print. In fact, this value is
(implicitly) chosen by the person who set up the DGC and plate-making. Typical values range
from 0.4% to 1.6%.

PackEdge uses 8-bit precision, yielding 256 different possible gray values. A single gray value in an
image may make the difference between a dot or no dot on a flexo plate. To allow for this precision,
Viewer uses percentages with one decimal digit.

8-bit gray value in PackEdge Percentage

0 0.0%

1 0.4%

2 0.8%

3 1.2%

... ...

254 99.6%

255 100%

Note:

If you do not specify a first dot, you will not be able to use the following Viewer view modes for
this press setting:

• The Flexo Plate Preview

• The Flexo Print Preview
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Dot Gain in Highlights
When you have specified a First Dot job percentage, you can also specify how dark it should actually
print. Enable Dot Gain In Highlights and specify the dot gain parameters:

• First Dot Prints As: indicates the dot gain for the first dot. Typical values range from 5% to 15%
depending on the substrate. The value is a job percentage, that will print on an ideal reference press
as dark as the first dot prints on this press.

• Range: while the previous value measured the amount of dot gain in the highlights, this value
expresses how far this effect penetrates into the midtones. Typically plate making is configured in
such a way that the mid-tones print like an offset press.

Note:

If you do not specify Dot Gain In Highlights, you will not be able to use the following Viewer
viewing mode: Flexo Print Preview.

Limited Total Area Coverage
The Total Area Coverage is the sum of percentages of the different channels on the same location. A
higher total area coverage means more of the various inks is printed on top of each other.

If you want, you can specify the Maximum Total Area Coverage to specify the maximum amount of ink
that the substrate can take on the same spot on your press.

Note:

Exceeding the Maximum Total Area Coverage for the press may cause drying problems,
unexpected color results, and other problems.

Registration Error
Specifies the average maximum Registration Error on your press.

If you enable this option in the Press Settings, you can use the Registration Errors preview in Viewer to
check whether your trapping is sucient to compensate for possible registration errors on the press.

Moiré Settings
In the Moiré Detection settings of the Press Settings, you can define the default values for the settings
in the Moiré Detection window.

For more info on the different settings, see Moire Detection on page 30

3.5.  The Viewer window

3.5.1.  Viewing options

Options particular to certain Viewer previews are grouped under View Options. You can expand or
collapse them using the triangle beside View Options.

The following options are available in all Previews:
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Separation visibility
In the Ink list, you can:

• Click the eye icon in front of a separation/color name to show or hide it.
• Click the eye button above the separations/colors list to show or hide all separations/colors.
• Click the ink name (not the eye button) to quicly hide all other separations and go in single-

separation mode.

Reverse Printing Order

Use the Reverse Printing Order button  to view how your file would look like with its ink order
reversed.

When Reverse Printing Ink Order is enabled ( ), it is always used in all windows, and a red arrow icon
is visible in the title bar of all the windows.

Orientation
The orientation buttons allow to change the orientation of the Preview of the job.

This is applied to all windows when Show in All Windows is active, or only to the current window when
Show in All Windows is inactive.

Note:

Keep in mind that this only changes the rotation of the preview, it does NOT actually rotate the
job.

3.5.2.  Separations

The first viewing mode shows a list of all used inks.

Mode
By default a separation is displayed in color. In order to see a separation as it would appear on film, you
can switch to “Show as Film: Positive”.

By switching to “Show as Film: Negative”, the visible separation will be shown in negative.

Note:

As both “Show as Film: Positive” and “Show as Film: Negative” are more useful on a single
separation, switching to one of those will show only one separation.

Highlight
Traps
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The Traps checkbox highlights all automatic traps in the file, so you can check your trapping.

Transparency

This will highlight all objects that have an opacity percentage, a blend mode or an opacity mask
(regardless of what is underneath).

Overprint

Highlight Overprint will highlight the areas where an “overprint” setting in the paint style takes effect.

Screening Conflict

The Screening Conflict checkbox highlights areas where a screening conflict can occur. They can
occur if an object with transparency (opacity mask, opacity percentage or blend mode) is overlapping
on an object with another screening. The PDF definition clearly states that screening is always taken
from the topmost object, even if that object is completely transparent in some areas. In most cases,
this is not what you would expect.

In the example underneath, you can see a cyan rectangle, and a circle on top, with an opacity mask. The
objects have a different screening. Where the circle is on top of the cyan rectangle, the cyan will take
the screening of the blended circle. Therefore, as shown on the right, these areas will be highlighted as
Screen Conflict.

 

 

Dim Artwork

When you enable an Highlight option, the document artwork is faded to the percentage you choose in
Dim Artwork

Color
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When you enable a Highlight option, the objects are highlighted in the color you chose in the Color
Picker.

3.5.3.  Color

This viewing mode shows a list of used colors.

 

 

Click the eye-icons in front of the colors to show or hide them.

Click the eye button above the colors list to show or hide all colors.

3.5.4.  Total Area Coverage

The Total Area Coverage (TAC) is the sum of all separation-densities at a certain point in your
document.

TAC Limit
The TAC Limit is the maximal Total Area Coverage that your document may contain. This value depends
on the press and the substrate your design will be printed on. Your printer should provide you with the
TAC Limit value to use.

Defining the TAC Limit

The TAC limit is defined in the Press settings. See Define Press Settings on page 19). By default the
TAC Limit is set to 270%.

Viewing areas over the TAC Limit

When you switch to the Total Area Coverage preview, the image in the preview pane will be dimmed
and all areas where the sum of the densities is higher than the TAC limit specified in the current Press
Setting will be displayed in 100% black.
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Note:

You can press the “D” key to activate the Densitometer Tool, and measure the actual TAC
amount in a specific area (see Measure Ink Densities).

To quickly see the maximum TAC in your document, use the TAC Limit slider.

Move the slider to the right to use a TAC Limit value higher than that used by your current Press
Setting. The more you move the slider to the right, the less pixels will typically be over the TAC Limit.

3.5.5.  Flexo Plate

If you change the Viewer Preview mode to Flexo Plate, a single separation (by default the first in the
list) will be shown as a simulated flexo plate.

Note:

In this Preview mode, only one separation can be viewed at a time.

Note:

Viewer uses the same technology as the Esko Flexo Tools for Photoshop.
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First Visible Dot
The Flexo Plate preview will use the First Visible Dot percentage from the press settings (see Define
Press Settings on page 19).

Pixels with a percentage lower than the First Visible Dot percentage will be shown as areas without
dots.

Pixels with a percentage equal or higher than the First Visible Dot percentage will be shown as areas
with dots.

Plate Color
The Flexo Plate preview predicts how clean your flexo plates will be. Especially in very light or very dark
areas, you could end up with isolated dots or holes on the flexo plate, and those areas are dicult to
hold on the plate or the substrate.

You can choose the plate color (Cyrel Red, Blue, Green or Safran Yellow, or a High Contrast Blue&White)
to match the type of plate you are using.

3.5.6.  Flexo Print

This Viewer preview mode shows the effect of highlight dot gain on the image.
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This effect is equivalent to a curve adjustment. To determine this curve, the Flexo Print Preview will
use the First dot and the Dot gain in highlights settings from the Press Settings (see Define Press
Settings on page 19).

Going from light to dark:

• The Flexo Print Preview will display percentages below the First visible dot percentage as 0%.

• The First visible dot percentage will be shown using the First Dot Prints as percentage.

• Percentages above the First visible dot percentage will be shown darker.

• Towards the midtones this darkening effect will fade out until the Range value.

• Percentages above the Range value are displayed unchanged.

3.5.7.  Registration Error

The Registration Error Preview is a simulation of a design printed with registration errors of a specific
press (defined in the Press Settings, see Define Press Settings on page 19). It can be very helpful to
see if trapping is applied suciently and correctly.

The Registration Error value is taken from the Press Setting you selected.

The separations are randomly shifted. In fact, all separations are moved exactly the distance of the
Registration Error, but all under a random angle.

If you want to see another random registration error simulation, click the Simulate Again button.
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In the example above, you can see a small area of a job in regular preview (left) and with registration
errors (right). In this case, you can clearly see no trapping was applied, so white lines appear at the
registration shifts.

3.5.8.  Breakout

A Breakout is an area where the percentage of a single separation is lower than the First Visible Dot
value. This can be used to track areas that won’t show up on print because the values are too low.

Your printer should provide you with the First visible Dot value. The First visible dot is set in the Press
Settings: see Define Press Settings on page 19.When switching to Breakout mode, the preview will
be dimmed and all areas where a single separation has a value lower than the First Visible Dot value
(but higher than 0%), will be displayed in highlight color.

You can measure the actual percentages in that specific area using the densitometer (see Measure Ink
Densities).
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3.5.9.  Moire Detection

Moire Detection allows to detect possible screening problems (Moire) in the file.

You can set the options to highlight overlapping areas, to detect situations in which Moire might
occur:

• when the two overlapping areas have screening angles that do not differ 30 degrees.
• when the two overlapping areas have the same angle
• when the two overlapping areas have different rulings
• when the two overlapping areas have different dot shapes.

You can use the Ignore inks option to ignore inks that have

• a density lower than a certain value,
• a density higher than a certain value
• a Luminance higher than a certain value

as in all those cases, the Moire patterning will hardly be visible.

All these Moire Detection options are stored in the Press Settings. See Define Press Settings on page
19

3.6.  Viewer Compare Tool

You can use the Viewer Compare tool to compare the active document with another document.

To compare the active job:

1. Go to Window > Esko > Viewer > Compare...

The Compare dialog opens, and the name for the Current Document is shown.

 

 
2. Select the file you want to compare the active document to:

• If you want to compare it to an open document, select its file name from the dropdown list
• If you want to compare it to a document on disk, click the browse button and select the file

3. Define what to compare:

• all artwork
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• the current Artboard
• only Trim Box or Media Box (if they are defined)
• only the selected area.

4. Click OK

A Viewer Compare window will open, showing a comparison between the two jobs.

Note:

If you have a Trim Box defined in the Illustrator job, the Viewer Compare tool will only show
what’s inside the trim box.

3.6.1.  The Viewer Compare window

The Viewer Compare window shows the two jobs and their differences, and contains a number of tools
and buttons to inspect these differences in various ways.

Move over a button with the cursor and the tooltip will indicate what it stands for.

Buttons with a triangle in the lower right corner contain additional options: Control-click (Windows) or
Command-click (Mac) the button, or click and hold the button to see the extra options.
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3.6.2.  Navigating the Viewer Compare window

The Viewer Compare window contains different ways to navigate:

The Inspect tools
 

 

• The Zoom tool. Under the zoom tool you find

• Zoom out

• Fit document in view

• Fit document width / height

• Zoom to 1:1 view

• Show Zoom Options (showing all these options as individual buttons)

• The Zoom out tool

• The Pan tool

The Navigator
By dragging the red rectangle (when zoomed in), you can navigate through the job.

 

 

The View options
The View options allow to go back to the previous view, or use additional settings, such as rotate,
invert or mirror the view.
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3.6.3.  Compare modes

Using the Compare butons, you can choose different Compare modes / views

 

 

• View Current version only

• View Reference version only

• View Both documents on top of each other.

Additional options:

• View Both in their original colors

• View Both - Show difference: the differences will be shown in the "Added" and "Substracted"
highlight colors.

• View Both - highlight difference: same as above, but the identical parts are dimmed.

• View Both - only difference: same as above, but the identical parts are hidden.

• Change "Added" Highlight Color, Change "Substracted" Highlight Color and Change Both
Highlight Color, to change the colors in which differences are shown

• Reset Difference Highlight Colors to reset the default colors

• Channel Matching, to match corresponding channels/inks for the two documents.

• View Both - side by side shows both versions next to each other. You can choose between

• Automatic tiling

• Horizontal tiling

• Vertical tiling.

• View both - mirror reference shows the current document on top of the mirrored reference
document.
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3.6.4.  Alignment

Comparing files with different sizes may seem like a challenge as they are not aligned in the Viewer
Compare window, but it provides some tools that make it very easy.

 

 

• Alignment

• on one of 9 corner / center points

• Align From Ruler: see Align from Ruler on page 34

• Auto Align From Ruler: see Auto Align from Ruler on page 35

• Auto Align: see Auto Align on page 35

• Auto Align: see Auto Align on page 35

• Use trim box for alignment

• Offset, Horizontal and Vertical

Align from Ruler
The ruler tool works by defining two points (one in each file) that have to be aligned.

1.

Select the reference version of the file by clicking the  icon.
2.

Select the Ruler tool 
3. Indicate the ruler anchor point

 

 
4.

Switch to the other version by clicking the  icon (or use Ctrl + S).
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The anchor point, here in the red circle, will be in a different location in the second file version.
5. Indicate the point that should be positioned on the ruler anchor point (here in the blue circle)

 

 
6.

Click the Alignment button and select Align From Ruler. The files are now aligned.

Note:  Depending on how precisely you defined the second ruler point, you may have to
zoom in and repeat the alignment procedure to align your files with more precision.

Auto Align from Ruler
Auto Align from Ruler is used the same way as the Align from Ruler tool, but is more accurate at high
resolution.

If the details of the alignment points match, the viewer will be able to increase the alignment precision
(and have a good alignment with fewer iterations).

Auto Align
Auto Align does not use the ruler, but rather the currently visible view of the two compared images to
attempt an automatic alignment.

For convenience, a separate tool button is available to perform an Auto Align operation without having
to open the Alignment pop-up menu. Clicking this button will perform an Auto Align from Ruler if a ruler
selection is active, otherwise an Auto Align (from view).

3.6.5.  Viewer Compare Preferences

You can open the Compare Preferences by choosing Illustrator > Preferences > Esko > Viewer
Compare Preferences (on Mac OS) or Edit > Preferences > Esko > Viewer Compare Preferences (on
Windows).

You can define the resolution for the Viewer Compare previews: either based on the document size, or
at a fixed resolution. "Based on Document Size" will result in a low resolution for big documents, so e.g.
aligning will become more dicult when zooming in. On the other hand, a "Fixed Resolution" can result
in a very heavy preview calculation if the fixed resolution is high and the document is large.

You can define if anti-aliasing should be applied.
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3.7.  Using a Collection

A Collection is a temporary set of objects, based on a selection. It allows to navigate through the
objects in the Collection, automatically zooming in on them.

A collection is temporary, and only kept until it is cleared, until the document is closed, or until you
change the page of the document.

Note:

Objects that are removed from the job will also be removed from the collection.

1. Select a number of objects.

You can select objects manually, or by using e.g. Select by Attribute
2. Choose Select > Collection... to open the Collection dialog

 

 
3. Click the Make Collection button to make a collection based on the selection

The Collection dialog will show the number of objects in the Collection

 

 

• Use the browse buttons to navigate through the different objects in the collection
• The Info field shows the type of object currently selected
• Select the Zoom option to automatically zoom in on the currently browsed object.
• Select the Select option to automatically select the currently browsed object.

4. Click the Clear button to "forget" the collection, so you can create a new collection.
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Note:

Selecting or deselecting objects doesn’t change the collection. You can still select and/or
edit objects, without loosing your collection.

3.7.1.  Modifying a Collection

You can modify the Collection using one of the functions in the fly-out menu of the Collection palette:

• Click the Make New Collection button or select Make Collectionfrom the fly-out menu to "forget" the
current collection, and create a new collection based on the current selection.

• Select Clear Collectionfrom the fly-out menu to "forget" the current collection.
• Select one or more objects in the job, and select Add Selection from the fly-out menu to add the

selected objects to the collection.
• Select one or more objects in the job, and select Remove Selection from the fly-out menu to

remove the selected objects from the collection.

Note:  Objects that are removed in the job, are automatically removed from the collection.

• Select Select All from the fly-out menu to select all objects in the collection.
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4.  Edit

4.1.  Create Lines and Shapes

With Polygon/Ellipse on the toolbar you can create ellipses and polygons numerically or manually.

You can use the Polygon/Ellipse tool to create circles and squares by keeping the [SHIFT] key down.

You can use Polygon from the Polygon/Ellipse tool to create all kinds of polygons including squares,
rectangles, triangles, etc. In this case Constrain from the Select menu helps you to create the regular
shaped polygons.

Note:

The starting point of the object affects the results when you are using Warp or Blend.

4.2.  Manipulating Linework Objects

4.2.1.  Select Linework Objects

You can:

• Select or deselect objects individually
• Select or deselect objects within an area
• Select all objects within a job
• Select objects within a layer with Select Layer
• Select objects by color with Select by Color
• Select objects by attribute with Select by Attribute
• Select the next object with Select Next

To select individual design objects:

1.
Click  on the Linework toolbar.

Select changes in a highlighted button to indicate that Select is activated.
2. Position the cursor on the object you want to select, and click the mouse button.

The object is displayed in red to indicate selection, and can be manipulated or modified.

You can continue to position the cursor to select other graphic objects.

To select all design objects within an area:

1.
Click  on the Linework toolbar.

38



4PackEdge

Select changes in a highlighted button to indicate that Select is activated.
2. Position the cursor outside of the objects you want to select, and click, hold and drag the mouse to

create a box around the design objects. Release the mouse button.

The objects are displayed in red to indicate selection, and can be manipulated or modified.

Note:

You must enclose the entire object within the selection box for the object to be selected.

Use caution when you click the mouse button. If the cursor is positioned on an object, you
will select the object when you click the mouse button (and you will not be able to drag a box
around objects to select them).

Tip:

You can use the Select tool to draw a square selection box (instead of a rectangular
selection box) by keeping the SHIFT key down. Hold and drag the red selection box around
the objects to be selected.

Note:

You can also select objects when you use the tools (except Polygon/Ellipse) from the toolbar.
For example, if you activate the Transform tool, you can select an object by dragging a red box
around the objects you want to transform.

You can select objects in:

• Red
• Green
• Blue.

Select Linework Objects in Red
Select objects in red to manipulate and modify the objects immediately.

Attention:

All red selected objects will be manipulated or modified, even if they appear outside of the
active layout window.

Select Linework Objects in Green
• To prioritize objects
• To keep an object intact when you use "destructive operations" (such as the Contours options)
• To compare objects
• To indicate the destination of other objects

Objects can be selected in green to prioritize the objects; red having the highest priority and green
having the lowest priority. For example, you can select an object in red and move the red selected
object temporarily into the background (by switching the red selected object to a green selected
object). Next, you can select another object in red and manipulate that object first. After the object is
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manipulated, you can switch the green selected object back to red to manipulate it (you can make the
modifications without having to select the object again).

When you are modifying objects with the Contours options, select in red the objects to be modified,
and select in green the objects that will not be modified. The green objects have a "cookie cutter"
effect (they are kept intact) on the red selected objects (they are modified).

Objects can be selected in green when you need to compare original objects against resulting objects
(for example, when you are using Straighten or To Splines).

You can also use green selected objects as the destination object to modify a red selected object (for
example when you are using Warp).

Select Linework Objects in Blue
Select objects in blue to extract part of a file to generate a PostScript file, or to use Backwarp.

When you are backwarping an object, select the object you want to backwarp in red, and select the
outline for the backwarp in blue. Everything outside the blue area will be ignored.

4.2.2.  Edit Linework Objects

Editing objects means cutting, copying, and pasting objects.

You can cut or copy an object to the clipboard and then paste it from the clipboard to another position
of the job displayed on screen. With Cut the original object is temporarily deleted. If you no longer need
the object you can delete it.

You can Undo or Redo editing functions.

The pasted object (or group of objects) is always pasted into the currently active layer.

When you paste objects, the objects are pasted in the same position from which they were cut, unless
you use Align. With the Align bar displayed, the alignment options can be applied to all pasting options.

Use:

• Paste to paste one or more times within a job. The object is copied from the clipboard into the
design;

• Paste Once to reduce memory usage when pasting very large objects. The object is moved from the
clipboard into the design;

• Paste In Front to paste in front of a selected object (or group of objects);
• Paste Behind to paste behind a selected object (or group of objects);
• Paste Inside to paste an object, using the red selection as a mask.
• Paste on Crosshair to paste the objects on the clipboard to the same location relative to the

crosshair.

4.2.3.  Transform Linework Objects

Use the Transform tools from the toolbar to modify selected objects manually (with a mouse), or
numerically.

You can:
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• Move, scale and stretch objects
• Rotate objects
• Shear objects
• Mirror objects (vertically or horizontally)
• Mirror objects on a guide or crosshair

You can access the Transform tools from the toolbar with the Transform rosette which enables you to
transform objects manually or numerically, based on a step size you defined.

With the Numbers dialog box you can transform objects numerically, based on a value you enter into an
input box.

The Transform rosette shows up where the cursor is positioned to enable you to quickly activate
another Transform option. You can also use the numeric keypad to perform the transformation (even if
the Transform rosette is not displayed), as long as the Transform button on the toolbar is activated.

You can perform most of the Transform functions from either the Transform rosette or the Numbers
dialog box.

Changing sizes in the Numbers dialog box will adapt the selected objects.

Tip:

If you are using the Transform tools on a text box, the text box will be modified (for example,
sheared or rotated), but the text will not be expanded or compressed unless the scale
attributes option is activated. Refer to Work with Text Boxes (advanced).

Using the Transform Reference Box
When you use the Transform tools, a red reference box (the Transform reference box) appears around
the perimeter of objects that have been selected in red. The individual objects within the Transform
reference box are modified as a unit with the Transform tools.

If you click, hold, and drag the Transform reference box to perform the manual transformation, only the
Transform reference box (not the object) appears.

To display a single object (within the Transform reference box), click a point on the object within the
Transform reference box, and perform the manual transformation (without waiting until the cursor flips
over).

To display all of the objects (within the Transform reference box), click the Transform reference box
or click a point on an object within the Transform reference box, and wait until the cursor flips over.
Perform the manual transformation. All objects appear as you perform the manual transformation.

Note:

If you press [Ctrl] while dragging, the origin (for polygons and circles this is the center) will be
immediately positioned on the center of the crosshair.

Also, if you press [Alt] while dragging, the selected object is kept in its initial position, a new
copy of the selected objects is made and the new copy is dragged to its new position.
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Moving the Point of Origin
You can move the point of origin to another location for transformations that are based on the selected
object's point of origin. Scale, Stretch (H & V), Rotate, Shear (H & V), Mirror (H & V). (If you want the
transformation to be based on a point of origin that is different from the default position).

If you are unable to locate the point of origin when you use the Transform tools to modify objects (for
example, if you zoomed in on the layout window and the origin is located outside the display area),
press [F11] and click a point. The point of origin appears on the clicked point.

4.2.4.  Spread Linework Objects

Use Spread to:

• Spread or reduce objects interactively (with the mouse)
• Spread or reduce objects numerically
• Spread an object inside another object

When you spread or reduce an object, the object is spread or reduced, parallel to the original object.

When you spread or reduce an object, you can also define the type of corner to be used for the spread
or reduced object.

You can spread or reduce an open and/or closed object.

You can use Spread on compound objects, unlinked objects, and open objects. When you use Spread
on compound objects, the objects are spread or reduced as a single object. If you spread the objects
into each other, a single object is created from the points in which the objects meet.

When you use Spread on unlinked objects, the objects are spread or reduced (proportionately) as
separate objects (some objects can overlap).

When you use Spread on a single object that intersects itself, you can create multiple, linked objects.

'Loops' are automatically removed when you use Spread. The system uses the minimal number of
points to generate the spread or reduced objects accurately, and automatically removes the 'loops' that
are visually incorrect.

4.2.5.  Splice Linework Objects

Use the splicing options from the Contours menu to create or modify objects based on overlapping or
intersecting parts, or to connect open-ended objects.

You can create or modify objects:

• From the perimeters of selected objects with Union,
• Based on the positions where two or more selected objects intersect with Intersection, Difference

and Regions,
• By using the lines of a green selected object to cut intersecting lines of a red selected object with

Cut by Objects,
• From open-ended objects, creating a single object with Connect Objects,
• From overlapping selected objects with Merge Objects,
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• By converting a stroke into an individual object with Convert Stroke.

Note:

A stroke can be created when you assign color style to an object.Refer to Apply Color to
Objects for additional information.

Note:

When you use the options from the Contours menu, the resulting objects and their properties
vary, depending on which objects are selected in red and which objects are selected in green.
The red selected objects are modified, but the green selected objects are not affected.

Attention:

You cannot perform any of the Splicing options to linked objects. Refer to Compound Objects.

4.2.6.  Manipulate Linework Layers

You can compose a job using multiple layers to increase eciency when you manipulate or modify
objects.

With the Layer Browser dialog box you can:

• Create one or more layers (insert a layer)
• Rename layers
• Delete layers which results in deleting all objects within a layer (instead of having to manipulate

each object individually)
• Change the order of layers (move)
• Display or hide layers
• Lock layers (no modifications are possible)
• Make layers invisible

Note:  Invisible layers are saved as non-printable layers in the Normalized PDF file.

With Layers in the Status bar you can easily determine or select the layer you want to work with.

Note:

You can use Select Layer from the Select menu to select and display in red all objects within
the currently active layer.

4.2.7.  Use Groups and Group Levels (Linework)

When you work with the application you can group individual objects into groups to manipulate and
modify a group as a single selection. You can also create a group that is composed of other groups, or a
group that is a combination of individual objects and groups.
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Groups are created in a hierarchical way within group levels to create a tree-like structure within the
job. There is no limit to the number of group levels within the job.

The group levels are numbered according to the order in which objects (or groups of objects) are
grouped, and are always numbered relative to the individual objects (or groups of objects) that are
designated in the group.

You can work more eciently by carefully grouping objects.

For example, if you are creating a job that consists of several flowers, group each flower. In this way,
you can easily select the whole flower to modify (for example, to move or to scale), or you can move
down a level to work on the flower's details (for example, to change the shape or color of the petals
only).

You can :

• Determine or select the Preset Grouping Level
• Monitor or select the Current Grouping Level

Note:

Group Level 1 is always reserved for single contours or objects that are composed of linked
contours, and Group Level 0 is always reserved to enable you to select the individual contours
(that are part of the compound). Group Level 2 is actually the lowest group level you can create.

Attention:

You cannot create a group that is created of objects that are positioned throughout multiple
layers, because layers are in itself a sort of group.

4.2.8.  Compound Objects (Linework)

Link multiple objects together to create a single object. The linked object acts as a single object, and
has the properties of the object that is in the uppermost position (on top of all other objects) within the
linkage.

Compound objects are modified as a single object (instead of individual objects) when you use Spread
and Color Style.

Selected objects will be linked together as a single entity, even if the objects are not overlapping.

When you link objects that have different properties, the properties of the object in the uppermost
position (on top of all other objects) are applied to the resulting (compound) objects.

When you link intersecting objects, negative spaces or "holes" are created where "filled" objects
overlap.

When you import files with scanned images or 1-bit data, the image or data is constructed as multiple
objects that have been linked into a single entity.
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Attention:

• You cannot perform any of the options from the Contours menu with individual objects after
the objects have been linked.

• You cannot cut and/or paste individual objects after the objects have been linked, even if
you select a level or change to Level 0.

Note:

If you later use Unlink to unlink certain objects from the linkage these unlinked objects do not
revert to their original properties.

Note:

• If you use Union (from the Contours menu) the selected objects must touch or overlap to be
affected. If the objects do not overlap, one linked object will be created.

• If you use Convert Stroke (from the Contours menu) and if more than one object is created,
the new objects will be linked.

4.2.9.  Convert Objects (Linework)

Straighten and Convert Vector-Based Objects
Straighten objects that have been created, scanned or saved in vector format (for example a 1-Bit TIFF
files) and convert them to spline format. You can straighten or convert individual vector-based objects,
or all vector-based objects in a file. When you straighten a vector object with the Reduce options, the
number of points is reduced, creating a smoother vector-based object. Convert the object to splines if
you want to manipulate or edit the object.

Vector-based objects require less space in the database. Because of this, you can want to leave the
object in vector format if you are working with a scanned file that is very complex, or if you want to
keep a 'scanned' look (for an object that has a 'scanned' look).

Note:

You can control how closely to the original object, the object will be straightened or converted
by entering a number in the Deviation input box.

Attention:

You cannot straighten or reduce spline objects.
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Note:

When you work with vector objects that have very rough edges, straighten the objects before
you convert them to spline format. By straightening the objects, you will have fewer points to
convert.

Other Conversions
Refer to To Splines in the Reduce menu for information about converting a vector object to a spline.
The resulting object contains fewer points than a paint object that is converted to spline format
(without being converted to vector).

You can Contourize text to convert the text characters to individual objects.

You can convert a stroke into an individual object (Convert Stroke).

4.2.10.  Flatten Objects

The Flatten Transparencies function replace all blend modes and transparencies by "normal" objects,
maintaining the look of the final result, i.e. the blend will be calculated to whatever is underneath at
that moment, and will be adepted in a lineart object (if possible) or an image.

Note:

Flattening is only done on the current page

4.3.  Working with Text

4.3.1.  Work with Text Boxes

Use text boxes when you are entering multiple lines of text, or when you are importing text from a text
file.

With Create Text on the toolbar you can create a text box numerically (based on screen x,y coordinates,
text box height, and text box width), or you can create the text box manually (based on points you click
with the mouse).

The I-beam cursor automatically appears as you create a text box.

You can enter text:

• From the keyboard (refer also to Use the Keyboard in Text Mode);

• By using the Font Window (for special characters that are not available at the keyboard);

• By importing text from a text file.

The text will have the characteristics displayed in the Text status bar.
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You can modify and format text within the text boxes by using Edit Text. Refer to Edit Text and Format
Text.

Each text box can be named (by using the Text status bar) to keep large groups of text organized. If you
import an ASCII file, the box automatically displays the name of the text stream.

You can also move, resize and reposition text boxes with the Transform tool and options from the Edit
menu. If you are using the Transform options on a text box, the text box will be modified (for example,
sheared or rotated), but the text will not be expanded or compressed unless the Scale Attributes option
is activated.

Note:

• To create a colored background for the text, you must create a background object.
• You can Contourize text to convert the text characters to individual objects that can be

manipulated and modified.

4.3.2.  Edit Text

When you edit text you change the contents of an existing text line or text block by adding, deleting or
moving characters, words or paragraphs.

You start an editing session by putting the application in the Edit Text mode with Edit Text from the
toolbar.

You can enter characters when the I-beam cursor appears.

You can add text:

• From the keyboard (refer also to Use the Keyboard in Text Mode on page 48);

• By using the Font Window (for special characters that are not available at the keyboard);

• By importing text from a text file.

The text will have the characteristics displayed in the Text status bar.

You can use the following tools from the Edit menu to edit selected text:

• Cut

• Copy

• Paste

You can delete individual text characters, multiple text characters, all text within a text box (leaving the
text box), or a text box and its contents.

If the text has not been contourized, you must select the text with the Edit Text selection method (refer
to Edit Text) to use these editing tools.

47



4 PackEdge

Attention:

Text characters that have been contourized are individual objects, and must be selected in the
same way you would select any object. Refer to Selecting Objects for additional information.

4.3.3.  Use the Keyboard in Text Mode

When the application is set in the text mode while creating or editing text various keys or key
combinations have special functions.

• Navigate through the text

You can use the keyboard arrow keys to navigate through the text.

• Create a New Paragraph

Create a new paragraph by entering a hard carriage return.

To insert a hard carriage return, press [Enter].

• Create a New Line Within the Same Paragraph

You can enter a soft carriage return to create a new line within the same paragraph (the new line is
not recognized as a new paragraph).

To insert a soft carriage return, press [Ctrl]+[Enter].

• Use a Soft Hyphen to Define Hyphenation

Use a soft hyphen to define hyphenation when a word does not fit on a line.

You can use a soft hyphen to hyphenate a word even if Hyphenation is set to Off in the Text status
bar.

To insert a soft hyphen, position the I-beam cursor where you want to place the hyphen, and press
[Ctrl]+[-].

Note:

The hyphenation for the word is based on the hyphenation settings (Char. Before, Char.
After, and Min. Length in Paragraph Styles dialog box on page 270).

4.3.4.  Create Text

With Create Text on the toolbar you can:

• Create a single line of text;
• Create text on a single object;
• Create text on multiple objects;
• Create text in a single text box.

The I-beam cursor automatically appears as you create a text.

You can enter text:

• From the keyboard (refer also to Use the Keyboard in Text Mode);
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• By using the Font Window (for special characters that are not available at the keyboard);

• By importing text from a text file.

The text will have the characteristics displayed in the Text status bar.

Note:

You can Contourize text to convert the text characters to individual objects that can be
manipulated and modified.

4.3.5.  Format Text

Format text to change the text characteristics by using the Text status bar. You can interactively
format text by selecting the text (with Edit Text options) and changing the settings in the Text status
bar.

Tip:

• When you select text to modify the text's paragraph settings (for example to modify
alignment and leading), all text within the paragraph in which the cursor is positioned is
modified. The text characters do not have to be highlighted to be affected.

• You can also format text by entering the settings in the Text status bar before you begin
entering the text.

4.3.6.  Miscellaneous Text Formatting

Perform miscellaneous text formatting functions to:

• Insert or modify fractions, leaders, and spaces with Fields;

• Optimize text placement in a paragraph or on a text line with Optimize Paragraph;

• Position text around or inside objects with Run Around;

• Create a background from a text box with Make Background;

• Create a font list with Font Preferences.

4.4.  Working with Text (advanced options)

4.4.1.  Create Text

To work with multiple, linked text boxes and to use styles.

In addition to the Basic Text features, you may also work with multiple, linked text boxes and use styles
when you use the Optional Text module.
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4.4.2.  Work with Text Boxes

To enter multiple lines of text, or to import text from a text file.

Each text box (or set of linked text boxes) can be named (by using the Text status bar).

You can link multiple text boxes to work with large amounts of text that may need to be placed in
various positions within the job. When the text boxes are linked, text automatically flows to the next
linked text box (if the text doesn't fit within the previous text box). You may adjust the flow of the text by
changing the order of the linked text boxes.

You may also name the text stream (in the Text status bar) to keep large groups of text organized as a
single unit.

4.4.3.  Linking Text Boxes

To link text boxes to make text flow from one text box to the other.

All linked text boxes are identified with a name for the text (text stream), and the text boxes are
numbered in the order in which they were created. The text stream flows into the text boxes according
to the numbering sequence of the text boxes.

You may link text boxes in these ways:

• By linking after you have interactively created text boxes, by using Link.

You can also unlink text boxes.

You can check the order of the text stream by looking at the name and number of a text box and the
icons at the bottom of the text boxes:

• An arrow in the bottom of the text box indicates the text flow continues to another text box.
• A diamond in the bottom of the text box indicates the text flow does not continue to another text

box (this is the last text box in the chain).
• A diamond in the bottom of the text box with a number displayed beside the icon indicates the

number of lines that cannot be displayed in the text box. Add another text box or resize the text box
to display the text.

Note:

If you load an ASCII file (as the default), the dialog box automatically displays the name of
the ASCII file. When you create additional, linked text boxes, each of the linked text boxes
has the name of the original text box, with a number that indicates its numeric order in the
chain.

You can rearrange the order of the text boxes to change the text flow.

4.4.4.  Format Text

To format text.
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Format text by using the Text status bar, or by applying a style. You can interactively format text by
selecting the text (with the Edit Text options) and changing the settings in the Text status bar.

- OR -

You can also format text by applying styles to the text (from the Text menu or from the Text status bar).

4.4.5.  Work with Styles

If you want to format text quickly, you can use styles. There are four different styles which allow you to
do so:

Character
Character styles define the attributes that can be applied to a line of text, word, or
sentence (for example, font or font size).

Paragraph
Paragraph styles define the attributes that can be applied to a paragraph (for
example, alignment or leading).

Tab Tab styles define the attributes that can be applied to a tabulated text.

Text
Text box styles define the attributes that can be applied to a text box (for example,
the vertical position of the first line).

Basically, styles are settings that can be applied to everything related to text. These settings can be
saved and can easily be modified.

When you modify a style, all text to which the style has been applied, is automatically modified with the
new settings.

If you save a job in which styles have been applied, the styles are automatically saved with the job. Each
time you open the job, the styles are automatically available.

Note:

• The <default> style is applied to text if you do not apply a different style.
• If you want to put a part of a text in another style, select it and make the modification. In the

status bar you will see the name of the general text style between brackets.

4.4.6.  Apply Styles

You can apply four different styles to your text. You can create a style that modifies the character, a
paragraph, the tabulation and you can define the settings of a text box.

It is possible to detect some kind of hierarchy in the styles. If you, for instance, create and apply a text
box style, this style may contain information that will also used in, for instance, a character style. So
the styles may take over certain characteristics of each other. That means that you do not have to
define every parameter again and again. When you have chosen a certain font in a Text box style, this
font will also be selected in the corresponding character style.
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This works the other way round too. When a certain element is not defined on character level, the
system will look for the information in the next level (paragraph or text box level). If the element was not
defined at all, the system will use the default settings.

4.5.  Working with Color

4.5.1.  Define Colors and Inks

The colors you use in the application are composed of one or more Inks that can be Process inks
(CMYK), PANTONE Inks, Designer Inks or inks from other standard ink books like Toyo, HKS, NCS...

To use these colors you have to put them together in a Color Palette starting from the Colors dialog.

Note:

If you drag inks from the Inks dialog box to a box already containing a color in the Color Palette,
the ink will be added to the color; if you press [Ctrl] while dragging, the original color will be
replaced by the new one.

Use the Color Factory to make your choice of colors, to display the characteristics of the colors you
have used or to modify colors. You can display a color's inks or mix a color with the Ink Factory. With the
color factory you can even define a color as a 'vignette color' by combining two or more colors.

At any point during the development of your project you can add or modify colors and inks, or delete
them if you no longer need them.

4.5.2.  Apply Color to Objects

Use the Style bar to assign color properties to objects or modify an object's color.

To apply a color to an object in the document:

1. Drag the color from the Colors dialog and drop it to the fill or stroke patch in the Style dialog.
2. Do one or both of the following:

• Press Shift and click a color to apply this color to the fill of the selected object(s).
• Press CTRL and click a color to apply this color to the stroke of the selected object(s).

3. Drag the color from the Colors dialog and drop it to the object in the drawing window to apply the
color to the fill of the object. Press CTRL to apply the color to the stroke of the object on which it is
dropped.

You can define the following settings in the Style bar:

• The fill color and the stroke color,
• The stroke width,
• The opacity for the fill, stroke or object color,
• Whether or not the fill, stroke or object color has a blend mode,
• Whether or not the fill or stroke color is masked,
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• The line end cap shape for the stroke,
• The stroke corner shape.

The fill color is used to fill the outline of a closed object with a color from the Color Palette. The stroke
color is used to paint an outline around an open or closed object with a color from the color palette.
The stroke is centered on the outline of the object. You can define the line width, the end cap and the
corner shape for the stroke.

The fill or stroke can be attributed different blend modes. For more information about these blend
modes, we refer you to the Style Bar.

In the Object/Group part of the Style dialog you have the ability to apply a transparency effect (Blend
Mode, Opacity) to an object or a group of objects in the database. The object or group of objects are
treated like a single object relative to underlying objects (= PDF Transparency Group).

4.5.3.  Working with Color (advanced options)

Define Colors and Inks (Color Factory)
Use the Color Factory to:

• Add or modify colors on the color palette with the CMYK Picker, the Block Color Palette, the Blend
Color Palette, the RGB Picker or the LCH Picker;

• Convert a color to a color from another ink book,

• Convert a PANTONE color to a CMYK-color,

• Convert an RGB- or LHC-color to a PANTONE or CMYK-color (this is obligatory because it is
impossible to assign screen colors directly to objects),

• Convert colors from a custom ink book into PANTONE colors, colors from other standard ink books,
or into CMYK.

• Create your own customized color tables with Ink Books by adding a CMYK color, a PANTONE or
other standard ink book color, RGB- or LHC- colors.

Measure Colors
Use the Color Factory to analyze the color you created based on lightness, hue, and chroma with LHC
Picker.

4.6.  Positioning Objects

4.6.1.  Work with Page Borders

Page borders are used to define the outside borders of a job.

To display or hide the page borders, activate or deactivate Page Borders and Guides in the Status bar.
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To change the size of the page borders, change the Borders size in the Document Setup dialog box.

4.6.2.  Use the Crosshair

The crosshair is used to position objects.

To display or hide the crosshair, click Crosshair in the Status bar.

For some options, you can activate a crosshair toggle button that enables you to use the crosshair for
reference when you use the option.

To move the crosshair, place the cursor on the crosshair, and click, hold and drag the crosshair to the
appropriate position. You can move the horizontal crosshair, the vertical crosshair, or both crosshairs,
depending on the location in which you click. To rotate the crosshair use the rotate crosshair button OR
left-click + Alt and rotate the crosshair.

To activate gravity on the crosshair for positioning and modifying tools, choose Snap Crosshair (F4)
from the Arrange menu.

4.6.3.  Work with Guides

Use guides to visually create and place graphic objects.

When you move the cursor around the screen, the cursor, the object's points, or the object's origin
will be pulled (or snapped) to the guides (or the intersection of the guides), based on the Gravity value
defined in Preferences.

You can create vertical, horizontal, circular, or diagonal, guides based on a numeric value; or create
perpendicular or tangential guides based on a point you click on a selected object.

The guides can be fixed or unfixed (perpendicular and tangential guides are always fixed guides). Only
fixed guides are saved with the file. Fixed guides remain in the position in which they were created,
and cannot be moved. Unfixed guides are automatically moved with the crosshair (when you move the
crosshair).

The guides can be displayed and hidden, or deleted when they are no longer needed.

Refer to the following table as a quick reference to understand the differences between fixed and
unfixed guides.

• Unfixed Guides

1. All vertical, horizontal, circular, and diagonal guides are unfixed when they are created.
2. Are not saved with the file.
3. Move with the crosshair (when the crosshair is moved).
4. You can have only one unfixed guide per type (vertical, horizontal, circular, and diagonal) in a file.
5. Can be hidden individually.

• Fixed Guides

• All perpendicular and tangential guides are fixed when they are created. Vertical, horizontal,
circular, and diagonal guides can be fixed by clicking Numeric after the guides are created.

• Are saved with the file.
• Do not move with the crosshair (when the crosshair is moved).
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• You can have as many fixed guides as you need in a file.
• Cannot be hidden individually.

Tip:

It is possible to create guides out of the displayed rulers by simply clicking one of the rulers and
dragging a guide to the desired position.

4.6.4.  Use the Page Origin

You cannot change the page origin. To use a reference other than the page origin, you can activate (and
move) the crosshair to use another location as a reference when you use some options.

4.6.5.  Use Grids

With the Layer Operations dialog box you can:

• Create (insert) one or more grid layers

A grid is a combination of construction lines allowing accurate composing of images and objects.
Gravity can be defined to make the cursor snap to the grid.

• Create (insert) one or more markup grid(s).

Use a markup grid of irregularly spaced horizontal and vertical help lines to visually create and place
graphic objects. The markup grid can be used to position the cursor, the object's points, or the
object's origin when you draw objects, position objects, or manipulate objects with the Transform
options.

To enable you to accurately position objects.

You can even define markup grids based on an object.

With the Layer Operations dialog box you can:

• Enter or modify grid settings and markup grid settings,
• Rename grids and markup grids,
• Delete grids and markup grids,
• Change the order of grids within the layers (move),
• Display or hide grids and markup grids,
• Lock grids and markup grids (allowing no modifications),
• Have gravity (snap) applied to a grid or markup grid.

With Layer in the Status bar you can easily determine or select the grid or markup grid you want to work
with.

Tip:

You can also use the gravity of a grid to create a markup layer. First, create a grid and activate
Snap. Next, insert a markup grid and add lines to the markup grid. If the gravity setting in
the Preferences dialog box is high, the markup grid will be created on the coordinates of the
original grid.
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4.6.6.  Align Objects

Use Align to:

• Align a file or selected objects based on the crosshair,

• Align a file or selected objects based on two clicked points (two-point positioning),

• Position a selected object or place a file within another object.

Objects are never moved, scaled or rotated automatically when the Align dialog is visible. You have to
press the "Apply" button to do the alignment.

4.6.7.  Arrange Objects Within a Layer

Change the order of objects within the current layer as you create or modify a job.

You can:

• Move an object to the top of the current layer with To Front;

• Move an object to the bottom of the current layer with To Back;

• Move an object forward within the current layer with Forward;

• Move an object backward within the current layer with Backward.

Use the drag and drop functionality in the Layer Browser to change the order or to move the object into
another group or layer.

Objects are created within the active layer, and are positioned in the order in which the objects are
created. For example, if you create an ellipse and then create a polygon that overlaps the ellipse, the
polygon is positioned on top of the ellipse.

You can change the order of the objects (within a layer) to obtain the results you need for a particular
job.

Note:

To position an object directly in front of or behind an object, use Paste In Front or Paste Behind.

The order of objects affects the results when you are:

• Working with opaque objects

An opaque object hides all the objects behind it.

• Working with overprinting.

If you are working with an object that will be overprinted, the overprint object has to be in front of all
objects to achieve the overprint effect.

• Working with a mask.

If you are working with an object that is a mask (created to mask another object or group of
objects), the mask object has to be behind the object it is masking. The mask object will mask all
objects in front of the masked object (within the same layer). To mask an individual object within a
layer composed of multiple objects, group the object with the mask.

56



4PackEdge

4.7.  Thin parts

The Thin Parts function allows to search for areas where objects are thinner than a given minimum
width.

The Thin parts dialog can be opened by selecting Contours > Thin Parts

 

 

Clicking the Collect button, will create a Collection of all occurrences, showing all locations where
parts of objects are thinner than the entered Threshold.

Note:  Keep in mind that strokes are NOT considered.

The Collection palette will open, so you can browse through all occurences found. See Using a
Collection on page 36 for more information on using a Collection.

Be aware that the Collection generated by Thin Parts, unlike normal collections, does NOT contain any
real objects. Instead it contains "occurences", virtual outlines of places where objects are thinner than
the entered Threshold, possibly including the suggested fix.

In the example underneath you can see that at the ends, the lines around the logo are smaller than the
Threshold. The red (virtual) objects show the suggested fix.
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Note:  Since the Collection doesn't contain real objects, the Select option is disabled in the
Collection dialog.

4.7.1.  Fixing all Thin Parts

You can use the Thin Parts function to automatically create fixes:

1. Open the Thin Parts dialog, enter the desired Threshold, and click Collect
2. In the Collect dialog, browse through the Thin Parts, and check the suggested fixes.
3. In the Thin Parts dialog, click the Fix button.

The Fix Thin Parts function will create objects (as shown in the Collection), immediately on top of
the original objects, fixing all Thin Part occurrences.

4. In the Select By Attribute palette, select "Thin Part Correction" in the Object Type section. See
Select by Attribute... (Select menu) on page 231

5. Click the Collect button
6. In the Collection palette, browse through all fixes, and correct or delete them as necessary.

4.7.2.  Fix Thin Parts tool

You can use the Thin Part Tool to interactive create fixes:

1. Open the Thin Parts window, enter the desired Threshold, and click Collect.
2. In the Collect palette, browse through the Thin Parts, and check the suggested fixes.
3.

Select the Fix Thin Part tool 
4. Click the Thin Parts you want to fix

The Fix Thin Parts function will create objects (as shown in the Collection), immediately on top of
the original object.
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Thin Part fixes created with the Fix Thin Part tool can also be selected using Select By Attribute. See
Select by Attribute... (Select menu) on page 231

4.7.3.  Thin Parts settings

Threshold: the minimum width below which parts of objects are shown as a "Thin Part" occurence.

Between thick parts:

 If this option is chosen, all thin parts will be flagged. (In the example underneath: the result on
top)

 If this option is enabled, parts of objects are only flagged as Thin Parts if the thin part is in
between two parts of the object above the Threshold. (In the example below: the result shown at the
bottom)

 

 

Suggest Fixes (in the Fly-out menu): If this option is enabled, Thin Parts will show the suggested fix,
instead of just highlighting the Thin Part itself.

Show Centerline (in the Fly-out menu): If this option is enabled, the centerline of the thin part is shown.
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5.  Text

5.1.  Working with Text

5.1.1.  Work with Text Boxes

Use text boxes when you are entering multiple lines of text, or when you are importing text from a text
file.

With Create Text on the toolbar you can create a text box numerically (based on screen x,y coordinates,
text box height, and text box width), or you can create the text box manually (based on points you click
with the mouse).

The I-beam cursor automatically appears as you create a text box.

You can enter text:

• From the keyboard (refer also to Use the Keyboard in Text Mode);

• By using the Font Window (for special characters that are not available at the keyboard);

• By importing text from a text file.

The text will have the characteristics displayed in the Text status bar.

You can modify and format text within the text boxes by using Edit Text. Refer to Edit Text and Format
Text.

Each text box can be named (by using the Text status bar) to keep large groups of text organized. If you
import an ASCII file, the box automatically displays the name of the text stream.

You can also move, resize and reposition text boxes with the Transform tool and options from the Edit
menu. If you are using the Transform options on a text box, the text box will be modified (for example,
sheared or rotated), but the text will not be expanded or compressed unless the Scale Attributes option
is activated.

Note:

• To create a colored background for the text, you must create a background object.
• You can Contourize text to convert the text characters to individual objects that can be

manipulated and modified.

5.1.2.  Edit Text

When you edit text you change the contents of an existing text line or text block by adding, deleting or
moving characters, words or paragraphs.
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You start an editing session by putting the application in the Edit Text mode with Edit Text from the
toolbar.

You can enter characters when the I-beam cursor appears.

You can add text:

• From the keyboard (refer also to Use the Keyboard in Text Mode on page 48);
• By using the Font Window (for special characters that are not available at the keyboard);
• By importing text from a text file.

The text will have the characteristics displayed in the Text status bar.

You can use the following tools from the Edit menu to edit selected text:

• Cut
• Copy
• Paste

You can delete individual text characters, multiple text characters, all text within a text box (leaving the
text box), or a text box and its contents.

If the text has not been contourized, you must select the text with the Edit Text selection method (refer
to Edit Text) to use these editing tools.

Attention:

Text characters that have been contourized are individual objects, and must be selected in the
same way you would select any object. Refer to Selecting Objects for additional information.

5.1.3.  Use the Keyboard in Text Mode

When the application is set in the text mode while creating or editing text various keys or key
combinations have special functions.

• Navigate through the text

You can use the keyboard arrow keys to navigate through the text.
• Create a New Paragraph

Create a new paragraph by entering a hard carriage return.

To insert a hard carriage return, press [Enter].
• Create a New Line Within the Same Paragraph

You can enter a soft carriage return to create a new line within the same paragraph (the new line is
not recognized as a new paragraph).

To insert a soft carriage return, press [Ctrl]+[Enter].
• Use a Soft Hyphen to Define Hyphenation

Use a soft hyphen to define hyphenation when a word does not fit on a line.

You can use a soft hyphen to hyphenate a word even if Hyphenation is set to Off in the Text status
bar.

To insert a soft hyphen, position the I-beam cursor where you want to place the hyphen, and press
[Ctrl]+[-].
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Note:

The hyphenation for the word is based on the hyphenation settings (Char. Before, Char.
After, and Min. Length in Paragraph Styles dialog box on page 270).

5.1.4.  Create Text

With Create Text on the toolbar you can:

• Create a single line of text;
• Create text on a single object;
• Create text on multiple objects;
• Create text in a single text box.

The I-beam cursor automatically appears as you create a text.

You can enter text:

• From the keyboard (refer also to Use the Keyboard in Text Mode);

• By using the Font Window (for special characters that are not available at the keyboard);

• By importing text from a text file.

The text will have the characteristics displayed in the Text status bar.

Note:

You can Contourize text to convert the text characters to individual objects that can be
manipulated and modified.

5.1.5.  Format Text

Format text to change the text characteristics by using the Text status bar. You can interactively
format text by selecting the text (with Edit Text options) and changing the settings in the Text status
bar.

Tip:

• When you select text to modify the text's paragraph settings (for example to modify
alignment and leading), all text within the paragraph in which the cursor is positioned is
modified. The text characters do not have to be highlighted to be affected.

• You can also format text by entering the settings in the Text status bar before you begin
entering the text.

5.1.6.  Miscellaneous Text Formatting

Perform miscellaneous text formatting functions to:
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• Insert or modify fractions, leaders, and spaces with Fields;
• Optimize text placement in a paragraph or on a text line with Optimize Paragraph;
• Position text around or inside objects with Run Around;
• Create a background from a text box with Make Background;
• Create a font list with Font Preferences.

5.2.  Fonts in the application

Fonts can be made available for usage as in your design as:

•  Local fonts : These fonts are available to the current jobdirectory.
•  Parent fonts: These fonts are stored in the parent directory of the jobdirectory and are available

to all the subdirectories of this directory.
•  Central fonts: These fonts are available worldwide for PackEdge .

Fonts are made available for PackEdge by Esko's FontManager. FontManager installs Type 1 fonts and
Esko V3 fonts. They can be recognized by their icon:

• Type 1 fonts 
• CID fonts
• Esko V3 fonts 

When the application is running as a standalone application (so without connection to an Automation
Engine server, for example whenn running in trial mode), you will be able to use your local system fonts.

5.2.1.  Importing PostScript and PDF

 Standard Installed Fonts in PackEdge
Standard installed fonts are available as central fonts after installing PackEdge on your workstation

and can be recognized by the icon :

Font AvantGardeCE-Book Font TimesCE-BoldItalic Font HelveticaCE-Oblique

Font
NewCenturySchlbkCE-
Roman

Font TimesCE-Bold Font CoronetCE-Regular

Font HelveticaCE-CondObl Font AvantGardeCE-DemiOblique Font HelveticaCE-
NarrowBoldOblique

Font PalatinoCE-Italic Font BookmanCE-LightItalic Font BookmanCE-DemiItalic

Font HelveticaCE Font CourierCE-BoldOblique Font HelveticaCE-CondBold

Font HelveticaCE-Bold Font PalatinoCE-Bold Font HelveticaCE-NarrowOblique

Font AvantGardeCE-
BookOblique

Font ZapfChanceryCE-MediumItalic Font TimesCE-Italic
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Font HelveticaCE-Cond Font HelveticaCE-BoldOblique Font HelveticaCE-CondBoldObl

Font
NewCenturySchlbkCE-
Italic

Font PalatinoCE-BoldItalic Font CourierCE

Font CourierCE-Bold Font PalatinoCE-Roman Font BookmanCE-Demi

Font BookmanCE-Light Font AvantGardeCE-Demi Font HelveticaCE-Narrow

Font HelveticaCE-
NarrowBold

Font CourierCE-Oblique Font NewCenturySchlbkCE-
BoldItalic

Font
NewCenturySchlbkCE-
Bold

Font Palatino-Bold Font NewCenturySchlbk-
BoldItalic

Font Univers-
CondensedOblique

Font Univers-Oblique Font MonaLisa-Recut

Font Optima-BoldItalic Font Clarendon-Light Font Bodoni-BoldItalic

Font AlbertusMT-Light Font Bodoni-Bold Font GillSans-LightItalic

Font Helvetica-Bold Font GillSans Font Bookman-LightItalic

Font Helvetica-Narrow-
Oblique

Font LetterGothic Font LubalinGraph-Book

Font NewCenturySchlbk-
Bold

Font LubalinGraph-DemiOblique Font Optima

Font LetterGothic-Slanted Font GillSans-BoldItalic Font Oxford

Font StempelGaramond-
BoldItalic

Font Helvetica-Narrow-Bold Font Marigold

Font Univers-BoldExtObl Font Helvetica-BoldOblique Font Copperplate-ThirtyThreeBC

Font Helvetica-
Condensed-Oblique

Font Univers-CondensedBoldOblique Font Times-Roman

Font Goudy-BoldItalic Font Palatino-BoldItalic Font Univers

Font Goudy-ExtraBold Font Goudy Font GillSans-Condensed

Font Univers-
CondensedBold

Font Clarendon-Bold Font AvantGarde-DemiOblique

Font LubalinGraph-Demi Font Goudy-Bold Font GillSans-BoldCondensed

Font AntiqueOlive-Roman Font CooperBlack Font LetterGothic-BoldSlanted

Font Univers-LightOblique Font JoannaMT-BoldItalic Font JoannaMT-Italic

Font ZapfChancery-
MediumItalic

Font AvantGarde-Demi Font NewCenturySchlbk-Italic

Font Optima-Italic Font Bodoni Font GillSans-Light

Font AdobeSerifMM Font NewCenturySchlbk-Roman Font AlbertusMT

Font Helvetica-Narrow Font Palatino-Roman Font Goudy-Italic
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Font Univers-Bold Font Times-Bold Font CooperBlack-Italic

Font Univers-Condensed Font Univers-Extended Font Bookman-Light

Font AdobeSansMM Font Helvetica Font AntiqueOlive-Italic

Font Bodoni-Poster Font Coronet-Regular Font Courier

Font StempelGaramond-
Roman

Font Tekton Font Times-BoldItalic

Font Helvetica-Narrow-
BoldOblique

Font Univers-ExtendedObl Font Univers-Light

Font Univers-BoldExt Font Courier-BoldOblique Font Eurostile-ExtendedTwo

Font GillSans-Bold Font AlbertusMT-Italic Font Courier-Bold

Font Bodoni-
PosterCompressed

Font Eurostile Font GillSans-ExtraBold

Font LetterGothic-Bold Font Optima-Bold Font StempelGaramond-Bold

Font Times-Italic Font JoannaMT Font Univers-BoldOblique

Font Copperplate-
ThirtyTwoBC

Font Helvetica-Condensed Font AvantGarde-Book

Font AvantGarde-
BookOblique

Font Clarendon Font Eurostile-Bold

Font AntiqueOlive-Bold Font Helvetica-Oblique Font Bodoni-Italic

Font Bookman-DemiItalic Font Helvetica-Condensed-Bold Font LubalinGraph-BookOblique

Font Courier-Oblique Font Bookman-Demi Font Eurostile-BoldExtendedTwo

Font GillSans-Italic Font Helvetica-Condensed-BoldObl Font Palatino-Italic

Font JoannaMT-Bold Font StempelGaramond-Italic Font AntiqueOlive-Compact:

Font Carta Font
ZapfDingbats

 Font Extraction during Import
The PostScript/PDF interpreter extracts fonts embedded in PostScript and PDF files. Only Type 1
fonts embedded in a PostScript/PDF file will be extracted. The extracted fonts will be installed locally
automatically.

Attention:

For copyright reasons extracted fonts can ONLY be used to view and output the particular
PostScript, PDF or Illustrator job containing the font. Any other use of that font e.g. editing the
text requires a license of that font.
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Fontmatching

Note:

The PostScript Name is always used for fontmatching.

If the option 'Convert Text to Contours' for import of a Postscript/PDF or Illustrator file in the
Esko application is activated, all text will be contourized.

Flow chart: Fontmatching

 

 

In PackEdge, the search order for fonts to which the PostScript/PDF or Illustrator job is referring to, is:

1. If the font is embedded, this font is used.

Should the text be preserved as text, the embedded font will be extracted and automatically
installed as a local font in the current directory. The current directory is the directory where the
PostScript file is located.
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Note:

• If the embedded font is not a Type 1 font, this font is used BUT the text is contourized.

• If the embedded font is a Type 1 font, this font is used AND the imported text is
composed text.

2. If there is an Active font associated with the local jobdirectory and having the given PostScript

name this Active Local Font( ) is used for the fontmatching during the import.

The jobdirectory is the directory where the PostScript/PDF or Illustrator file is located.
3. If there is an Active font associated with the Parent ( ) directory having the same PostScript

name, this Active Parent Font is for fontmatching during import.
4. If there is an Active font in the central font ( ) directory this active Central Font is taken for

fontmatching during the import.
5. If no active central font ( ) is found, the system checks the standard PostScript font installed

during the installation of PackEdge
6. If no standard PostScript font is found, the system will replace the font with the selected

replacement font.

Note:

All fonts found (embedded, local, parent, central, standard, replacement font) for fontmatching
during import are stored as Local Fonts.

If a central font is found for fontmatching it will be stored as a local font on the specified output
directory of the EPS / PostScript/PDF or Illustrator file.

The output directory is :

• By default the directory where the EPS / PostScript/PDF or Illustrator file is located,

• or it is the output directory specified in the output tab sheet in the Esko NT application.

5.3.  Working with Text (advanced options)

5.3.1.  Create Text

To work with multiple, linked text boxes and to use styles.
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In addition to the Basic Text features, you may also work with multiple, linked text boxes and use styles
when you use the Optional Text module.

5.3.2.  Work with Text Boxes

To enter multiple lines of text, or to import text from a text file.

Each text box (or set of linked text boxes) can be named (by using the Text status bar).

You can link multiple text boxes to work with large amounts of text that may need to be placed in
various positions within the job. When the text boxes are linked, text automatically flows to the next
linked text box (if the text doesn't fit within the previous text box). You may adjust the flow of the text by
changing the order of the linked text boxes.

You may also name the text stream (in the Text status bar) to keep large groups of text organized as a
single unit.

5.3.3.  Linking Text Boxes

To link text boxes to make text flow from one text box to the other.

All linked text boxes are identified with a name for the text (text stream), and the text boxes are
numbered in the order in which they were created. The text stream flows into the text boxes according
to the numbering sequence of the text boxes.

You may link text boxes in these ways:

• By linking after you have interactively created text boxes, by using Link.

You can also unlink text boxes.

You can check the order of the text stream by looking at the name and number of a text box and the
icons at the bottom of the text boxes:

• An arrow in the bottom of the text box indicates the text flow continues to another text box.
• A diamond in the bottom of the text box indicates the text flow does not continue to another text

box (this is the last text box in the chain).
• A diamond in the bottom of the text box with a number displayed beside the icon indicates the

number of lines that cannot be displayed in the text box. Add another text box or resize the text box
to display the text.

Note:

If you load an ASCII file (as the default), the dialog box automatically displays the name of
the ASCII file. When you create additional, linked text boxes, each of the linked text boxes
has the name of the original text box, with a number that indicates its numeric order in the
chain.

68



5PackEdge

You can rearrange the order of the text boxes to change the text flow.

5.3.4.  Format Text

To format text.

Format text by using the Text status bar, or by applying a style. You can interactively format text by
selecting the text (with the Edit Text options) and changing the settings in the Text status bar.

- OR -

You can also format text by applying styles to the text (from the Text menu or from the Text status bar).

5.3.5.  Work with Styles

If you want to format text quickly, you can use styles. There are four different styles which allow you to
do so:

Character
Character styles define the attributes that can be applied to a line of text, word, or
sentence (for example, font or font size).

Paragraph
Paragraph styles define the attributes that can be applied to a paragraph (for
example, alignment or leading).

Tab Tab styles define the attributes that can be applied to a tabulated text.

Text
Text box styles define the attributes that can be applied to a text box (for example,
the vertical position of the first line).

Basically, styles are settings that can be applied to everything related to text. These settings can be
saved and can easily be modified.

When you modify a style, all text to which the style has been applied, is automatically modified with the
new settings.

If you save a job in which styles have been applied, the styles are automatically saved with the job. Each
time you open the job, the styles are automatically available.

Note:

• The <default> style is applied to text if you do not apply a different style.
• If you want to put a part of a text in another style, select it and make the modification. In the

status bar you will see the name of the general text style between brackets.

5.3.6.  Apply Styles

You can apply four different styles to your text. You can create a style that modifies the character, a
paragraph, the tabulation and you can define the settings of a text box.
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It is possible to detect some kind of hierarchy in the styles. If you, for instance, create and apply a text
box style, this style may contain information that will also used in, for instance, a character style. So
the styles may take over certain characteristics of each other. That means that you do not have to
define every parameter again and again. When you have chosen a certain font in a Text box style, this
font will also be selected in the corresponding character style.

This works the other way round too. When a certain element is not defined on character level, the
system will look for the information in the next level (paragraph or text box level). If the element was not
defined at all, the system will use the default settings.
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6.  Export & Print

6.1.  Printing or Exporting to PostScript

6.1.1.  Optimizing PostScript Files Generation

Any job, opened in the editor, can be converted to a PostScript file. This PostScript file can be proofed/
exposed on a standard PostScript device. Although PostScript is defined to be device independent, it
is better to specify the target device while converting, in order to obtain an optimal PostScript file:

1. The complexity of the data that can be processed depends on the hardware of the PostScript
device.

2. Supported page sizes (and imageable areas) also differ from device to device.
3. If the device has pre-installed fonts, they do not need to be included in the generated PostScript

file.
4. Some devices support special features, such as output mode selection (e.g. draft mode), input slot

selection (e.g. manual tray) or duplexing...
5. A PostScript file can be generated which does not contain any redundant information:

The resolution of the line art may be reduced to about the device's resolution and the pixel art may
be subsampled at about the same rate as the device's screening resolution.

For these reasons, it is important to use the correct device driver. This will result in optimal results,
performance and the smallest possible PostScript files.

6.1.2.  Resolve Overprint and Translucency

The 'Resolve Overprint and Translucency' option ensures that the visual representation of overprinting
objects in the input job and the exported job, is exactly the same. This option allows you to overcome
problems when exporting/printing designs containing overprint and transparency. When 'Resolve
Overprint and Translucency' is active, transparent objects are pre-processed and their color is
combined with the color of their background. During this process, overprinting objects are split into
color regions which either receive a new combined color (e.g. for overprinting solid colors) or are pre-
ripped to a CT image (e.g. for text overprinting an image).

6.1.3.  Intellicurve (dot gain compensation) and PackEdge

The first part of the Calibration tab of the print/export options allows to use Esko's IntelliCurve
technology to compensate for dot gain.
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Dot gain is an effect occurring in all of today's printing processes. A screened area on the film used in
platemaking appears darker when printed. A 40 percent screen could look like a 60 percent screen,
so a screen with a bigger screen dot, hence the name "dot gain". Dot gain causes the press to print
darker than was intended by the designer. As a result, the general aspect will be too dark. It will lack
brightness and most people will not like it. Furthermore, dot gain happens on screened densities, but
not on unscreened densities. A color consisting out of 100 % Cyan and 50 % Magenta will suffer from
dot gain on the magenta, but not on the Cyan. The color will be too dark but also too red. So it is not
purely a shift to darker colors, but also the hue and saturation of the colors can seriously alter due
to dot gain. As a result, sensitive colors like skin colors, fruit, vegetables or brand logos cannot be
reproduced correctly on a press with high dot gain, unless this effect is professionally compensated
for.

Intellicurve is Esko's high quality dot gain compensation and imagesetter calibration utility. The
IntelliCurve procedure lets you define how the values on film or plate relate to the values in your
job and does all corrections automatically when exposing on your imagesetter. Compared to more
conventional dot gain compensation methods, Intellicurve is:

• easier to use
• very precise
• designed for both film workflows as direct to plate workflows.

The process is in short as follows:

1. You make dot gain curves with the IntelliCurve . Double click on the icon on your desktop.
2. Possibly, you make a screen based dot gain compensation table with IntelliCurvePro.
3. Use the DGC curves or SCRDGC tables for outputting via PostScript by selecting their name in the

Calibration tab of the Print Options.

'Global' allows to select one DGC curve that will be applied to all your data.

'Screen'-Based' allows to select a SCRDGC table that allows you to apply dot gain compensation
selectively depending on the screen ruling, angles dot shapes and even Contone or Linework
properties.

Note:

You can also apply both DGC and SCRDGC at the same time, resulting in a cumulation of
both effects.

6.1.4.  Color and Profiles PackEdge

Note:

This information is not detailed. It is aimed at operators familiar with Color Management
Systems (CMS).

The application offers you the possibility to select BGCMS (Esko's Color Management Systems) or
standard ICC profiles when exporting to PostScript.
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Color Space
Colors are assigned to objects. A color is defined as an array of numbers. Each number refers to a
quantity of a physical entity like the percentage coverage of an ink on paper. A color is a point in an n-
dimensional color space with n being the length of the array.

A color space can be either device dependent or device independent.

A device dependent color space is characterized, profiled, tagged ... if the conversion from this color
space to a device independent color space is known.

Following color spaces and conversions between color spaces are of particular importance:

• Object and Reference color space

This is the native color space of the object. Some applications can work with a mix of objects
defined in various color spaces. Some applications can only handle objects that belong to a single
color space. In the former case we speak of object color spaces, in the latter we deal with a single
reference color space.

• Monitor color space and preview conversion

For displaying the graphical objects on the monitor, the objects have to be converted from their
object color space to RGB for the monitor.

• Input color space and input conversion

When objects are imported in the application, they sometimes have to be converted from their
original color space to a more suitable object color space or application reference space.

• Output color space and output conversion

When objects are exported from the application, they sometimes have to be converted from their
object color space or the application reference color space to a more suitable color space e.g. the
native device dependent color space of the output device.

Color Management Systems

ICC

ICC stands for International Color Consortium: a group of industrial partners that defined a standard
for Color Management Systems. An ICC compatible color management system has the following parts:

Device Profiles
They describe 2 transformations:

1. From device dependent to device independent color space.

This is the actual characterization of the device. The transformation is described by a number of
Look Up Tables (LUT's), matrices and multidimensional interpolation tables.

2. From device independent color space back to the device dependent color space.

The transformation is described by a number of LUT's, matrices and multidimensional interpolation
tables. This is actually separation technology. There can be more than 1 of these transformations.
Each of these tables has a different rendering intent.

The most common rendering intents are:
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• Absolute colorimetric

No white point or black point adaptation is taken into account (XYZ matching).

• Relative colorimetric

Lab matching with clipping of out-of gamut to nearest in gamut color.

• And some less well defined intents like: saturation and perceptual.

CMM
At the heart of the Color Management System there is a Color Management Module (CMM). This is the
actual engine carrying out the transformations. There is a multitude of CMM's available from different
vendors. These CMM's can be found in the Operating System (OS) or as a plug-in of the application.

Some CMM's:

'ColorSync on Mac' and 'Windows 2000' can be found in the OS.

'PhotoShop', 'Illustrator'... can be found as a plug-in of the application.

Note:

• Profiles can have vendor specific parts next to the standard parts. These vendor specific
parts are of course only usable by a CMM of the same vendor.

• There are also device link profiles that describe a transformation from 1 device dependent
color space to another. This is actually a concatenation of a forward transformation of 1
profile and a backward transformation of another profile.

• ICC profiles can be embedded in a number of file formats like e.g. PhotoShop PSD, JPEG,
TIFF, EPS, PDF and PICT.

• Although all rendering intents have to be present in output profiles, they sometimes point to
the same transformations internally. The fuzzy definition and usage of rendering intents is
without any doubt the most confusing issue in ICC.

PostScript 3

PostScript 3 (and to some extent also PostScript 2) contains a somewhat similar but different system
for handling color.

Color specification
The PostScript generator can specify color of objects using a number of color spaces:

• CIE Based color spaces
• Device color spaces
• Special color spaces

Color rendering
The PostScript interpreter handles the different classes of color specifications in the following way:

• CIE Based color specifications and re-mapped device color spaces are converted to device
coordinates using 'color render dictionaries' (CRD). The mathematical machinery in the CRD's is
similar to the backward transformation of an ICC profile. Moreover PostScript 3 also defines entries
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in CRD's that define render intents that map 1 to 1 on ICC render intents. Just like fonts CRD's can be
embedded in the PostScript file or they can be downloaded in the PostScript RIP.

• Non re-mapped device color specifications are used directly, if the color space matches the one of
the device. If this is not the case, simple color space conversion are available to map back and forth
between DeviceRGB, DeviceCMYK and DeviceGray.

• If a device does not support all colorants in a DeviceN color specification, the DeviceN color
specification is transformed to an alternate color space: typically CMYK, using a PostScript
procedure.
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7.  Advanced Prepress functionality

7.1.  Working with Print Rule Checker

The common use of digital equipment in graphics arts has made it even more dicult to control the
quality of the work at stages prior to film or plate generation or, worse still, prior to printing. Detecting
an error that should have been fixed in pre-press, not earlier than on the press itself is a most annoying
and costly matter.

Print Rule Checker can help you to avoid these belated discoveries as much as possible. It inspects
jobs, completely or partially, for potential printing problems and violations of standard printing
conventions. Insucient line thickness or object dimensions, wrong halftone densities, the use of too
many inks, and various other production related issues are instantly brought up. A report file with a list
of all the errors that were found in the job can be generated.

PRC is available as an option on PackEdge workstations.

Tip:

The performance of PRC can improve dramatically by using PostScript-Fix first.

7.1.1.  Print Rule Checker

PRC consists of three modules:

• Report

Allows you to view the PRC report that was generated in the Check phase.
• Rules

Consists of all possible sets of rules. In these module the rules which will be active during the check
phase will be selected. Device dependent parameters can also be initialized.

• Check

Searches the job and the problems are detected and highlighted in real time. Additional information
or suggestions help you to decide if and how the problem needs to be fixed. All the tools in
PackEdge are at hand to do so. In some cases, automatic fixing is possible.

7.2.  Trapping

Trapping creates overlapping areas to compensate for possible misregistration between the different
inks on the printed result. It is used whenever two adjoining colors contain different inks in such a
way that misregistration during the printing action results in a white gap or an undesirable line of a
different color at the border of the two colors.
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There are two ways of looking at trapping:

• Spread trapping is used to trap a lighter area into a bigger darker area. The light object overprints
and spreads into the darker background of the darker object.

• Choke trapping is used to trap the lighter into a smaller darker area. The light object overprints the
darker area and chokes it.

Trapping can be applied both manually and automatically:

• With PowerTrapper, the user selects (in green) the objects that may need trapping. The system
scans these selected objects, indicates where trapping is needed and creates the trapping areas.
Here, the Trapping is executed automatically. See PowerTrapper on page 475

• Trap Red under Green is the manual trapping method. The user defines which contours need
trapping.

Note:

The trapping areas are placed in a separate 'Trap' layer. This way, you can easily remove the
trapping area, without affecting your job.

Another type of trapping is Keep Red Away from Green, where the system introduces an extra distance
between two adjoining colors in such a way that, when printed, the adjoining colors do not overlap
or mix. This is necessary for certain printing processes, where the nature of the inks or the printing
surface cause an unwanted mixing of adjoining inks.

Together with the automatic trapping, you can also define the settings for Rich Black and White
Underprint.

• Rich Black creates a separate (choked) layer on top of the black object with the ink that you defined
(by default Cyan), to obtain a darker black.

• White Underprint places a background under your design, when working with transparent or
metallic material. The default ink is Transparent white, but you can select any ink of your job.
When printing Yellow on a metal can, for example, the result of the combination will have a goldish
appearance. To avoid this, apply White Underprint.

7.3.  Bar Codes

See Bar Code on page 330

7.4.  Warp

Warp allows you to perform all linear and non-linear distortions of graphic objects on or in other graphic
objects. With the warp tool it is possible to deform or distort a selection of graphical objects onto a
curve or between two curves. The data that is selected for warping is covered with a source or input
grid. The data is warped on top of a destination curve, or between the destination curve, and an output
grid is constructed. A special application of warping is the Metal Can Distortion on page 78.
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7.5.  Metal Can Distortion

Metal can distortion is a module that allows to pre-distort a job to compensate for the distortion that
is applied when molding pre-printed 2 piece metal cans. The distortion is fully defined by a source and
destination grid. It is the customer's responsibility to capture the grid data. There are basically 3 ways
to get this data into a LW-Brix grid file:

• use the basic grid editor that is inside LW-Brix.
• define a format in which the grid data will be presented to the BG system. Esko will write a

customized import filter for you that converts this format into the BG grid format.
• export BG grid format directly from within your system that captures the distortion data. The BG

grid file format is a simply ASCII file format.

7.6.  Job Parameters

Automation Engine has the concept of job Parameters, certain parameters (bar codes, ticket
settings...) are predefined for a complete job. These job Parameters overrule the editor's settings in
most cases.

7.7.  Shuttle

Shuttle allows to connect to an Automation Engine Server. It allows to submit the current job to a
workflow queue, and to monitor jobs running on the server.

All Shuttle functionality can be found in Window > Shuttle and Window > Toolbars > Shuttle

A full explanation on Shuttle can be found in the Shuttle documentation. See https://www.esko.com/
en/support/product?id=Shuttle

Restrictions for Shuttle in PackEdge

Using Shuttle in PackEdge has some restrictions:

• Shuttle in PackEdge only connects to an Automation Engine server, and only to one single server.

• In PackEdge, a file needs to be on a shared volume known to the server in order to be able to launch
the file to a workflow.

7.8.  Studio Designer

Studio offers a 3D viewing environment where designers can see their artwork applied instantly on the
packaging. It also includes navigation and alignment tools, and by writing a 3D PDF file from Studio,
designers can share their ideas with clients for review and approval.

78

https://www.esko.com/en/support/product?id=Shuttle
https://www.esko.com/en/support/product?id=Shuttle


7PackEdge

Studio reduces time-consuming mock-ups, spots design-errors faster and takes away the guesswork
from 2D flats.

For folding carton or corrugated packaging, the shapes can be supplied by ArtiosCAD or Score!.

The Studio tools in PackEdge can be found in Production > Studio Designer

7.8.1.  Introduction

Welcome to the Studio Designer documentation.

This documentation describes Studio Designer as a plugin in Illustrator as well as Studio integrated in
other Esko applications such as PackEdge. Although the documentation is based on Studio Designer in
Adobe Illustrator, the functionality is the same in other versions.

About Studio Designer
Studio Designer is a plug-in for Adobe Illustrator, ArtPro, PackEdge and Plato, for interactive 3D
packaging design which helps designers make graphic designs or do pre-press for folding carton,
bag files, cans, corrugated boxes, flexible packages and so on. Studio Designer works with structural
design files, created in ArtiosCAD or Studio Toolkit. These can be ARD files, .bag files or .dae/.zae
files (Collada files with a printable part defined). Once a structural design file is placed in a document,
Studio Designer can display a three-dimensional preview of the packaging with the artwork rendered
on it. This allows designers to see how their graphics will look on the final package. Studio Designer
also lets you load a multi-part structural design file as a scene. Each part of the scene can get its
graphics from another document. Studio Designer also contains productive tools for quick and
accurate aligning and duplicating graphic elements.

Studio Designer is able to export a three-dimensional package to PDF and it can export snapshots of
the three-dimensional package to an image file.

About Structural Design files
A structural design file should always contain 2D information, and possibly even 3D information. If the
structural design file contains 3D information, Studio Designer can show a folded 3D representation of
the structural design file.

A structural design file (2D and 3D) contains all the cut and crease lines for a specific type of package.
A structural design file may also contain folding angles that define how the package is to be folded into
its final shape. The structural design file does not contain the graphics, only the structural lines. To
bring the structural design and the graphic design together, a structural design file can be placed or
opened.

Supported structural design file formats:

• ArtiosCAD or Studio Toolkit for Boxes (.ard files) for boxes
• Studio Toolkit .bag files
• Collada files with a printable part (.dae or .zae files)

In case a Collada file is placed, a check is performed to see if the Collada file has a printable part
defined. A printable part is an Esko extension to the Collada format.

Collada files with one or more printable parts can also be created in Studio Toolkit and ArtiosCAD.
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You can also load a structural design file as an extra scene in the Studio window. Each part of the scene
can get its graphics from another illustrator document. See Scenes and Multiple Documents on page
93

Licenses
This software is protected against unauthorised use.

To purchase a license or a subscription, please visit http://www.esko.com/store or contact your Esko
sales representative

If you have a license for Studio Designer in PackEdge, ArtPro or Plato, this license is included in
the PackEdge, ArtPro or Plato licensing. For more information, see the licensing chapter in the
corresponding manual.

7.8.2.  Studio Designer Basics

To get started with Studio Designer, you need a document with a structural design file placed into it.

If the current document does not contain a structural design file, the Studio window will look like this:
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Above you can see how a structural design file is show as a 2D representation. Open the Studio window
to see the 3D view.

The Studio Window
The Studio window is the heart of Studio Designer. It is a floating palette where you can see the three-
dimensional shape of the package.

To view the Studio window, choose Production > Studio Designer...
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1.

The Maximize button . Click it to make the Studio window options panel visible. See The Studio
Window options panel

2. The Scene. This can be the structural design file used in the current document, or a scene
combining multiple documents. See Scenes and Multiple Documents on page 93

3. The View dropdown. You can select a View preset from the dropdown, or click View to open the
View settings. See View on page 84

4. The Orientation. See Changing the Document Orientation
5. The Fly-out button, opening the fly-out menu.
6. The 3D preview of the current document or scene.
7. The Refresh button. See Refreshing on page 83
8. The Full Screen Preview button. This will open the Studio Window in full screen preview, until you

hit the esc key. See Full Screen Mode on page 83
9. Show/Hide transparent panels. See Working with Panels on page 86
10. The Show/Hide Outlines button adds the outlines of the structural design to the 3D preview.
11. The Show/Hide 3D Guides button. See 3D Guides on page 102
12. The Zoom Slider. See Changing the viewing Angle and Distance on page 83

Note:  If the placed ARD file does not contain folding angles, the plug-in cannot know how the
box has to be folded. In that case 90-degree foldings are assumed on all folding lines. If the
resulting shape is not the intended one, the proper folding angles need to be added to the ARD
file, for example using ArtiosCAD or Studio Toolkit for Boxes.
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Refreshing
By clicking the Refresh button in the bottom-left corner of the Studio Window, the graphics will be
drawn on the box. Every time the graphics change, the Studio Window will only update if you click the
Refresh button.
 

 

Refresh is also available via refresh in the fly-out window.

If Auto-Refresh is enabled in the fly-out window, the Studio Designer window will automatically be
refreshed every time your document is changed.

Changing the viewing Angle and Distance
In the Studio Window, you can look at the package from different angles.

• You can click and drag to rotate the 3D object.

• You can hold the shift key and click and drag to move the 3D object left, right, up or down (Panning).

• By moving the slider in the bottom-right corner you can look at the box from a closer or further
distance. Another way to do this zooming, is by using the mouse wheel.

• You can reset the camera position by double-clicking while holding the shift key.

To indicate that the package is not floating in mid-air, the floor concept was introduced. A package
in the Studio Window is always positioned relative to the floor, giving the package a top and bottom
definition. If the package (currently only boxes) is showing the wrong panel as top panel, then you can
use the Turn Box option. See Turn Box on page 88

Note:

When your box is facing the wrong way and when you have diculty to turn your box upright,
try using Turn Box... The turning around functionality has been designed in such a way that it
works fine if you have selected the right bottom panel.

Full Screen Mode

There are different ways to switch your Studio window to full screen mode:

•
By clicking the "Full Screen Mode" button  at the bottom of the Studio window

• By choosing Enable Full Screen Mode from the Studio Window fly-out menu
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• By choosing Window > Esko > Studio Designer > Enable Full Screen Mode

• By using the shortcut F11 on Windows or Cmd+Alt+- (minus) on Mac

When full screen mode is activated, you can only change the camera rotation, panning and
environment rotation. You can get out of full screen mode by pressing the esc key.

Scene Settings
In the Scene Settings you can finetune the way your work looks in the Studio window.

You can open the Scene Settings dialog by choosing Scene Settings from the fly-out menu, or by
clicking the Scene Settings link in the Studio Options.

If the Preview option is enabled, the Studio window will immediately reflect the changes you make in
the Scene Settings.

All settings from the Scene Settings dialog are used in the Export dialog, except Floor Reflection and
Background Image for PDF file with 3D design and UD3.

Environment

In the Environment tab you can set the Lighting Environment, the amount of Shadow Contrast, and
the background, either a color or an image.

Floor Reflection

The second tab of the Scene Settings defines the Floor Reflection by setting the amount of Reflection
Opacity and the Fade effect.

Note:  Lighting Environment and Floor Reflection Fade can only be set when using Visualizer
Quality. See Studio Visualizer in Studio Designer on page 85

View

In the View settings tab you can numerically set the view angles, pan and camera distance.

• Set the Object Heading and Object Tilt to define the position of the object

• Set the Pan and Camera Distance to define the position of the camera, or click Fit in Window to
reset the pan to zero and automatically adjust the camera position so that the 3D view fits in the
Studio Window.

• Set the Perspective by either defining the Focal Length (in mm) or Field of view (in degrees) of the
camera.

• Enable Keep vertical lines parallel if you want to get the effect of a tilt shift lens. If enabled, the
vertical lines in the pack shots remain vertical (without vantage point). You can use this to create
images that are easier to combine afterwards in a 'line-up' image. If the tilt angle is very large it can
lead to very unrealistic distorted perspective.

The View Preset dropdown allows to select one of the default settings, or any previously saved Preset.

You can save the current settings as a new preset by selecting Save as in the dropdown.

Select Manage... to open a separate dialog in which you can delete unnecessary presets.

The Scene Presets and View Presets folders can be found here:
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• On Macintosh: Macintosh/Users/user/Library/Application Support/Esko/
Studio/

• On Windows: C:\Users\user\AppData\Roaming\Esko\Studio\

You can exchange the Presets between different operators by copying the files to another computer.

If you remove all Presets and restart Adobe Illustrator, the default Presets will be recreated.

Scene Presets

The Scene Preset dropdown allows to select one of the default settings, or any previously saved
Preset.

Note:  Scene Settings contain the Environment, Floor Reflection and View.

You can save the current settings as a new preset by selecting Save as in the dropdown.

Select Manage... to open a separate dialog in which you can delete unnecessary presets.

The Scene Presets and View Presets folders can be found here:

• On Macintosh: Macintosh/Users/user/Library/Application Support/Esko/
Studio/

• On Windows: C:\Users\user\AppData\Roaming\Esko\Studio\

You can exchange the Presets between different operators by copying the files to another computer.

If you remove all Presets and restart Adobe Illustrator, the default Presets will be recreated.

Selecting Parts and Panels
You can select parts and panels by clicking on them in the Studio window.

By holding the alt key and clicking a panel or part one or several times, you can select a panel or part
that is behind another one.

A Printable part or panel will be selected in red. When selecting a non printable part, all non printable
parts sharing the same material will be highlighted in orange. For multiple instances (e.g. multiple cans
on a tray), only the printable parts of the original instance will be highlighted.

See also:

• Zooming in on Panels in the document window on page 88
• About Hidden Panels on page 87
• Scenes and Multiple Documents on page 93

Studio Visualizer in Studio Designer
Besides the Studio Designer functionality, the Studio window contains a number of functions and
options that are related to Studio Visualizer for Adobe Illustrator. These options require a Studio
Visualizer license.

By default, Studio Designer shows a preview in its own Studio Designer quality. You can switch to the
enhanced Visualizer Quality preview, by selecting Visualizer Quality in the fly-out menu of the Studio
palette, or by selecting Visualizer Quality in the Studio Window settings panel, if no part is selected.

If Visualizer Quality is checked, a number of extra options, such as changing the lighting environment,
will also become available.
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Next to these options in the Studio window, Visualizer for Adobe Illustrator also contains specific
palettes such as the Substrate and the Finishing Operations. For more information on these, we refer
to the Studio Visualizer for Adobe Illustrator documentation: http://help.esko.com/products/Studio
%20Visualizer%20for%20Adobe%20Illustrator

7.8.3.  Working with Panels

A box design and a bag design consist of a set of panels which are folded relative to each other.

Selecting Panels
In the Studio Window you can select a panel, simply by clicking on it. The selected panel is used by
certain Studio Designer features and does not affect the selected artwork.
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Tip:

Show Face Outline (in the fly-out menu) ensures that the selected panel is also shown in the
your document as a blue solid line.

Note:

Sometimes a dotted line appears next to the solid one. This is the case when you select a panel
that is also part of a composed face.

About Hidden Panels
Some panels cannot be seen in the Studio Window because they are covered by another panel no
matter which angle you are viewing the package from. To see those panels, you can choose Show
Transparent Panels, which is available at the bottom and from the Studio Window fly-out menu. In this
mode the package is drawn in a semi transparent way, allowing you to see covered panels. This will help
you to understand how the package's 2D unfolded view and the 3D view relate to each other.
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By holding the alt key and clicking a panel one or several times, you can select a panel that is behind
another panel.

Zooming in on Panels in the document window
If you double-click a panel (or if you select Fit Panel in Document Window from the Studio Window's
fly-out menu), the document window will zoom in on the corresponding part of the graphics.

If your graphics are in another document, then this document will become active.

Since only one document can be open at once, this will close the open document. If the open document
was changed, you will be asked if you want to save the document first.

Furthermore, the orientation of the document window will change to match the orientation in the
Studio Window as closely as possible.

You can also zoom in by holding down the Ctrl key and dragging a rectangle around the area you want to
zoom in on.

 

 

By spinning the package and double-clicking the different panels, the Studio Window can be used to
navigate through the document.

Turn Box
When working with designs for folding carton or corrugated boxes, you might not be able to position
the box in the desired viewing angle in the Studio Window. This happens when the package has the
wrong panel(s) facing up. You can change this e.g. in the structural design file (by selecting another
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Base Panel in ArtiosCAD or Studio Toolkit for Boxes), but you can also turn the box in the Studio
Window. Just select a panel that should be facing up or down and select Turn Box from the Studio
fly-out menu. The Turn Box functionality is linked with the Floor concept, so e.g. The selected panel
facing up means that the selected panel will become the top panel relative to the floor.

Note:

The Turn Box option is only available for boxes (ard files)

 

 

Bring Panel Forward and Send Panel Backward
This functionality is only available for boxes and composed faces of which the panels are all in the
same plane. Overlapping panels in the same plane can occur in any file. Sometimes the order of these
overlapping panels is incorrect. Most of the time, this will happen when the panels have been folded 90
degrees on top of each other. With Bring Panel Forward and Send Panel Backward, you can correct
this order.

If you wish to view another panel on top, you can select the panel, select Bring Panel Forward from the
Studio fly-out window and bring it forward.

Creating Copies with the Distribute command
Most of the faces of a package consist of a single panel. So there is just one rectangular area in the
document that will make up this face. However, sometimes a face is made of several panels. The
panels of such a “composed face” are spread across the document. They can even have a different
orientation. So for composed faces it is very dicult to create graphics that run continuous from one
panel into the other. Studio Designer can help you in this process with a feature called Distribute.
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Note:

You can use Distribute on .bag and .ard files but not on Collada files.

Composed Faces

This is an example of a box with composed faces.-

 

 

This is an example of a bag.
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Viewing the Composed Face
If you select Show Face Outlines in the Studio fly-out menu and you click one panel that is part of a
composed face, 'ghost’ outlines will be drawn of the other panels of that face. These ghost outlines can
give you a good impression of the size and shape of the composed face.

 

 

Distribute
If you draw some art within the boundaries of such a composed face, it will only appear on one
panel, since the other panels are actually somewhere else in the Illustrator document. However, with
Distribute, you can create copies of the art over several panels that are perfectly aligned to make it
look continuous on the folded composed face.

This is how the folded package will look without applying Distribute.
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Distribute is available from Studio's fly-out menu. First you need to select art in the document and
you need to select the corresponding panel in the Studio Window. The selected art is supposed
to be positioned correctly on the selected panel. If you choose Distribute, copies will be made of
the selected art for the other panels (of the same composed face). In the Studio Window (which is
automatically refreshed after a Distribute) you can see how the graphics are running seamless from
one panel into another.

Normally, distribute will make a copy of the selected objects for every panel in the composed face
(unless there is no overlap). If you do not need all these copies, you can simply delete the ones you do
not need.

This is how the folded package will look when having applied Distribute.
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Making Clipping Masks
It is very likely that one or more of the copies lay partially outside of the panel they were created
for. Sometimes this is a desired effect (having the graphics run continuously over a folding line).
Sometimes this is not a desired effect and you will have to create a clipping mask to contain the copy
within its panel.

 

 

Working With Distributed Art
You can update the copied distributed art, for example after you have edited the original art; or you can
undistribute and expand distributed art if you want to delete the copies.

Undistribute and Expand

The options Undistribute and Expand, which can be found in Studio's fly-out menu also apply to
distributed art. If you select distributed art and you Undistribute, all other (non-selected) copies
are deleted. If you have distributed art selected and you Expand, nothing will change visually yet the
selected art will loose its 'intelligence' and become regular artwork, insensitive to actions like Update
Copies or Undistribute.

You will need to use Expand if you start copying and pasting distributed art. The copy will still be
considered as part of a distribution, by expanding it, it will no longer be seen as a distribution, but as an
ordinary object.

Note:

When the distributed art is a group, ungrouping it is equivalent to applying Expand. The art
does not longer know that it was distributed, even if you group it again.

7.8.4.  Scenes and Multiple Documents

The 3D object that you see in the Studio window is typically the combination of two files: The artwork
from the current Illustrator document and the shape from the structural design file that is placed in
that document.

However, sometimes you would like to make combinations of more than one Illustrator document or
more than one structural design file. Some examples are:

• A box with inside and outside artwork

• A bottle with more than one label

• A tray containing 6 cans
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• A complicated multi-piece display

• ...

This chapter describes the different mechanisms behind these workflows.

Alternative scenes

Load Scene

At the top of the Studio Window is the Scene dropdown box. Here you can see which structural design
file is currently visible in the Studio Window. By default this is the same file that is placed in your
document, but from this drop down you can load other structural design files.

 

 

Your artwork will appear automatically on the loaded scene if the following conditions are met:

• There is a structural design file placed in the PackEdge document

• The selected scene has a printable part

• The printable part has the same size as the placed structural design
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In this example, the placed structural design file is a Collada file of a single can. The two other loaded
scenes are Collada files made in ArtiosCAD or Studio Toolkit, featuring that same can. You can switch
quickly between the loaded scenes from the drop down list. This can help you to improve the artwork
by seeing it in all of its different contexts.
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Note:  If you have the WebCenter Connector plug-in installed, you can use Load Scene from
WebCenter. See Using Studio Designer and WebCenter Connector

Remove Scene

You can remove items from the list by selecting Remove…. This will free up memory but will not delete
the files. The files that are placed in an illustrator document cannot be removed, unless you close the
document first.

Back side and Double-sided Artwork
When you place or open a structural design, it is loaded with the front side facing towards you (typically
the outside of the box). The Studio window will show the artwork in this document on the front side of
the board.

For ArtiosCAD structural design files you can also show artwork on the back side of the board (typically
the inside of the box):

This feature works only for ArtiosCAD files.

The Studio Window can show artwork on both sides:

• The front and back artwork must be in two different documents

• In both documents the same ArtiosCAD structural design file must be placed (or two ArtiosCAD files
with identical size)

• The ArtiosCAD info must be flipped in one of the documents.

A fast and easy way to add graphics to the inside or back side, is to double-click the inside or back side
panel, creating a new file for the inside.
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Collada files with Multiple Printable Parts
Some of the Studio Toolkits can produce Collada files with more than one printable part:

• A bottle with two labels, created by Studio Toolkit for Labels

• A multi-pack shrink sleeve, created by Studio Toolkit for Shrink Sleeves

• …

ArtiosCAD can also output structures with multiple printable parts. There is a slightly different
workflow for ArtiosCAD files that will be explained in the next chapter.

When you use a Collada file with multiple printable parts, you can only choose one printable part to
place:

 

 

To see the object in the Studio Window with artwork on all the printable parts, organize your artwork in
a different document for each part. Use the same structural design file in every document and select
the corresponding part.

When opening all the documents one by one, the Studio window will automatically show the different
documents as artwork on the different parts:
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Working with multi-part structures from ArtiosCAD
In ArtiosCAD you can also build structures with more than one printable part. This section describes
how to handle these in Studio Designer.

Multi-Part ARD files

If all the parts are in the same board material, it is possible to save them into one ArtiosCAD (ARD) file.

Like any other ARD file, you can open it in a PackEdge document.Like any other ARD file, you can
import it in an ArtPro document.

Studio Designer will show the composition in 3D. In this case the artwork is organized in one document.

Multiple ARD Files

In ArtiosCAD it is also possible to combine multiple files into a 3D composition (this is typically stored
as an A3D file). If you export as a Collada file, you could use the workflow described in 5.3. But then you
loose some powerful features of the ArtiosCAD file format such as 'Create Varnish Plate', 'Distribute'
and back-side. We suggest a workflow that uses both Collada and ArtiosCAD files:

In ArtiosCAD:

• Create an ARD file for every part

• Combine the parts with ArtiosCAD 3D features.

• Save the composition as a Collada file

In PackEdge:
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Organize your artwork in a different document for every part. Place the corresponding ARD file in each
document.

 

 

The Structural Design layer shows the ArtiosCAD drawing. By default, the Studio window shows just the
one part. Repeat this for the other documents:
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To see the parts together in the Studio Window load the Collada file (from ArtiosCAD) as an alternative
scene:
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The Studio window will show the 3D shape of the collada file with the artwork of the different
documents:

 

 

Note:

For some collada files it can occur that the artwork for one part is also displayed on another
part. (This can happen if the two corresponding ARD files have identical physical dimensions).
For these Collada files, please use the procedure as described in Collada files with Multiple
Printable Parts on page 97
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Navigating between the different PackEdge documents
When multiple PackEdge documents supply artwork to the same scene, you can double click any of the
parts in the Studio window to make the corresponding PackEdge document active. (See also Zooming
in on Panels in the document window on page 88)

If you click on a printable part for which there is no PackEdge document, you will be asked to create a
new document for that part.

7.8.5.  3D Guides

In Illustrator, PackEdge, ... you can create horizontal and vertical Guides to align art. Studio Designer
offers another type of guides: 3D Guides for boxes and Collada files.

3D guides appear both in the document window and in the Studio Window.

Note:  3D guides are temporary visual aids, and are NOT saved.

You can hide or show the 3D guides in the document window by switching the visibility of the 3D Guides
layer on or off in the Layer window.

Select Show/Hide 3D Guides from the Studio fly-out menu (or click the button at the bottom) to hide or
show the 3D guides in the Studio Window.

In the Studio Window, the 3D guides appear like a horizontal or vertical plane that is intersecting
the shape. In the document, a 3D Guide appears like a set of horizontal, vertical or even slanted line
segments clipped inside panel boundaries. These line segments show where the plane is intersecting
with the panels. Graphics can snap to these segments just as with regular guides.

This is how the 3D guides are presented in the 2D and 3D view:

 

 

For Collada files made with Studio Toolkit For Labels, you can get curved 3D Guides in the document if
your printable part is a conical label:
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Creating and Editing 3D Guides
To create or move a 3D guide, use the 3D Guide tool (in the applications toolbar). Click and drag
somewhere in the shape in the document to create or move a guide. By holding the option (alt) key, you
can switch between vertical and horizontal guides.
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To delete a 3D guide, use the 3D guide tool and simply drag it outside the shape in the PackEdge
document.

To delete all 3D guides, you can delete the “3D Guides” layer that contains all 3D guides.

7.8.6.  Exporting

Studio Designer offers a variety of export options to a number of common formats.

The background color and other settings defined in the Scene Settings will show up in your exported
file.

Note:  If you have the WebCenter Connector plug-in installed, you can use Save to WebCenter
to upload the exported file directly to WebCenter. See Using Studio Designer and WebCenter
Connector

Writing TIFF Images
Studio Designer can export the 3D design to an RGB TIFF image with the graphics on top (much like the
Studio window but at higher resolutions).

1. Choose Export… from Studio's fly-out menu. Choose TIFF Image as file type.
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2. Define the Width, Height and Resolution for the image that you want to export.
3. Define the Artwork Quality. Depending on what the image is needed for, you can choose between

4 presets for the level of detail. Choosing Low (fast) will export to an image fast but with less detail,
while choosing Medium, High or Highest (slow) will produce greater detail but will take more time.

Tip:

The "Low" and "Medium" presets correspondent to the "High" and "Very High" Image Quality
found under "Model" in the "old" Studio Visualizer 14 application.

4. The Transparent Background option allows you to set the background transparent instead of the
background (color or image) defined in the Scene Settings.

5. Click Save As... to save the TIFF file.

The Scene Settings are used in the exported TIFF image: Object heading and Tilt, Pan, Perspective,
etc. See Scene Settings on page 84

Export to a 3D PDF File
In Adobe Reader or Acrobat Professional (version 8.0.1 or later) you can view / rotate 3D objects in PDF
files. Studio Designer can write such PDF files that can be used to view a package in 3D on a computer
that does not have Illustrator or Studio installed.

Choose Export… from Studio's fly-out menu. Choose PDF File with 3D Design as file type.

You can define the Size of the PDF file. Since the PDF file is only meant for on-screen viewing, this size
is of little importance.

The Add Footer toggle allows you to switch on or off the footer text. Instead of the default EskoArtwork
text you can also personalize the footer text and include your own message.
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Note:

To avoid z-fighting problems in the exported PDF files, you can use the Avoid Artefacts option.
This will make sure that whenever it is unclear which panel is on top (resulting in flickering
graphics), a calculated choice will be made, cutting out the underlying part and giving the top
part carte blanche.
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Export to a U3D File
U3D is a common exchange format for 3D objects. For example, in Acrobat Professional 8.0.1 or higher
you can place U3D files in PDF files.

Choose Export... from Studio's fly-out menu. Choose U3D File as file type.

 

 

Note:

To avoid z-fighting problems in the exported U3D files, you can use the Avoid Artefacts option.
This will make sure that whenever it is unclear which panel is on top (resulting in flickering
graphics), a calculated choice will be made, cutting out the underlying part and giving the top
part carte blanche.

Export Collada File
Studio Designer can also export to a Collada file (*.zae), a common exchange format for 3D models.

1. Choose Export... from Studio's fly-out menu.
2. Choose Collada File (*.zae) as file type.

 

 
3. Select Include Graphics at… to include the graphics at the desired resolution.

107



7 PackEdge

4. If you want to further use the Collada file in Studio Designer you need to select Keep Printable
Parts.

If Keep Printable Parts is enabled, the artwork is always exported at the default resolution.
5. Click the Save As button, and define name and location for the file.

Note:

The exported Collada files (.zae) can be further used in other EskoArtwork Studio applications
like Studio Visualizer, Studio Toolkit for Shrink Sleeves or Esko Store Visualizer and ArtiosCAD
or uploaded to the online Esko Studio Viewer.

Save Graphics Preview as PNG...
From within the Studio window, you can save a graphics preview file as a .png file, mainly for use in
Studio Toolkit for Flexibles.

 

 

7.8.7.  FAQ

This section contains the answers to a number of Frequently Asked Questions.

There is no overlap between the selected objects and the selected panel
I try to distribute a logo, and I am getting the error message There is no overlap between
the selected objects and the selected panel. Please select a panel that
overlaps with the selected objects.
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Whenever distributing for the first time, you will need to select two things: the graphics that you want
to distribute in the 2D view AND the source panel in the Studio window. The 'no overlap' error message
indicates that you did select a panel in the Studio window, but in 2D there is no overlap between the
selected panel and the selected art.

It is a good idea to switch on Show Face Outlines in Studio's fly-out menu.

 

 

When Show Face Outlines is switched on, the selected panel in the Studio window will be shown in the
2D View:
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You will immediately see that there is no overlap between the selected panel (the blue rectangle) and
the selected art (the star), so you basically selected the wrong panel. You need to select a panel that
has an overlap with the selected art:

 

 

Now you see that there definitely is an overlap between the blue rectangle and the star. You will notice
that Distribute Selection will work, which will give you the following result:
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Please note that you never had to specify to which ‘target panel’ you had to distribute, so how can you
know which target panels will be taken?

In this version of Studio Designer, the distribute functionality only works on coplanar panels. The
bottom face consists of four panels coming together: two glue panels and two larger panels. The
selected panel is drawn with a solid blue line in the 2D View, the other panels that are coplanar with it
are drawn with dashed lines. Distribution happens from the panel drawn with a solid blue line to the
panels drawn in dashed blue lines.

That is why Show Face Outlines is so interesting, as it immediately gives you an indication whether or
not distributing is at all possible and to which panels the distribution will happen.

If we move one of the stars and do an update, you will notice that the three other stars need to move as
well. It is now enough to select the moved star and click Update Copies. You will notice that Distribute
Selection is now called Update Copies. There is no need anymore to select a panel in the Studio
window.

The selected art knows that it has been distributed before. An indication that you have selected
“distributed art” is given in the info message in the Studio window: The selection contains
distributed art. This piece of distributed art has become a smart object that knows to which
panel it belongs and which other art belongs to the same distribution. When clicking Update Copies,
the other art that belongs to the same distribution (in our example, the other stars) will be replaced
with a new updated copy of the selected distributed art.

In the layer browser, you also have an indication which art is “distributed art” and hence smart. The
name of distributed art is always “Distribution”.
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What can I do if the distribution looks wrong?
The graphics have been distributed to the correct coplanar panels, but the result of the distribution in
the Studio window is still not correct.

 

 

In this case it is not that the distribution has positioned the copies in the wrong place, but that in the
2D document window, the different copies are overlapping one another. This can happen whenever
the graphic that you want to distribute is rather large.We will need to make clipping masks in this case,
using the standard tools.

If we do this for every distributed copies and then refresh the Studio window, we will get the correct
result:

You only need to make the clipping masks once. Assume you would like to move the frog a little, then
simply move one copy and click Update Copies. The other copies will also be updated and they will
keep their position under their clipping masks.

How can I distribute around a corner?
In this version of Studio Designer, distributing is only possible to other coplanar panels. Sometimes a
distribution appears to go around the corner, but this only works if a panel that is attached to the panel
around the corner is coplanar with the selected panel.

This is not the case with the box in the next example.

 

112



7PackEdge
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In this version of the software, we are not capable of doing this with the automatic distribute. We
have limited the distribution functionality to panels that are coplanar. A face in the Studio window can
be made up of different panels coming together. A beautiful example is the bottom of the box in the
picture below.

 

 

The bottom of this box consists of four panels coming together. If you select Show Face Outlines in the
Studio's fly-out menu, you will see blue lines showing up in your 2D Document Window. The solid blue
line is a reflection of the selected red panel in the Studio Window. The other panels that are coplanar
with the selected panel and that together form the bottom face, are drawn on top of that in dashed
lines. If you were to draw some graphics and click Distribute Selection then the graphics would be
copied and pasted to the three other panels that are coplanar with the selected one. Those three
panels are shown with dashed blue lines in the 2D Document Window.

In the following example, we would like a distribute from one panel to another that is adjacent to the
first in the Studio Window, but they are not at all coplanar. On the contrary, the angle between the two
panels is 90 degrees. As automatically distributing will be impossible in this case we will have to do the
copying, rotating and pasting of the graphics ourselves. The Create 3D Guide option can be a solution.

You could create a 3D Guide in the back inner panel and that is immediately going to create extra
guides in the other panels that the guide plane intersects with.

You could now design your graphics in the back inner panel. You do not need to do this upside down as
double-clicking on the panel in the Studio Window will rotate the whole job. You can also rotate your job
manually using the orientation buttons in the right top of the Studio Window.

We will add some text to this panel that also needs to extend into the other panel.
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We will now copy the text, double-click the other panel in the Studio Window where you would like the
text to be pasted, paste the text, rotate it and position it correctly on the guide:
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8.  Menu Functions

8.1.  File Menu

8.1.1.  New (File menu)

Choose New from the File menu if you want to start working on a new file.

The Document Set-up dialog box appears. If there is no need to change the Document Set-up, just
press OK and start creating.

8.1.2.  Open... (File menu)

 

 

1. File Name: the name of the selected file. It is possible to enter a complete path here.
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2. Files of type: Select the file type from the dropdown list.
3. Job: lists the 100 most recently created Jobs on the Automation Engine server. Click 'Search...' to

open the 'Select Job' dialog box, which lists all jobs defined on the server you are connected to.

 

 
4. Product: Select the Automation Engine Product from the list of available products and your

document will be opened automatically.
5. Click Search. The Select Product dialog appears, listing all products defined on the server you are

connected to.
6. Profiles: select a profile from the dropdown list. Profiles are sets of import or export settings you

can save. you can do so by hitting the Customized Settings button in the Setup... dialog
7. Setup: opens the Setup... dialog. This dialog differs for each file type.

Tip:

Use the up and down arrows to navigate in the list of previously used filenames. Use [SHIFT] up
and down arrows to navigate in the list of directories of previously used file names.

Only files of the selected type are displayed in the Files box. Some file types allow you to define certain
settings: click the 'Setup' button to open

The available file types are:

• PDF File (PDF File Setup)

• Normalized PDF file

• GRS File > the native format of the LW-editor and Strike! 1.5 or higher; (GRS File setup)

• PAL File > the Palette file format
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• CT File > the Continuous Tone file format; (CT File setup)

• TIFF File > Tagged Image File Format, designed by Aldus (TIFF File setup)

• LC File > the Contour file format (LC File setup)

• LP File > the Pixel image format (LP File setup)

• GRQ File > Quickstep file format (GRQ File)

• PLA File > Plato file format (PLA file)

• PDFPLA > Plato Normalized PDF file

• ArtPro File (ArtPro Import Options dialog on page 168)

• PostScript File > PostScript format (PostScript File setup)

• EPS File > Encapsulated PostScriptEPS File setup

• Illustrator File (8 or lower), a graphic design file format; (Illustrator File setup)

• DXF File > Drawing eXchange Format

• ArtiosCAD

• CFF2 File >Common File Format version 2 (CadX)

• DDES File > Digital Data Exchange Specifications (CadX)
• EPF > Esko Prep File

Customized Settings
The editor allows you to save customized settings as profiles. You can select these profiles in the
various open, place, export, etc. dialogs.

The idea is that you save the setup settings in profiles, so you can use them again quickly.

 

 

• File Name: enter a name to save the profile under.

• Load: Loads the selected profile

• Save: saves the profile. If you want to save a new profile: enter a new name in the File Name field
and hit 'Save'.
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• Save as Default: the changes are saved into the Default profile

• Delete: deletes the selected profile.

• Cancel: closes the dialog, changes are not saved.

Tip:

There are ready made profiles: they assist you when you export to PostScript or to PDF.

Export to PostScript:

• PostScript for press (DeviceN Composite): This output mode which is only supported by
PostScript 3 devices uses the PostScript DeviceN color space to produce high-fidelity
colors. These colors are combinations of the standard CMYK process colorants and/or spot
colorants, guaranteeing perfectly separatable PostScript code which can also be proofed
on a composite PostScript 3 device.

• PostScript for press (Separated)

• PostScript for viewing or proofing (CMYK Composite)

Export to PDF:

• PDF 1.3 for data interchange: High compatibility but slow and less editable.

• PDF 1.4 for data interchange: Interchange with modern applications, well editable. E.g.
Acrobat 5 and more recent.

• PDF 1.5 for data interchange: Interchange with modern applications, well editable. E.g.
Acrobat 5 and more recent.

• PDF for data interchange (PDF/X): PDF/X is a standardized subset of PDF designed
specifically for reliable prepress data interchange. Uses: ripping and imposition.

• PDF for Illustrator CS2 or higher.

• PDF CMYK proofing: Useful when using hard copy proofers, or when the result doesn't have
to be editable or when the result is used for softproofing. It is not useful to serve as final
output.

• PDF for RGB proofing: Useful for softproofing (smaller file, and it's faster to generate).

• PDF x-1a 2001 for data interchange.

8.1.3.  Close (File Menu)

Closes the file. The editor will ask you whether you want to save the changes.

Note:

When actions on this file were logged by an Esko Automation Engine TrackEdit Session task,
closing the file will also stop the TrackEdit Session task on the Esko Automation Engine server.
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8.1.4.  Save (File menu)

Shortcut:Ctrl + s

Choose 'Save' from the File menu. The file is saved to the file name displayed in the window's title bar.

If you imported a GRS file, the file ill be saved as a Normalized PDF file. To save a file as GRS, you can
use the Export function.

Note:

If your job has not been saved to a name before, 'Save' will behave as 'Save as'.

Attention:

If your file has been saved to a name before, and if you want to overwrite this file, the following
procedure is followed: the existing file will be saved as 'strikesave_xxx.pdf', the new file will
be written under its original name and if this file is written without any problems, the file
'strikesave_xxx.pdf' will be deleted. In case the file is not written without problems, the file
'strikesave_xxx.pdf' will be renamed to its original name.

8.1.5.  Save As... (File menu)

Shortcut: Alt + Ctrl + s

To save a file to another name or directory.

When you choose 'Save As' from the 'File menu', the Save As dialog box appears. You can only save files
to Normalized PDF file. To save in a different file type, select Export from the 'File menu'

Clicking 'Options' opens the 'Save as' dialog.

Options...

Display Image You can save the file with 'no display' image, 'thumbnail' (200 x 200 pixels)
or low-resolution 'display image' (To save the file with a 72 dpi image.
This image can be used when the file is placed as an external file).

Select You can save the entire job (default) or only some objects of the job.
Select one of the following:

• Job: To save the entire job.
• Red Selection: To save red selected objects only (refer to Select

Linework Objects in Red on page 39).

• Current Layer: To save the currently active layer only (refer to
Manipulate Linework Layers on page 43).
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Save Unused Colors Saves the unused colors of the job also. If this toggle is deactivated, only
the used colors will be saved.

Hide Technical Inks There are three options:

• Yes
• No
• As is indicated in the original File

When this option is activated technical inks will be stored in the GRS file,
but will not be visible as exposable inks for the FlexRip.

Note:

This option is not available if the Job File Format is PDF.

8.1.6.  Export... (File menu)

Shortcut: Alt + Ctrl + e

To save a file to a format other than the application's native format.

When you choose Export from the File menu, the Export dialog appears.

Export dialog
 

 

First browse to the directory to where you want to export your file.Then select the export format you
wish to export to.
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The available file types are:

• GRS
• PDF File
• Normalized PDF file
• PostScript File
• EPS File
• Export to ArtPro File on page 140
• MultiChannel CT
• RGB Preview TIFF
• CIP3 File
• LC File
• CFF2 File
• HPGL File
• PAL File
• VRML File

Should you wish to set specific export parameters, click the 'Options' button. Clicking the 'Options'
button opens the Export Options dialog. The content of this Export Options dialog depends on the
selected file type.

See also Profiles and Customized Settings.

Export to GRS
 

 

Display image: You can save the file with ’no display’ image, ’thumbnail’ (200 x 200 pixels) or low-
resolution 'display image' (To save the file with a 72 dpi image. This image can be used when the file is
placed as an external file).

Hide Technical Inks: There are three options:

• Yes
• No
• As is indicated in the original File

Select

• Job
• Red Selection
• Current Layer
• Current Page

Inks and Colors
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• Save unused inks and colors
• Clean up unused colors
• Clean up unused colors and inks

Export to PDF File
To convert to PDF format

Choose Export from the File menu and PDF File as File Type, press Setup... and the PDF Export dialog
opens with the following additional options.

Any file opened in PackEdge can be converted to a PDF file.

Tip:

For more information: read the Resolver White Paper. It can be found on the installation disk
\extra\documentation\english\resolver_wp.pdf

The PDF Export dialog consists of.

• Output on page 123
• Device on page 125
• Inks / Separation: this tab is the same as the PostScript Export Inks / Separation on page 134.
• Color Management on page 125
• Rasterize. this tab is the same as the PostScript Export Rasterize on page 135.
• Compression on page 126
• Advanced

Output
PDF Version Select a PDF version from the dropdown list.

• PDF for Illustrator CS2 or higher
• PDF/X-1 a:2001 (ISO/DIS 15930-1)
• PDF/X-1:2001 (ISO/DIS 15930-3)
• PDF 1.6: the Acrobat 7 file format
• PDF 1.5: the Acrobat 6 file format
• PDF 1.4: the Acrobat 5 file format.
• PDF 1.3: the Acrobat 4 file format.

Password security: allows you to make your file password protected. For more information, please
refer to Password Security... on page 124.

Output type

• Composite: this output type can only be selected for PostScript 3 devices since they support
deviceN colorspace to produce high-fidelity colors. These colors are combinations of the standard
CMYK process colorants and/or spot colorants, guaranteeing perfectly separatable PostScript code
which can also be proofed on a composite PostScript 3 device. The generated PostScript file will
proof correctly and separate correctly. Color management for spot color objects must be handled
by the device.

• Separated: Activate this option to generate separations. Multiple pages will be generated,
corresponding to the inks in the job.

Emulsion Up To obtain Right Reading (= emulsion up) or Wrong Reading (=emulsion down).

Image To specify Positive or Negative print mode.
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Note:

Image and Emulsion up becomes unavailable (appears dimmed) when CMYK Composite Output
was chosen.

Indicate the correct Orientation: Auto, None, 90° cw, 90ccw, 180°

Scale Define the scale in percentages. Note that the file size and the contents of the PDF file remain
unaffected: only the Scale field in the PDF file properties is filled in. PDF readers use this scaling
percentage when they import or place the file.

Enter the Vertical and/or Horizontal distortion in percentages

Select SmartMarks from the dropdown list.

Example: Put marks with ink coverage on a hardcopy proof (or view it in Acrobat).

Account for Media Box (margins) To select the margins of the job as the true boundary. Normally the
borders of the job are taken as the true boundary of the job. Sometimes however you may also want to
convert everything that is situated within the margins too.

Hide trap layers in output Toggle this option on if you do not want the trap layers included in your
output.

Output range

• Output All pages.
• Selection: output only the current page, or the red selection
• Output a number of pages. Enter page numbers or page ranges separated by commas. e.g. 1,3,5-8.

Password Security...
Click the Password Security button in the Output tab (Export to PDF task), the Password Security
window opens:
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Compatibility: the compatibilities offered here depend on the PDF version you chose in the Output tab.

Encryption level: Low (40-bit RC4)

Require a password to open the document: enter a password.

Use a password to restrict permissions: enter a password.

Printing Allowed

• Select 'None' to prevent users from printing the file.
• Select 'High resolution' to give the users the permission to print the file at high resolution only.

Changes allowed

• Select 'None' to prevent users from doing anything with the file, including filling in signature and
form fields.

• Select 'Any except extracting pages' to let users do anything to the document except extract
contents.

Enable copying of content: Lets the user select and copy the contents of the PDF document. This
option is available only if the Compatibility option is set to Acrobat 5.0 and later.

Enable Text Access: (Acrobat 5.0 and later) Enables visually impaired users to read the document
with screen readers. This option does not allow users to copy or extract the document's contents. This
option is available only if the Compatibility option is set to Acrobat 5.0 and later.

Enable plain text metadata: To allow secure content of the document to be protected while still
allowing the document to be searched according to its properties.

Device
Dot Gain Compensation You can select Dot Gain Compensation (DGC) curves made with IntelliCurve or
IntelliCurvePro.

• Single curve: Allows you to select one DGC curve (.dgc file) that will be applied to all your data.

• Automatic: Allows you to select a Screen-Based DGC table (.scrdgc file) or a DGC Strategy (.icpro
file). The former allows you to apply dot gain compensation selectively depending on the dot shape,
screen ruling, angles and even Contone or Linework properties. The latter does the same but also
offers ink based dot gain compensation.

Note:

You can also apply both single curve and automatic DGC simultaneously, resulting in a
cumulation of both effects.

Color Management
Convert to

• CMYK: all inks are converted to CMYK values.
• RGB: all inks are converted to RGB values.
• Gray: all inks are converted to Gray values.

Use link profile: Link profiles describe a transformation from 1 device dependent color space to
another. This is actually a concatenation of a forward transformation of 1 profile and a backward
transformation of another profile. This means that all other options will be grayed out as the Link
Profile takes complete care of the color management.
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Source profile: If any CMYK objects are to be converted, choose a source profile. The list shows all
CMYK print profiles in the color database. The source profile defines the target that the destination
profile is supposed to match.

Destination profile: Choose a color profile for your destination color space. The list shows all print
profiles in the color database. These profiles are either measured in Kaleidoscope or imported ICC-
profiles.

Rendering intent

• Relative (No Background): Use this option if you do not want any background simulation. The white
point of the source will be mapped on the white point of the destination process. This rendering
intent takes into account the ability of the human eye to adapt to the surrounding white.

• Perceptual: This will result in no background simulation (white of reference colorspace is mapped
on white of destination colorspace). Use this option if you don't care too much about an exact color
match but you want the pictures at least to look nice on your proofer. It will give a visually pleasing
result. If the gamut of the source is wider than the proofer, the entire gamut is shrunk so that it fits
inside the gamut of the proofer.

• Absolute (Background): Use this option if you want background simulation and you want an exact
color match, including the paper simulation.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent will
map saturated colors on saturated colors.

Map black on black When toggled on, the CMY-part of the composite colors are converted separately
from the black component. As a result, the type of black separation (Skeleton, UCR, GCR...) is
preserved by the conversion. (It is still possible that the black percentage changes slightly due to
different dot gain in the color profiles.) When toggled off, the converted CMYK colors are completely
re-separated into the black behavior that is built into the destination profile.

Use the document profile as source profile if available If there is a document profile defined, that will
be used as a source profile. The one chosen from the Source Profile dropdown list will be overruled.

Embed the Destination profile as an intermediate color space

If this toggle is off, the colors in the PDF file will not be tagged with an ICC color profile. The document
is device dependent and its colors will only be reproduced accurately if the PDF file is output on the
device that is specified in the Destination Profile. This choice is preferable if we are sure the PDF file
will be sent to the device specified in the Destination Profile.

If this toggle is on, the color in the PDF file will be tagged with an ICC color profile. The document then
becomes device independent, and its colors will be reproduced accurately even on devices with a color
space different from the one specified in the Destination Profile. In this case, the Destination Profile
is an intermediate colorspace between the Source Profile and the color profile of the device that will
eventually process the PDF file.This method is preferable when the PDF file will be sent to an unknown
device.

Embed the document profile as PDF Output intent The output intent is an ICC profile that specifies
the intended output device. If this option is toggled on, the document profile will be saved as the PDF
output intent. For certain PDF flavors (PDF-X/3) an output intent is mandatory and this option is always
on. If no document profile was set explicitly, the default document profile (crom_offs) is used instead.
If the document profile is a Kaleidoscope profile, it will first be converted to an ICC profile.

Compression
The compression type and the quality can be selected from different dropdown lists, which will make it
more convenient to select the correct type.
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General

Attention:

Activating this option will slow down PDF export considerably, so use it only for file size critical
jobs.

Optimized lossless image compression Selecting an overall lossless image compression method
seldom results in the smallest overall file size. This option will use the smallest lossless compression
method for every image separately (JPEG2000, Flate, FlateDiff, LZW, LZWDiff, CCITT3, CCITT4 or
RLE) depending on the image type and the allowed lossless compression methods for the chosen PDF
version. When activating this option the compression methods for Contones and Bitmaps are disabled
and the encoding is set to Binary. Please do not overrule this option unless you have good reasons to
choose another encoding method, otherwise the resulting file will become larger.

Attention:

Activating this option will slow down PDF export considerably, so use it only for file size critical
jobs.

Check Crop images on clip mask to crop the image(s) on the clip mask. All information located outside
the clip mask will be lost.

Encoding

• Binary: The image data is represented as binary data. This results in compact files that however are
not editable in a common ASCII editor. Nor can these files be sent over a communication line using
a communication protocol that relies on control characters in the data stream itself.

• Hex: In this way, the PostScript file remains editable with an ASCII editor at all times. They also
can be sent over a communication line using whatever communication protocol is available. The
drawback, however, is that hexadecimal image data may take up to twice as much size as binary
data.

• Ascii 85: Encodes binary data in an ASCII base-85 representation. This encoding uses nearly all of
the printable ASCII character set. The resulting expansion factor is 4:5, making this encoding more
ecient than hexadecimal.

Bitmaps

Downsample The images referenced in your design are subsampled approximately to the specified
value. Activating this option, allows you to reduce the size of the generated PDF file. Select the unit for
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subsampling from the dropdown list: lpmm or ppi. Please be aware that 1-bit copydot Images cannot be
downsampled.

Compression

• None
• CCITT group 3 and CCITT group 4
• Run Length
• LZW
• LZW Diff
• Flate (ZIP)
• Flate (ZIP) Diff

Contones

Downsample The images referenced in your design are subsampled approximately to the specified
value. Activating this option, allows you to reduce the size of the generated PDF file. Select the unit for
subsampling from the dropdown list: lpmm or ppi.

Compression

• None
• LZW
• LZW Diff
• JPEG compressions
• JPEG2000
• Flate (ZIP)
• Flate (ZIP) Diff

When selecting JPEG, an extra dropdown list becomes activated. It allows you to select the quality of
the JPEG compression that needs to be used: from Limited over Standard to Extreme.When selecting
JPEG2000, the dropdown list offers the following compression types: lossless, limited, low, standard,
high or extreme compression.

Text and Lineart

Compression

• None
• LZW
• Flate (ZIP)

Advanced
Fonts

• Contourize BG, Type 1 and unprotected CID fonts.

• Embed all fonts: Allows you to include the used BG and Type 1 fonts of your design in your PDF file. A
subset of the font will be embedded, not the whole font.

Note:

In case the BG font does not have a corresponding PostScript Name, it will automatically be
included in the PostScript file.
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Attention:

When you switch off these functions, take into account that the font downloaded on the
PostScript device can be different from the font used in your job. Consequently, the output
result can be different to your design.

Split Complex Paths

Attention:

These are workarounds for typical PostScript level 1 path limitations. Only use these when
really necessary.

• Filled and stroked paths at X points. Use this option to split linework with more than x points into
several smaller linework parts. This option decreases the complexity of the linework. A suitable
value for the selected device type is calculated for this option.

• Clip paths at X points. Use this option to split linework masks for images with more than x points
into several smaller linework parts. This option decreases the complexity of the masks.

Workaround

• Add Ink Coverage data in XMP

Uncheck this to not save the ink coverage data in the XMP section of the exported PDF file
(calculating the ink coverage might be time consuming and slow the PDF export down).

• Ignore varnish inks in output

Varnish inks will not be included while outputting PostScript

• Use technical inks in output

Technical inks will be included when the PDF file is generated. This option is by default selected

• Resolve once identical one-ups in Step & repeat file

stations will be resolved only once, they will be repeated in the output. This is faster than resolving
the whole repetition.

• Resolve once identical external files

Instead of resolving the complete file and all its external references, identical external files will be
resolved only once

• Resolve pure black overprint:

overprints are normally resolved, but default, pure black is left alone, if you want Pure Black to be
resolved too, select this toggle. This toggle is only available when the Color Management options in
the Color Management tab are activated.

• Limit size of filename to 31 characters

Use this toggle if you want to make sure your imported files can be seen/read from/by all Apple
operating systems.

• Split multipage job into multiple files.

Every page will be output as a separate file.

• Sux for PANTONE ink names

Activate this option to overrule the sux for PANTONE inks in the output file. When this option is
not activated, the PANTONE sux from the PANTONE ink name in the ink list is used.

• Force Black Overprint
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Activate this option to force overprint for objects in 100% black

Export to Normalised PDF
 

 

External references: External references have to be converted.

• Reconvert if recently updated: only updated references will be reconverted, all other conversions
will be used as they were.

• Use previous conversions: the existing conversions will be used, potential updates will not be
considered.

• Always reconvert: all external references will be converted at all times.

Put external references/Images into Output folder: Referenced files in GRS Job File Format will be
converted to referenced external files in Job File Format, but where will they end up There are two
options:

1. External Normalized PDF files will be written in the output folder, next to the main Normalized PDF
file.

2. External Normalized PDF files will be written in the original folder, next to the original external GRS
files.

• Always: the converted external files will be saved next to the main file.

• Never: the converted external files will be saved in the folder of the original files.

• If relative: if the external GRS files were close to the main GRS file (subfolder, neighboring folder)
the converted files will be saved in the output folder. If the external GRS files were not 'close' to the
main file (central SmartMarks, logos...) the converted files will be saved next to the original files

130



8PackEdge

Display image: You can save the file with 'no display' image, 'thumbnail' (200 x 200 pixels) or low-
resolution 'display image' (To save the file with a 72 dpi image. This image can be used when the file is
placed as an external file).

Composed text: Composed text is non-editable text. It can be converted to editable text by clicking it
when you are in text edit mode.

Export to Scope 3 Compatible file: Check this box if you want your Normalized PDF file to be Scope 3
compatible.

Export to PostScript File
To convert your design to a composite or pre-separate PostScript format.

Any design, opened in PackEdge can be converted to a PostScript file. Typically you want to output
to a composite PostScript file for proofing on a standard PostScript device. The generation of a
pre-separated PostScript File on the other hand is typical for exposing films or plates on a standard
PostScript device.

The PostScript Export ticket has the following tabs:

• Output on page 131

• Device on page 133

• Inks / Separation on page 134

• Color Management on page 134

• Rasterize on page 135

• Compression on page 136

• Advanced on page 137

Output
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Device type To select the output device you want your design to be exported to or printed to, the
corresponding PPD is chosen and will be used.

Output type To export or print your design as CMYK Composite, Separated or Composite.

• CMYK Composite: Activate this option to generate a composite PostScript file for proofing.

Note:

Remark that a CMYK composite PostScript file will proof correctly but separations will not
be correct since all spot color are converted to CMYK.

• Separated: Activate this option to generate separations. Multiple pages will be generated,
corresponding to the inks in the job.

• Composite: this output type can only be selected for PostScript 3 devices since they support
deviceN color space to produce high-fidelity colors. These colors are combinations of the standard
CMYK process colorants and/or spot colorants, guaranteeing perfectly separatable PostScript code
which can also be proofed on a composite PostScript 3 device. The generated PostScript file will
proof correctly and separate correctly. Color management for spot color objects must be handled
by the device.

Emulsion Up To obtain Right Reading (= emulsion up) or Wrong Reading (=emulsion down).

ImageTo specify Positive or Negative print mode.

Note:

Image and Emulsion up becomes unavailable (appears dimmed) when CMYK Composite Output
was chosen.

Enter the Vertical and/or Horizontal distortion in percentages.

Select SmartMarks from the dropdown list.

Account for job margins To select the margins of the job as the true boundary. If you deselect this
toggle, the borders of the job are taken as the true boundary. When you want to output everything that
is placed within the margins too, leave the option activated.

Hide trap layer(s) in output Trap layers will not be included in the output.

Page range

• Output All pages.
• Selection: output the current page only, or the red selection only
• Output a number of pages. Enter page numbers or page ranges separated by commas. e.g. 1,3,5-8.

Scale & Tile

• Scale. Give in a percentage.
• Fit job on page: This scales the job so it fits the selected paper size.
• Shrink oversized jobs to paper size.
• Select the 'Tile Job' toggle to obtain a tiled output if the job is too big to fit on the selected paper

size. Overlap X mm/inches: To specify a tiling overlap. The value you enter here, is the amount of
overlap in all four directions between adjacent tiles. It defaults to 5 mm.

Page Setup

• Paper size: select a paper size from the dropdown list. (This list depends on the page sizes
supported by the selected ppd.)

• Orientation: Auto, None, 90° cw, 90°ccw, 180° (becomes unavailable when 'Tile job' is selected)
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• Alignment: Bottom left, Top left, Top right, Bottom right, Centered (becomes unavailable when 'Tile
job' is selected)

• Enter the number of copies.

Device
 

 

Select the Resolution: depends on your output device and what you need the PostScript for (for
proofing for example, a lower resolution might suce).

Select the Dotshape.

Halftoning if you select CMYK Composite or Composite as Output type, you can choose to include
screen information when outputting (lpi and angle).

• Use printer default: the output device's default screen info will be used.
• Take over from job.
• Some devices offer other dotshapes if they are available in the PPD.

Dot Gain Compensation You can select Dot Gain Compensation (DGC) curves made with IntelliCurve or
IntelliCurvePro.

• Single curve: Allows you to select one DGC curve (.dgc file) that will be applied to all your data.

• Automatic: Allows you to select a Screen-Based DGC table (.scrdgc file) or a DGC Strategy (.icpro
file). The former allows you to apply dot gain compensation selectively depending on the dot shape,
screen ruling, angles and even Contone or Linework properties. The latter does the same but also
offers ink based dot gain compensation.

Note:

You can also apply both single curve and automatic DGC simultaneously, resulting in a
cumulation of both effects.

Roll Fed Devices Account for Media Width allows the conversion program to find the best printing
orientation. For roll-fed devices, mostly imagesetters, a Media Width (film width) can be specified. The
conversion program finds the best printing orientation in order not to waste paper or film if Rotation is
set to Auto. The Media Width value is expressed in mm.Extra GapAllows to specify extra width for the
film or paper feed. The Extra Gap value is expressed in mm. By default, no Extra Gap is set.

Device specific options please refer to the manual of your output device.
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Inks / Separation
The Inks / Separations tab depends on the output type you selected in the Output tab. If you choose
CMYK Composite or Composite, the Inks tab will be visible, if you choose separated, the Separations
tab will be visible.

Inks Tab

Use technical inks in output Normally technical inks are hidden when you save a job in an Esko editor.
But, there's a possibility to save the Technical inks as visible. This toggle here makes it possible to
output the visible (non hidden) technical inks.

The inks are listed. You can deselect the ones you want to exclude from export by clicking the print icon

 

 

Separations Tab

Use technical inks in output Normally technical inks are hidden when you save a job in an Esko editor.
But, there's a possibility to save the Technical inks as visible. This toggle here makes it possible to
output the visible (non hidden) technical inks.

The inks and separations are listed. You can deselect one or more inks, the according separation will
disappear from the Plates list.
 

 

Color Management
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Convert to

• CMYK: all inks are converted to CMYK values
• Gray: all inks are converted to Gray values.

Use link profile: Link profiles describe a transformation from 1 device dependent color space to
another. This is actually a concatenation of a forward transformation of 1 profile and a backward
transformation of another profile. This means that all other options will be grayed out as the Link
Profile takes complete care of the color management.

Source profile: If any CMYK objects are to be converted, choose a source profile. The list shows all
CMYK print profiles in the color database. The source profile defines the target that the destination
profile is supposed to match.

Destination profile: Choose a color profile for your destination color space. The list shows all print
profiles in the color database. These profiles are either measured in Kaleidoscope or imported ICC-
profiles.

Rendering intent

• Relative (No Background): Use this option if you do not want any background simulation. The white
point of the source will be mapped on the white point of the destination process. This rendering
intent takes into account the ability of the human eye to adapt to the surrounding white.

• Absolute (Background): Use this option if you want background simulation and you want an exact
color match, including the paper simulation.

Map black on black When toggled on, the CMY-part of the composite colors are converted separately
from the black component. As a result, the type of black separation (Skeleton, UCR, GCR...) is
preserved by the conversion. (It is still possible that the black percentage changes slightly due to
different dot gain in the color profiles.) When toggled off, the converted CMYK colors are completely
re-separated into the black behavior that is built into the destination profile.

Use the document profile as source profile if available If there is a document profile defined, that will
be used as a source profile. The one chosen from the Source Profile dropdown list will be overruled.

Rasterize
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Rasterizing resolution Enter the resolution for the objects that will be resolved.

Output as image When this toggle is activated an image is made of the job. The resolution entered
above will be taken into account.

Anti-aliasing is relevant for the line-art objects in your design, that need pre-processing and for which
images are generated. Anti-aliasing smoothens the staircase effect you get in the generated images of
lineart objects that need pre-processing.

Tip:

This option increases the readability of small text that is pre-processed to image.

Convert vignettes to image To avoid banding in the vignettes when exporting. Exporting vignettes to
a PostScript Format, may result in blends and banding due to restrictions in PostScript. However, to
obtain a nice result in your export file, activate Convert Vignettes to CT. All the vignettes present in
your design will be converted to images.

Vignette noise When exporting to PostScript, some vignettes or parts of vignettes will be converted
to images. This happens when the vignettes overlap other objects with translucency or overprint
between the vignette and the other objects. When the option 'Convert Vignettes to Image' is activated
all vignettes are converted to images regardless of overlap with other objects. Vignettes that are
converted to images may have tone jumps in the final result. To reduce this banding effect, noise is
applied on the image. The amount of noise can be specified in the field Vignette Noise.

Compression
 

 

Encoding:
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• Binary: The image data is represented as binary data. This results in compact files that however are
not editable in a common ASCII editor. Nor can these files be sent over a communication line using
a communication protocol that relies on control characters in the data stream itself.

• Hex: In this way, the PostScript file remains editable with an ASCII editor at all times. They also
can be sent over a communication line using whatever communication protocol is available. The
drawback, however, is that hexadecimal image data may take up to twice as much size as binary
data.

• Ascii 85: Encodes binary data in an ASCII base-85 representation. This encoding uses nearly all of
the printable ASCII character set. The resulting expansion factor is 4:5, making this encoding more
ecient then hexadecimal.

Compression: None, LZW or Flate (PostScript3 devices).

Downsampling The images referenced in your design are subsampled approximately to the specified
value. Activating this option, allows you not only to reduce the size of the generated PostScript file, but
also a quicker generation of the PostScript file. Select the unit for subsampling from the dropdown list:
lpmm or ppi. You can subsample both bitmaps and contones.

Advanced
 

 

Fonts

• Contourize BG, Type 1 and unprotected fonts: protected CID fonts will be referenced by name.
• Embed BG and Type1 fonts: Allows you to include the used BG and Type 1 fonts of your design in your

PostScript file. To avoid this font inclusion, because the BG or Type 1 fonts are downloaded on the
PostScript device, deactivate the option Include all Type 1 fonts. This will reduce the size of the
generated PostScript file.

Note:

In case the BG font does not have a corresponding PostScript Name, it will automatically be
included in the PostScript file.

Attention:

When you switch off these functions, take into account that the font downloaded on the
PostScript device can be different from the font used in your job. Consequently, the output
result can be different to your design.

Split Complex Paths
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Attention:

These are workarounds for typical PostScript level 1 path limitations. Only use these when
really necessary.

• Filled and stroked paths at X points. Use this option to split linework with more than x points into
several smaller linework parts. This option decreases the complexity of the linework. A suitable
value for the selected device type is calculated for this option.

• Clip paths at X points. Use this option to split linework masks for images with more than x points
into several smaller linework parts. This option decreases the complexity of the masks.

Workaround

• Ignore varnish inks in outputVarnish inks will not be including while outputting to PostScript
• Resolve once identical one-ups in Step & repeat filestations will be resolved only once, they will be

repeated in the output. This is faster than resolving the whole repetition.
• Resolve once identical external filesInstead of resolving the complete file and all its external

references, identical external files will be resolved only once.
• Resolve pure black overprint:overprints are normally resolved, but default, pure black is left alone,

if you want Rich Black to be resolved too, select this toggle. This toggle is only available when the
Color Management options in the Color Management tab are activated.

• Limit size of filename to 31 characters Use this toggle if you want to make sure your imported files
can be seen/read from/by all Apple operating systems.

• Split separated output into multiple files.Instead of writing one file containing all separations, the
system will write one file per separation.

• Suppress Hairlines At ClipsDue to the PostScript limitation of maximum points allowed for a path,
complex paths will be cut into smaller pieces. When the PostScript file is printed/exposed on
some older PostScript Rips, hairlines can become visible. To avoid this problem, activate Suppress
Hairlines at Clips.

• Image To Paper Edge To move the origin of the converted job to the lower left corner of the paper or
film. Activate this toggle to align your job to the edge of the paper or film to use the full area instead
of the imageable area.

Attention:

Exporting to a paper PostScript device: For most of these devices, there is always a border
on the output page where nothing can be imaged. Parts of your design in that border will be
lost.

• Avoid Tabular Number ProblemWhen digits are written as tabular numbers, exporting to some
PostScript Rips may result in bad positioning of the numbers. The tabular numbers are not correctly
placed at the text base line. To avoid this problem, activate Avoid Tabular Number Problems

• Disable path clipping: by default, paths are clipped by the borders of the job, but there are instances
where you do not want the paths to be clipped, if so, select this toggle.

• Sux for PANTONE ink names: Activate this option to overrule the sux for PANTONE inks in the
output file. When this option is not activated, the PANTONE sux from the PANTONE ink name in
the ink list is used.

• Maximum deviation from resolved curves  During the resolving process bezier curves are
sometimes approximated by vectors. The maximum allowed deviation of the curves can be entered
here.

• Force Black Overprint

Activate this option to force overprint for objects in 100% black
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Export to EPS/DCS File
Any design, opened in PackEdge can be converted to an EPS file.

Choose Export from the File menu and EPS File as File Type, press Options... and the EPS Export dialog
opens.

It contains five tabs:

• Output on page 139

• Color Management (Identical to the Color Management on page 134)

• Rasterize (Identical to the Rasterize on page 135)

• Compression (Identical to the Compression on page 136)

• Advanced (Identical to the Advanced on page 137)

Output
 

 

PostScript version Choose between PostScript 3 or PostScript level 2.

Output type Choose between an EPS, a Single DCS and a Multiple DCS file.

EPS: This will create an EPS file with an RGB preview. When the selected PostScript version is
PostScript 3 and the color management toggle in the Color Management tab is switched off, this will be
and deviceN EPS, in all other cases a CMYK composite EPS will be created.

Single DCS file This will create one EPS DCS file containing multiple separations. The DCS file always
contains an RGB preview used when placing the EPS DCS file. In addition a composite grayscale or
color CMYK preview may be added used for composite printing.

Multiple DCS file This will create a master EPS DCS file referring to multiple separations (one file per
ink). These separations may contain linework as well as images. The names of these files consist of the
output filename followed by the name of the ink. The master DCS file always contains an RGB preview
used when placing the EPS DCS file. In addition a composite grayscale or color CMYK preview may be
added used for composite printing.
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• EPS
• Single DCS file, no composite
• Single DCS file, grayscale composite
• Single DCS file, color composite
• Multiple DCS file, no composite
• Multiple DCS file, grayscale composite
• Multiple DCS file, color composite

Preview Resolution The default resolution is set on 72 ppi. This option can change the resolution of
the RGB preview used when placing the EPS DCS file. A higher value will produce a finer, more detailed
preview but will also increase the files size of the EPS DCS. The minimum value is 72 ppi.

Resolution The default resolution is set on 16.000 ppi. If you don't know where the EPS will be placed,
you might want to make the resolution a high one.

Page Number: To select the page of the job you want to export.

Scale you can scale using percentages.

Add SmartMarks sets by selecting one from the dropdown list.

Account for job margins Selects the margins of the job as the true boundary. Normally the borders of
the job are taken as the true boundary of the job. Sometimes however you may also want to convert
everything that is situated within the margins too.

Hide Trap Layer in output: Allows you to export your file with or without the trap layer.

Export to ArtPro File
 

 

Pages: select the page(s) you want to output.

Note:  ArtPro only reads single page files, whereas normalized PDF files can be multipage.
For “All” and multipage PDFs, PackEdge will generate one ArtPro file per page, and name it
<output filename>_<pagenr>.ap.

Version: choose either ArtPro 8.x or ArtPro 7.x (which doesn’t support transparency so PackEdge
flattens the ArtPro output file).

If you want a copy of all linked files next to the ArtPro file, you can enable the Copy linked files next to
output file option.

Export to MultiChannel CT
CT Resolution Enter the final resolution for the CT.The default is 12 pixels/mm.
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CT Aliasing Enter a value (0-4) to determine the anti-aliasing setting (which defines the pixel colors) for
the CT.If you enter 1, you normally obtain a good result. The higher the value you enter, the longer it will
take to process the file. This option is used if you are going to transfer the file into an image retouching
application (for example, ColorTone), or create an output where line art is blended into a CT.

Vignette Noise Smoothens the tone jumps in the generated vignette CT.Enter a value (%) to determine
how much noise is to be applied to the vignette CT.

Add Display Image Select this option if you want to add a display image. This display image will be used
when you place the file in the editor.

Write Alpha Plane Activating this option will generate an alpha channel to keep your transparency.

Only save red selection Exports only the red selection of your job.

Export to RGB Preview TIFF
Exports a preview of your file to RGB Tiff. This can be used in the ArtiosCAD 3D viewer.

Overview
Resolution: Define the image resolution in dpi.

Format: Options: '8 bit RGB' (indexed) or '24 bit RGB'.

Compression:

• No Compression
• LZW
• LZW diff
• Pack bits

Export to CIP3 File
A CIP3 file contains information that can be used on press, pre-press and post-press systems. A
CIP3 file has the file extension .ppf. CIP3 files generated from PackEdge will only include information
regarding the ink key settings on the press. A low resolution image of all separations will be stored in
the CIP3 file. Separations of technical inks are not included in the CIP3 file.

Tip:

A CIP3 file has a PostScript syntax, but cannot be opened as a PostScript file. A stand-alone
Plato will benefit most of CIP3 export. There is also a CIP3 export module on the FlexRIP
(InkPlanner).

The General tab allows you to define some general settings regarding the generated PPF file. Some
CIP3 convertor systems need special settings in the CIP3 file when parsing a CIP3 .ppf file: the
resolution must be in a specific range, the compression and encoding of the image data is limited to
a specific set, etc. Please contact your CIP3 convertor software manual for more information about
special requirements for the settings in the CIP3 file.
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The Administration tab offers the most commonly used keys in PPF files. You can enter data
depending on what your press actually needs.
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Attention:

Exporting to CIP3 files only works for single page documents.

In Plato, the Front and Back side of a plate are stored in one CIP3 file.

Export to LC File
When you choose Export from the File menu and LC as file type, the Export to LC dialog appears with
the following options:

GRC Compatible Only activate this option when you are generating an LC file to be used in the GRC
editor.

Merge: To select a part or the whole design to export to LC format.Activate this option when several
overlapping /intersecting objects are selected to be exported to LC format. The contours of the
objects will be joined.

Select:

The dropdown list offers you three possibilities:

• Job: the whole job is exported into one LC file.
• Red Selection: only the red selected objects will be exported into one LC file.
• Current Layer: The active layer with all objects will be exported into one LC file.
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Export to CFF2 File
CFF2 is short for the Common File Format version 2.

 

 

Use the dropdown list to select whether you want to export the whole 'job', the 'red selection' or the
'current layer'.

You can also (de)select which ink you (do not) want to output by clicking the tick: .

Define the CFF2 LineType and determine the mode:

• Output as Contours.

Two objects (Cyan) will be output as two squares:
 

 

• Output as Regions.

Two objects (Cyan) will be output as one 'region'
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Export to HPGL File

Overview

Note:

HPGL stands for Hewlett Packard Graphics Language

Pen To define the diameter of the pen

Accuracy Splines are converted to vectors when exporting to HPGL format. The value
here specifies the maximum allowed deviation.

Paper Height To define the vertical output format

Paper Width To define the horizontal output format

Orientation Possible options are: 'up' and 'down'

Origin Possible options are: 'top left', 'center' and 'bottom left'

Select Possible options are: 'Job', 'Red Selection' and 'Current Layer'.

• Job: the whole job is exported.
• Red Selection: only the red selected objects will be exported into one file.
• Current Layer: The active layer with all objects will be exported into one file.

Export to PAL File
Allows you to export the Color Palette in your PackEdge document to a Palette (.PAL) file. You can then
open the saved palette in other documents to quickly reuse your existing color definitions.

Export to VRML File
VRML stands for Virtual Reality Modeling Language. This tasks takes a GRS file and folds it into a 3D
model. It uses the folding information in the ARD file (placed in the GRS file). The result of the task is -
a VRML file which has wrl as extension. wrl stands for 'world' as in virtual world -a number of JPEG files
(they make up the panels of the 3D simulation).

Note:

• The GRS must contain a link to an ARD file.
• The ARD file must contain folding information.

Tip:

You will need a VRML viewer to view the result of the task. There are three types of VRML
viewers: a plug in, a helper application or a stand alone application.
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You can set resolution in dpi and define the JPEG compression. Options range from: JPEG Limited,
JPEG Low, JPEG Standard Low, JPEG Standard (default), JPEG Standard High, JPEG High and JPEG
Extreme.

Attention:

There's a limit to the kind of resolution that the task will process, internally the output
resolution is restricted, so entering a higher resolution does not necessarily result in high res
output.

JPEG Images:

• Separate Image on each face: creates a separate JPEG file for each face.
• High resolution images: use 'High Resolution Images when there is small text on the design, or other

graphics which require a high level of detail. A separate file is created for each face, but if more
detail is available, the files are larger.

• Single image: makes a single large JPEG file for each design instead of a single JPEG for each face.
Use this option when using the VRML file in other 3D graphics applications.

Creases:

• No creases
• Creases in board color: creases are included in the VRML, they have the same color as the board,

the lightning in the VRML rendition shows them as slightly contrasting.
• Creases in pink: turns the creases pink for easy visibility.
• Graphics on creases: wraps the graphics around the creases, this is the most sophisticated option,

but it increases the file size by 50 percent.

Include graphics: this toggle controls the export of graphics. Toggle on for rich detail, toggle off for the
smallest VRML files with the most robust performance.

Include corrugations: this option draws corrugations on the edges of corrugated boards.
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Use compression: this option controls whether the VRML geometric information file is compressed or
not. A smaller file is faster to download, but some VRML browser plug ins do not support compression.
The JPEG image files are already compressed according to the JPEG Compression (at the top of the
task).

Automatically Open:  the VRML file will be automatically opened in a VRML viewer.

Background color.

• No background: no background will be defined, the preferences set in the VRML plug in will be used.
• Define values for Red, Green, Blue

Output units: As there is no measurement ability in the browser window, the options in this group
control the granularity of the VRML plug-in's zoom tools. Selecting 'Meters' provide coarse zoom while
selecting 'millimeters' provides fine zoom. 'Centimeters' is the default, and should be selected when
choosing 'With toolbar' in the 'Animation' group.

Animation Group:

• No animation: creates an unmoving view of the design.
• Forward: runs the animation continuously.
• Forward and Back runs the animation forward, then backward, and repeats.
• With toolbar inserts a toolbar into the VRML file allowing you to manually step through the file, as

well as toggle design transparency.

Example: This is a job (Lemon.grs). It contains a link to an ARD file which contains folding information.
 

 

If we run this file through the VRML task, we get a wrl-file which looks like this when we view it in a
VRML browser:
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8.1.7.  Place... (File menu)

Alt + Ctrl + o

To place a file that has already been created.

Place the file within a job to use the file as part of a job.

When you choose 'Place' from the File menu, the Place dialog box appears. The file will be mapped
on the page origin (0,0 position in the upper left corner), unless the Align box is displayed (see Align
(Window menu) on page 521). If the Align box is displayed, the file will be placed according to the
options in the Align box.

If you place a Palette file (.pal) while another file is open, the color palette (from the selected file) will
be added to the displayed file's color palette.

Place dialog box
Click 'Options' after you have chosen the desired file type.

Show Info button
Activating 'Show Info' displays extra information about the selected file.

Setup... button
Click 'Options' to open the Import Settings dialog box.
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The content of this dialog box depends on the selected file type. See:

• Normalized PDF Import options on page 149,
• GRS Import Options dialog box on page 150,
• CT Import Options dialog box on page 151,
• TIFF Import Options dialog box on page 152,
• LC Import Options dialog box on page 152,
• LP Import Options dialog box on page 153,
• GRQ Import Options dialog box on page 153,
• PostScript / EPS / PDF or Illustrator Import Options dialog box on page 154,
• Pla Import Options dialog box on page 153,
• ArtPro Import Options dialog on page 168,
• Artios CAD Import options dialog box on page 170,
• CFF2 Import Options dialog box on page 171,
• DDES Import Options dialog box on page 172,
• BAG files on page 166,
• Collada files on page 167,
• ASCII Text Import dialog box on page 172,
• 16 Bit Text Import dialog box on page 173.

Place
Click 'Place' to place the selected file into the current job.

Cancel
Click 'Cancel' to close the dialog box without placing any file.

Normalized PDF Import options
 

 

Pages:

• Import all pages
• Select a page you want to import
• Import a range of pages

Layers :

There are three options:
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• Add: adds the layers of the placed job to the layers of the current job.
• Flatten: merges the layers to one layer and transforms each layer to a group of objects.
• Merge: merges layers of the placed job with layers of the current job that have the same name (only

applies to layers that have a name).

Composed text: Composed text is non-editable text. It can be converted to editable text by clicking it
when you are in text edit mode.

Place External: Both PDF Scope 3.0 as Esko 7.0 PDF can be placed (externally) in the same document.
External PDF Scope 3.0 files will not be converted to a higher version.

GRS Import Options dialog box
When you choose Open, Place or Place Inside from the File menu, and you select GRS as file type,
additional options appear in the dialog box:

 

 

Pages
To select the page you want to open or place (for a multi page document), by entering a number in the
Page input box.

There are three options:

• All: creates and opens one file, containing all the pages (internal multi page file).
• Select: enables you to fill in the number(s) of the page(s) you want to open in the Page box next to

the right.
• Range: enables you to select the range of pages you want to open in the input boxes next to the

right.

Layers
There are three options:

• Add: adds the layers of the placed job to the layers of the current job.
• Flatten: merges the layers to one layer and transforms each layer to a group of objects.
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• Merge: merges layers of the placed job with layers of the current job that have the same name (only
applies to layers that have a name).

Composed Text

Note:

Composed text is non-editable text. It can be converted to editable text by clicking it when you
are in text edit mode.

Place External

Note:

Place External appears when you have chosen Place or Place Inside from the File menu.

If you activate this toggle, the placed file will be considered as an external reference.

CT Import Options dialog box
When you choose Open, Place or Place Inside from the File menu, and you select CT as file type,
additional options appear in the dialog box:

 

 

Plane
To define whether you want to open or place all the planes of the CT or only the selected ones.

Embed Image
Select this toggle if you want to embed the image.

Use Opacity
Activate if the opacity information should be included in the file. If you do not activate this option, the
output will be a lot faster.

Force to place 1-bit images as copydot image
This toggle makes sure that Copydot optimization will be activated when outputting to FlexRip, if this
toggle is not selected, the Rip will contourize the 1-bit image (resulting slow performance or out of
memory issues).
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Attention:

The 1-bit image needs to be placed in blend mode Darken, when placed in blend mode opaque,
the rip will still contourize.

TIFF Import Options dialog box
When you choose Open, Place or Place Inside from the File menu, and you select TIFF as file type,
additional options appear in the dialog box:

 

 

Import Bitmap
This option is valid for bitmap (1 bit) TIFF images only. There are four options:

• Intern, to place the imported bitmaps in the design. No external reference is made.
• Extern LP, to place the imported bitmaps as external referenced LP files.
• Extern TIFF, to place the imported bitmaps as external referenced Tiff file.
• Contour, to contourize the imported bitmap in the design. No external reference is made.

Output Directory
To specify the directory where you want the files, generated on-the-fly during import, have to be
stored.

LC Import Options dialog box
When you choose Place or Place Inside from the File menu, and you select LC as file type, an additional
option appears in the dialog box:
 

 

Place External If you activate this toggle, the placed file will be considered as an external reference.
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LP Import Options dialog box
When you choose Open, Place or Place Inside from the File menu, and you select LC as file type, an
additional option appears in the dialog box:

 

 

Mode

To specify how you want your file to loaded into your (new) design. There are three possibilities:

• External: to keep your LP file as an external referenced file
• Bitmap: to load your LP file as a Bitmap in your design, without external reference.
• Contours: to load your LP file as contours in your design, without external reference.

GRQ Import Options dialog box
When you choose Open, Place or Place Inside from the File menu, and you select GRQ File as file type,
the following options appear in the options dialog box (they are the same options for importing GRS
files):

 

 

Pla Import Options dialog box
Hit the Setup button for extra options:
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Pages:

• All: creates and opens one file, containing all the pages (internal multi page file).
• Select: enables you to fill in the number(s) of the page(s) you want to open in the Page box next to

the right.
• Range: enables you to select the range of pages you want to open in the input boxes next to the

right.

Layers:

There are three options:

• Add: adds the layers of the placed job to the layers of the current job.
• Flatten: merges the layers to one layer and transforms each layer to a group of objects.
• Merge: merges layers of the placed job with layers of the current job that have the same name (only

applies to layers that have a name).

The 'Composed Text' toggle:

Note:

Composed text is non-editable text. It can be converted to editable text by clicking it when you
are in text edit mode.

PostScript / EPS / PDF or Illustrator Import Options dialog box
When you choose Open, Place or Place Inside from the File menu, and you select PostScript File/EPS/
PDF or Illustrator File as file type, additional options appear in the dialog box:

• Pages (not available for EPS file type)

• Color Management

• Inks

• Overprint
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• External Images
• Page Size (not available for EPS file type)
• Other
• Output

Note:

Encapsulated PostScript files are handled as PostScript 3 files where the (hires) bounding box
sizes are taken into account. The following EPS files are supported: generic EPS, MacBin EPS
and PC EPS (with or without TIFF preview) files.

Tip:

Placing and Placing Inside:

When converting a multi-page PostScript file (combined with Place/ Place Inside), you might
want to define only 1 page to import.

Note:

Depending on the selected PDF file (Normalized or non-Normalized) different options will be
displayed.

• When a Normalized PDF file is selected, the same options are displayed as described in the
chapter 'Normalized PDF file'.

• When a non-Normalized PDF file is selected, you will see the options as described below.

Pages (not available for EPS/Illustrator file type)
 

 

Select All Pages or specify a Range of pages.

Split up a multipage file To divide the original multipage PostScript file into smaller parts. You define
the amount of pages to open (of the specified pages or range). What you need to know:

• Each part is stored as a separate Esko native file. It is either stored locally or stored in the Output
Directory .
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• Each part is stored with the name of the imported PostScript file followed by _001, _002,
_0001_001... or it gets the Output Name.

Merge Tiled CT files to one CT Some ArtPro files have tiled CTs, those are CTs which are actually
divided into a number of little CTs (tiles). Some jobs are so large that there are thousands of these little
CTs. Select this toggle to merge the tiles into one CT to improve editability of the Esko native file and
to optimize further processing. This option is default selected, it doesn't matter if you import a file with
no tiled CTs.

Note:

When errors occur when a PostScript file is imported (e.g. a font is not found), the Merge Tiled
CTs to one CT will not be performed.

Merge Separated PostScript file to Composite page Merges separated single-page and multi-page
PostScript files to a composite file.

Optimize Merged PostScript File This option optimizes the merged PostScript file. This is useful when
you need to edit the imported PostScript file. This option becomes available when 'Merge Separate
PostScript File to Composite Page' is activated.

Note:

When errors occur when a PostScript file is imported (e.g. a font is not found), the Optimize
Merged PostScript File will not be performed.

Password You can enter a password for protected PDF files.

Color Management
 

 

Destination Colorspace
Here you define what colorspace the opened/imported document will have.

Colorspace:

• CMYK
• Grayscale
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Destination Profile Choose a color profile from the drop-down list. Currently only CMYK and Grayscale
profiles are supported, you can choose between standard ICC profiles and Esko Kaleidoscope profiles.

The 'Use PDF Output intent if available' toggle: in some PDF files, the PDF Output intent is defined
(e.g. PDF/X-3). If you want to use the color space as defined in the output intent, use this toggle. If you
selected the toggle for a file without PDF Output intent, the chosen Destination Profile will be used.

Rendering Intent

• Relative (No Background): any colors that fall outside the range that the output device can render
are adjusted to the closest color that can be rendered, while all other colors are left unchanged.

The white point is not preserved.

Example: The whitest white of a paper is more yellow than the whitest white of a computer monitor.
An image converted into the gamut of the printer using relative colorimetric intent would result in
all colors becoming more yellow. The white point of the image is moved to match the white point
of the printer. All other colors in the image keep their position relative to the white point. This
produces an image that more accurately reflects what the printed image will look like. However, the
user may find it visually disconcerting.

• Absolute (Background): Any colors that fall outside the range that the output device can render are
adjusted to the closest color that can be rendered, while all other colors are left unchanged. The
white point is preserved.

For example, the whitest white of a paper is more yellow than the whitest white of a computer
monitor. An image converted into the gamut of the printer using 'Absolute' would result in all colors
being converted and matched into the gamut of the printer. The white point of the image is not
moved to match the white point of the printer. Therefore, the distance of the colors to the white
point may change. This produces an image that is less visually disconcerting to the user, but is also
a less accurate rendition of printer output.

• Perceptual: causes the full gamut of the image to be compressed or expanded to fill the gamut
of the destination device, so that gray balance is preserved but colorimetric accuracy may not be
preserved.

In other words, if certain colors in an image fall outside of the range of colors that the output device
can render, the picture intent will cause all the colors in the image to be adjusted so that the every
color in the image falls within the range that can be rendered and so that the relationship between
colors is preserved as much as possible.

• Saturation: It preserves the saturation of colors in the image at the possible expense of hue and
lightness.

Note:

White point: the whitest white that can be produced in a device's color gamut.

Set Document Profile

• Always: you can 'tag' a Normalized PDF file with its Document Profile. This means that the file
'knows' what its Document Profile is, which may make further color conversion throughout a
workflow more correct.

If you selected the 'Use PDF Output intent if available' toggle, the Document Profile will be the same
as the PDF Output intent (if the imported file had one).

• Never: Document Profile is not saved.

Spot Colors
PANTONE inks

• Keep All: No PANTONE inks will be converted to process inks.
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• Convert All: All PANTONE inks will be converted to process inks.
• Keep list: All PANTONE inks will be converted except those listed in the Inks tab.

Method

• Use Destination Profile: PANTONE and Designer inks will be converted using the selected
Destination Profile. This gives the most accurate color reproduction.

• PANTONE Solids to Process (Euroscale). PANTONE inks will be converted to process inks according
to a fixed conversion table provided by PANTONE. The result is independent of the selected
Destination Profile. This assumes the Euroscale print conditions.

• PANTONE Solids to Process (SWOP). PANTONE inks will be converted to process inks according to a
fixed conversion table provided by PANTONE. The result is independent of the selected Destination
Profile. This assumes the American SWOP print conditions.

• When using the Color Engine Database (CMS) from Suite 10 or higher, you can also choose HP Indigo
or Xeikon as method.

Other Inks

Note:

The term Other Inks refers to inks from a standard ink book. It excludes the PANTONE ink
books, other standard ink books (HICS, NCS, Toyo etc.) and inks from a custom ink book.

• Keep All: No Other inks will be converted to process inks.
• Convert All: All Other inks will be converted to process inks.
• Keep list: All Other inks will be converted except those listed in the Inks tab.

Note:

If the 'Flatten PDF transparencies and layers' box is checked and you select 'Convert all' or 'Keep
list', the color conversion may give unexpected results when overprint is involved.

RGB
RGB will always be converted to process inks during import.

RGB Method Select one from the drop-down list

• Source to destination profile: the user needs to specify both the Source Profile (RGB) and the
Destination Profile (CMYK or Grayscale).

• With Link profile: the user specifies a Kaleidoscope Device Link Profile. this Link Profile implicitly
determines the Source and Destination profiles.

Source Profile / Link Profile Select one from the drop-down list.

Objects with RGB Profile tags The RGB objects in a PostScript or PDF file may be tagged with a Color
Profile.

• Convert using the RGB Profile tags: The user may choose to use that Color Profile as a Source
Profile (overruling the Source / Link Profile selected above).

Tip:

In strictly controlled workflows, the embedded tags are probably accurate, so this option
may be preferable.

• Ignore tags: the embedded Color Profile will be ignored, the Source / Link Profile defined above will
be used during conversion of RGB objects.
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CMYK and Gray
The CMYK objects in a PostScript or PDF file may be tagged with a Color Profile. The color percentages
of untagged objects will always be preserved. For tagged objects, users have a choice:

• Ignore tags, preserve percentages: the Color Profile tag will be ignored, the percentages will be
those of the object's color.

• Convert, preserve appearance: the objects' color profile will be taken into account; this means that
their color values will change.

The Gray objects in a PostScript or PDF file may be tagged with a Color Profile. The color percentages
of untagged objects will always be preserved. For tagged objects, users have a choice:

• Ignore tags, preserve percentages: the Color Profile tag will be ignored, the percentages will be
those of the object's color.

• Convert, preserve appearance: the objects' color profile will be taken into account; this means that
their color values will change.

Inks
The Inks / Separations tab depends on the output type you selected in the Color Management tab. If you
choose CMYK Composite or Composite, the Inks tab will be visible, if you choose separated output, the
Separations tab will be visible.

Use rulings, angles and dot gain compensation from PostScript file if available If the PostScript file
contains rulings, angles and dot gain compensation, these will be used when this toggle is selected,
other settings in this tab will be overruled.

Apply Screen Swap Table Select a screen swap table from the dropdown list.

Map PANTONE Inks to Check this box if you want to map all PANTONE inks that are present in the file to
Coated/Uncoated/Matte inks.

Use ClassicColors ink book Check this box to use a ClassicColors Ink Book. This is optional to avoid
conflicts for inks using generic names, such as "White".

Search Custom Ink Names If custom ink names are present in the file, you can indicate the custom ink
book that should be searched in order to retrieve the ink. You can either have PackEdge immediately
look in the 'designer' ink book, or you can indicate what ink book should be searched first before the
designer ink book is consulted.

Process inks and inks from a standard ink book (PANTONE, Toyo, HKS, HP Indichrome, Esko Visualizer
Swatches etc.) are always taken from the standard ink book. You can use the Inks dialog in the editor to
change the ink book of other inks.

Ink Settings (double-click the fields to edit)

Autoload Ink Settings from Job Setup If Job parameters were defined, you can use this toggle to
make sure these inks are used. If you do not click this button, you are free to edit the ink settings. The
default values as defined at the bottom are used for ink attributes that are not set in the ink settings of
the job setup.

Default values, used when a ruling, angle or dotshape is not specified Enter the default values for
ruling angle and dotshape, the system will take these values when they are not specified elsewhere (i.e.
in the PostScript file, or in job Parameters...).
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Overprint
 

 

Strict overprint behavior this toggle controls how zero percentage inks are handled when reading
composite PostScript files. When the toggle is switched on all zero percentage inks of a color are kept
and correspondingly affect the overprint behavior. When the toggle is switched of all zero percentage
inks are removed.

Overprinting Default is non-zero overprint prevents overprinted objects with zero CMYK values from
knocking out CMYK objects beneath them.

PostScript Overprint

To set the overprint mode that the conversion needs to apply when importing the file.

• Convert into Opaque overprint: Ignores any overprint of your job.
• Convert into Darken (Esko): Converts all overprint present in your PostScript job to Darken.
• Keep PostScript Overprint: All PostScript overprint present in the job is imported correctly. (This is

the default setting.)

Note:

The preferred setting is 'Keep PostScript Overprint'. This will result in faster conversion when
outputting the job to PostScript/EPS/PDF.

Pure Black To set the overprint mode for objects containing 100% black only. Possible Pure Black
overprint modes in the dropdown list:

• As other colors: As it is defined in the job.
• Force Opaque: Forces Opaque for objects in 100% black and knocking out all underlying inks.
• Force PostScript Overprint: Forces PostScript overprint for objects in 100% black.
• Force Darken (Esko): Forces Darken (Esko) for ALL objects in 100% black. The black color is printed

on top of other colors, instead of erasing the color underneath.
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Attention:

There are two problems:

• Sometimes ink saturation can occur.

100% black text on a 100% red (this is, 100% magenta and 100% yellow) background,
results in three inks printed at 100%.

• Black is best handled as knockout for flexo, since it is better to add a small trapping
region than to make the complete black region overprint.

Rich Black Set the paint mode for objects containing 100% black and at least one other ink. Possible
Rich Black paint modes:

• As other colors: As it is defined in the job.
• Force Opaque (masking): Sets the overprint mode to opaque for all objects containing 100% black

and at least one other ink.
• Force PostScript Overprint: Keeps the PostScript overprint for objects in 100% black and at least

one other ink (overprint objects stay in overprint and opaque objects stay opaque).
• Force Darken (Esko): Sets Darken (Esko) for all objects in 100% black and at least one other ink.

White Possible White paint modes to select from the dropdown list:

• Force Opaque: Forces all objects in white to Opaque.
• Keep PostScript Overprint: Keeps the PostScript overprint for objects in White (overprint objects

stay in overprint, opaque objects stay opaque).

Images
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Embed all images: all images will be placed internal. Some images will be embedded whether the
toggle is selected or not: these images are smaller than the maximum size for embedded images
defined in the Automation Engine Configure.

Link External Images (OPI, DCS, Helios...): force the system to look for referenced images.

Fail if not Found: activate this option if you do NOT want the system to continue opening your
PostScript file when it cannot find an image. When this option is not activated the imported EPS/
PostScript file will appear on screen but without the missing images.

Search for Preconverted Files: this option forces the system to look for the GRx, CT or LP equivalent
for the original EPS file. If this equivalent is not found, it will use the EPS instead.

The Optimize DCS LineWork toggle: without linework DCS optimization, the result after conversion
of linework DCS files can be dicult to edit afterwards. However it will be correct when viewed in
extended preview or RIPped. 'Optimize DCS Linework' will do an additional operation to combine the
elements on each DCS plate to a composite and a more editable result.

Images: Available options are:

• Use Most Recent: forces the system to use the existing images of a previous conversion of the
same job.

• Reconvert: forces the system to regenerate the images on-the fly.

Use Masks: available in the dropdown list are:

• PostScript Mask: Forces the system to take the PostScript mask present in the PostScript file. The
mask available in the external image is discarded. If no PostScript mask is present in the PostScript
file, no mask will be taken.

• External Mask: if any, PostScript Mask otherwise Forces the system to take the mask present in the
external image. The PostScript mask is discarded. If the external image has no mask, but there is a
PostScript mask available in the PostScript file, this PostScript mask will be taken.

• External Mask: if any, no mask otherwise Forces the system to take the mask present in the external
image. The PostScript mask is discarded. If the external image has no mask, no mask will be taken.

• No Masks: The PostScript mask and the mask of the external image are discarded.
• Joined External and PostScript Mask: Forces the system to join the available PostScript mask in the

PostScript file and the available mask in the external image.

Search directories: to specify a list of directories to look for referenced images. Use the buttons
'Add' and 'Remove' to optimize the Search Directories list. Clicking the 'Add' button opens the directory
selector. You can browse to the correct directory and hit 'OK' to add the directory to the Search
Directory list.

Path Translation: to define an understandable link for paths from a platform to another platform. The
Path translation dialog opens, it has three columns:

• From Platform: Use the dropdown list to select a platform from which the files are to be retrieved:
NT, Macintosh, Unix or VMS

• From path: specify the syntax of the path(s) of the platform you want to retrieve files from. e.g.

Mywork:PostScript:job1

• To Path: define the syntax of the paths so that the destination platform understands. e.g.

Mywork/PostScript/job1
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You can do the same for files: File Translation

Page Size (not available for EPS/Illustrator file type)
 

 

Page Size

The default page size is PS Page Size. PS Page Size is the page size found in the selected PostScript
file for import. The drop-down list displays all possible options (Custom, A5...).

Reader's Spread

To determine how the PostScript file, which has reader's spread format, must be opened.

• Single Page: Forces the reader's spread in the PostScript file into single page output.
• Double Page: Forces PostScript File into reader's spread format. When the PostScript file contains

no reader's spread info, the single pages will be set as double pages.

Offset

The original offset is Bottom Left. Specifying a positive vertical/horizontal offset moves your
PostScript file upwards/to the right in relation to the bottom/right border. Specifying a negative
vertical/horizontal offset moves your PostScript file downwards/left in relation to the bottom/left
border.

Scale vertical

To enter the vertical scale percentage. 100 % is the original size of the PostScript file.

Scale horizontal

To enter the horizontal scale percentage. 100 % is the original size of the PostScript file.

Rotate

Forces the system to rotate the PostScript File with the specified angle. The origin for rotation is
bottom left. Possible angles in the dropdown list:

• 0: No rotation is to be performed.
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• 90: Forces to rotate over 90 degrees counterclockwise
• 180: Forces to rotate over 180 degrees.
• 270: Forces to rotate over 270 degrees counterclockwise.

Other
 

 

Substitute Missing Fonts

Roman fonts by: choose a default replacement font for the missing fonts for this job on your system.

Japanese fonts by: choose a default replacement font for the missing fonts for this job on your system

Images

Import 1-bit images as:

• Embed: Images become internal black and white bitmaps.
• Linked file: Images are imported as external referenced LP files.
• Contours: Images are contourized during import of the (E)PS file.

CT display images Choose Yes to create a display image for the generated CT files on-the-fly.

Output file display images This option is activated when 'Split Up a MultiPage File' was activated.
Select the type of display from the drop-down list: None, Thumbnail, Image.

Miscellaneous

Device resolution (xxx ppi)Device resolution is the resolution used internally by CertIn during the
normalization. Normally the produced output is not dependent of this internal resolution but in some
rare cases like when converting RIP test strips or device specific tests it is important that this value is
the same resolution of the final RIP device which will be used to print output.

Virtual Memory Limit The default value for the virtual memory is 50MB. The limit is set to 1 gigabyte.

Convert text to contours will contourize all text.

Note:

Conversion might increase the file size.
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Workaround Options

Skip Images Check this box to open the EPF file without linking to external images or converting
embedded images.

Preserve Quark trapping Forces the system to keep the trap strokes made by QuarkXpress.

Disable optimizations Vignettes recognition and optimization for Photoshop Multitone images are
performed (whenever possible) when this option is not activated. Sometimes after updating your DTP
applications, Esko can no longer perform the optimization and the conversion of the (E)PS file might
fail. Switching this option ON will allow you to import the (E)PS file.

Show PS comments All PS comments present in the (E)PS file are displayed on screen.

Disable OPI This option is valuable when you are importing (E)PS files of QuarkXpress containing high
resolution Tiffs files for which the option 'Include tiff, omit...' or 'Include all' was activated. In this case,
when importing such a file and if Link External Images (page 5) is activated, the matching for the TIFF
files will surely fail. It fails because at the time the (E)PS file was generated OPI commands were also
inserted for the TIFF files. Therefore, the system will try to link to images for the Tiff files. To overcome
this, activate Disable OPI.

Show external images searches Displays the path(s) in which the system has found and linked to
external images.

Optimize Illustrator Patterns into PostScript patterns Illustrator writes patterns in a different way
than PostScript does, default behavior is that Illustrator patterns will be optimized. Normally this
speeds up the further processing (less linework in your file) sometimes, though, the optimization itself
may take some time.

Use PostScript rules for color conversion Check this box to make sure that all color management will
happen using PostScript rules, instead of BGCMS. Most options in the Color Management will be grayed
out.

Object Based Color Conversion Object by object color conversion does not take overprint and
transparency interaction between objects into account, and may therefore produce undesirable
results. However, it may greatly improve editability.

Recognize ArtScreen (lpi-angle) Check this box and the application will try to recognize screens that
are created in ArtPro applications and swap them to Esko-Graphics screens. If a (E)PS or PDF file with
an unknown ArtScreen is imported, an error will be generated.For more information, please refer to the
ScreenFilter user manual.

Output
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Output name: enter a name for the generated file, if you don't, the generated filename will be based on
the name of the input file.

Output directory: define a output directory, if you don't, the generated file will be written in the same
directory the input file is saved.

Image creation path: you may want to define a image directory where all generated CT files are stored.

Fit Media Box (margins) Check this box to automatically fit the margins to the bounding box of all the
objects in the file.

Show Report This option displays valuable information during the import of PostScript files.
Information about errors, linked images, search directories... are shown on screen.

Keep Layers Keeps the Illustrator layer information. This will only work for Illustrator 8 files. It will not
work for native Illustrator 9 files (or higher).

Limit Filename Length to Maximum 31 characters Use this toggle if you want to make sure your
imported files can be seen/read from/by all Apple operating systems (CTs that are kept on a Windows
share but might be edited on a MAC for instance).

BAG files
The BAG file format is the native format of Studio Toolkit for Flexibles. This flexible packaging design
application allows a designer to build realistic structural models of common flexible packaging types.
The first version of the Studio Toolkit for Flexibles file format supports pillow bags, gusseted bags and
rectangular stand-up pouches.
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The BAG File import dialog has the following options:

• Import in Dedicated Layer: to import the BAG data on a dedicated layer.
• Fit page to BAG shape: to fit the document's Trim Box around the bounding box of the BAG data

when the BAG shape is loaded.
• Line types: to set your personal color for the Cut, Fold and Soft Fold lines of the Bag Shape.

The BAG import filter only loads the 2D shape of the flexible bag. A BAG shape is a protected object in
the document. Use the Transform Tool to rotate or scale it. Choose Production > Die Object Property to
see the link to the original BAG file. Here you can rotate the BAG shape in the document.

Note:

Click Degrade to objects to unlock the BAG shape in the document and convert it to normal
contour objects.

Tip:

Choose File > Show in > Esko Visualizer to see the 3D visualization of the BAG file and its
graphics. Keep in mind that this only works when you have a valid Esko Visualizer license.

Collada files
The Collada file format stands for COLLAborative Design Activity, for establishing an interchange file
format for interactive 3D applications.These files can also be created from Studio Toolkit for Labels or
Studio Toolkit for Shrink Sleeves.
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The Collada File import dialog has the following options:

• Import in Dedicated Layer: to import the Collada data on a dedicated layer.
• Fit page to Collada shape: to fit the document's Trim Box around the bounding box of the Collada

data when the Collada shape is loaded.
• Line types: to set your personal color for the Printable Area of the Collada shape.

The Collada import filter only loads the 2D shape of the shape. A Collada shape is a protected object in
the document. Use the Transform Tool to rotate or scale it. Choose Production > Die Object Property to
see the link to the original Collada file. Here you can rotate the Collada shape in the document.

Note:

Click Degrade to objects to unlock the Collada shape in the document and convert it to normal
contour objects.

Tip:

Choose File > Show in > Studio Visualizer to see the 3D visualization of the Collada file and its
graphics. Keep in mind that this only works when you have a valid Studio Visualizer license.

ArtPro Import Options dialog
With the ArtPro import filter you can import an (Esko)Artwork ArtPro file into PackEdge directly. The
ArtPro files must have file extension .ap or .art.

Choose File > Open and select an ArtPro import file. Additional options appear in the ArtPro Import
dialog.
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Search for missing images in:

Use this to search for missing images in a specific folder.

Note:  The images are searched: in the place referenced in the links, next to the input file, in
the folder defined in this dialog.

Embed all images

Use this to embed all images in the file.

Add non-printable layers

Use this option to include all layers, including the non printing layers.

Add fully transparent objects

If this option is disabled, objects that are completely transparent will be ignored. If the option is
enabled, these objects will be included.

Folder Mapping:

When the ArtPro file contains links to images that reside on a Mac OS-based file server, you can mount
the drive of the Mac OS server on the PackEdge (Windows) workstation and use the Folder Mapping
feature in the Export ArtPro to Normalized PDF task to keep the the references to the images working
in the normalized PDF.

To map folders from the ArtPro file to the Normalized PDF file:

1. Click Add.
2. In the Client column, type the drive name on the Mac OS system.
3. In the Server column, type the drive letter that is used to mount the Mac OS drive on the PackEdge

machine.

Example: In our ArtPro file, the path of an externally linked image is: Intel_Mac:images:image1.
We mount the Intel_Mac drive of the Mac OS file server on our Windows-based PackEdge system, using

169



8 PackEdge

the G:\ drive letter. To allow Automation Engine to automatically locate the images on the Mac OS file
server when exporting the ArtPro file, we use the Folder Mapping feature to map "Intel_Mac" to "G:/".

Limitations
There are some limitations when importing ArtPro files in PackEdge.

• When you import an ArtPro file into PackEdge, you will notice that the graphic visualisation of both
documents is the same, but the document structure is not.

Example: Linked ArtPro files and external ArtPro CT files will be embedded, and certain special
objects in the ArtPro file will have been degraded to normal objects.

Where possible, links to external images will be maintained.

• Step and Repeat or externally linked files in ArtPro to non-normalized PDFs and PostScript files
cannot be imported.

• Objects that do not have screening information in the ArtPro file get the following defaults:

• frequency 120
• dotshape: simpledot (round)
• angles C: 15, M: 75, Y: 0, B: 45 and any others: 45

• Inks from the PANTONE and Visualizer ink book are recognized. All other (custom) inks are loaded
from the ink book "designer" in PackEdge.

• Ink attributes "opaque", "varnish" and "normal" are kept. Ink attribute "Technical" (Die) is not kept.
• Nexus screening is not allowed. For Extended Nexus screening, only use angle/ruling.
• The font is subsetted and embedded. This results in real text in PackEdge. When you import an

ArtPro file, two-byte fonts are always vectorized.
• Where possible, images keep their links. This is the case for most Tiff, jpeg and PSD files, and

also for mapped images. Some image formats are not supported by or are incompatible with Esko
software. This is the case for DCS images, PSD with multiple alpha channels and Tiffs with extra
channels which are often generated by ArtPro PS/PDF import. These images are either embedded
or they generate a .ct file on Esko software.

• Artlink updates are disabled.
• Barcode information is not kept, nor is the link to BAG and ARD files when the ArtPro file is

imported.

Artios CAD Import options dialog box
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The ArtiosCAD import options consist of one toggle:

Import in Dedicated Layer: The CAD data will be imported on a dedicated layer:
 

 

CFF2 Import Options dialog box
The CFF2 import options consist of one toggle:

Import in Dedicated Layer: The CFF2 data will be imported on a dedicated layer:
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DDES Import Options dialog box
The DDES Import options dialog box allows you to import the DDES File to a dedicated and locked layer.

 

 

ASCII Text Import dialog box
Choose Place or Place inside from the File menu, and select ASCII Text + as file type.

Additional options appear in the Text Import dialog box.

Text Filter
Select the type of text filter you want to use:

• ISO-Latin 1
• ISO-Latin 2
• ISO-...
• Mac Roman
• Windows ANSI
• PDF Document
• CNS 11643-1986 1
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• CNS...

Smart Quotes
To change straight quotes into smart quotes.

Replace Tab by Spaces
To replace all tabs in the text field with single spaces.

Carriage Control
Activate one of the following options:

• Ignore Carriage Returns: To ignore every return in the text file and put all text in a single paragraph.
• Many Carriage Returns is EOP: To translate multiple returns into a single end of paragraph.
• Single Carriage Return is EOP: To translate each return into an end of paragraph.

16 Bit Text Import dialog box
Choose Place or Place inside from the File menu, and select 16 Bit Text as file type.

Additional options appear:

• Text Filter

• Carriage Control on page 173

Text Filter
Select the type of text filter you want to use:

• JIS (JP)
• EUC (JP)
• SJIS (JP)
• GB (CN)
• KS C
• Big Five (TW)
• CNS 11643-1 (TW)
• Unicode

DXF Import dialog box
Click the 'Setup' button, the DXF Import dialog pops up.

DXF = Drawing eXchange Format
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1. Preview area. In the preview area, one sees the result of the current settings on the selected file.
(Cut lines are visualized in red, crease in green and bleed lines in blue).

2. Mapping Rules. The mapping rules allow to map DXF layer names, DXF line styles and DXF color
numbers onto line types (ArtiosCAD style). The mapping rules are a simplified version of the tune
options from ArtiosCAD. Use the mapping rules to indicate which DXF elements will be imported
as cut, crease or bleed lines. The mapping rules are scanned from top to bottom, as soon as a DXF
element matches a rule, the action corresponding with this rule (ignore or import as cut, crease,
bleed) will become effective.

3. Units. As the DXF file format does not have any indication of the units used in it's coordinates, the
correct unit must be defined.

4. Design side: InSide or OutSide. the linework editor always reads CAD data in 'outside' mode - if the
CAD data was designed from the inside, the CAD data will be flipped around the vertical axis.

5. 'Import as one up' toggle: use this toggle as a work around to import rather complex files as a one-
up to avoid problems.

Tip:

it's very likely that different suppliers of DXF files will use different conventions. Some might
use different layers to distinguish between cut and crease lines, some might use different
colors. Suppliers of DXF files should be able to indicate how the DXF file is structured. It is good
practice to save mapping rules as customized setting for each supplier.

EPF Import dialog box
The Import dialog has three tabs.

External Images
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Link External Images (OPI, DCS, Helios...) Force the system to look for referenced images.

Fail if not Found Activate this option if you do NOT want the system to continue opening your
PostScript file when it cannot find an image. When this option is not activated the imported EPS /
PostScript file will appear on screen but without the missing images.

Search forPreconverted Files: this option forces the system to look for the GRx, CT or LP equivalent
for the original EPS file. If this equivalent is not found, it will use the EPS instead.

The Optimize DCS LineWork toggleWithout linework DCS optimization, the result after conversion
of linework DCS files can be dicult to edit afterwards. However it will be correct when viewed in
extended preview or RIPped. 'Optimize DCS Linework' will do an additional operation to combine the
elements on each DCS plate to a composite and a more editable result.

Images Available options are:

• Use Most Recent: forces the system to use the existing images of a previous conversion of the
same job.

• Reconvert: forces the system to regenerate the images on-the fly.

Use Masks Available in the dropdown list are:

• PostScript Mask: Forces the system to take the PostScript mask present in the PostScript file. The
mask available in the external image is discarded. If no PostScript mask is present in the PostScript
file, no mask will be taken.

• External Mask: if any, PostScript Mask otherwise Forces the system to take the mask present in the
external image. The PostScript mask is discarded. If the external image has no mask, but there is a
PostScript mask available in the PostScript file, this PostScript mask will be taken.

• External Mask: if any, no mask otherwise Forces the system to take the mask present in the external
image. The PostScript mask is discarded. If the external image has no mask, no mask will be taken.

• No Masks: The PostScript mask and the mask of the external image are discarded.
• Joined External and PostScript Mask: Forces the system to join the available PostScript mask in the

PostScript file and the available mask in the external image.

Search directories To specify a list of directories to look for referenced images. Use the buttons 'Add'
and 'Remove' to optimize the Search Directories list. Clicking the 'Add' button opens the directory
selector. You can browse to the correct directory and hit 'OK' to add the directory to the Search
Directory list.
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Path Translation To define an understandable link for paths from a platform to another platform. The
Path translation dialog opens, it has three columns:

• From Platform: Use the dropdown list to select a platform from which the files are to be retrieved:
NT, Macintosh, Unix or VMS

• From path: specify the syntax of the path(s) of the platform you want to retrieve files from. e.g.
Mywork:PostScript:job1

• To Path: define the syntax of the paths so that the destination platform understands. e.g. Mywork/
PostScript/job1

Image Creation Path Specify the directory where CT images that are created during the conversion are
saved.

• CT images generated during the conversion will be saved in the current working directory if no
output directory has been specified.

• CT images generated during the conversion are saved in the specified output directory.

Other
 

 

Images

Import 1-bit images as:

• Embed: Images become internal black and white bitmaps.
• Linked file: Images are imported as external referenced LP files.
• Contours: Images are contourized during import of the (E)PS file.

Miscellaneous

Virtual memory limit: default value for the virtual memory is 50MB. The limit is set on 1 gigabyte.

Convert text to contours: all text will be contourized.

Workaround Options

Skip Images Check this box to open the EPF file without linking to external images or converting
embedded images.

Disable optimizations Vignettes recognition and optimization for Photoshop Multitone images are
performed (whenever possible) when this option is not activated. Sometimes after updating your DTP
applications, Esko can no longer perform the optimization and the conversion of the (E)PS file might
fail. Switching this option ON will allow you to import the (E)PS file.
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Show PS Comments All PS comments present in the EPF file are displayed on screen.

Optimize Illustrator Patterns into PostScript patterns Illustrator writes patterns in a different way than
PostScript does, default behavior is that Illustrator patterns will be optimized. Normally this speeds up
the further processing (less linework in your file) sometimes, though, the optimization itself may take
some time.

Use PostScript rules for color conversion Check this box to make sure that all color management will
happen using PostScript rules, instead of BGCMS.

Recognize ArtScreen (lpi-angle) Check this box and the application will try to recognize screens that are
created in ArtPro applications and swap them to Esko-Graphics screens. If a (E)PS or PDF file with an
unknown ArtScreen is imported, an error will be generated. For more information, please refer to the
ScreenFilter user manual.

EPF
 

 

Fit Borders to This options allows you to specify the borders (and indirectly also the margins) of the
output file. One of the following rectangular areas of your document may be selected as borders of the
output file:

Artboard: The borders of the output file will be set to the Artboard of the document.

Graphics: The borders of the output file will be set to the bounding box of all artwork in the document.

Crop Marks: The borders of the output file will be set to the Crop Marks defined in the document. This
option is available only when a Crop Area is present in the current document.

The figure below illustrates the borders and margins of an output document as interpreted on an Esko
system. The full black line represents the borders (corresponding to one or the above options) while the
dotted black line indicates the margins of the document:
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If the option Artboard or Crop Marks is selected, the margins of the input document will be defined
implicitly by the bounding box of all artwork in the document. If there is no artwork (partially) outside
the Artboard (or Crop Area) then the top, bottom, left and right margins will be set to zero (no margins).
In other cases the margins will be computed automatically to include artwork of the document.

8.1.8.  Place Image (File Menu)

Places an image but keeps it native. i.e. these files will not be converted to a CT file, even when the file
(containing the placed ones) is saved as a Esko native file.
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You can place:

• CT File: You can select the plane you want to place (click the swatch to open the Select Plane
dialog). The 'Use opacity' toggle: Activate this toggle if you want the opacity information included in
the file. If you do not activate this option, the output will be a lot faster.

• Photoshop File

• JPEG File
• TIFF File
• EPS File
• Image Files: shows all PSD, JPEG, TIFF, EPS, CT files in that folder.
• All Files:

Note:

You can place all files as a copydot file. Click the setup button, the 'Place Image Setup dialog'
pops up, toggle 'Force as copydot file'.

Note:

The editor cannot place RGB images.
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Note:

You cannot place LENX files (LENX is a bitmap file format developed exclusively for Esko's
CDI Crystal imager series and Crystal screens, and generated by Imaging Engine. For more
information, please see the Imaging Engine documentation).

8.1.9.  Place Inside... (File menu)

Alt + Ctrl + i

To place a file within a selected object.

When you choose 'Place Inside' from the File menu, the Place Inside dialog box appears. The file will be
loaded into the active layer and will automatically be masked out by the selected object. The file will be
mapped on the page origin (0,0 position in the upper left corner), unless the Align box is displayed. If
the Align box is displayed, the file will be placed according to the options in the Align box.

To mask the contents of a file with an object :

1. Select in red the object into which you want to place the file (see Select Linework Objects in Red on
page 39).

2. Select Place Inside.

The object is placed in front of the red selected object.

The red selected object becomes a mask, and is grouped with the placed object (or group of
objects).

All areas of the placed object that fall outside of the red selected object (now a mask), are hidden in
the preview and the extended preview mode.

Place Inside dialog box
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Use the following options after you have chosen the desired file type.

Setup button
Press the Setup button to open the Import Settings dialog box.

The contents of this dialog box depend on the selected file type.

• The Normalized PDF file import settings.

• The GRS Import settings for the file type GRS.

• The Pal File

• The Pla import settings

• The CT Import settings .

• The TIFF Import settings.

• The LC Import settings.

• The LP Import settings.

• The GRQ Import settings.

• The PostScript Import settings.

• The EPS Import settings for the file type EPS.

• The PDF import settings

• The Illustrator settings

• ArtiosCAD File

• CFF2 File
• DDES File
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• BAG File
• The ASCII Text Import settings for the file type ASCII Text.

• The 16 Bit Text Import settings for the file type 16 Bit Text.

Place
Press OK to place the selected file into the selected object.

8.1.10.  Place Image Inside... (File Menu)

To place a file within a selected object and keep it native.

For more information, check: 'Place image...' and 'Place Inside...'

 

 

8.1.11.  Structural Design

Open / Place from Shapes
You can open or place Structural Desing files from Shapes from the File > Structural Design menu.

You can choose a new Shape to download from the store or you can use an already downloaded Shape
from the library on your computer. In order to access the Shapes store, you must have already entered
the Shapes server settings and your Shapes account information in Preferences > Shapes. See Shapes
on page 225.

Opening and placing a file from Shapes follows the same general workflow as for another Structural
Design file. This example will show how to open a Shapes file.
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1. Select File > Structural Design > Open from Shapes.... The Shapes window appears in the state you
last used it, either at your local computer’s Shapes Library or at the online Shapes Store.
 

 
2. If you want to use a new Shape, choose it and download the Collada 3D Model. It gets downloaded to

your local machine’s Shapes Library.
 

 
3. If you downloaded a new Shape, the Shapes window should switch to the Shapes Library

automatically. To use an existing Shape, click Library in the Shapes window. Select the desired
Shape and click Accept.
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4. The Shape is either placed in the open document or opened as a new document. Only the printable

area of the Shape is visible in PackEdge. If you have one of the Studio products, use the Studio
palette to view the Shape with the printable area.

Note:  Shapes in the local Shapes Library are saved at a shared location, so the same Shapes
will be available in the Shapes Library of other Esko Applications on the same system.

Show in Shapes
By using File > Structural Design > Show in Shapes, you can view the details of a structural design file
imported from Shapes.

The Show in Shapes window contains 3 tabs:

• Previews: 3D previews of the Shape
• Attributes: properties, dimensions, ...
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• Parts: printable parts in the 3D model.

Update Structural Design
By choosing File > Structural Design > Update you can reload the selected Structural Design file.

This can be useful to update the external Structural Design file if it was changed or overwritten by
another application.

Structural Design Save as ...
By choosing File > Structural Design > Save as... you can save the Structural Design file to a different
location. This can be used e.g. to save structural design files from Shapes (which are saved locally) to a
central folder, so the structural design file can be used on the Automation Engine server.

8.1.12.  Show in

To directly open the current document, e.g linked to an ARD file or BAG file, in Esko Visualizer. Keep
in mind that you need to have a valid license for or a trial version of Esko Visualizer installed on your
computer to do so.

The current document is saved to a (temporary) normalized PDF file and opened in Esko Visualizer.
When Esko Visualizer is not running already, it starts automatically. When you have edited the
document in PackEdge, click Show in Esko Visualizer to update the document in Esko Visualizer, as this
is not done automatically. As you do so, the temporary normalized PDF file is deleted.

8.1.13.  Save and Open with Esko Automation Engine Pilot

Automatically selects the open file in the Esko Automation Engine Pilot. When the document has been
changed, you will be prompted to save the changes.

Note:

The Esko Automation Engine Pilot needs to be running.

8.1.14.  Save Red Selection and Open with Automation Engine Pilot

This function will save the red selected object(s) from the open document to a unique name. A
sux _redselection 'nr' is added to the file name. This new created file will be selected in the Esko
Automation Engine Pilot.

185



8 PackEdge

Note:

The Esko Automation Engine Pilot needs to be running.

8.1.15.  Document Set-up... (File menu)

To determine the document's page size, Mediabox, document profile...

The Document Set-up dialog box appears.
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Document Set-up dialog box

Job
Select Job: When connected to a BackStage 2.0 or higher server, you have the possibility to choose
the Job you'll be working in. This is only possible when working with a new file. This has a few
advantages: you'll save your file in the right job, the job parameters (if defined) will be honored, job
specific SmartNames can be used, when files need to be normalized, they will be normalized to the
right file format (GRS or Normalized PDF file).

Page
Size: Select the page size from the list (A5, A4, A3, A2, A1, A0, B5, B4, Letter, Legal, Tabloid or Custom).
The vertical and horizontal border sizes display automatically in the input boxes.

: Vertical and horizontal page dimensions.

Orientation: Choose 'Portrait' or 'Landscape'.

Tip:

You can also enter the size for the page in the input boxes.

Advanced
Reader's Spread: Activate Reader’s Spread to indicate that if page information is spread over two
pages, it should continuously run from one page into the other. This information is important when
imposition is done.

Units: Select the unit of measure (millimeters or inches) to be used by the application.

Resolution: Select the resolution (imperial or metric) to be used by the application.

Output resolution when rasterizing special objects: Set the resolution when rasterizing special
objects such as:

• Objects with special vignettes: edge vignettes, softmask vignettes and vignettes containing noise.
• Warped CT's.
• Blend objects with option "CT" on.

Media Box (Margins)

 To define the distance between the top margin and the top border.

 To define the distance between the bottom margin and the bottom border.

 To define the distance between the left margin and the left border.

 To define the distance between the right margin and the right border.

Transform Page Size

 To move the starting point of the borders vertically.
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 To move the starting point of the borders horizontally.

 To move or size the borders interactively

Fit To set the borders exactly around the visible objects you created

Fit Selection To set the borders exactly around the red selected object(s) of the job.

8.1.16.  Document Info... (File Menu)

To write job dependent production information.

The 'Document Info' dialog opens after clicking 'Document Info...' in the File Menu.

Click 'OK' after entering your text and then go to the 'File Menu' and click 'Save'. Only when 'Save' is
performed, the 'Document Info' is stored.

File version gives an indication of the number of times you actually saved the file. Only when the
document has been modified, a save results in an updated version number.

This data is stored in the XMP info, which is visible via File > XMP Info... and can be used as a SmartMark
via Production > SmartMarks... > Add SmartMark > Text Mark > Smart Text > Document > Document
version. In the File Version you can check whether a normalized PDF, a GRS file and an Outright PDF file
are generated from the same document. This is the case when the File Version in the XMP of the files
have the same value.

Note:

Saving the document under another name does not reset the version number. Only creating a
new document will put the version number back on 1.

8.1.17.  XMP Property Info... (File Menu)

XMP stands for eXtensible Metadata Platform, it is a standard for metadata. The editor understands
and works with XMP.

Choosing 'XMP Property Info' from the 'File Menu' opens the XMP Metadata Properties dialog.
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Tip:

Note that the Inks section also contains the selected Ink Book.

8.1.18.  Reference Points... (File menu)

To mark a number of 'anchor points' in your job.

'Reference Points' ( ) links one or more anchor points to certain positions within your file. These
anchor points are saved by the system whenever you save your file which allows you afterwards to
place the file accurately into another document. Use the Reference tab in the "Align" dialog to do so.

Choose 'Reference Points' from the File menu to add, modify or delete reference points in your file.

 

 

 

 

 

 

Overview of the coordinates of the added reference points in your job.

  To modify reference points added to your file.
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To add reference points to your file,

 

 

To delete reference points added to your file,

To add reference points to your file
1.

Click the  icon.
2. Click the spot in your file where you want to mark a reference point.

A small red colored reference point is added to your file. The coordinates of the added reference
point appear in the Reference Points window.

- OR -

Click in the input boxes of the Reference Points window and enter the coordinates of the
reference point you want to add.

The reference point will be placed according to the values you entered.

Note:

• When your file is saved, the reference points will also be saved.

To modify reference points added to your file
1.

Click the  icon.
2. Select the reference point you want to modify.
3. Drag the reference point to the spot where you want it to appear.

The coordinates of this reference point will be adapted automatically by the system and appear in
the input boxes of the Reference Points window.

- OR -

Click in the input boxes displaying the coordinates of your reference point and adapt the values
of the coordinates.

The reference point will be placed according to the values you entered.
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Note:

• When your file will be saved, the modified reference points will also be saved.

To delete reference points added to your file
1. Select the reference point you want to delete in the Reference Points window by clicking in one

of its input boxes.
2.

Click the  icon.

The reference point will be deleted from your file.

You can also delete a reference point as follows :

1.

Click the  icon.
2. Click the reference point you want to delete.
3.

Click the  icon.

The reference point will be deleted from your file.

8.1.19.  Print... (File menu)

To proof or expose the design opened in PackEdge.

Clicking Print in the File menu opens the Print dialog.
 

 

Hit the 'Setup...' button to modify the settings, the dialog has much in common with the Export to
PostScript tabsheets.

Hit the 'Customized Settings' button for user and predefined settings.
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Predefined settings
• PostScript for press (DeviceN Composite): This output mode which is only supported by PostScript

3 devices uses the PostScript DeviceN colorspace to produce high-fidelity colors. These colors
are combinations of the standard CMYK process colorants and/or spot colorants, guaranteeing
perfectly separatable PostScript code which can also be proofed on a composite PostScript 3
device.

• PostScript for press (Separated).
• PostScript for viewing or proofing (CMYK Composite).

8.1.20.  Catalog... (File menu)

To collect files that have to be or are used in a job in a catalog.

Jobs can be rather complex to work on. Very often, a lot of time is needed to identify, to locate and
to place the files. Assembling these externally referenced files in a catalog, makes it much easier to
handle them. The catalog provides you with the necessary tools to manipulate the files while working
on your job or to collect various bits of information about them.

When you choose Catalog from the File menu, the catalog appears.

Note:

The Catalog will not display embedded images.

 

 

Tip:  CTRL + double click an icon to place a file externally.

Catalog

When you click the following buttons  the following catalog functions become available:

1. New ...: To create a new catalog.

It closes the currently opened catalog - if any - and creates a catalog called Untitled . If no catalog
was previously opened, an empty catalog called Untitled appears automatically.

2. Open...: To open an existing catalog.

It closes the currently opened catalog - if any - and displays the Open catalog dialog box where you
can select the catalog of your choice. The extension of a catalog is ICP.

3. Save: To save the current catalog when you have made any changes.
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4. Save as...: To save the current catalog with a new name, especially to save a newly created catalog,
which is always called Untitled.

Current catalog

To switch to an other opened catalog.

Enter the name of a catalog in the input box or click the arrow on the right to select a name from the
list, containing the names of the most recently opened catalog files. It allows you to quickly switch to a
previously opened catalog as well as to specify or select a name for the current catalog.

File Filter

To filter the visualization of the files.

All : visualizes all the files of the current catalog.

Used only: visualizes only the files of the catalog that have been used in your job.

Unused only: visualizes only the files of the catalog that have not been used in your job.

'Used only' and 'unused only' apply to external files only.

Display list box

In the selection field of this icon, you can indicate the representation of the files in the catalog. You can
choose between Thumbnails, Pinkynails and Text only.

When you select Thumbnails in this selection field, the files in the catalog will be represented by a
thumbnail view of the image and the file name underneath.

When you select Pinkynails in this selection field, the files in the catalog will be represented by a
smaller view of the thumbnail and by the file name underneath. The Pinkynails allow you to visualize
much more files in quite a smaller place of the catalog.

When you select Text only, the files in the catalog will be represented by their filenames.

Display mode

In the drop down list of this icon you can choose how you want the files in the catalog to be displayed:
unsorted, by name, by type or by path.

Add files

To add files to your catalog.

When you click Add files, the Select Files dialog box appears, where you select the file you want to
include in the current catalog. By holding down the Shift key, you can select more than 1 file. In the
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catalog, the files are represented by an icon and/or by their name. Click Add to add the selected files to
the catalog.

If no file in the catalog is selected, the new files are added at the end, else, they are inserted before the
selected file. To select a file, you simply click it and a black frame appears around its icon. To deselect
it, you must click it a second time.

Note:

You can append an existing catalog to the current one by selecting an ICP file from the Add files
dialog box.

Info

To obtain detailed information about the selected file in the catalog. When you click the Info button, the
Info dialog box appears.

External objects

To trace external references in a file in the catalog.

When you select a file in the catalog and click the External objects button, the external references - if
any - of the selected file will be put in a catalog subdirectory.

Clipboard

To temporarily store a file cut from the catalog.

The catalog allows you to cut a file and paste it somewhere else in the current catalog or in another
one.

To cut a file, click on the thumbnail, pinkynail (when Thumbnails or Pinkynails is selected in the Display
mode box) or on the file name (when Text only is selected in the Display mode box) and drag it to the
clipboard.

To paste the file from the clipboard into the catalog, click the  icon, drag and drop it on top of a
thumbnail in the catalog. The pasted file will be inserted in front the existing file.

Attention:

You cannot paste a file from the clipboard into an empty catalog.
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Attention:

You can store only one file at the time in the clipboard. When you drag a second file to the
clipboard, it supersedes the previous one.

Tip:

You can also use the clipboard to remove files from the catalog.

Place all

Places all the files from the catalog into the job. To place all these files you have to create objects in
your job. The principle is exactly the same as for Place Inside. The shortcuts of Place and Place Inside
apply to the selected job in the catalog. There are two possibilities:

• If the available objects in your job are selected with Select All (Ctrl A), the first file of the catalog will
be loaded in the object that was created first, etc.

• If the available objects in your job are selected with Select Add (F2), the first file of the catalog will
be loaded in the object that was selected first, etc.

Note:

• When you want to place all the files of your catalog into the job, you have to create as many
objects as there are files in the catalog. When you don't create as many objects as there are
files in the catalog, the system starts placing the files of the catalog and stops when there is
no empty object anymore.

• If a file is selected in the catalog, the placing of the files will start from there on.
• You can click a file in the catalog to drag and drop to another location.
• To place one file of the catalog into your job, press [Ctrl] and double-click the thumbnail

(when thumbnails is selected) or the file name (when text only is selected). The result will be
exactly the same as with Place.

• To place one file of the catalog into your job inside an object, create an object, select it in
red, double-click the thumbnail (when Thumbnails is selected) or the file name (when text
only is selected). The result will be exactly the same as with Place Inside.

Extract job objects

By clicking this button you can trace external references in the current job. If the job doesn't contain
any external references, nothing happens. If it does, a catalog subdirectory will appear, containing the
external references of the current job.

CT-Switch

Purpose
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To quickly and accurately place or switch externally referenced files, using 1 Point positioning, 2 Points
positioning or Box positioning.

 

 

Click the CT-Switch button to start the CT-Switch software module. As CT-Switch works closely
together with the Catalog for quick file selection, you start up CT-Switch by clicking the CT-Switch
button in the Catalog. To start up CT-Switch, the Catalog must contain at least one file.

When you open the CT-Switch dialog box for the first time, it displays with the Envelope open. The
envelope contains the default settings for 1 Point, 2 Points and Box positioning, and allows you to
change these settings. When you leave CT-Switch, the system retains if the Envelope was open or
closed and will display as such the next time you use CT-Switch.

When you want to save space on your screen, you can hide the 3 positioning mode tab sheets by
closing the envelope. When you do so, three buttons appear in the CT-Switch dialog box, representing
the three positioning modes. There also appears a button for the definition of the switch reference
point(s) in the current job with 1 Point or 2 Points positioning. This button represents the Define button
that you can find in the 1 Point and 2 Points tab sheets.

Instead of clicking the Apply button, you can also execute the placement or switch by putting your
cursor over the preview image in the CT-Switch dialog box and clicking the mouse button while you
press the Control key of your keyboard.

You can execute the complete file-switch without changing anything to these default settings in the
CT-Switch envelope, thus while you keep the CT-Switch Envelope closed.

When you click the CT-Switch button in the Catalog, the CT-Switch dialog box appears.

Info dialog box
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Identification info
• A magnified view of the selected file;
• The name of the file;
• The date and time of the file;
• The size of the file;
• The number of times the file is used in the current job;
• The full path specification of the selected file.

Envelope

To display or change the file-specific information and the design information about the file in question.

Click the Envelope to display the File tab sheet and the Design tab sheet.

File tab sheet

To display or change the file-specific information about the file in question.

Note:

This information is only displayed if the file in question is placed in the job.

Inks
Displays the inks which have been used in the file (for example C, M, Y, K). When more than 4 inks have
been used, you can display the other inks by using the scroll bar.
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Display quality
To define the display quality of your file. You can choose between the following options:

• Very High
• High
• Default
• Low

Even if in Preferences (Edit menu), the CT Display Quality is put on High and you choose Low in the
Catalog, the CT Display Quality will be low. The Catalog settings overrule all other settings.

Pages
This option will only be displayed for GRS files. It has no meaning for CT files and can therefore not be
activated.

Displays the number of the page within a series of pages on which the previewed file is displayed. The
system also displays if the file contains reader's spread pages or not.

Bleed
This option will only be displayed for GRS files. It has no meaning for CT files and can therefore not be
activated.

It gives you information about the bleed of the file in question.

Resolution
Displays the vertical and horizontal resolution of the file in question (only for CT files. This resolution is
expressed in pixels/mm.

Borders
This option will only be displayed for GRS files. It is not displayed when a CT file is displayed.

Displays the vertical and horizontal borders of the file in question. These borders are expressed in mm.

Design tab sheet

To display or change the design information about the file in question.

Origin
Displays the exact location of the external file in your job. The first coordinate is the distance from the
left border until the left side of the file. The second coordinate is the distance from the upper border
until the upper side of the file. If you want to modify the location of the file you can enter the values in
the input boxes or use the arrows.

Transformations
The first input box informs you about the horizontal scaling of the file in question.

The second input box informs you about the vertical scaling of the file in question.

The third input box informs you about the corner under which the file has been rotated.

The fourth input box informs you about the corner under which the file has been slanted.

If you want to modify the transformation values of the file you can enter the values in the input boxes or
use the arrows.
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Note:

The chain at the right of the first and second input box indicates if the input values you entered
in the input boxes for horizontal and vertical scaling should be the same or not.

If the chain is closed, the input value you entered for horizontal scaling will also be set in the
input box for vertical scaling (or vice versa).

If the chain is not closed, you can enter different values for horizontal and vertical scaling.

Original resolution
This option will only be displayed for CT files.

Displays the vertical and horizontal resolution of the original file. This resolution is expressed in pixels/
mm.

Current resolution
This option will only be displayed for CT files.

Displays the vertical and horizontal resolution of the current file in the job. This resolution is expressed
in pixels/mm.

Select In Design
This option allows you to select the file in your job.

CT-Switch dialog box

Preview
Gives you a display of:

• the original externally referenced (CT, GRS...) file after selection in the current file.
• the new file (CT, GRS...) after selection in the Catalog.

When you want to use the 1 Point or 2 Points positioning to switch files, you can quickly define the
switch reference point(s) by clicking in the Preview window. The switch reference point is displayed in
red in the Preview window AND in the job itself.

File Information
• Name of the selected file (CT, GRS...)
• Size, Creation date and time
• Number of times used in the current job
• Path

CT-Switch envelope

To display or change the default parameters for 1 Point, 2 Points or Box positioning. Click the CT-Switch
envelope to display the 1 Point tab sheet, the 2 Points tab sheet and the Box tab sheet.

CT-Switch 1 Point tab sheet

To display and/or modify the options to switch or place externally referenced files (CT, GRS...) using 1
Point positioning.
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Define switch reference point

To manually define the switch reference point of the CT-image/GRS-file in the job.

Click the Define button and then click the desired point in the file in the job. When you want to place
quickly one CT after another in the job, without having to deselect the previously placed CT, use the
right mouse button to manually define the reference point in the job. When you do so, the previously
placed CT is deselected automatically.

Tip:

When the switch reference point needs to be placed very accurately and the resolution of the
preview is not detailed enough, define the switch reference point in the job itself, where you
can zoom in. Use Reference Points in the File menu.

Switch reference point position

To numerically define the switch reference point of the old file in the job.

Keep Original Mask
To keep the Mask of the old file for the new file.

Fit to Original
To scale the size of the new file to the job size of the old file in the job.

Proportional

To scale the size of the new file proportionately.

Add to scale

To add extra scaling to the new file during the Fit to Original action.

Apply
To execute the switch or placement of the externally referenced files.

Tip:

To execute the placement or switch, you can also put your cursor over the preview image in
the CT-Switch dialog box and click the mouse button while pressing the Control key of your
keyboard.

Try
To preview the result of the CT-switch.
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The new CT appears on top of the old CT. During the Try-action, you still can make interactive changes.
To Undo the interactive changes you make during the Try-display, choose Undo (Edit menu) on page
204.

Note:  To undo the Try-action, press Cancel.

Try opacity

To change the opacity of the new CT when trying out the CT-switch. Lower the opacity of the new CT
when you want to have a better display of the old CT through the new CT.

Cancel
To stop the Try-display.

CT-Switch 2 Points tab sheet

To display and/or modify the options to switch externally referenced files (CT, GRS...) using 2 Points
positioning.

Define switch reference points

To define the switch reference points of the old CT-image/GRS-file in the job. The switch reference
points appear in red in the Preview window AND in the job itself, with an arrow to indicate the order of
the points.

Tip:

When the switch reference points need to be placed very accurately and the resolution of the
preview does not allow this, define the switch reference points in the job itself, where you can
zoom in.

First switch reference point position
 

 

To numerically define the first switch reference point of the old CT-image/GRS-file in the job.

Second switch reference point position
 

 

To numerically define the second switch reference point of the old CT-image/GRS-file in the job.
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Keep Original Mask
To keep the Mask of the old CT-image/GRS-file for the new CT-image/GRS-file.

Horizontal
To avoid rotation when placing the new file.

Apply
To execute the switch or placement of the externally referenced files.

Try
To preview the result of the CT-switch.

The new CT appears on top of the old CT. During the Try-action, you still can make interactive changes.
To Undo the interactive changes you make during the Try-display, choose Undo (Edit menu) on page
204.

Note:  To undo the Try-action, press Cancel.

Try opacity

To change the opacity of the new CT when trying out the CT-switch. Lower the opacity of the new CT
when you want to have a better display of the old CT through the new CT.

Cancel
To stop the Try-display.

CT-Switch Box tab sheet

To display and/or modify the options to switch externally referenced files (CT, GRS...) using Box
positioning.

Position bounding box
To define the placement of the new image in relationship to the bounding box or the mask of the
original image.

Position method
Object on Object

To place the bounding box of the new file on the bounding box of the original file.

Object on Mask

To place the bounding box of new file on the bounding box of the mask of the original file.

Mask on Object

To place the bounding box of the mask of the new file on the bounding box of the original file.

Mask on Mask

To place the bounding box of the mask of the new file on the bounding box of the mask of the original
file.
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Keep Original Mask
To keep the Mask of the old file for the new file.

Fit to Original
To scale the newly placed file to the size of the old file in the job.

Proportional

To scale the new file proportionately.

Add to scale

To add extra scaling to the new file during the Fit to Original action.

Apply
To execute the switch or placement of the externally referenced files.

Try
To preview the result of the CT-switch.

The new CT appears on top of the old CT. During the Try-action, you still can make interactive changes.
To Undo the interactive changes you make during the Try-display, choose Undo (Edit menu) on page
204.

Note:  To undo the Try-action, press Cancel.

Try opacity

To change the opacity of the new CT when trying out the CT-switch. Lower the opacity of the new CT
when you want to have a better display of the old CT through the new CT.

Cancel
To stop the Try-display.

CT-Switch modes

 

 

To choose the CT-Switch mode when the CT-Switch Envelope is closed:

•

1 Point positioning 

•
2 Points positioning 
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•

Box positioning 

Define switch reference point

 

 

To define the switch reference point(s) in the job instead of in the preview. This button only
appears when the CT-Switch Envelope is closed. When the CT-Switch envelope is open, use the

Define 1 point button ( ) in the 1 Point tab sheet or the Define 2 Points button

( ) in the 2 Points tab sheet. For 1 points positioning and 2 points
positioning, to execute the placement or switch, put your cursor over the preview image in the CT-
Switch dialog box and click the mouse button while pressing the Control key of your keyboard.

8.1.21.  Exit (File menu)

To leave the application.

Choose Exit from the File menu. If you modified the file before you clicked Exit you can save these
modifications. You can only save your work to the Esko native file format.

8.2.  Edit Menu

8.2.1.  Undo (Edit menu)

To cancel the last editing function (or a series of editing functions) you performed.

Choose Undo from the Edit menu.

Note:

The number of undos you can perform depends on the number of Undo Levels entered in
Preferences.

8.2.2.  Redo (Edit menu)

To cancel the last undo (or series of undos) you performed.
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Choose Redo from the Edit menu.

Note:

The number of redos you can perform depends on the number of Undo Levels entered in
Preferences.

If you change something to your job after an undo action, you cannot redo it anymore, or - in
other words - redo only works immediately after an undo action.

8.2.3.  Delete (Edit menu)

To delete an object or a group of objects.

To delete objects:

1. Select the object or group of objects that you want to delete in red.
2. Choose Delete from the Edit menu.

All red selected objects are deleted.

Tip:

Choose Undo to return an object that is accidentally deleted.

Attention:

All red selected objects are deleted, even if they are displayed outside of the active layout
window.

8.2.4.  Cut (Edit menu)

To cut a contour, an object or a group of objects and store it in the clipboard.

Choose Cut from the Edit menu to delete selected red objects from their current position in order to
paste them into another position.

The cut object(s) is/are stored in the clipboard with all the properties (for example: color, stroke)
assigned to the object(s).

To cut objects:

1. Select the object or group of objects that you want to cut in red.

Tip:  Refer to Select Linework Objects in Red on page 39.

2. Choose Cut from the Edit menu.

The selected object or group of objects is cut from the current job, and is stored in the clipboard.
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Note:

• Cut does not apply to contours being part of an object.
• The clipboard can only contain one item. As soon as something else is dropped in the

clipboard, the first item disappears.

8.2.5.  Copy (Edit menu)

To copy a contour, an object or a group of objects and store it in the clipboard.

Choose Copy from the Edit menu to copy red selected objects in order to paste them into another
position.

To copy objects:

1. Select the object or group of objects that you want to copy in red.

Tip:  Refer to Select Linework Objects in Red on page 39.

2. Choose Copy from the Edit menu.

The selected object or group of objects is copied and is stored in the clipboard.

8.2.6.  Duplicate (Edit menu)

Allows to duplicate any (group of) object(s) at its exact location.

You can move the duplicate to a new location. The original object is kept.

8.2.7.  Paste (Edit menu)

To paste a contour, an object or a group of objects one or more times from the clipboard into the
current layer.

Choose Paste from the Edit menu to paste cut or copied objects from the clipboard.

The object(s) is/are pasted into the job with all of the properties (for example: color, stroke) that have
been assigned to the object(s).

Objects are pasted in the same position from which they were cut or copied. Unless you use the
Alignment options. The objects can be positioned according the settings in the Align box, and
automatically scaled and rotated (depending on the selected Alignment options), if the Align box is
displayed when you perform Paste.

To paste object(s) (multiple times):

1. Copy or Cut the object(s) you want to paste into the clipboard.
2. Choose Paste from the Edit menu.

The object is pasted from the clipboard in the same position from which it was cut or copied (unless
the Align box is displayed).

3. Choose Paste again to continue pasting additional copies into the current level.
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Tip:

• Paste inserts the object as the frontmost object of the current layer.
• To move an object from one layer to the other use cut, change layer and paste.

8.2.8.  Paste on Crosshair (Edit menu)

Choose Paste on Crosshair from the Edit menu, to paste the object relative to the position of the
crosshair instead of relative to the position of the document's origin (top/left borders). This may
prove its use when pasting object(s) in a document with other page sizes (to have the object on the
same position relative to the crosshair) or after you have moved the document's crosshair to another
position.

8.2.9.  Paste Text from Windows clipboard (Edit menu)

An extra feature to paste Unicode text from the Windows clipboard into a Text Box.

Choose Paste Text from Windows Clipboard from the Edit menu and the text will be pasted. Note that
only text is pasted, not its original typesetting. The text will be pasted with the typesetting (font, font
size, underline...) of the cursor position in the selected Text Box.The text will be placed on the cursor
position in the Text Box, or on top in Text box when the Modify Text tool is not active.

Shortcut: ALT+V

To paste text:

1. Copy or Cut the object(s) you want to paste into the clipboard.
2. Choose Paste Text from Windows Clipboard from the Edit menu.

8.2.10.  Paste Once (Edit menu)

To paste a contour, an object or a group of objects once from the clipboard into the current layer.

Choose Paste Once from the Edit menu i.e. the object is pasted in the job and removed from the
clipboard.

This function also enables you to reduce memory usage while pasting a very large object or a group of
objects.

Objects are pasted in the same position from which they were cut or copied. Unless you use the
Alignment options. The objects can be positioned according the settings in the Align box, and
automatically scaled and rotated (depending on the selected Alignment options), if the Align box is
displayed when you perform Paste.

To paste object(s) once:

1. Copy or Cut the object(s) you want to paste into the clipboard.
2. Choose Paste Once from the Edit menu.
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The copied or cut object is pasted from the clipboard in the same position from which it was cut or
copied (unless the Align box is displayed), and the clipboard is emptied.

8.2.11.  Paste In Front (Edit menu)

To paste an object or a group of objects in front of another selected object.

Choose Paste In Front from the Edit menu.

The object(s) is/are pasted into the job with all of the properties (for example: color, stroke) that have
been assigned to the object(s).

Objects are pasted in the same position from which they were cut or copied. Unless you use the
Alignment options. The objects can be positioned according the settings in the Align box, and
automatically scaled and rotated (depending on the selected Alignment options), if the Align box is
displayed when you perform Paste.

To paste object(s) in front of another object:

1. Copy or Cut the object(s) you want to paste into the clipboard.
2. Select the object you want to paste the copied object in front of in red.

Tip:  Refer to Select Linework Objects in Red on page 39.

3. Choose Paste In Front from the Edit menu.

The copied or cut object is pasted in front of the selected object.

Tip:

When dealing with a lot of objects this is the quickest way to change the order of the objects.

Note:

When you paste an object to a group of objects, it will become part of the group.

8.2.12.  Paste Behind (Edit menu)

To paste an object or a group of objects behind of another object.

Choose Paste Behind from the Edit menu.

The object(s) is/are pasted into the job with all of the properties (for example: color, stroke) that have
been assigned to the object(s).

When you paste objects, the objects are pasted in the same position from which they were cut or
copied. Unless you use the Alignment options. The objects can be positioned according the settings in
the Align box, and automatically scaled and rotated (depending on the selected Alignment options), if
the Align box is displayed when you perform Paste.

To paste object(s) behind another object:

1. Copy or Cut the object(s) you want to paste into the clipboard.
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2. Select the object behind which you want to paste the copied object in red.

Tip:  Refer to Select Linework Objects in Red on page 39.

3. Choose Paste Behind from the Edit menu.

The copied or cut object is pasted behind the selected object.

Note:

When you paste an object to a group of objects, it will become part of the group.

8.2.13.  Paste Inside (Edit menu)

To paste an object (or group of objects) into one selected object in the current layer.

Choose Paste Inside from the Edit menu. The objects are pasted into the current layer and the selected
object(s) automatically become(s) a mask.

When you mask an object as you paste, the objects are automatically grouped together.

When you paste objects, the objects are pasted in the same position from which they were cut or
copied, unless you use the Alignment options. The objects can be positioned according the settings in
the Align box, and automatically scaled and rotated (depending on the selected Alignment options), if
the Align box is displayed when you perform Paste.

To mask an object as you paste:

1. Copy or Cut the object(s) you want to paste into the clipboard.
2. Select the object you want to use as a mask in red.

Tip:  Refer to Select Linework Objects in Red on page 39.

3. Choose Paste Inside from the Edit menu.

The copied or cut object is pasted inside the selected object.

The red selected object becomes a mask, and is grouped with the pasted object (or group of
objects).

All areas of the pasted object that fall outside of the red selected object (now a mask), are hidden in
the preview and the extended preview mode.
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Note:

• To paste an object into more than one red selected object, the red selected objects must be
linked (refer to Compound Objects (Linework) on page 44).

• When you paste objects that have been grouped, a new (higher level) group is created,
containing the original group and the mask.

For example, if you paste objects that are created as Group Level 4, the resulting (pasted)
objects are considered Group Level 5.

8.2.14.  Notes

Using the Notes tool and Notes function in the Edit menu, you can add and edit notes in the PackEdge
document.

Notes are saved in the Normalized PDF file as regular PDF Comments, and will show up as "Sticky
notes" in Adobe Acrobat. Sticky notes created in Acrobat will also show up in PackEdge, while other
types of comments (text corrections, highlights, ...), and note properties or statusses are disregarded
when opening a PDF file in PackEdge.

 

 

A note consists of two parts: the Note itself, the yellow balloon indicating the location of the note, and
the Note Pop-up, containing text, the name of the user that created it, and the time of creation.

You can change the color of the note and note pop-up in the View tab of the Preferences. See View tab
on page 213

 

 

• To create a note, select the Note tool and click in your document, or select Edit > Notes > Add Note,
or select Add note from the contextual menu using the Note tool

210



8PackEdge

• To move a note, click and drag the note pop-up

• To delete a note, select it and choose Edit > Notes > Delete Note or select Delete Note from the
contextual menu using the Note tool.

• To delete all notes, choose Edit > Notes > Delete all Notes or select Delete all Notes from the
contextual menu using the Note tool.

• To hide or show all notes, choose Edit > Notes > Hide/Show all Notes or select Hide/Show all Notes
from the contextual menu using the Note tool.

Note:  When using Hide all Notes, both the notes and the note pop-ups will be hidden. Only
Show all Notes makes notes visible again. Using Show all Note Pop-ups will not have any
affect.

• To hide a note pop-up, click the X in the top right corner. This doesn't affect the note itself, it only
hides the pop-up

• To hide all note pop-ups, select Edit > Notes > Hide all Note Pop-ups or select Hide all Note Pop-
ups from the contextual menu using the Note tool

• To show all note pop-ups, select Edit > Notes > Show all Note Pop-ups or select Show all Note Pop-
ups from the contextual menu using the Note tool

8.2.15.  Update CT Masks (Edit menu)

To update a CT mask, according to modifications that have been made to the mask in other
applications.

Update CT Masks applies to red selected masks only. It saves a lot of time, because it is no longer
necessary to load the whole CT all over again, if only an update of the mask is required.

Choose Update CT Masks from the Edit menu.

8.2.16.  Preferences... (Edit menu)

To define standard settings to be used by the application as you work on a job.

When you choose Preferences from the Edit menu, the Preferences dialog box appears.

Preferences dialog box
The Preferences dialog box contains:

• General

• View

• Color

• Editing

• Files

• Shortcuts
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• Messages
• Licenses
• Server and Resources

General tab
To define general standard settings to be used by the application as you work on a job.

 

 

Language Setting
You can change the language of the user interface by selecting one of the following languages from
the list box: English, French, German, Spanish, Japanese, Chinese Simplified or Chinese Traditional.
You no longer need to install the language packs from the DVD to have a non-English user interface. In
case you prefer to have the localized online help documentation, however, you still need to install the
language packs.

Note:

The editor needs to be restarted before the changes will become effective.

Number of Undo Levels
Defines the minimum number of steps the system remembers for Undo and Redo.

Enter a value between 0 and 1000.

Tip:

For complex jobs, it is best to keep the number low to save memory.

Number of visible decimals in Input Fields
Defines the number of decimals displayed in the input boxes.
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Enter a value between 0 and 8.

Values are rounded when you enter more digits (into an input box) than the number defined in this
Decimals input box.

Save automatically every
Defines how often you want the application to save your work automatically. The interval between
2 automatic saves is expressed in minutes. Your work is saved in a file called 'autosave.grs' in the
Temporary directory you have selected in the Files tab sheet.

A value of 0 disables automatic save.

Maximum Memory Usage for Image Data
Defines the amount of RAM allocated for storing Image display images.

The higher the value, the more RAM the system has at its disposal for the display image(s), reducing the
need to reload display images from the hard disk.

Select "Low" when several application are running simultaneously on the system. The maximum
amount of memory allocated by the editor is limited to make sure that other applications still have
enough memory. This setting is also recommended when the system has 512Mb or lower.

Select "Medium" for normal use and for the editor's most optimal performance. By choosing "Medium"
there is still some free memory available for other applications and the system itself.

Select "High" when the editor is allowed to allocate most of the system resources. In this case most
image data is stored in memory instead of written to temporary files on the disc. This setting is only
recommended when the editor is the only high-end application on the system and when the system
has 1GB or more physical computer memory. This setting is not recommended when running PackEdge
and/or Plato and/or ColorTone at the same time.

Select "Custom" to fill in the total percentage of the physical computer memory that can be allocated
by the editor for handling image data. Make sure there is enough other physical computer memory
available for the OS (250Mb), other applications and the memory needed to run the editor and handling
documents (200Mb).

View tab
To define standard view settings to be used by the application as you work on a job.
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Image Display Quality
Defines the resolution used by the application to display images.

From the drop down list, select one of the following possibilities:

• Real: the application creates a display image at the highest possible resolution, regardless of the
display information in the image file itself.

• High: the application creates a display image at a high resolution (72 dpi), regardless of the display
information in the image itself. This can take very long since all data of the images are read. If you
have, however, a large job that takes more than half of the CT Cache Size, the display image will be
displayed at a resolution lower than 72 dpi.

• Default: the application uses the display image of the CT file itself or, if none is available, creates a
display image.

• Low: the application uses a display image only if it is available in the CT image itself. If you choose
this possibility, the CT will not be visible in the Extended Preview mode.

Attention:  The options Very High and High are introduced to enable “real” resolution views
of CT's. Due to the large amounts of data it involves, the options Very High and High will
considerably slow down the visualization.

Display External Files
• Cross
• Key Line
• Display

214



8PackEdge

• Real

View Modes
View Modes Buttons

 

 

There are four View Modes, you can define the first three, the last one is set. The last one is the Ink
Based View, which is the most correct one, but also the most taxing for your system, because it uses
real data when previewing linked data. You can use the Ink based preview without this option, though.

Attention:  When selecting "use real data in preview", or when switching to the 4th preview
mode, PackEdge will read the high resolution data of an image as soon as you zoom in on that
image. This may slow down the application considerably.

Just click the button you want to define and change the settings in the way you see fit. These buttons
can be chosen in the editor's Status Toolbox:

 

 

Hitting the Reset button will reset all your changes.

View Mode

Choose a View Mode:

 

 

• Contour
• No Overprint
• Overprint
• Overprint

Anti-Alias

Defines the anti-aliasing setting when displaying images on screen in the Preview Mode or the
Extended Preview Mode.

A higher value will result in smoother edges, but also in substantially slower repaints.

Enter a value between 0 and 4.

Attention:  Setting an anti-alias value different from 0 may slow down the application.
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Text Greeking

Defines the minimum size of the text before it is displayed as a filled box rather than readable text. The
boxes will turn into text again when zooming in.

Show Image Name

Defines whether or not the names of the Images used in your job appear on the screen while working in
a layout window that is set to Contour Mode.

Show Selection in Preview

Defines whether or not red selections are made visible if the Display Mode of the layout window is set
to Filled, Preview mode or Extended Preview mode.

Show Bounding Box around selection

If this option is enabled, the bounding box of the selection is shown. Since this bounding box is always 1
pixel thick (independent of the zoom factor), the selection remains visible even when zooming out a lot
and/or selecting tiny objects.

Use Real Data in Preview

Uses real data in preview, is very accurate, but takes more time in rendering.

Colors
Double-click the color patch to modify the color of selected and selectable objects, borders, margins,
crosshair, grids, etc...

Click Reset to restore the default settings.

Color tab
 

 

Default document profile: choose the default profile from the list.

Monitor profile: choose a monitor profile from the list.

PANTONE Color conversion: choose a PANTONE color conversion from the dropdown list.

Check Warn when placing files with another document profile to have the system display a warning
when placing PDF files that have other document profiles embedded.

Editing tab
To define standard editing settings to be used by the application as you work on a job.
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Gravity
Defines the distance in screen pixels within which the reference guides apply gravity.

The higher the value, the easier the object will snap to the reference guides.

Enter a value between 0 and 16.

Cursor Drag Delay
Defines the minimum distance in screen pixels the cursor must be moved before any transformation of
an object takes place.

Enter a value between 0 and 16.

Default Softmask Width
Defines the default width that is used when Soft Mask transparency is applied to an object.

Pan Overlap
Defines the percentage of overlap between the previous and the new view when panning.

With an overlap of 40%, a new viewport rectangle contains 40% of the previous view and 60% of a new
view.
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Update External Files when they are modified
Defines whether or not the displays of the external images that are in the job you are working on, are
updated automatically when they have been edited in the meantime.

"Shift and drag-select" reverses the selection
Dragging a selection over an object while holding SHIFT actually deselects selected objects and
selects unselected ones.

Use accurate selection tool
If you drag a selection (in order to select an object for instance), the editor will make the selection four
pixels larger on each side. This makes selecting easier in some cases. If you do not want this 'enlarged'
selection, use the 'Use accurate selection tool' option. The selection will be accurate to the pixel!

Make crosshair selectable
Check the box if you want to make it possible to select the crosshair when the selection tool is active.

Create polygons by
• One mouse click: click the top left corner of the polygon and drag the desired size.
• Two mouse clicks: click both the top-left and the bottom-right corner of the polygon.

A dialog pops up when clicking in the document without dragging the mouse. In this dialog you can
numerically fill in the values of the position and the dimension of the polygon/ellipse that you want to
create.

Paste places the copied selection
Choose where you paste a object or a selection you copied:

• on the same position of the artwork (default PackEdge behavior),
• in the middle of the view area (default Illustrator behavior).

Note:  The pasting mode you choose here will be assigned the Ctrl + V shortcut.

When applying a transformation on objects
• Transform Stroke: Defines whether strokes are transformed together with their object.
• Transform Vignette: Defines whether vignettes are transformed together with their object.
• Transform Text: Defines also whether or not text is transformed together with the text box.
• Transform Pattern: Defines also whether or not patterns are ransformed together with their object.

• Transform (toolbar).

Files tab
To define standard file settings to be used by the application as you work on a job.
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Folder Temporary Files
Click Browse... to select the directory where you want to store temporary files. By default, the
temporary files directory is c:\temp\ on the hard disk of your workstation. Clicking Browse... opens
the Temporary Files dialog box where you can select another directory if you do not want to use the
default one. Always choose a directory on a hard disk of the workstation, preferably the fastest.

Create backup file (.bak)
Creates a backup file in the same folder or another folder before saving or before loading.

• Before saving: a backup file of the file that was previously saved will be created.

• Before loading: a backup file of the newly loaded file will be created.

You need to change the .bak into .pdf in order to be able to read the file into the editor. Save the back
up file in the same folder, or select another folder.

File Filters
Click Modify... to open the File Filters dialog box. It allows you to remove and/or add File Filters to the
File menu commands: 'Open', 'Place' and 'Export'.

Show options in File Selector dialog
Check this option to have the File Options dialog box opened every time you open a new file.

Show thumbnail in File Selector dialog
Check this option to have a thumbnail present in the file selector.
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To add or modify Search Folders for missing links
Click Modify... to be able to specify search folder paths in the Search Folders dialog box.

When visible objects are found outside the Media Box (margins) while saving:
Indicate what should happen when saving:

• Ask me what to do
• Fit the Media Box around these objects
• Clip the objects on the Media Box

Automation Engine: Warn for editing documents with status Approved
Defines how to respond when opening Automation Engine documents with an "Approved" status. If the
option is on, a warning will be shown when a document with status "Approved" is opened. If the edited
file is saved, the Approval state will be reset. If the option is off, no warnings will be generated, and the
Approved status will not be changed.

Check Job Parameters after opening a document
Job parameters are defined via the Automation Engine Pilot on the Automation Engine server. Every
time a document from a Automation Engine Job is opened/saved, it will be checked to see if there are
conflicts with the options defined in the Automation Engine Job Parameters.

Disable this if you don’t want to perform this check when opening a document.

Check Job Parameters before saving a document
Disable this if you don’t want to perform the Automation Engine Job Parameters check when opening a
document.

File Filters dialog box
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Select an action:

• File Open
• File Place
• File Place Image
• File Export

Check the box of the file types you want to see for the selected action.

Tip:

You can drag the files types to put them in the desired order.

Shortcuts tab
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To define or personalize shortcuts.

Three predefined sets of shortcuts are available:

• Scope uses the shortcuts that are also used in other Esko Software Suite applications: Plato, Esko
Bitmap Viewer....

• DTP uses generic shortcuts, used in most DTP applications.

• Esko Classic uses the shortcuts as they existed in the older PackEdge versions.

• ArtPro uses the shortcuts that are used in ArtPro.

You can, however, modify whichever set of shortcuts to fit your personal needs.

1. Select the right set of shortcuts, if it is not yet selected.
2. Select the 'Category' (e.g., 'File') of which you want to personalize a shortcut.
3. Select the command you wish to personalize (e.g., 'New')
4. Now personalize your shortcut. Enter a key and click 'Assign'.

Note:

If you want to remove a shortcut , click 'Remove'..

If you want to return to the original shortcuts, click 'Reset All'.

Messages
The editor allows you to choose whether you want a certain error / info / warning messages displayed
again or not. If you did click the message "Do not show this message again" but you want to undo this
afterwards, you can select the messages you want to see displayed again.

The list of messages will increase during a PackEdge session. Each time you click "Do not show this
message again", an extra message will be added to the list.
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Licenses
The Licenses tab allows you to activate the licenses that you want to enable.
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Server and Resources tab
To define the Automation Engine server to connect to, and the Data Resources to be used by the
application as you work on a job.

Note:

In case the application is connected to an Automation Engine or BackStage server, the Data
Resources are always used from this server. You can use the emote or local Data resources if
the application is not connected to an Automation Engine or BackStage server.

 

 

Automation Engine Server
You can set the Server Name, User Name and Password to connect to Automation Engine.

The connection to an Automation Engine Server has an influence on the following features in the
application:

• Submitting to Shuttle: you can only submit to the Automation Engine server the application is
connected to

• The user name for the Track Edit Session task on the Automation Engine server

• The list of Jobs and Products in the File Selector dialogs

• The parameters for the ’Check Job Parameters’ as available on the Automation Engine server
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Note:

If you are connected to an Automation Engine, a green notification will be shown.

Data Resources
The common Data Resources used by the application are Color Engine Database, Marks, Fonts, Custom
and DGC.

By default, these Data Resources are taken from the Automation Engine server. However, it is possible
for 2 or more stand-alone applications (without an Automation Engine server) to share the same data
resources. This requires that the Data Resources are shared on a remote computer.

Note:

Changing the Data Resource settings requires a restart of the application.

Shapes
This allows to define the Shapes server, by entering the Server address, the User Name and Password.
See also Open / Place from Shapes on page 182.

The default Esko Shapes server address is shapes.esko.com.

8.3.  View Menu

8.3.1.  Contours

In this mode, only the contours of the objects are displayed.

8.3.2.  No Overprint Preview

All overprint modes are translated in opaque. Use this mode if you want to work fast. Note however that
the overprint modes are visualized incorrectly.

8.3.3.  Overprint Preview

In this mode, you can see the inks and colors of each separate object. First, the color of each object is
converted to RGB and afterwards these RGB values are mixed to get a final result. Use this mode if you
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want to work fast. Note however that the overprint modes are visualized incorrectly: the overprints will
all be visualized as Darken ('Esko overprint') overprints.

8.3.4.  Ink Based Preview

In this mode, which is of a higher quality, all inks and colors are displayed the best possible way,
resulting in a job that is the best possible approach of the printed result. First, the inks of the different
objects are mixed in their original separations. Afterwards, the mixed ink values are converted to RGB.

8.3.5.  Zoom In (View menu)

To zoom in (by a factor of 2) on the displayed job in the active window.

Choose Zoom In from the View menu. You can continue to zoom in as many times as necessary,
allowing you to accurately modify or measure the displayed job.

The zoom is based on the center of the current display.

Note:

To display the view in all of the layout windows at the same time (if multiple layout windows are
being used), activate Same Zoom.

Tip:

You can use CTRL + mouse wheel to zoom in/out in the document.

8.3.6.  Zoom Out (View menu)

To zoom out (by a factor of 2) on the displayed size of the job in the active window.

Choose Zoom Out from the View menu. You can continue to zoom out as many times as necessary,
allowing you to accurately modify or measure the displayedjob. The zoom is based on the center of the
current display.

Note:

To display the view in all of the layout windows at the same time (if multiple layout windows are
being used), activate Same Zoom (Alt+ W).

Tip:

You can use CTRL + mouse wheel to zoom in/out in the document.

8.3.7.  Job View (View menu)

To display what is included inside the margins of the active window.
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If information exists outside the margins of the window; it will not appear on the screen.

Choose Job View from the View menu.

Note:

To display the view in all of the layout windows at the same time (if multiple layout windows are
being used), activate Same Zoom.

8.3.8.  Total View (View menu)

To display the entire job, including objects outside the margins, after you have used any of the other
View options.

Choose Total View from the View menu.

Note:

To display the view in all of the layout windows at the same time (if multiple layout windows are
being used), activate Same Zoom.

8.3.9.  Actual Size (View menu)

This function allows you to view the actual size of your job.

8.3.10.  Same Zoom (View menu)

To zoom in or out, the same way in all windows without changing the display mode.

Activate Same Zoom in the View menu.

8.3.11.  Zoom to Selection

This function allows you to zoom automatically on the selected area in your job.

8.3.12.  Previous View (View menu)

To display the previous view of the active window after you have used any of the other View options.

Choose Previous View from the View menu. With Previous View you can toggle between the last two
views.
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Note:

To display the view in all of the layout windows at the same time (if multiple layout windows are
being used), activate Same Zoom.

8.3.13.  Repaint (View menu)

To repaint the active window to remove stray pixels or to finish painting a large file on screen.

Choose Repaint from the View menu. If you perform an action when a large file is repainting, the
repainting is interrupted, allowing you to continue working (an asterisk displays in the title bar of the
active window to indicate repainting of the file has been interrupted).

The system will automatically continue to repaint the file when you stop working for several seconds.
To expedite this process, use Repaint to begin repainting the file immediately.

8.3.14.  Show Rulers

When visible, rulers appear along the top and left side of the window. Markers in the ruler display the
ruler's position when you move it. Change the ruler's origin (the (0, 0) mark on the top and left rulers) by
drag and dropping it to the new position. The ruler origin determines the grid's point of origin.

Tip:

Double-click left to align the rulers to the top-left position of the document's borders. Double-
click right to align the rulers to the origin of the document's crosshair.

8.3.15.  Lock Guides

Guides appear as lines that float over the entire job. Use this to lock a guide to avoid accidentally
moving it.

8.3.16.  Show Technical Inks (View menu)

Allows you to view the Technical Inks in the job window.

'Show Technical inks' is default selected.

Selecting or deselecting 'Show Technical inks' only applies for the active window.

8.3.17.  Viewer (View Menu)

Viewer is a very accurate separation viewer with a lot of extra production tools. Viewer eliminates the
need for separated proofs and will avoid a lot of bad platemaking. See Viewing options
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8.4.  Select Menu

8.4.1.  Select Layer (Select menu)

To select all objects within the current active layer.

1. Determine or select the Layer in the status bar.
2. Click on Select Layer in the Select menu.

The objects are displayed in red to indicate selection, and can be manipulated or modified.

Attention:  Objects in a 'locked layer' cannot be selected. Refer to Manipulate Linework Layers
on page 43 for additional information.

8.4.2.  Select All (Select menu)

To select all objects within a job.

1. Choose select All from the Select menu.

The objects are displayed in red to indicate selection, and can be manipulated or modified.

Attention:  Objects in a 'locked layer' cannot be selected. Refer to Manipulate Linework Layers
on page 43 for additional information.

8.4.3.  Deselect (Select menu)

To deselect objects that have been selected in red.

Choose Deselect from the Select menu.

Deselected objects display in black, and can no longer be manipulated or modified.

Note:

Green and blue selected objects cannot be deselected. Use Switch Red-Green or Switch Red-
Blue to change them to red selected objects if necessary.

To deselect individual (red selected) objects
1. Choose Deselect in the Select menu.
2. Position the cursor on the object you want to deselect, and click the mouse button.

The object is displayed in black to indicate the object is deselected, and can no longer be
manipulated or modified.
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Note:

Objects in locked layers cannot be deselected. Refer to Manipulate Linework Layers on page 43
for additional information.

To deselect (red selected) objects within an area
1. Choose Deselect in the Select menu.
2. Position the cursor outside of the objects you want to deselect, and click, hold and drag the mouse

to create a box around the objects you want to deselect. Release the mouse button.

The objects are displayed in black to indicate they are deselected, and can no longer be
manipulated or modified.

Note:

You must enclose the entire object within the selection box for the object to be deselected.

Note:

Objects in locked layers cannot be deselected. Refer to Manipulate Linework Layers on page 43
for additional information.

To deselect all (red selected) objects
1. Click anywhere in the layout window (outside an object).

The objects are displayed in black to indicate they are deselected, and can no longer be
manipulated or modified.

Note:

All objects are deselected (even objects in locked layers). Refer to Manipulate Linework Layers
on page 43 for additional information.

8.4.4.  Deselect All (Select menu)

Allows you to quickly deselect everything.

8.4.5.  Same (Select menu)

Automatically select all the object with the same features as the selected one.
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Choose from:

• Fill Color
• Fill Overprint Mode
• Stroke Color
• Stroke Overprint Mode
• Stroke Width
• Fill and Stroke

8.4.6.  Select by Color (Select menu)

To select all objects by color.

1. Select the reference color from the color palette.

Tip:

Refer to entering settings in the Style palette.

2. Choose Select by Color from the Select menu.

All objects that are assigned with the same color (fill or stroke) as the reference color are displayed
in red to indicate selection, and can be manipulated or modified.

8.4.7.  Select by Attribute... (Select menu)

Select objects based on the values of their attributes.

When you choose Select by Attribute from the Select menu, the Select by Attribute dialog box appears.

Changing a selection in the user interface in the 'Select by Attribute' dialog will automatically display
the number of objects that are matching the criteria.

Press the 'Select All' button to clear the current selection and to put the matching objects in a
selection. Press SHIFT + 'Select All' button the add the matching objects to the current selection.

Press the Reset button to clear all selected options. Use the step buttons to navigate through the
matching object(s). Step forward/backwards with the next/previous button, go to the end/begin
by using the fast forward/backward buttons. While starting navigating through the objects, the
red selection is cleared. The view is zoomed to the current targeted object. This objects is also red
selected.

Select by Attribute dialog box

General attributes
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Object type: selects objects based on its type: contour, blend, image... You can define a name as a
selection criterion.

Box width: Selects objects based on the width of its bounding box, define the width as lower than /
equal to / higher than.

Contour length: Selects contours based on length, define the lenght as lower than / equal to / higher
than.

Outside: Trim box (borders) / Media box (margins): To select objects that fall outside the trim box or
media box..

Runaround: To select an object by runaround text 'in' or 'out'-side the object.

Transparency: To select all objects having a non-default transparency for the fill, stroke or object
attribute (overprint flag, opacity, opacity gradient, opacity & mask define knockout shape, isolate
blending, knockout group).

Open Contour: Selects contours that are not closed.

Fill attributes
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Color: Selects objects based on their fill's color (drag and drop a color patch).

Pattern: Selects objects based on their fill's pattern (drag and drop a pattern or double click to
open the pattern window). Select the Pattern toggle with an empty pattern to find all objects in the
document without a fill pattern.

Blending: Selects objects based on their fill's blend. Selecting 'non-separable' activates the four
bottom blending options: Hue, Saturation, Color and Luminosity.

Overprint: Select the objects with their fill in overprint.

Opacity: Select objects based on their fill's opacity: define opacity as lower than, equal to, higher
than...

Opacity gradient: Select objects based on their fill's opacity gradient, choose a grandient from the
drop down list. Select "Opacity Mask" from this list to find all objects in the document with a PDF
Opacity Mask.

Mask: Select objects with a masked fill.

Stroke attributes
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Color: Selects objects based on their stroke's color (drag and drop a color patch).

Pattern: Selects objects based on their stroke's pattern (drag and drop a pattern or double click to
open the pattern window).

Blending: Selects objects based on theirstroke's blend, select the blends from the drop down list.

Overprint: Select the objects with strokes in overprint.

Opacity: Select objects based on their stroke's opacity: define opacity as lower than, equal to, higher
than...

Opacity gradient: Select objects based on their stroke's opacity gradient, choose a grandient from the
drop down list.

Mask: Select objects with a masked stroke.

Object attributes
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Ink : Selects objects based on their ink (drag and drop a ink patch).

Color: Selects objects based on their color (drag and drop a color patch).

Blending: Selects objects based on their blend, select the blends from the drop down list.

Opacity: Select objects based on their opacity: define opacity as lower than, equal to, higher than...

Opacity gradient: Select objects based on their stroke's opacity gradient, choose a grandient from the
drop down list.

8.4.8.  Select In-between (Select menu)

To select all objects (lying on top of each other) in between the currently selected objects in the job.

You can for example select a complete blend by selecting the innermost and the outermost object,
and then choose Select in between. This may be interesting if you want to delete or modify blends in
imported jobs.

Choose Select in between from the Select menu.

8.4.9.  Select Next (Select menu)

To select the next object in a series of objects that overlap.

Choose Select Next from the Select menu.

The 'next object' is selected according to the position you click in the layout window.

You may use Browse to verify the selected object.

If you are selecting objects in the contour display mode, you can toggle between contour objects that
are positioned on top of each other (and for which it would be dicult to select them by clicking).
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If you are selecting objects in the filled, preview and extended preview display mode, you can toggle
between the objects that overlap by clicking them.

8.4.10.  Select Related (Select menu)

To quickly select objects related to the one currently selected.

Choose Select Related from the Select menu in situations where it is dicult to select objects by
clicking.

You can use the function to:

• Select the mask of the currently selected object;

• Select the object that is masked out by the currently selected mask;

• Select the background of the currently selected text box;

• Select the text box for which the currently selected object acts as a background.

If the currently selected object is related to several other objects, Select Related always selects the
one that is closest in the file hierarchy. You can use Browse to obtain detailed information about the file
hierarchy.

If you press Select Related several times consecutively, the selection switches between the related
objects.

8.4.11.  Select Inside (Select menu)

To quickly select objects that are inside another object.

Choose Select Inside from the Select menu to quickly select objects that are inside another object.

To select objects by means of this function, you must select the surrounding object in blue first.

8.4.12.  Switch Red - Green (Select menu)

To switch the red selection to Green.

8.4.13.  Switch Red - Blue (Select menu)

To switch the red selection to Blue.
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8.5.  Contours Menu

Note:

When you perform Set operations such as Geomapper, Flattening, Trapping, Clipping, Union,
Intersection, Difference etc. on objects from the document, you keep the graphical description
of the objects:

• Splines are kept as splines
• Vectors are kept as vectors

Using splines instead of vectors reduces the file size when you save the document.

8.5.1.  Union (Contours menu)

To create an object from the outside perimeters of two or more selected objects.

Choose Union from the Contours menu.

If you use this option on objects that have different properties, the properties displayed in the Color
Style bar are assigned to the new object.

To use Union:

1. Select the objects you want to keep intact in green, and select the objects you want to modify in
red.

Tip:

Refer to Select Linework Objects in Red on page 39.

Note:

The selected objects must touch, overlap or one object has to include the other one to be
affected. If the objects do not overlap, one linked object will be created. The linked object
will have the properties based on the settings in the Style bar.

2. Choose Union from the Contours menu.

The new object is created, and is positioned directly above the object having the highest position
(from the previous selection). The order of the original objects is unchanged.

8.5.2.  Intersection (Contours menu)

To create an object from the common parts of red selected objects that fall within green selected
objects.

Choose Intersection from the Contours menu.
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To use Intersection:

1. Select the objects you want to keep intact in green, and select the objects you want to modify in
red.

Tip:

Refer to Select Linework Objects in Red on page 39.

Note:

The selected objects must touch, overlap or one object has to include the other one to be
affected.

2. Choose Intersection from the Contours menu.

The new objects are created, and are positioned directly above the object having the highest
position (from the previous selection). The order of the original objects is unchanged.

If you use this option on objects that have different properties, the properties displayed in the Color
Style bar are assigned to the new object.

Note:

If the Measure Plug (from the Style bar) is activated and the objects were selected individually,
the Style bar displays (and applies) the properties of the last selected object, even if the object
was not used with Splice.

Note:

If the Measure Plug is activated and the objects were selected by dragging a selection
rectangle around them, the Style bar displays (and applies) the properties of the lowest object.

8.5.3.  Difference (Contours menu)

To subtract the green selection from the red selection.

Choose Difference from the Contours menu.

To use Difference:

1. Select the objects you want to keep intact in green, and select the objects you want to modify in
red.

Tip:

Refer to Select Linework Objects in Red on page 39.

Note:

The selected objects must touch, overlap or one object has to include the other one to be
affected.
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2. Choose Difference from the Contours menu.

The new object is created and has the shape of the red selected object(s) that lie outside of the
green object.

The order of the original objects is unchanged. Each object's properties remain unchanged.

Note:

If you want to apply Difference for strokes, you first have to convert the strokes and only then
you can apply Difference.

8.5.4.  Regions (Contours menu)

To create an object from the differences and the intersections of overlapping objects.

Tip:

This option is the same as using Intersection and Difference (at the same time).

Choose Regions from the Contours menu.

To use Regions:

1. Select the objects you want to keep intact in green, and select the objects you want to modify in
red.

Tip:

Refer to Select Linework Objects in Red on page 39.

Note:

The selected objects must touch, overlap or one object has to include the other one to be
affected.

2. Choose Regions from the Contours menu.

The new objects are created, and are positioned directly above the object having the highest
position (from the previous selection). The order of the original objects is unchanged. The green
selected object remains, and can be deleted.

If you use this option on objects that have different properties, the properties displayed in the Color
Style bar are assigned to the new object (even if the Apply Plug is deactivated).

Note:

If the Measure Plug (from the Style bar) is activated and the objects were selected individually,
the Style bar displays (and applies) the properties of the last selected object, even if the object
was not used with Splice.

239



8 PackEdge

Note:

If the Measure Plug is activated and the objects were selected by dragging a selection
rectangle around them, the Style bar displays (and applies) the properties of the lowest object.

8.5.5.  Cut by Objects (Contours menu)

To cut a red selected object by all points intersected by a green selected object.

Choose Cut by Objects from the Contours menu.

To use Cut by Objects:

1. Select the objects you want to use to cut the red selected object in green, and select the objects
you want to cut in red.

Tip:

Refer to Select Linework Objects in Red on page 39.

Note:

The selected objects must touch or overlap to be affected. If you select all objects in red,
individual objects will be created wherever the objects intersect.

2. Choose Cut By Objects from the Contours menu.

The new objects are created, and are positioned directly above the object having the highest
position (from the previous selection). The order of the original objects is unchanged.

The new (red selected) object will be an open object. Although an open object has no fill, the stroke
remains with the object.

8.5.6.  Cut on Crosshair... (Contours menu)

To cut one or more red selected object(s) by means of the crosshair.

You move the crosshair to the desired position with regard to the object(s) concerned and cut away a
part in any quadrant(s) of the crosshair.
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The object(s) to be cut is (are) represented by the red square. To indicate which part(s) you want to cut
away, you must click the corresponding quadrant(s) of the red square, which will disappear. If you click
the same quadrant a second time, it will appear again.

Note:

If the object is a contour with only the Fill attribute, the result is a physical cut. In all other
cases the result is a visual cut by means of (a) mask(s). To avoid this, you must contourize the
object first.

Note:

If you have applied Cut on crosshair on several objects that overlap, you may obtain quite
a number of masks. To make sure you select the mask you intended, you should use Select
Related

8.5.7.  Reduce... (Contours menu)

To reduce points of a vector-based design object or to convert a vector-based design object to a
spline-based format.
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When you choose the Reduce options from the Contours menu, the Reduce dialog box appears. The Try
button allows you to get a preview of the result. You can change the Deviation value and see the effect
immediately. Then you can click the Apply button to apply the Reduce, or click the Try button again to
turn it off.

Reduce dialog box

Reduce ponts
To straighten a vector-based design object to reduce points.

1. Select the object you want to straighten.

If you select the object in red, the selected object will be replaced with the straightened object.

If you select the object in green, a new, straightened object will be created on top of the original
object.

Tip:  Refer to Select Linework Objects on page 38.

2. Select Reduce points.
3. Click the Try button.
4. Choose Deviation from the Contours menu.
5. Enter the numeric value for the maximum allowable distance between the original and the

straightened object, in the Deviation input box.
6. If the Deviation gives the result as wanted, click the Apply button.

Note:  The straightened vector-based object can be converted into a spline-based format that
can be manipulated and modified.

To Splines
To convert a vector-based design object to a spline-based format. The spline-based object can be
manipulated and modified with the application's options.

To convert a vector-based object:

1. Select the object you want to convert.

If you select the object in red, the selected object will be replaced with the converted object.

If you select the object in green, the converted object is created beside the original object.

Tip:  Refer to Select Linework Objects on page 38.

2. Select Convert to Splines.
3. Click the Try button.
4. Choose Deviation from the Reduce submenu.
5. Enter the numeric value for the maximum allowable distance between the original and the

converted object, in the Deviation input box.
6. If the Deviation gives the result as wanted, click the Apply button.

Tip:  When working with design objects that have very rough edges, straighten the objects
before you convert them to spline format. By straightening the objects, you will have fewer
points to convert.
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Deviation
To enter the Deviation Value which is needed for the Reduce Points and the Convert To Splines options
from the Reduce menu.

The number you enter in the Deviation input box determines how far the outline of the resulting
straightened or splined object is allowed to deviate from the original:

• By entering a high number, the straightened or converted object will have fewer points, and will be
less accurate than the original object.

• By entering a low number, the straightened or converted object will have more points, and will be
closer to the original object.

• If you enter 0 (no deviation), the straightened or converted object will have the same number of
points as the original object.

8.5.8.  Convert Strokes (Contours menu)

To convert the boundaries of a stroke into parallel contours.

Choose Convert Stroke from the Contours menu.

You can convert the stroke of one or more selected objects.

The 'stroke' property (assigned from the Color Style bar) is lost, and the newly created object is linked.
The original stroke properties become the fill properties for the newly created object.

Note:

The original object is kept with its fill properties (if the original object had fill properties).

Note:

If a stroke is not converted into an individual object, the stroke cannot be manipulated or
modified separately (from the object).

To convert a stroke into an individual object:

1. Select the object that has the stroke you want to convert in red.

Tip:

Refer to Select Linework Objects on page 38.

2. Choose Convert Strokes from the Contours menu.

The stroke is converted to an individual object that can be manipulated and modified (as an
individual object).

If the original stroke is an open object, the converted stroke will have the same caps as the original
stroke.

If more than one object is created, the new objects will be linked.
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Note:

If you are converting the stroke for two overlapping objects (that have stroke properties), the
newly created objects will not merge.

Note:

If you are converting the stroke for two overlapping objects (that have stroke properties) and
the objects are linked, the newly created objects will be merged.

8.5.9.  Merge Objects (Contours menu)

To create new objects by removing the overlapping areas of two or more selected objects.

Choose Merge Objects from the Contours menu.

The new objects are created by removing the underlying parts of other selected objects. If more than
two objects are selected, the system removes the objects based on the levels (from the top down).

To use Merge Objects:

1. Select the objects you want to merge in red.

Tip:

Refer to Select Objects.

Note:

The selected objects must touch, overlap or one object has to include the other one to be
affected.

2. Choose Merge Objects from the Contours menu.

The new objects are created, and can be manipulated and modified. The properties and the order of
the objects remain unchanged.

8.5.10.  Connect (Contours menu)

To create a single object from two or more open ended objects that have points that are positioned on
top of each other.

Note:

The screen gravity is zoom dependent, which means that it might be impossible to connect
objects when you use a high zoom factor.

Choose Connect Objects from the Contours menu.

To use Connect Objects:

1. Select the objects you want to connect in red.
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Tip:

Refer to Select Objects.

2. Choose Connect Objectsfrom the Contours menu.

The new object is created, and can be manipulated and modified as a single object.

The new object has the attributes of the selected object that was created last.

8.5.11.  Create Inner/Outer Stroke

To create a contourized stroke object based on a closed contour or text object.
 

 

When you choose Create Inner/Outer Stroke from the Contours menu, the Create Inner/Outer Stroke
dialog box appears.

Create Inner/Outer Stroke dialog box

Outer /Inner Width The distance from the original object to the outside / inside

Outer / Inner Corner The type of corner at the outside / inside of the stroke

Use Color from Selection If disabled, the color defined in the Create Outer/Inner Strokes dialog will
be used.

If enabled, the created stroke will use the color, blend mode and
transparencies of the selected object: the stroke attributes if the original
object has a stroke, or the fill attributes when it has a fill.

The object transparencies are always applied.
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Miter Limit The limit for mitered corners

8.5.12.  Round Corners... (Contours menu)

To modify the shape of one or more corners of (a) selected objects.
 

 

When you choose Round Corners from the Contours menu, the Round Corners dialog box appears.

Round Corners dialog box

Radius To specify the distance from the corner.

Corner types

 Round corner

 Antique corner

 Beveled corner

Click either one of these buttons to perform the cutting, according to the type
illustrated by the icon. When you have clicked one of the buttons, you can
still click one of the other buttons to choose another corner type. Once the
selection changes, for example additional objects are selected or the object is
deselected and then selected again, the modification is definitive.

Note:

It is possible to modify only one corner of the object, or to modify each of the corners in a
different way. Therefore, activate the Modify tool and select the corner you want to modify
before you click either one of the icons.

8.5.13.  Etch and Emboss... (Contours menu)

To create a relief like effect on an object.
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You can make an object look as if it was carved out in the background using Etch or you can make it
stand out against the background using Emboss.

To obtain these effects, both functions create a number of new objects (a back object and side objects)
derived from the original one (the front object) and group them in a particular way. Etch also turns the
original object into a mask. By assigning colors of different shades to the various objects, you obtain
the desired optical effect.

You can create either parallel or perspective Etch/Emboss. Parallel means that a copy of the original
object is moved by a certain distance, without changing the size, whereas Perspective means that a
copy of the original object is moved and scaled with respect to a vanishing point.

When you choose Etch/Emboss from the Contours menu, the Etch/Emboss dialog box appears.

Etch/Emboss dialog box

Parallel Etch/Emboss tab sheet
 

 

 

 

Vertical distance To define the vertical distance between the original
object and the copy. A positive value moves the new
objects in downward direction, whereas a negative
value moves them upward.

 

 

Horizontal distance To define the horizontal distance between the original
object and the copy. A positive value moves the new
objects to the right, whereas a negative value moves
them to the left.
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Diagonal distance To define the diagonal distance between the
original and the copy. This value is normally used in
combination with Angle.

 

 

Angle To define the angle by which the copy will be moved.

Etch button To execute the Etch function with the specified values.

Emboss button To execute the Emboss function with the specified
values.

Perspective Etch/Emboss tab sheet
 

 

 

 

Vertical position To define the vertical position of the vanishing point with
regard to the file origin or with regard to the center of the
crosshair if the crosshair toggle is activated.

 

 

Horizontal position To define the horizontal position of the vanishing point
with regard to the file origin or with regard to the center of
the crosshair if the crosshair toggle is activated.

  Crosshair To relate the values to the center of the crosshair instead
of the file origin.
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Scaling factor To define the size of the destination object and its
position with respect to the vanishing point, which will be
inversely proportional.

Etch button To execute the Etch function with the specified values.

Emboss button To execute the Emboss function with the specified values.

Tip:

When your objects consist of more than one contour, it is advised to Make Compound the
selected contours, before performing Etch/Emboss.

8.6.  Arrange Menu

8.6.1.  To Front (Arrange menu)

To move an object to the top of all other objects within the current layer.

Choose To Front from the Arrange menu.

To move an object to the top of the current layer:

1. Select the object you want to move.

Tip:

Refer to Select Objects.

2. Choose To Front.

Note:

To Front will not work for one object out of a group, because this might cause problems with
masks.

Tip:

Use Cut and Paste in front to leave a group.

8.6.2.  To Back (Arrange menu)

To move an object to the bottom of all other objects within the current layer.
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Choose To Back from the Arrange menu.

To move an object to the bottom of the current layer:

1. Select the object you want to move.

Tip:

Refer to Select Objects.

2. Choose To Back.

Note:

To Back will not work for one object out of a group, because this might cause problems with
masks.

8.6.3.  Forward (Arrange menu)

To move an object one step up within the current layer.

Choose Forward from the Arrange menu.

To move an object one step up within the current layer:

1. Select the object you want to move.

Tip:

Refer to Select Objects.

2. Choose Forward.

The object is moved one level within the layer.

You can continue to move the object forward (within a layer), one position at a time.

Note:

To position an object directly in front of or behind an object, use Paste In Front.

Note:

Forward will not work for one object out of a group, because this might cause problems with CT
masks.

8.6.4.  Backward (Arrange menu)

To move an object one step down within the current layer.

Choose Backward from the Arrange menu.

To move an object one step down within the current layer:
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1. Select the object you want to move.

Tip:

Refer to Select Objects.

2. Choose Backward.

The object is moved one level within the layer.

You can continue to move the object backward (within a layer), one position at a time.

Note:

To position an object directly in front of or behind an object, use Paste Behind.

Note:

Backward will not work for one object out of a group, because this might cause problems with
CT masks.

8.6.5.  Align and Distribute (Arrange Menu)

The Align and Distribute functionality helps you to quickly align two or more objects

The Align and Distribute menu items offer the same options as can be found in the Align dialog. See
Align and Distribute objects on page 614

8.6.6.  Group (Arrange Menu)

To group red selected objects.

Choose Group from the Select menu.

To group objects:

1. Select the objects you want to group in red.

Tip:

Refer to Select Objects.

2. Choose Group from the Select menu.

The objects are grouped and can be manipulated or modified as a single selection.
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Note:

Each object retains its individual properties.

Grouping will automatically rearrange the objects in a way that there are no other objects in-
between.

8.6.7.  Ungroup (Arrange Menu)

To ungroup objects after they have been grouped.

Choose Ungroup from the Select menu.

You can take an individual object out of a group or ungroup all the objects in the group.

To ungroup objects:

1. Select the object(s) you want to ungroup in red.

Tip:

Refer to Select Objects.

2. Choose Ungroup from the Select menu.

The selected objects are ungrouped and can be manipulated and modified as individual objects.

Note:

When releasing a group containing Group Transparency, a warning will be displayed, stating
that the transparency will be lost when releasing the group.

8.6.8.  Hide (Arrange Menu)

The Hide functionality allows you to quickly hide the selection, the objects above and/or below the
selected object.
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The Hide functionality is linked with the Object Browser.

8.6.9.  Show All

Very useful when you've used the Hide functionality.

8.6.10.  Lock (Arrange Menu)

The Lock functionality allows you to lock the selected object or the objects above and/or below the
selected one.
 

 

The Lock functionality is linked with the Object Browser.

8.6.11.  Unlock (Arrange Menu)

The Unlock functionality is very useful when you've locked certain objects.

8.6.12.  Clipping Mask (Arrange Menu)

 

 

By using Clipping Mask you can easily create and release clipping masks or clip the masked objects.

• Make: create a group and use the first selected contour object as clipping mask for the other
objects. The fill and stroke attributes of the clipping mask are reset.

• Release: ungroup the selected group and remove the clipping mask attribute from the clipping
mask. The former clipping mask is copied before the first element of the ungrouped objects.

• Clip: calculate through the clipping paths to reduce the file size at output and to simplify the
visualization in contour mode. It might be more dicult to edit the document afterwards. There
are some exceptions that will keep their clipping masks: images and linked files, blend objects, text
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objects etc. Only contour objects are clipped in the first version when you choose Clipping Mask >
Clip.

8.6.13.  Make Compound (Arrange menu)

To link multiple objects together to create a single object.

The compound object acts as a single object, and has the properties of the object that is in the
uppermost position (on top of all other objects) within the compound.

Choose Make Compound from the Arrange menu.

To link objects:

1. Select the objects you want to link in red.

Tip:

Refer to Select Objects.

2. Choose Make Compound from the Arrange menu.

The objects are linked, resulting in a single object that can be manipulated and modified.

8.6.14.  Release Compound (Arrange menu)

To unlink objects in a compound.

You may release an individual object, or all objects that are part of the same compound.

Note:

Unlinked objects do not revert to their original properties.

Choose Release compound from the Arrange menu.

To unlink an individual object:

1. Make sure the Preset Grouping Level is 1.
2. Select the object you want to release.

Tip:

Refer to Select Objects.

3. Press [PgDn] to display the objects you do not want to release in black.

The individual object displays in red.
4. Choose Release compound from the Arrange menu.

The individual object is no longer part of the compound.

The other compound objects (in the compound) are unaffected.

To release some objects (linked into a single object):

1. Select the objects you want to release by dragging a rectangle.
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2. Select the (linked) object you want to unlink.
3. Choose Release Compound from the Arrange menu.

The individual object is no longer part of the compound.

The other compound objects (in the linkage) are unaffected.

To release all objects (linked into a single object):

1. Make sure the Preset Grouping Level is not set to 0.
2. Select the (compound) object you want to unlink.

Tip:

Refer to Select Objects.

All objects included in the compound display in red.
3. Choose Release Compound from the Arrange menu.

The compound no longer exists, and the objects (that were in the linkage) are individual objects.

8.6.15.  Remake Compound (Arrange menu)

To link objects of a different color.

They will be unlinked from the original objects, and relinked per subset of selected contours belonging
to the same original object, and inherit their original properties.

1. Make sure that the Preset Grouping Level is 0.
2. Create a selection of objects by dragging a selection rectangle around the objects that you want to

relink.

All objects included in the selection display in red.
3. Choose Remake Compound from the Arrange menu.

The selected objects are unlinked from original objects, and relinked per subset of selected
contours belonging to the same original object, and inherit ther original properties.

8.6.16.  Degrade to Objects (Arrange menu)

To make active, separate objects or images from an externally placed file.

Choose 'Degrade to objects' from the Arrange menu. This function enables you to convert an externally
placed file into active, separate objects or images that can be manipulated and edited. Consequently,
each object is turned into a separate, real contour object.

8.6.17.  Snap Crosshair (Arrange menu)

To make the crosshair jump to the last selected point.

Choose Snap Crosshair from the Arrange menu. If no point has been selected, the crosshair jumps to
the center of the job.
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8.7.  Image Menu

8.7.1.  Edit

Opens the selected file(s) in the editor that is associated with the file type of the selected image.

Tip:

You can associate a program to a file type via the right-click context menu on a file in Windows
Explorer. Select "Open With" and "Choose Program..." to browse to the associated program.

8.7.2.  Replace by...

Replaces the selected image with another image or an external link.

A file selector dialog pops up to browse for a new file. Options in 'Replace by...' dialog:

• Fit to original size
• Keep aspect ratio
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• Replace all identical images (when the selected image or link) has 2 or more references in the
document

8.7.3.  Embed Image...

Embeds all placed images from the current page in a file. The editor asks a name for the embedded
image. Also works with multiple selected images, but you will not be able to enter new names.

8.7.4.  Embed All Images...

Embeds all placed images in a file. The embedded images have the same name as the original placed
ones.

8.7.5.  Create Linked Image...

Makes a linked image from an embedded one, the system asks for a prefix and a place to store the
linked images. Also works with multiple selected images.

8.7.6.  Create Links from all Embedded Images...

Makes linked images from all embedded images in the current page, the editor asks for a prefix and a
place to store the linked images.

8.7.7.  Contourize 1-bit Image

Converts the selected 1-bit image into paths.This function only works on 1-bit TIFF or LP files.

8.7.8.  Contourize all 1-bit Images

Converts all 1-bit images in the job into paths.This function only works on 1-bit TIFF or LP files.

8.7.9.  External File Ink Mapping...

To replace the ink separations of a external job by any color from the color palette or by any ink from
the Inks dialog box.

To apply Ink Mapping to selected external jobs only.

External jobs are externally placed GRx, pla files or normalized PDF files.

This is an overview of the External File Ink Mapping dialog box:
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Icon/name Explanation

Ink Map rows To map the original ink in the left column to the destination ink in the right
column.

Name input box Instead of dragging an ink to an ink box in the right column, you can also fill out
the name of an ink in the name input box

Select Similar Allows you to select all External Files, this feature makes it easier to perform
inkmapping on all externally placed files at once.

 

 

This toggle adapts the size of the dialog box to the size of your list. Click once to
activate the toggle, click again to resize the dialog box to the default size.

 

 

Allows you to reset.

8.7.10.  Image Plane Mapping...

To replace the ink separations of a loaded image by any color from the color palette or by any ink from
the Inks dialog box.

Choose Image Plane Mapping from the Paint menu or double-click the Image Plane Mapping box in the
Fill style or Stroke style part of the Style Palette, to display the Image Plane Mapping dialog box.

This is an overview of the Image Plane Mapping dialog box:

 

 

Icon/name Explanation

Ink Map rows Drag and drop inks from the Inks dialog box or colors from the Color Palette in the
Style bar to the destination ink boxes of the Image Plane Mapping dialog. You can
also map to an empty separation or another separation from the drop down menu
when you click the black triangle. Click the Density field to reduce the density of
the mapped separation.

Name input box Instead of dragging an ink to an ink box in the right column, you can also fill out
the name of an ink in the name input box
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Icon/name Explanation

Select Similar Allows you to select all similar images, this feature makes easier to perform Image
Plane Mapping on all images at once.

Save as CT... Allows you to create a new CT form the selected CT with the plane maps
separations calculated through in the pixel data. The link to the original CT is
replaced to a link to the new one. The original CT is not deleted from the disc.

 

 

This toggle adapts the size of the dialog box to the size of your list. Click once to
activate the toggle, click again to resize the dialog box to the default size.

 

 

To undo the Image Plane Mapping, click the reset button, or drag and drop the
original ink separation on the destination color swatch

Tip:

It is better to drag inks from the Inks dialog box than to drag colors from the Color Palette in the
Style Bar, as colors still can be modified when working on the job.

Note:

The original Image separations are replaced according to the applied plane mapping, when
proofing or exposing your job. The Image file itself however, remains unchanged.

Double-clicking a destination ink box displays the Color Factory, while clicking the right mouse
button displays the PANTONE Book.

An ink separation is removed when you drop an empty ink box on the destination ink box of that
separation or when you select Empty from the drop down popup menu.

Note:

The Preview Mode displays the result immediately when the CT Display Quality in the
Preferences dialog box (or in the Info dialog box in the Catalog) is set at high or very high.

The Extended Preview Mode (X-Mode) displays the result when the CT Display Quality is put on
at medium, high or very high. (A "Low" CT Display Quality only displays de contours of the CT.)

Note:

Image Plane Mapping does not apply to monochrome CT's. If you selected a monochrome CT, all
boxes in the Image Plane Mapping dialog box appear dimmed. Use the Style bar to assign colors
from the Color Palette to your CT.
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Attention:

A link to a multichannel native image file (PSD, JPEG, Tiff...) is seen as a link to a monochrome
image when all separations, except one, are mapped to empty paint and after saving to a
normalized PDF file. Reset the plane mapping by replacing the image by its original file.

8.7.11.  CT Image Composer...

The CT Image composer recombines a set of CT images into one or more groups of composed CT
images. This technology diminishes the number of (small) CT images and provides the user with a fair
level of editability of the document. A number of CT images are generated during normalization of
PostScript, PDF and EPS files:

• A document created in PackEdge might contain non-native PostScript or PDF features. The
conversion to PostScript or PDF file implies that the job is "resolved". In some cases a lot of image
data is created (rasterized) in the output file.

• Transparencies, complex clipping masks, and transparency groups in a PostScript or PDF file are
flattened in the Adobe CPSI RIP during normalization to GRS or Normalized PDF file. A lot of CT
images might be created during the normalization.

Tip:

Please refer to the CT Image composer white paper. It is part of the Esko Software Suite install
DVD.

8.7.12.  Rasterize

The Image Rasterizer will render all selected objects into the image data of a new CT image. The
selected objects will be replaced by the newly created CT image and clipping mask. Any type of object
from the document - or mix of different types of objects - can be rasterized to a CT image. Contour
objects with complex transparency effects, multiple (tiny) CT images, a mix of both types, or even a
complete document can be rasterized into a CT image.
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'Resolution' determines the number of dots per inch (dpi) in the rasterized CT image.

'Calculate background colors in image data' allows you to add the transparency effects of (non-selected)
underlying objects in the CT image data.

'Make image background transparent' allows you to fill transparent areas with white pixels or to make
the background transparent.

'Make image embedded' allows you to create a linked CT file or an embedded CT object from the
selected object(s).

For more practical information on the Image Rasterize option, please refer to the white paper 'Image
Rasterizer' which is available on the Documenation DVD.

8.7.13.  Image Properties...

General
The General tabsheet offers generic information: name, type, location, size, etc.

Use the Select All button to select all instances of that image.

 

261



8 PackEdge

 

Design
 

 

Inks
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8.8.  Text Menu

8.8.1.  Select All (Text menu)

To select all text within a text box and its linked text boxes or a single text line.

Choose Select All from the Text menu.

To use Select All:

1. Make sure the Edit Text mode (a|b tool) is activated.
2. Position the cursor within the text box and click to select the appropriate text box or position the

cursor within the text line and click to select the text line.
3. Click Select All.

The selected text is highlighted in gray to indicate selection, and can be manipulated and modified.

Tip:

You can also press [Alt] and click on the text (instead of performing step 3) to select the text.

8.8.2.  Move Further (Text menu)

To increase the text box number by one position when you are rearranging a chain of linked text boxes.
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Choose Move Further from the Text menu. The text reflows and the other linked text box numbers
change accordingly.

8.8.3.  Move Back (Text menu)

To decrease the text box number by one position when you are rearranging a chain of linked text boxes.

Choose Move Back from the Text menu. The text reflows and the other linked text box numbers change
accordingly.

8.8.4.  Text Style (Text menu)

To interactively format text.

When you choose Text Style in the Text menu, the Text Style bar appears.

The Text Style bar contains :

• Text Box settings

• Paragraph settings

• Character settings

Open the envelope in the Text Style bar to display additional text options.

To interactively format text with the Text Style bar:

1. Select with Edit Text (toolbar) on page 564 the text object(s) you want to modify.
2. Enter the settings for the text object(s) in the Text Style bar.

The selected text object(s) is (are) modified according to the settings in the Text Style bar.

Note:

• When you type information into input boxes, the text has to be in the proper case.

For example, if you want to select Bold as the text weight, you have to type Bold, not bold to
be recognized.

Enter a '?' in any field to display the default value.

• When you enter information into numeric input boxes in the Text Style bar, the default is
expressed in points unless you enter mm, inch, or pica after the selection to express the
size in one of these units of measure.

8.8.5.  Tab Status Bar (Text menu)

To show a Tab status bar at the top of the current text box.

The Tab status bar displays the tabs for the part of text where the cursor is in. This happens the same
way as in the Tab bar of the Tab Style dialog box. You can update the tabs, and the text gets updated
accordingly.
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When you choose the Tab Status Bar from the Text menu, the Tab status bar appears.

8.8.6.  Show Labels (Text menu)

To display the information labels of a text box while you are editing text.

The label at the top of the text box contains the name, whereas the label at the bottom contains
symbols about text that cannot be displayed, about links to secondary text boxes, etc.

8.8.7.  Character Styles... (Text menu)

To create, edit or delete character styles.

When you choose Character Styles from the Text menu, the Character Styles dialog box appears.

 

 

Character Styles dialog box

Style You can enter the name for a new character style in the style input box.

- OR -

The style input box displays the character style selected from the style list.

<Default> is the name of the default character style.

Style list Select a style from the list of existing character styles to edit, copy or delete.

Edit To modify the selected character style in the Character Style dialog box.
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Copy To copy the selected character style in the Character Style dialog box.

Delete To delete the selected character style.

You cannot delete the <default> style or a style that is being used.

Extra information about the Edit button
Clicking the 'Edit' button opens the Character Style dialog box; to modify the selected character style in
the Character Style dialog box.

Character Style dialog box

To create or modify a character style.

When you click the Character Style button  in the Text style bar, the Character Style dialog box
appears.

Open the envelope in the Character Style dialog box to display additional text options for Superscript,
Subscript, Leader, and Underline.

Note:

You can also open the Character Style dialog box when choosing Character Styles in the Text
menu.

Note:

• Dimmed settings indicate the default value will be used to format the text, but it can always
be changed.

• To display the default value, position the cursor in the appropriate input box and enter a '?'.
• Click Reset to return to the default settings.

Tip:

Use Apply Local to display how the formatted text will look on a small amount of text (before
you change the format for all text to which the style has been applied), or to make a comparison
between two text settings.

Overview Character Style options

Name The name of the character style.

Font To select a font for your text. You can type the name of the font or some
character of the font name in the input box next to Font or you can click the
arrow of the drop down list to get a font list out of which you can choose the
desired font.
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Weight To specify the variation of the letter form, for example light, bold or heavy.
Type in the weight or click the arrow of the drop down list to get a list of
available weights out of which you can choose one by clicking the name.

Size To specify the font size. The size is defined in pica points by default. Other
possible units are mm, cm, in, mil, pica or didot. Type in the size in the input
box or click the arrow of the drop down list to get a list of sizes. For example
8, 10 or 12.

• ptc: capital height is taken. For example 12ptc. 12pt capital is taken as
reference.

• ptx: x-height: x-height is taken. For example 12ptx. 12pt x-height is taken
as reference.

Slant To obtain an italic effect. In the input box you can specify an angle, for
example 15 will slant the selected characters with an angle of 15 degrees.
The maximum slant value is 75, the minimum slant value is equal to -75.

Distort Distort narrows or broadens text artificially. It only changes the width of
the characters. It does not affect their height. Type the desired distortion
percentage or click the arrow of the drop down list to display a list of
percentages out of which you can choose one by clicking on the percentage.
For example -3% or 2%.

Track Track reduces the space between several selected characters. The value
is expressed as a percentage of the Em-box. Type the desired track
percentage or click the arrow of the drop down list to display a list of
percentages out of which you can choose one by clicking the percentage.
For example -3% or 2%.

Char Space To indicate the distance between two characters. Type the distance in a
percentage value.

Hyphenate Hyphenate defines the hyphenation language. The hyphenation program
determines how words will be hyphenated. Type the name of the language
or click the arrow of the drop down list to display a list of languages. For
example Off (no hyphenation), Danish, Dutch or English.

Kern Kern changes the spacing between letter pairs according to values found
in the kerning table, in order to enhance their visual appearance. Typical
aesthetic kerned pairs are for example LT and AV. To get a list of the options
click the arrow of the drop down list or fill in the appropriate term in the input
box. For example Always, Above 10pt and Above 12pt.

Base Shift Base Shift moves characters above or below their base lines. Select the text
box and type the wanted base shift in points, mm or percentage (of current
size). You can give in positive and negative values. A negative value result in
a downward move.

X3 (superscript) Puts the selected characters in superscript. Select the characters and
activate X3. To enter extra settings for Superscript (Vertical Scaling,
Horizontal Scaling and Base Shift) open the envelope in the Character Style
dialog box.
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C2 (subscript) Puts the selected characters in subscript. Select the characters and
activate C2. To enter extra settings for Subscript (Vertical Scaling, Horizontal
Scaling and Base Shift) open the envelope in the Character Style dialog box.

Numbers To choose tabular or mediaeval numbers. Type in tabular or mediaeval or
click the arrow of the drop down list to display the possible options. For
example Normal, Tabular or Mediaeval. Not all typefaces have tabular or
mediaeval numbers. You can find out in the Font Preferences dialog box
whether a specific font has this feature or not.

Smallcaps To choose smallcaps.

Ligatures To choose ligatures. For example ff, fl or tl. Ligatures are only visible for
fonts containing ligatures.

Underline To underline text. To enter extra settings for underline (Width, Position) open
the envelope in the Character Style dialog box.

Color swatch To define the color for the text. You can drag a color from the Style bar on
page 595 to the color swatch.

Color Plug If the color plug is connected, the text color follows the general settings. If
the color plug is not connected, the text color does not follow the general
settings.

Blend mode To choose the blend mode that should be applied to the character style in
question.

 

 

The contents (of the Character Style envelope on page 610) change
depending on your choice in the Settings for drop down list.

• Hyphenation (Text menu)

• Paragraph Styles dialog box on page 270

Overprint Mode Note
• Same as box: by choosing this overprint mode, you indicate that the system should apply the

overprint mode (Opaque, Darken ('Esko overprint'), PostScript, Add) of the current selected text
box(es) to the character style.

• Normal (default mode): by choosing this overprint mode, you indicate that the system should apply
the Opaque overprint mode to the character style. In the Opaque overprint mode, the fill color of an
object overprints the fill color of another object that lies (partly) underneath. The object that lies
underneath is knocked out.

• Darken ('Esko overprint'): by choosing this overprint mode, you indicate that the system should apply
the Darken ('Esko overprint') mode to the character style. The Darken ('Esko overprint') mode can be
clearly explained when you have different objects of which the fill color consists of the same ink but
in a different percentage. For each separation, the Darken ('Esko overprint') mode takes the highest
percentage in overprint, even when the object with that ink lies underneath the other object.

• Multiply: by choosing this mode, you indicate that the system should apply the Add overprint mode
to the character style. The Add overprint mode can be clearly explained when you have two objects
of which the fill color consists of the same ink but in a different percentage. Take for example an
object with a fill color that contains 57 % of Cyan and another piece of text with a fill color that
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contains 39% of Cyan. In the Extended preview mode, the 57 % of Cyan is added up to the 39 % of
the remaining 43%, where the two pieces of text overlap. Consequently, you will have 76% (= 57 %
+(39% of 43%=) 19 %) of Cyan in that area.

For more information on the overprint modes of the fill color, we refer you to Style (Windows menu)

Reset
To return to the default settings.

Apply Global Plug
If the Apply Global Plug is activated (which is activated by default), all text to which the style has been
applied will be modified.

Apply Global
The general way to apply styles is to use the status bar. However, you can use Apply in the appropriate
style dialog boxes as well.

All text set in the named style is adapted. Apply Global is only available when working with named
styles.

Apply Local Plug
If the Apply Local Plug is activated, only selected text will be modified.

Apply Local
The text is adapted locally (in the selected part only). The named style and all text using this named
style are not changed.

Character Style envelope
The contents of the envelope change depending on your choice in the Settings for drop down list.

Superscript
envelope

To enter the values for vertical and horizontal scale of the character and for the
base line.

Subscript envelope To enter the values for vertical and horizontal scale of the character and for the
base line.

Leader envelope To determine:

• A string. Define the text characters to be used for the leader. Type in your
selection in the String input box. For example - #

The default is '.' (point).

• A distance. Define the distance between the text characters to be used for
the leader. Type in your selection in the Distance input box. The default is
15%.

• An origin. The point where to start, calculated from the beginning of the first
character of the line. Values in pt, mm or percentage of EM-box. The default
is 0.

Underline envelope To enter a width, position and a color for the line in pt, mm or percentage.
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• Width: The default is Auto (the width determined by the font designer).

• Position: Define the position of the underline, relative to the text base line.

A positive number positions the underline under the base line, a negative
number positions the underline above the base line, and a value of 0 centers
the underline directly on the base line. Type in your selection in the Position
input box. The default is Auto (the position determined by the font designer).

• If the color plug is connected, the underline color follows the general
settings. If the color plug is not connected, the underline color does not
follow the general settings.

8.8.8.  Paragraph Styles... (Text menu)

To create, edit or delete paragraph styles.

When you choose Paragraph Styles from the Text menu, the Paragraph Styles dialog box appears.

Paragraph Styles dialog box

Style You can enter the name for a new paragraph style in the style input box.

- OR -

The style input box displays the paragraph style selected from the style list.

<default> is the name of the default paragraph style.

Style list box Select a style from the list of existing paragraph styles to edit, copy or delete.

Edit To modify the selected paragraph style in the Paragraph Style dialog box.

Copy To copy the selected paragraph style in the Paragraph Style dialog box.

Delete To delete the selected paragraph style.

You cannot delete the <default> style or a used style.

Paragraph Style dialog box
To create or modify a paragraph style.

When you click the Paragraph style button  in theText Style bar, the Paragraph Style dialog box
appears.

Open the envelope in the Paragraph Style dialog box to display additional text options for Quadding,
Hyphenation and DropCaps.
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Note:

You can also open the Paragraph Style dialog box when choosing Paragraph Styles in the Text
menu.

Note:

• Dimmed settings indicate the default value will be used to format the text.
• To display the default value, position the cursor in the appropriate input box and enter a '?'.
• Click Reset to return to the default settings.

Tip:

Use Apply Local to display how the formatted text will look on a small amount of text (before
you change the format for all text to which the style has been applied), or to make a comparison
between two text settings.

Paragraph Style settings

Name The name of the paragraph style.

Char. Style Define the name of the character style you want
to use for the text. Select from the list (beside
the input box), or type in your selection in the
Char. Style input box.

Note:  If you enter a
name of a character
style that is not on the
list, a new character
style is created with
default character
settings.

Quadding To specify the horizontal positioning of text in
the text box. Type the correct quadding name or
click the arrow to get a list of quadding modes:
left, justify, center and right.

Note:  Open the
envelope and select
Quadding (in the
Settings for input box)
to enter additional
settings for quadding
(see below).

Leading Leading defines the distance from one base line
to the next base line of your text. The leading is
defined in points by default. Type the leading or
click the arrow to get a list.

Other units are also allowed: e.g. mm or cm.

'Auto' gives you an automatic
leading which is 120% of the
font size.

Space Before Define the vertical space before each new
paragraph (except for the first paragraph). You
may enter 0, any positive whole number or any
positive fraction for the value. Type in your
selection in the Space Before input box.

The default is 0.
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Space After Define the vertical space after each new
paragraph. You may enter 0, any positive whole
number or any positive fraction for the value.
Type in your selection in the Space After input
box.

The default is 0.

Tab Style To specify a tab style. Type the correct name
of the tab style or click the arrow to have a list
of already created tab styles out which you
can choose one. Pay attention to the fact that
whenever you type a name that is not in the list,
the style is created immediately with the default
settings. Clicking the label in front of the edit
input box immediately shows you the tab style.

Next Style Define the paragraph style for the next
paragraph. Select from the list (beside the input
box), or type in your selection in the Next Style
input box.

Tip:  Each time you
press [Enter] the
properties from the
style you selected
for Next Style will be
automatically applied
to text when you start
entering the text for
the new paragraph.

First Indent Define the distance from the left edge or left
indent to the beginning of the first line of a new
paragraph. Type in your selection in the First
Indent input box.

The default is 0.

You may only enter a positive
value.

Left Indent Define the distance from the left edge of a text
box or column to the left edge of a paragraph.
Type in your selection in the Left Indent input
box.

You may only enter a positive value:

• 12ptA = absolute
• 12ptR = relative to the left indent (default)

The default is 0.

Right Indent Define the distance from the right edge of a text
box or column to the right edge of a paragraph.
Type in your selection in the Right Indent input
box.

You may only enter a positive value:

• 12ptA = absolute
• 12ptR = relative to the left indent (default)

The default is 0.

Hang Punct. Define the percentage by which punctuation
marks are shifted outside of the left and right
boundaries of the text box (for a better visual
result). Type in your selection in the Hang Punct.

The default is Off.
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input box, or select from the Hang Punct. List
(beside the input box).

The percentage is based on the width of the
punctuation mark. If you use 0%, the text will
not be shifted. If you use 100%, the text will
be shifted to allow the punctuation mark to be
placed completely outside of the text box.

 

 

Click this icon to see additional options. The
contents change according to your Paragraph
Style settings.

Paragrap Style buttons

Reset To return to the default settings.

Apply Global
Plug

If the Apply Global Plug is activated (which is activated by default), all text to which
the style has been applied will be modified.

Apply Global The general way to apply styles is to use the status bar. However, you can use Apply
in the appropriate style dialog boxes as well.

All text set in the named style is adapted. Apply Global is only available when
working with named styles.

Apply Local
Plug

If the Apply Local Plug is activated, only selected text will be modified.

Apply Local The text is adapted locally (in the selected part only). The named style and all text
using this named style are not changed.

Paragraph Style envelope

The contents of the envelope change depending on your choice in the Settings for combo list.

Settings for Quadding

Word Space Define the word spacing to be used with all quadding modes. The percentage is
based on the normal word space (as defined by the typeface designer).

If you use 100%, the word space will not be adjusted.

If you use 50%, the text will be adjusted to allow a 50% reduction from the normal
word space.

The default is 100%.

Min Gap Define the minimum deviation from the defined word spacing when text is
justified.

The default is 85% of the word space.

Max Gap Define the maximum deviation from the defined word spacing when text is
justified.
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The default is 250% of the word space.

Ratio Define the white space between characters and words when text is justified.
The percentage is based on the normal word space (as defined by the typeface
designer).

The justification occurs in two steps.

First the white space is determined by the values entered in Min Gap and Max Gap.
If there is still some white space left, the remaining white space is justified using
the percentage entered in Ratio.

For example, if you enter 0%, the white space is adjusted based on the values you
entered in Min Gap and Max Gap. If you use 25%, 75% of the white space is divided
between words, and the remaining 25% is divided between all text characters.

The default is 0%.

Justify Zone Determine when to apply justification based on the percentage of the text line
that is filled with text. Select from the list (beside the input box), or type in your
selection in the Justify Zone input box.

For example, if you enter 15%, justification will be applied when 85% of the line is
filled with text.

The default is 0%.

Settings for Hyphenation

Char. Before Determine the minimum number of characters that can be entered before a
hyphen is inserted (when text wraps to the next line). Select from the list (beside
the input box), or type in your selection in the Char. Before input box.

The default is 3.

Char. After Determine the minimum number of characters that can be entered after a hyphen
is inserted (when text wraps to the next line). Select from the list (beside the input
box), or type in your selection in the Char. After input box.

The default is 3.

Min Length Determine the minimum number of characters that can be entered (for a word)
before the word can be hyphenated. Select from the list (beside the input box), or
type in your selection in the Min. Length input box.

The default is 5.

Settings for DropCaps

DropCaps If you enable DropCaps the paragraph starts with a dropcap.

Lines Define the height of the dropcap as a number of lines. The default value is 2.

Characters Define the number of characters in the dropcap. The default value is 1.

SmallCaps Puts the remaining characters of the first line in small capitals.
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Contours If you enable Contours, the text runs round the contour of the last character in the
dropcap. Otherwise it runs round the bounding box of that character.

Guard To specify the distance between the dropcap and the rest of the text. Enter a
number (distance in points), a percentage of an EM space, Auto (10% EM) or click
the arrow to get a list of values to choose from.

8.8.9.  Textbox Styles... (Text menu)

To create, edit or delete Text Box styles.

When you choose Text Box Styles from the Text menu, the Text Box Styles dialog box appears.

Text Box Styles dialog box

Style
You can enter the name for a new text box style in the style input box.

- OR -

The style input box displays the text box style selected from the style list.

Note:

<default> is the name of the default text box style.

Style list box
Select a style from the list of existing text box styles to edit, copy or delete.

Edit
To modify the selected text box style in the Text Box Style dialog box.

Copy
To copy the selected text box style in the Text Box Style dialog box.

Delete
To delete the selected text box style.

You cannot delete the <default> style or a used style.

Text Box Style dialog box

To create or modify a text box style.

When you click the Text Box Style button  in theText Style bar the Text Box Style dialog box
appears.
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Open the envelope in the Text Box Style dialog box to display additional options for Insert and
Quadding.

Note:

You can also open the Text Box Style dialog box when choosing Text Box Styles in the Text
menu.

Note:

• Dimmed settings indicate the default value will be used to format the text.
• To display the default value, position the cursor in the appropriate input box and enter a '?'.
• Click Reset to return to the default settings.

Tip:

Use Apply Local to display how the formatted text will look on a small amount of text (before
you change the format for all text to which the style has been applied), or to make a comparison
between two text settings.

Name
The name of the text box style.

Par. Style
Define the name of the paragraph style you want to use for the text. Select from the list (beside the
input box), or type in your selection in the Par. Style input box.

Note:

If you enter a name of a paragraph style that is not on the list, a new paragraph style is created
with default paragraph settings.

Quadding
To specify the vertical positioning of text in the text box. Type the correct quadding name or click the
arrow to get a list of quadding modes. For example top, justify, center and bottom.

Note:

• Open the envelope and select Quadding (in the Settings for input box) to enter additional
settings for quadding (see below).

• If there are runarounds for the text box, only Top mode is allowed. If any other mode is
selected, it will not affect the quadding and a warning will appear.

Columns
To specify the number of columns. Type the number or click the arrow to get a list of numbers to
choose from.
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Gutter
To specify the distance between the columns. Click the input box and fill in the width in mm, cm, in or
pt.

First Base
Define the position of the base line for the first line of text, relative to the top of the text box. Select
from the list (beside the input box), or type in your selection in the First Base input box.

When Auto is applied, three quarters of an EM space EM-box of the font size will be used. If you enter 0,
the base line of the first line is positioned exactly on top of the text box.

The default is Auto.

Column Width
Column Width specifies the width of the columns. The default value is Auto, which means that the
system calculates the width of the columns automatically according to the width of the text box, the
number of columns and the gutter. Pay attention to the fact that when you type in a value (not Auto) the
size of the text box will be adjusted. Click the input box and fill in the width in mm, cm, in or pt.

The default unit is the unit specified in the Document Setup dialog box.

Reset
To return to the default settings.

Apply Global Plug
If the Apply Global Plug is activated (which is activated by default), all text to which the style has been
applied will be modified.

Apply Global
The general way to apply styles is to use the status bar. However, you can use Apply in the appropriate
style dialog boxes as well.

All text set in the named style is adapted. Apply Global is only available when working with named
styles.

Apply Local Plug
If the Apply Local Plug is activated, only selected text will be modified.

Apply Local
The text is adapted locally (in the selected part only). The named style and all text using this named
style are not changed.

Text Box Style envelope

The contents of the envelope change depending on your choice in the Settings for combo list.

Insert envelope
Top

Define the top margin for the text box. Type in your selection in the Top input box.
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You may enter 0, any positive whole number or any positive fraction for the value.

The default is 0.

Bottom

Define the bottom margin for the text box. Type in your selection in the Bottom input box.

You may enter 0, any positive whole number or any positive fraction for the value.

The default is 0.

Left

Define the left margin for the text box. Type in your selection in the Left input box.

You may enter 0, any positive whole number or any positive fraction for the value.

The default is 0.

Right

Define the right margin for the text box. Type in your selection in the Right input box.

You may enter 0, any positive whole number or any positive fraction for the value.

The default is 0.

Quadding envelope
Ratio

The extra space needed for justification is divided over lines and paragraphs. Type the value in
percentage.

30% means add 30% of the extra space between the paragraphs and divide the other 70% between the
lines.

The default value is 50%.

Justify Zone

Justify Zone defines the zone where the justification of the text box will be executed.

15% means when 85% of the box is filled, justification will be executed.

The default value is 10%.

8.8.10.  Tab Styles... (Text menu)

To create styles on tab level.
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You can assign specifications such as position and repetition.

When you choose Tab Styles from the Text menu, the Tab Style dialog box appears.

1. Click in the input box in the Tab Styles dialog box.
2. Fill in the name of the tab style that you want to create and press [Enter].
3. Click Edit.

The Tab Style dialog box appears with the name of the style.

Tab Style dialog box

Tab bar
The tab bar gives you visual feedback on the position of the tabs and makes a certain amount of editing
possible. The quadding modes of the tabs are visualized as follows:

•  Left aligned
•  Centered tab
•  Right aligned
•

 Decimal tab

Instead of specifying all options and then use Add, Remove or Modify, some actions can also be done
using the tab bar.

Adding tabs with the tab bar:

1. Double-click the position where you want the new tab. A new left aligned tab is created and its icon
is shown.

2. To change the quadding mode: Double-click the tab's icon until the icon for the correct quadding
mode appears.

Modifying tabs with the tab bar:
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1. Double-click the tab icon to change its quadding mode.
2. Drag the icon to the desired position.

Note:

• The parameters Leader, Repeat every and the decimal tab quadding mode cannot be
modified in the tab bar.

• Tabs can be removed by dragging them outside the tab bar.

Zoom
To zoom in, zoom out or restore the original scale of the tab bar.

Tab list
The tab list contains the tabs in a text representation.

For example, a left aligned tab, with position 0 (zero), repeating every 36 points is represented by:

0 - Left - Rep. (36 pt)

A tab definition can be selected by clicking its representation in the tab list.

Add
To add a tab with the current settings.

Remove
To remove the currently selected tab. If nothing is selected, Remove is disabled.

Modify
To modify the currently selected tab: the tab will have the current settings. If nothing is selected or if
no changes have been made to the settings, Modify is disabled.

Quadding
Click one of the options to select the tab's quadding mode:

•

 Left aligned

•

 Centered

•

 Right aligned

•

 Decimal tab

When decimal mode is selected, the character on which the tab is to be aligned also needs to be
specified. Type it in the input box next to the buttons, or click the arrow and select it from the list (.
or ,).
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Position
To specify the position of the tab. Type a number in the input box. The default unit is mm. Other units
are cm, in, mil, pica or didot.

Repeat every
If you selected Repeat every, the tab will be repeated. The distance between the tabs can be specified
by typing a value in the input box next to the toggle button. The default value for this distance is the
position of the tab. The default unit is pt. Other units are mm, cm, in, mil, pica or didot.

Leader
The space inserted by a tab character is normally blank, but you can format the tab character with
leader characters. Leader characters are especially useful for tables of contents and other lists.

Apply Global
The general way to apply styles is to use the status bar. However, you can use Apply in the appropriate
style dialog boxes as well.

All text set in the named style is adapted. Apply Global is only available when working with named
styles.

Apply Global plug
When the plug is connected, the changes you make are immediately shown, when working with named
styles.

Apply Local
The text is adapted locally (in the selected part only). The named style and all text using this named
style are not changed.

Apply local plug
When the plug is connected, the changes you make are immediately shown.

Reset
Reset clears all values in the style dialog box.

8.8.11.  Hyphenation... (Text menu)

To define the hyphenation setup for a language.

You can add, move or remove hyphenation dictionaries. Hyphenation dictionaries are lists of
hyphenation rules for words. A word can be in more than one hyphenation dictionary. The first rule for
the word that is checked, will be used.

When you choose Hyphenation from the Text menu, the Hyphenation dialog box appears.
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Hyphenation dialog box

Languages
To specify the language for which you want to change the settings. Click the arrow and select one from
the list. If the language is set to Off, no editing can be done.

If you are in text edit mode, this field is automatically set to the language of the text at the cursor
position.

Exception files
Two input boxes control the hyphenation setup: an edit input box and a list box.

The edit input box:

• to specify the name of a hyphenation dictionary file
• to display the name of the selected file

The list box:

• to display the hyphenation setup for the current language
• to select a dictionary by clicking its name
• to change the ordering of the exception dictionaries by dragging the files to another position in the

list. Dicts are searched from top to bottom.

Add
To add a new hyphenation dictionary to the bottom of the list. If a file name is specified in the edit input
box and that dictionary is not yet in the list, this dictionary will be added, else a file selector dialog box
is shown.

Note:

To create a new empty exception dictionary, specify a new, non-existing file name in the edit
input box or in the file browser.

Remove
To remove a dictionary from the list.

1. Select a dictionary by clicking its name in the list box or type its name in the edit input box.
2. Click Remove.

Modify
To edit the contents of an exception dictionary.

1. Select a dictionary by clicking its name in the list box or type its name in the edit input box.
2. Click Modify.

A Hyphenation Exceptions dialog box is shown.

Set as Default
To make the current hyphenation setup the default one. When a new job is created, these defaults will
be used.
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Hyphenation Exception dialog box

To edit hyphenation exception dictionaries.

Exceptions
To specify a new hyphenation exception, or edit an existing one.

Format for hyphenation positions:

• Dash ( - ) : Normal position. For example sev-er-al
• Equal sign (=) : Preferred hyphen. For example in-ner=most
• Tilde (~ ) : Causes replacement of the character before the hyphen by the character after it. For

example wec~ ken will change to wek-ken
• Plus (+) : Doubles the character before the hyphen. For example shiff+ahrt changes to shiff-fahrt

Exceptions combo box
To display all hyphenation exceptions in the dictionary in alphabetical order. You can select an
exception by clicking it.

Add
To add the exception in the input box to the dictionary. If the exception is already in the dictionary,
or if it has an invalid format, a warning will appear. If this exception dictionary is used in the text, the
changes will immediately appear.

Modify
To modify an exception

1. Select an existing exception by clicking it in the combo box.

The exception appears in the Edit input box.
2. Edit the exception.
3. Click Modify.

If the exception dictionary is used in the text, the changes will immediately appear.

Remove
To remove an exception.

1. Select an existing exception by clicking it in the combo box or type the exception in the Edit input
box.

Note:

You don't have to type the hyphenation signs.

2. Click Remove.

If the exception dictionary is used in the text, the changes will immediately appear.

Save File
To save the changes to the original file.
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Save File As
To save the contents of the current hyphenation exceptions dictionary to another file.

8.8.12.  Fields... (Text menu)

To insert or modify page numbers, fractions and spaces in text.

When you choose Fields from the Text menu, the Fields dialog box appears.

Fields dialog box

Type
Type: Space

 

 

To insert or modify various types of spaces in text. You may change the width of the spaces or insert
an elastic space. Elastic space automatically changes according to the size of the text box, when you
modify the text box size (justification).

• Parameters: to enter the percentage of the EM-value in the Parameters input box.
• Variant EM: to insert or modify a space having the width of a percentage of an EM-box.
• Variant 1/1, 1/2, 1/4, 1/8 EM: to insert or modify a space having the width of the selected fraction of

an EM-value.
• Variant Digit: to insert or modify a space having the width of a digit.
• Variant Period: to insert or modify a space having the width of a period.
• Variant Fixed: to insert or modify a space having the specified width (in millimeters, inches, or

points).
• Variant Elastic: to insert an elastic space.
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• Variant Leader: a leader is created from 'elastic space' that automatically changes according to the
size of the text box, when you modify the text box size.

Note:

You may have to open the upper envelope in the Text Style bar (page 245) to change the
distance between the leaders.Refer to Character Style (page 248) for additional information
about entering the settings for the leader in the Character Style dialog box.

Tip:

If you want to insert more than 1 space, you can also use the shortcuts that are linked to the
different spaces.

Type: Fraction

To insert or modify fractional values in text.

• Parameters: to enter the fraction's numerator and denominator separated with a comma.

• Variant: to select the way the fraction will be displayed : Nut Or Diagonal.

Type: Name access

To load a character by name. For example, the copyright character.

Type: Page Number

To insert page numbers in text.

8.8.13.  Optimize Paragraph... (Text menu)

To optimize text placement in a paragraph or on a textline.

The format of a paragraph defining the text's size, leading, distortion, tracking, and space between
words will adjust automatically, depending on the set of criteria you select.

When you choose Optimize Paragraph from the Text menu, the Optimize Paragraph dialog box appears.

To optimize text placement:

1. Position the I-beam cursor in the paragraph or text line you want to modify.
2. Choose Optimize Paragraph from the Text menu.

The Optimize Paragraph dialog box displays.

The text character's original setting displays in the From and To readout boxes.
3. Activate the desired settings.
4. Click Apply to format the text.

The text character's new setting displays in the From and To readout boxes.

-OR-

Click Reset to return the text to its original settings

The text character's original setting displays in the From and To readout boxes.
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Optimize Paragraph dialog box

Reflow into
To enter the number of lines you want to create when the text is reformatted.

Filled
To force the text to make complete lines from left to right.

Size
To modify the point size of the text and enter the minimum and maximum limits by which the text may
be modified.

Leading
To modify the leading between lines of text and enter the minimum and maximum limits by which the
text may be modified.

Distortion
To modify the distortion of the text and enter the minimum and maximum limits by which the text may
be modified.

Tracking
To modify the tracking of the text and enter the minimum and maximum limits by which the text may be
modified.

Word Space
To modify the amount of spacing between words and enter the minimum and maximum limits by which
the text may be modified.

8.8.14.  Run Around... (Text menu)

To position text around or inside objects, or to wrap text around objects (including CT's, masks, and
other text boxes).
 

286



8PackEdge

 

When you choose Run Around from the Text menu, the Run Around dialog box appears.

To position text around or inside objects:

1. Create the object.
2. Create a text box and fill the text box with the appropriate text.
3. Position the text box as needed on the object (or vice versa).
4. Select the object in red.

Tip:

Refer to Select Objects.

5. Choose Run Around from the Text menu.

The Run Around dialog box displays.
6. Activate the desired settings.
7. Click Apply to format the text (if the apply Plug is not activated).

Run Around dialog box

None

To leave the text unaltered in the text box.

Run Inside

To fill the selected object with the text (as long as the object is not a CT, mask, or text box).

Run Outside

To position the text on the outside of the selected object.
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Guard
To specify the distance between the object and the text.

Transparency
To flow the text around the transparency boundary of a contone image, instead of around the contone
image itself.

Enter a value for transparency in the edit input box, or increase (or decrease) the value by clicking the
left or right arrow.

The default value is 0 (zero).

Apply plug
If the plug is connected the changes will immediately be applied to the selected objects. If the plug is
not connected, the changes will only be applied when Apply is clicked.

Apply
If the Apply plug is not connected and you click Apply, the changes you made in the dialog box will be
applied.

8.8.15.  Search... (Text menu)

To search text occurrences of a word with a certain style, and replace it by another word with another
style.

When you choose Search from the Text menu, the Search dialog box appears.

Search dialog box

Find
To specify the word to search for. Type in the word or click the arrow to select a previously typed word
from the list.

Match Case

If Match Case is enabled, the search is case sensitive.

Whole Words

If Whole Words is enabled, parts of the word are skipped.

Current Story Only

If Current Story Only is enabled, only the current story is searched, otherwise all stories are searched.
This option is enabled by default.

Search
To specify the direction of the search: Down, All or Up. Type the direction in the input box or click the
arrow and select a direction from the list. The default option is Down.
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Style envelope
To specify the style options for the search.

If Style is enabled, only text with the specified character style will be found.

The style can either be an existing named style or a custom style.

Named style

Enter the exact name of the style in the edit input box or click the arrow and select a name from the
list. <custom> is not really a named style, it is the current custom style. Select this to reuse the last
created custom style.

Custom style

To specify some attributes of the text, regardless of which named style it is in. For example search
for all occurrences of a word in bold and italic. Click Character Style to open a style editor for a style
based on the named style in the edit input box, and fill in the options. The style edit input box is set to
<custom>.

Find Next
To search for the next occurrence of the given word.

Replace
To change this dialog box into a Replace dialog box. All current settings are kept.

8.8.16.  Replace... (Text menu)

To specify the text and style with which the searched text is to be replaced.

When you choose Replace from the Text menu, the Search & Replace dialog box appears.

Search & Replace dialog box

Find
You find detailed information on the Find section of this dialog box in the Search dialog box.

Replace
To replace the selected text with the specified replacement.

To specify the replacement, type the word or click the arrow and select a previously typed word from
the list.

Match Case
Match Case makes the replacement have the same case as the original. If the original is:

• All uppercase, the replacement is also uppercase
• All lowercase, the replacement is also lowercase
• First character uppercase and second character lowercase, the first character of the replacement

is also uppercase and the rest lowercase
• None of the above, the replacement is like it was typed in the edit input box.
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Style envelope
To specify the style options for the replacement.

If Style is enabled, the replacement will have a style as specified by the style input box.

The style can either be an existing named style or a custom style.

Named style

The replacement will have the specified style. Enter the exact name of the style in the edit input box or
click the arrow and select a name from the list. <custom> is not really a named style, it is the current
custom style.

Custom style

The replacement's style will be a combination of the original's style and the custom style. The options
that are entered in the custom style overrule those of the original style. Click Character Style to open
a style editor for a style based on the named style in the edit input box, and fill in the options. The style
edit input box is set to <custom>.

Replace & Find
To replace the selected text and find another occurrence.

Replace All
To replace all occurrences of the text to be found by the replacement. The extent of this operation
depends on the settings for Search (Down, All or Up) and Current Story Only.

8.8.17.  Font Window... (Text menu)

To enter characters from an extended character list.
 

 

Choose Font Window from the Text menu.

The Font Window displays the:

• Font name e.g. 

• Font type e.g. 
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•

Font encoding e.g. 

• The extended character set for the currently selected font.

 To obtain additional information about the font.

Example:
 

 

Refer to the Text Style bar for information about changing the currently selected font.

To enter characters from the Font Window:

1. If necessary, change the order of the characters according to the language you are working in,
by choosing one of the possibilities from the Encoding combo box. If you choose PI-symbols, all
characters of the font are shown.

2. Scroll through the list of characters, or resize the Font Window to display the characters you want
to insert.

3. Click the appropriate characters in the Font Window.

The characters are inserted where the blinking I-beam is positioned.
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Note:

The I-beam cursor automatically displays as you create a text. If you are inserting text
characters into existing text, make sure Edit Text on the toolbar is activated, and click where
you want to insert the text. The blinking I-beam cursor displays to indicate where the text will
be inserted. You may also use the keyboard arrow keys to navigate through the text.

Tip:

To create accented text characters, insert the cursor to the right of the character you want to
modify, then select the appropriate character from the Font Window.

8.8.18.  Font Preferences... (Text menu)

To search for fonts and add them to the Font List, making it easier to find the fonts you need from a
large list.

When you choose Font Preferences from the Text menu, the Font Preferences dialog box appears.

Note:

All fonts that are used in a file are automatically loaded into the Font List when you load the file.

The Font List is used in the Text Style bar and in the Character Style dialog box.

Font Preferences dialog box

Font Name Contains
Purpose

To enter a text string for which to search.

Arrow right
Purpose

To Save the Font List as Default or to Remove Unused Fonts.

Click the arrow and the two possibilities will pop up.

• Save List as Default

The list of fonts available in the Text Style bar, is saved as default list.

• The font file currently selected in the text style bar is saved as default font.
• Reopening the application will per default load this list of fonts and will put the default font in the

text style bar i.s.o. the former default font Helvetica.

Note:

You will notice that the default list can be extended with the local and sibling fonts of the
current directory.

• Remove Unused Fonts
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To remove all fonts that are not being used in the current job from the Font List.

Note:

The fonts are removed from the list until you log back in, or load another file that contains
the fonts.

Font Filters
Purpose

To narrow down the search for fonts to the activated types of fonts.

Available filters are:

• Type:

To activate a Font Type as a selection criterion to determine the fonts to be included in the search.
• True

To activate a Font True as a selection criterion to determine the fonts to be included in the search.
• Design

To activate a Font Design as a selection criterion to determine the fonts to be included in the
search.

• Width

To activate a Font Width as a selection criterion to determine the fonts to be included in the search.
• Format

To activate a Font Format as a selection criterion to determine what fonts to be included in the
search.

Find
Purpose

To execute the font search.

Found
Purpose

To display the number of fonts that match the selection criteria you entered.

Add all
Purpose

To add all of the (found) fonts to the Font List.

Add
Purpose

Opens the Found Fonts dialog box.

To add the selected font in the Found Fonts dialog box to the font list.

Reset
Purpose
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To clear out the selection criteria for the font search.

Found Fonts dialog box

Purpose

Displays the list of (found) fonts.

 

 

The fonts are displayed in alphabetical order per type. If more fonts are available than can be displayed,
use the scrollbar to search through the list.

To add fonts to the Font List of the current file, click the fonts you want to add.

The fonts are added to the Font List and can be used to format text.

8.8.19.  Contourize (Text menu)

To contourize selected text and to convert into individual objects.

Choose Contourize from the Text menu.

Before you select Contourize, select the text to be contourized with Edit Text.

All text in the line of text, text box, or the text that has been created on the contour is contourized into
individual objects.

Each individual text character (or object) can have color applied, and may be modified and moved like
any object. For example, you may rotate the text character with Transform or divide the text character
using options from the Contours menu.
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Attention:

• If you are contourizing a single line of text, all text characters in the line are contourized,
even if some of the text is not selected.

• Make sure all formatting (with Edit Text) is completed before you contourize the text. When
text has been contourized the text becomes individual objects, not text characters. The
individual objects cannot be formatted in the way you format text characters (for example
applying styles).

8.8.20.  Countourize All Text (Text Menu)

To contourize all text and to convert into individual objects

8.8.21.  Make Background (Text menu)

To create a background for a text box.

Choose Make Background from the Text menu.

You can assign properties (such as color, stroke, and transparency), and the background becomes an
individual object that can be manipulated and modified.

To create a background for a text box:

1. Select in red the text box to which you want to add a background.

Tip:

Refer to Select Objects.

2. Choose Make Background from the Text menu.

The background is created as an object that can be manipulated and modified with the application's
options.

Tip:

You can assign new properties from the Color Style Bar to the selected background.

If you press the space bar, you are automatically switched back to the Edit Text mode. The
background is deactivated, and the text box is activated again.

8.8.22.  Text Knockout... (Text menu)

To make text (or any other object) more visible within a mask of a CT by adding a colored (normally
white) stroke to the text (or the object).

Text Knockout allows you to make text more visible within a mask of a CT. In reality, your text is
contourized and a colored stroke and fill is added to the contours of the text. Consequently, you have
different layers in your job of which one is a selected object and another one a contourized text with a
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fill and a stroke. This structure allows you to make corrections to one of the layers and to modify your
job structure.

When you choose Text Knockout in the Text menu, the Text Knockout dialog box appears.

Text Knockout dialog box

Selected text color buttons
Display automatically the color of the text to which you want to apply Text Knockout after selecting the
text in the job. If you have several texts with different colors to which you want to apply Text Knockout,
several colors will appear in the list of selected text color buttons. If you have a text to which you do
not want to apply Text Knockout, deselect the color of this text by clicking the corresponding toggle
button.

Knockout color
Displays the color you want to use to make the text more visible. Default, the Knockout color is white.
You can of course change this default color into another one. If you want to change the Knockout color,
double-click the color. When you double-click the color, the Color Factory appears. You can now select
a new color.

Distance
To enter the width of the colored stroke you want to add to the text to which you want to apply Text
Knockout.

Stroke Corner Type
To choose the type of corner you want to use for the stroke of the selected objects:

•
 Sharp corner

•
 Rounded corner

•
 Beveled corner (refer also to the Miter input box)

Miter

To enter a value in the Miter input box to determine how sharp the corner has to be angled to have a
bevelled corner.

Lift All Text
To lift all text, not just the text that has been knocked out.

Scan
This button looks for and selects all text in the current job to which you want to apply Text Knockout.
When you have already selected a text but if you see that the selected text is not exactly the text you
want to have (because of a typing error for example) we advise you to delete the contourized layer
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in the layer structure, to scan the text another time, to adjust the text and to perform Text Knockout
again.

Perform
To apply Text Knockout to the selected text (or any other object).

Optimize
It could take a while to proof your job when Text Knockout is applied. You should use 'Optimize' to speed
up this process.

8.9.  Paint Menu

8.9.1.  Inks... (Paint menu)

To add, modify or remove Inks and to display the current inks in your job with their properties.
 

 

1. Ink number

This number, which appears automatically in front of the Ink box when the ink is defined, identifies
the ink by its place in the inks table.

Tip:

If you want to change the order of the inks in the table, drag the number of the ink towards
the number where you want to insert it.

Ink swatch

Displays the ink.

When you define an ink by entering its name, the ink swatch automatically displays the defined ink.

When you create new inks, they are added immediately in the Color Palette of the Color/Style box as
a color swatch with 100% of that ink.

2.
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Allows you to add an ink. You can give the name or the number of the ink.

Allows you to remove an ink.
3. Ink Book: Lists to which ink book the ink belongs.

An ink can either be a process ink, or it can belong to one of the standard ink books (PANTONE,
Toyo, HKS, NCS...). Inks can also belong to custom-made designer books. Inks that do not belong to
any of the above mentioned ink books are labeled 'unregistered'.

4. Ruling: To define the screen ruling for the ink (to obtain the appropriate printing quality).

The default value is 120 lines per inch. For more specific information on screen ruling, we refer you
to the manual on Screens.

5. Angle: To define the screen angle for the ink (to avoid moiré patterns, especially when using
process inks). For more specific information on screen angles, we refer you to the manual on
Screens.

6. Dotshape: To define the dot shape for the ink.

Example: M for Monet, E for Elliptical...

For more specific information on dot shapes, we refer you to the manual on Screens.
7. The Inks Type: choose Normal, Opaque, Varnish or Technical from the dropdown list.
8. : Opens a new menu (see Extra Information on page 299):

• Show Options: displays / hides the options at the bottom of the Inks window.
• Columns: select the columns you want to see.
• Remove Unused Inks
• Remove Unused Colors and Inks
• Sort Light to Dark
• Sort Dark to Light
• Reverse Ink Order
• Convert...
• Change Dotshape and ruling of All Inks...

9. Default values when adding a new ink: define the default settings for ruling, angle and dotshape,
these settings will be used when new inks are added.

Tip:

When you create a new ink, it appears immediately in the Color Palette as a color swatch with
100% of that ink.

However, it is not necessary to complete the inks table before you can build the Color Palette:
the corresponding inks are also automatically included as you define colors in the Color
Factory.

298



8PackEdge

Note:

A warning icon  may appear next to an ink name to indicate inks that are not visible in the
document, but which are linked to an opacity mask. These inks are not cleaned up by the
functions "Remove unused Inks" or "Remove unused Colors and Inks".

You receive a warning when an ink is no longer available in the ink book or when it has been
removed from the ink book. This may occur when you have moved a file to another system and
the ink is not available on that system. In this case the ink is "unregistered". Still, the name of
the original ink book is retained while using and saving the document.

 

 

Extra Information

Entering ink names
When entering an ink name, the following rules are applied:

• Check if the name refers to a process ink. 'M' or 'magenta' will result in 'Process Magenta'. The same
logic is used for 'C', 'Y' and 'K' for the other process inks.

• Check whether the name refers to an ink from the "preferred ink book". You can select a Preferred
Ink Book from the list on the Status toolbar.

 

 

• Check whether the name refers to an ink from a PANTONE ink book. "Warm Red" will find the
ink "PANTONE Warm Red C" from the PANTONE Color Coated book, while "9524" will find the ink
"PANTONE 9524 C" from the PANTONE Pastel Coated book.

Note:

If you want to force the use of a specific PANTONE book, set it as the preferred ink book on
the Status toolbar. For example, set the PANTONE Color Uncoated book as the preferred ink
book. In that case the name "Warm Red" from the PANTONE Color Uncoated ink book will be
found.

• Check whether the name refers to an ink from the standard non-PANTONE ink books. The standard
non-PANTONE ink books are protected ink books like Toyo94, NCS, HKS, HP Indichrome etc.

• Check whether the name refers to an ink from the custom ink books.

Note:

Type the ink book and the ink name to find the ink in the given book.

When you type "coca red", this name is searced for in all ink books. When this ink does not exist,
look for ink "red" in ink book "coca".
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Renaming of Inks
• It is also possible to rename a standard ink in the Inks dialog box. The reasons for renaming inks in

the Inks dialog box may be multiple:

Perhaps, you would like to display the names of the inks in your own language instead of English.
A French user would rather like to use Jaune instead of Yellow. A German user, on the other hand,
would rather like to use Schwarz instead of Black.

By only renaming the inks, you create Inks apart from the normal BG CMS system. Each of these inks
has a name and an RGB value.

Attention:

Renaming of an ink results inreplacing the ink by an unregistred designer ink. For
unregistrerd designer inks only an RGB equivalent is known. All colorimetric profiling is
lost. This will result in less accurate visualisation on screen and proofing.Essentially, the
renaming of the inks does no more than displaying a new name in the list of Inks on your
screen. When proofing a file with the renamed ink, only the RGB value of the ink will be
retained. All output proofing differentiations and concepts will then be lost.

Note:

If you rename an ink, the new name of the ink will also be displayed in the Ink Factory and
the Style Palette.

Changing the Ink Book of Inks
You can change the ink book of some inks in the Inks dialog. You can switch between the different
PANTONE ink books (i.e. Coated, Uncoated or Matte). You can also change a custom ink from a custom
ink book to another ink book if the ink is available in both ink books. For example, you can change the
"red" ink from the "coca" ink book to the "limo" ink book, but only if the ink book "limo" also contains a
"red" ink.

Extra options
Remove Unused Inks

To remove automatically all unused inks (inks that are not used in the colors of the Color Palette).

Note:

To remove just one unused ink, you can drag an empty ink box to the ink box you want to
remove. If the ink is used in your job, a warning appears.

Remove Unused Colors and Inks

To remove automatically all colors and inks that are not used in the job.

Clean Up Colors and Inks not only removes the unused colors of the current job, but also the unused
inks of External Jobs and planemapped CT files that are part of that job.

Tip:

To remove just one unused ink, you can drag an empty ink box to the ink that you want to
remove. If the ink is used in your job, a warning appears.

Sort Light to Dark
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Allows you to sort the colors in the ink table.

Sort Dark to Light

Allows you to sort the colors in the ink table.

Reverse Ink Order

Use this option to view how your file would look like with its ink order reversed.

Convert...

Allows you to convert all PANTONE Color or Pastel inks in the ink table.

Depending on the selection, you can convert all Coated or Uncoated inks to Coated, Uncoated or Matte.

Show Ink Group and Type

Selecting this expands the Ink dialog box.

Additional information will be available:

• Group

To define if the ink type is Normal, Opaque, Varnish or Technical. Select the correct type from the
list box.

Normal inks are inks that are transparent, in contrast with opaque inks, which cover underlying
inks. Their different behavior is directly visible when the display window is in the overprint mode
and the inkbased mode.

When Proofing, the ink type is visible via the Esko FastRip.

The effect of varnish, on the contrary, does not show in the layout window.

• Type

Displays automatically the name of the ink group to which an ink belongs. It indicates if an ink is a
process ink (C, M, Y, K), a PANTONE ink or a designer ink.

Change Dotshape and ruling of All Inks...

Selecting 'Change Dotshape and ruling of All Inks...' opens a dialog box which allows you to define the
ruling and dotshape for all the inks.

Replace Ink
To replace an Ink:

1. Open the Replace Ink by dialog by selecting Replace Ink... in the fly-out menu in the Inksdialog.
 

301



8 PackEdge

 
2. In the Current Inks and Colors, select the Ink you want to replace.

Inks defined in an Ink book will have a droplet icon next to their name

The Details window will show extra information on the selected ink.
3. Define the Replace by type:

• Replace by A Document Ink allows to select an Ink from the document inks. By enabling Include
Unused Inks, all spot color inks will be available, even the inks that aren’t used in the job.

• Replace by CMYK Color allows to convert the selected ink into its CMYK equivalent. The CMYK
values that will be used are shown underneath.

Note:

When converting to CMYK:

• inks from the document will be replaced by CMYK

• Inks from linked CT files will be planemapped to CMYK paint

• inks from linked PDF files are NOT converted, as this is not supported.
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• Find Best Match will scan the selected Ink Book, and list the inks with the lowest dE compared

to the ink you want to replace. At the bottom, the New and the Current ink are shown side by
side.
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• Replace by Color from Ink Book allows to replace the ink by a new ink from an Ink book.
 

 
4. Click the Replace Ink button.

Note:

If one or more objects can’t be converted, a description of the problem will appear in the
Messages dialog, and the converted ink will not disappear from the document.

Printing Method
You can set the Printing Method for every separation.

This information is stored in Normalized PDF files, and when exporting (or importing) ArtPro files.

The Printing Method information can be used in SmartNames, or for Automation Engine task that
handle the printing method.

By default, the Printing Method column is hidden. By selecting the Printing Method column in the fly-
out menu you can make it visible.
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You can select one of the predefined printing methods, or create a new printing method.

Presets
As from version 12.1.2, when connected to an Automation Engine Server, the list of Printing Methods is
loaded from the Automation Engine server.

Note:  This implies that Printing Methods saved in earlier versions of PackEdge are no longer
visible and will need to be redefined.

Printing Methods can be saved in the Automation Engine Configure tool, or in PackEdge by selecting
Save to presets

 

 

If there's no connection to an Automation Engine, the presets are saved on a central place in the
bg_data_custom_v010 folder, and can be reused by all client applications.

8.9.2.  Open Ink Book... (Paint menu)

Opens the selected ink book.

Note:

Inks in standard ink books (PANTONE, Toyo, HKS, NCS...) or PantoneLIVE ink books cannot be
altered. In custom ink books you can rename or delete inks and you can create new inks based
on Lab or RGB values.
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The info icon provides extra information on the number of pages, rows and columns of the selected
ink book. Empty ink patches in the book are left open, which implies that the layout of the ink book
appears unaltered the Ink Books dialog box. You can remove empty ink patches by clicking Remove
Empty Patches from the flyout menu.

You first have to unlock the ink book before you can do certain modifications, like removing empty
ink patches or renaming inks. Creating a New Ink will automatically unlock/lock the ink book. You can
either specify the ink by entering Lab values or RGB values.

Enter a value in the Search box to search for a specific ink in the selected book.

New Ink... allows you to create a new ink by entering Lab or RGB values.
 

 

You can remove inks by selecting the ink patch and selecting Clean Ink from the context menu.
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Note:

You will have access to the Smart Colour ink books when the Smart Colour ink books are
imported via Kaleidoscope / Color Engine Pilot, and when the Smart Colour license is
activated.

8.9.3.  Manage Ink Books... (Paint menu)

Shows you an overview of all ink books that are installed on the system and allows you to create, delete
and view individual ink books.

 

 

The selected ink book is regarded as the preferred ink book and will be checked first when inks are
entered in the Inks dialog box. The name of the selected ink book appears in the top toolbar. Click the

toolbar icon  to open the ink book.

Click New... to create a new ink book on the CMS data tree. All you have to do is enter a name. The name
of an ink book can only consist of one word. The following characters are not allowed in the ink book
name and ink names: '$' '%' '.' '/' '\' '*' '[' ']' '@' '&' ' ' ':' '|' '#' '<' '>' '"' and ';'.

8.9.4.  Color Factory... (Paint menu)

To display or modify the selected color.
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Open the Color Factory by:

• Double-clicking a color swatch in the Color palette,

• Or activating Vignette in the Color palette.

• Ctrl + Right mouse click an ink swatch to get a pop up menu which allows you to add/remove CMYK
inks

You can display or modify the selected color in the Color Factory.

1.

Color Factory on page 308 
2.

Ink Factory on page 309 
3.

Registration Factory on page 309 
4. CMYK Picker on page 310
5. Block Colors on page 311
6. Blend Colors on page 312
7. LHC Picker on page 312
8. RGB Picker on page 313
9. Convert to... on page 314
10. Convert to CMYK Ink... on page 315
11. Add to Designer Ink Book on page 315

Color Factory
 

 

You can modify the percentages of inks with the slider or the spin boxes. You can add an ink by entering
the initial of the ink name in the input box, next to the ink value input box. This adds a new ink (if still
non-existing) to the Inks dialog box.

Tip:

Use CTRL +move ink slider from an ink to modify the density of all other inks with the same
amount. Use SHIFT+move ink slider to change the ink density of all other inks proportionally.
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Ink Factory
 

 

To display or modify the inks that will be used to print a color when a job is printed or processed.

Registration Factory
A PDF registration color is recognized and kept as PDF registration color when loading or saving a
(non-)normalized PDF file. You can create a registration color by selecting a new patch in the Colors
dialog box and clicking the Registration Factory button. The registration color consists of all colors
that are used on the current page. You can add additional inks to the ink list, but as long as they are
not used on that particular page, the registration color will not be updated with this information. The
registration color will be updated dynamically when adding or removing inks, switching to another
page…

You can move the slider to adjust the density of the registration color. You will notice that the sliders
cannot be moved separately.

Note:

InkWizard will skip registration colors. The Trapping engine will trap registration colors.

In the example below, only two inks have been used in the document. The resulting registration color
will be composed of 100% cyan and 100% yellow.
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In the example below, multiple inks have been used in the document. As technical inks are not taken
into account when creating the registration color, it will only be composed of the four process colors
that have been used in the design.

 

 
 

 

CMYK Picker
 

 

To switch to the CMYK Picker to add or modify colors in the Color Palette.
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You can modify the percentages of inks with the slider or the spin boxes.

When you activate the CMYK Picker in the Color Factory the CMYK Picker dialog box opens in the Color
Factory.

CMYK Picker dialog box
To add or modify colors in the Color Palette.

Hue Selection box

Defines the Spectrum.

The value in the hue selection box immediately influences the values in one of the two other boxes.

If you cannot find the desired color immediately, you can click a color close to the one you want, and
then use the CMYK sliders to help you in finding the color you are looking for.

Saturation Selection box

To make the color lighter or darker.

You can either use the saturation selection box or the brightness selection box. The two cannot be
combined.

If you cannot find the desired color immediately, you can click a color close to the one you want, and
then use the CMYK sliders to help you in finding the color you are looking for.

Brightness Selection box

To add black to the color.

You can either use the saturation selection box or the brightness selection box. The two cannot be
combined.

If you cannot find the desired color immediately, you can click a color close to the one you want, and
then use the CMYK sliders to help you in finding the color you are looking for.

Block Colors
 

 

To switch to the Block Colors Palette, to add or modify colors in the Color Palette.

When you click the Block Colors Palette  in the Color Factory... (Paint menu) on page 307 the
Block Colors dialog box opens in the Color Factory.

Block Colors dialog box
To add or modify colors in the Color Palette.

You can select individual colors from the Block Colors Palette, or you can create a blend between two
colors on the palette before you make a selection.
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Block Color swatches

You can drag and drop colors from one color swatch to another within the Block Colors Palette, and you
can drag and drop colors from the Color Palette to the Block Colors Palette, and vice versa.

Block Color Blend button

You can create a blend between two colors in the palette before you make a selection.

Blend Colors
 

 

To switch to the Blend Colors Palette, to add or modify colors in the Color Palette.

Blend Colors dialog box
To add or modify colors in the Color Palette.

Blend Color display box

The color in the Color display dialog box changes interactively when you click, hold and drag the cursor
over the Blend colors palette .

Blend Colors Blend button

You may create a blend between four colors to create a continuous tone change between the colors.

Click the Blend button to blend the 4 colors into each other. A new blend color palette is created. You
can select any color from the new blend color palette; the color in the color palette will be updated. At
the bottom of the Blend Color palette the percentages of the selected colors appear.

LHC Picker
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To switch to the LHC Picker to add or modify colors in the Color Palette or to execute an LHC color
measurement.

When you click the LHC Picker  in the Color Factory... (Paint menu) on page 307 the LHC Picker
dialog box opens in the Color Factory.

LHC Picker dialog box
To add or modify colors in the Color Palette or to execute an LHC color measurement.

You can enlarge the color swatch display for making a more accurate selection. The enlarged color
palette appears in the LHC (CIE) dialog box.

The enlarged color palette needs more calculation and memory from your system. The adjustment of
the palette according to your selection will take some time, but the selection is more accurate.

LHC color space box

The LHC colors are represented by a Hue selection box and hue, chroma, and lightness values. You
always have to convert a color selected with the LHC Picker to a PANTONE or CMYK equivalent before
you can add it to the Color Palette.

RGB Picker
 

 

To switch to the RGB Picker to add or modify colors in the Color Palette.

When you activate the RGB Picker in the Color Factory... (Paint menu) on page 307 the RGB Picker
dialog box opens in the Color Factory.

RGB Picker dialog box
To add or modify colors in the Color Palette.
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Hue Selection box

Defines the Spectrum.

The value in the hue selection box immediately influences the values in one of the two other boxes.

If you cannot find the desired color immediately, you can click a color close to the one you want, and
then use the CMYK sliders to help you in finding the color you are looking for.

Note:

You always have to convert a color selected with the RGB Picker to a PANTONE or CMYK
equivalent before you can add it to the Color Palette.

Saturation Selection box

To make the color lighter or darker.

You can either use the saturation selection box or the brightness selection box. The two cannot be
combined.

If you cannot find the desired color immediately, you can click a color close to the one you want, and
then use the CMYK sliders to help you in finding the color you are looking for.

Note:

You always have to convert a color selected with the RGB Picker to a PANTONE or CMYK
equivalent before you can add it to the Color Palette.

Brightness Selection box

To add black to the color.

You can either use the saturation selection box or the brightness selection box. The two cannot be
combined.

If you cannot find the desired color immediately, you can click a color close to the one you want, and
then use the CMYK sliders to help you in finding the color you are looking for.

Note:

You always have to convert a color selected with the RGB Picker to a PANTONE or CMYK
equivalent before you can add it to the Color Palette.

Convert to...
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To convert the selected color to its equivalent in the selected ink book.

The original CMYK color displays in the center of the Color Display dialog box, with its equivalent
surrounding it. The color closest to the CMYK original is highlighted to indicate selection. Select a
different color, if necessary.

Note:

You can use any of the color palettes (CMYK Picker, Block color palette, or Blend color palette).

Convert to CMYK Ink...
To convert the selected color to a CMYK ink.

Add to Designer Ink Book
To add (register) the current color in the “designer” ink book.

8.9.5.  Dashes... (Paint Menu)

To create or modify a dashed stroke.

 

 

If you want to create a dashed stroke, you must specify the length of the colored (dashes) and
uncolored elements (spaces) and the order in which they have to alternate.

You can apply dashing in 2 ways. In its basic form, you specify the length of the elements as absolute
values. In a more complex form, you let the system adapt the values you have specified to make sure
the dashes fit perfectly on the selected object.

When you choose Dashes from the Paint menu or when you double-click the dashes box in the Style/
Color box , the Dashes dialog box appears.
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Dashes dialog box

Basic sequence description

Number of elements

You have to specify the number of alternating elements that you want to use as the basic sequence.

You can fill in any number between 0 and 11, but the 2 most common values are 1 and 2. You fill in 1 if you
want to apply dashing with a colored and an uncolored element of the same length, and you fill in 2 if
you want dashing with 2 elements of a different length.

If you put in 0, you obtain a solid stroke.

Note:

If you use an odd number of elements the order of colored and uncolored elements is inverted
at each repetition of the basic sequence.

Colored element length 

To define the length of the colored element.

Uncolored element length 

When you have defined the number of different elements, a length input box becomes available for
each of them.

Note:

Next to the length of the dashing elements, the outlook of the dashing will also depend on the
active type of stroke caps (page 552).

Envelope
To define or to alter the layout of the stroke for best fit on the selected object.

The layout depends on the following aspects:

Starting phase 

This value determines whether the stroke will start with a dash, a part of a dash, a space or part of a
space. To calculate the result, you must substract the value from the length of the first element.

Ending phase 

This value determines whether the stroke will end with a dash, a part of a dash, a space or part of a
space. To calculate the result, you must add the value to the length of the last element. This input box
is only available when the Adapt Dashes toggle box is on.

Stretch to Ends

Activate this toggle box if you want the application to adapt the dashing for best fit on the selected
object. To do so, the system automatically recalculates some parameters.

Stretch to Nodes
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Activate this toggle box if you want the automatic adaptations to be calculated from node to node,
rather than between the starting and ending point of the selected object.

Adapt buttons

To determine how the automatic adaptations must be calculated.

 Tells the system it can both lengthen and shorten the dashing elements to obtain the best fit,
depending on whatever is nearest;

 Tells the system it can only shorten the dashing elements;

 Tells the system it can only lengthen the dashing elements.

 Tells the system the adjustments can be applied to both dashes and spaces;

 Tells the system it can apply the adjustments to the dashes only;

 Tells the system it can apply the adjustments to the spaces only.

Dashes preview

Gives you a real-time graphic representation of the dashing you have laid out.

A blue mark represents the starting phase and - if Adapt Dashes is on - also the ending phase. The grey
marks separate the basic sequences.

8.9.6.  Pattern... (Paint menu)

To create a pattern.

 

 

A pattern is a regular repetition of a shape with which you can fill an object.

When you choose Pattern from the Paint menu, the Pattern dialog box appears.

Pattern dialog box

Selected Pattern
In this field the pattern you selected or loaded appears.

Pattern types
Lines To create a pattern of lines.
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Crossing lines To create a pattern of crossing lines.

Squares To create a pattern of squares.

Checkerboard To create a checkerboard pattern.

Circles To create a pattern of circles.

Degrade
The Degrade button allows to convert a pattern into regular objects.

Pattern attributes
Use file pattern To select an existing LP or LC file you want to use for your pattern. When you click this
button, the Pattern dialog box in which you can select a File Name and Path appears.

Shape size To determine the size of the shapes in your pattern. This input box is not available when
working on a pattern based on a loaded LP or LC file.

Shape distance To determine the distance between the shapes of your pattern. This input box is not
available when working on a pattern based on a loaded LP or LC file.

Rotate pattern Enter an angle value in this numeric input box to determine the rotation of the pattern.
This input box is not available when working on a pattern based on a loaded LP or LC file.

Scale pattern To scale the basic cell of the pattern. The default value is 1.

Note:

When you have a pattern based on an existing LP or LC file, it is not possible to change the size
of the shapes and the distance between the different shapes, nor to rotate the pattern. Scaling
the pattern is possible.

Position bounding box To determine the reference point of your pattern.

Blue/red square If you click the blue square, the pattern will be calculated relative to the borders. If
you click the red square, the pattern will be calculated relative to the bounding box of the object.

V offset To change the vertical reference point.

H offset To change the horizontal reference point.

Note:

When you need different types of patterns in your job, you can store up to 15 of them in the
Pattern Palette of the Style/Color box by dragging each pattern that you have defined into a box
of the palette.
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Note:

When you transform an object with a pattern, and the Transform Pattern option is on, the
values in the Pattern dialog (distance, scale, rotation) will be adjusted according to the
transformation. If the same pattern is used in different objects, the transformed pattern will
be added in a differen pattern box of the palette. This ensures that the pattern in the other
occurence remains unchanged.

8.9.7.  Screening... (Paint Menu)

The Screening window allows you to change the screening of the selected object.

 

 

You can change the angle, LPI and dotshape by clicking the edit fields and entering a value within
parameters. The Inks window updates automatically.

8.9.8.  Job Ink Mapping... (Paint menu)

To map inks in the job.

 

 

The Job Ink Mapping dialog box displays the current inks of the job. These are not only the inks of the
job objects, but also the inks of the external jobs, for example externally placed Esko native files or CT
files.
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Note:

After you have applied Job Ink Mapping, the inks that are not used anymore in your job are
cleaned up automatically.

Examples of technical printing problems where Job Ink Mapping brings a solution:

• You have a file where the 4 process inks have a screen ruling of 120 lpi. After placing a PostScript
file, you notice that the DTP operator has defined the 4 process inks with a screen ruling of 150 lpi.
The result is that you have 2 x 4 process inks. With Job Ink Mapping, you can easily map the screen
ruling of 150 lpi to 120 lpi.

• You have a file where the 4 process inks have a screen ruling of 120 lpi. You place a file externally (for
example a GRS file), with screen rulings of 150 lpi. With Job Ink Mapping, you can map all the inks of
the external file to 120 lpi, without changing the inks of the externally placed file.

Attention:

Please be careful with Job Ink Mapping, since it can change your inks drastically.

Attention:

In case some objects in the document have a non-white-preserving blend mode (blend mode
Difference, Exclusion, Hue, Saturation, Color or Luminosity), all process inks C, M, Y and K are
created in the ink list from the Inks dialog box due to the nature of these blend modes. The Job
Ink Mapping dialog box does not offer the possibility to remove or map these inks to other inks.

When you choose Job Ink Mapping from the Paint menu, the Job Ink Mapping dialog box appears. This
is an overview.

Icon/name Explanation

Ink Map rows To map the original ink in the left column to the destination ink in the right
column.

Name input box Instead of dragging an ink to an ink box in the right column, you can also fill out
the name of an ink in the name input box

OK To apply the settings that you entered in the Job Ink Mapping dialog box.

When you click OK, the ink mapping is executed and the Job Ink Mapping dialog
box closes.

Cancel To close the Job Ink Mapping dialog box without executing any Ink Mapping.

Apply Allows you to apply the changes, but it does not close the Job Ink Mapping dialog
box.

 

 

This toggle adapts the size of the dialog box to the size of your list. Click once to
activate the toggle, click again to resize the dialog box to the default size.

  Allows you to reset.
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Icon/name Explanation

 

8.9.9.  Ink Coverage... (Paint menu)

To estimate the needed ink coverage for the job.

Ink Coverage dialog box
 

 

Scan: Allows you to determine the area the scan has to cover.

• All inside Trim Box (Borders): The scan has to cover the area within the borders.
• All inside Media Box (Margins): The scan has to cover the area within the margins.

Determine the accuracy of the scan.

• Fast : The calculation is faster but the estimation only gives you a rough indication of the ink
coverage.

• Accurate: The calculation can take a while but you get an accurate estimation.

Merge Similar Inks: the Ink coverage tool merges the results for inks that are the same but have
different ruling and/or dotshape.

Only selected objects scans only in selected objects.

Select which Page should be taken into account; the current one, or all pages in the document.

Click Calculate Again to re-calculate the ink coverage in case the design has been changed or in case
you changed the accuracy of the scan.
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 This toggle adapts the size of the dialog box to the size of your list. Click once to activate the
toggle, click again to resize the dialog box to the default size.

 Informs you about the number of inks in your job or it displays the message 'Database has
changed'. Click Calculate Again to get a new estimation after the changes.

Note:

If the message 'Database has changed' is displayed, you will notice that the 'Save To File' button
can be unavailable and/or the separations are dimmed as well. It means that either the design
and/or the number of inks has changed.

Save To File... allows you to save the results of the calculation to a Text Report, a CSV Report or an
XML Report which can be printed or edited. The dialog box allows to select a destination directory,
to specify a file name and the type of file. Text and CSV reports can be opened in any text editor (e.g.
Wordpad, Notepad...). A CSV file can be opened in a spreadsheet program.

The list
The other part of the Ink Coverage dialog box consists of a list.

In the list each separation is represented by its name and by a color swatch.

Next to each separation the needed ink amount is shown. Clicking these values, will display the ink
coverage in cm2, mm2 or inch2. The percentage value informs you about the covered area within the
borders.

Note:

If no inks are displayed, click Calculate Again first.

8.9.10.  Create Ink Histogram... (Paint menu)

To create an ink key histogram in the document to visualize the ink key settings on the press.

By selecting Create Ink Histogram you can calculate the ink key histogram from the current document
and add it as a database object in the document.

The ink key histogram is an important factor in setting up the press. It allows you to regulate the ink
consumption in each printing zone before printing. This will significantly reduce the press setup time.
It is also useful to help you to decide whether or not to modify the layout of your designs on to plate or
to have a more homogeneous distribution of the ink consumption along the plate.

This ink key histogram is a database object and will be saved in the file. Position, orientation, number of
ink keys and scan borders/margins can be defined.

You can adjust the ink consumption by manually creating ink eater areas in Plato, based on the ink key
histogram. Use the Fill Ink Eater Area tool in Plato to automically adjust the ink distribution.
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Create Ink Histogram dialog box
 

 

Scan: Determine the area the scan has to cover.

• All inside Trim box will take into account all information within the trim box.

• All inside Media Box will take into account the information inside the media box.

Merge Similar Inks: the Ink Histogram tool merges the results for inks that are the same but have
different ruling and/or dotshape.

Position: specify the position of the ink histogram with respect to the trim box. To do so, select the Ink
Histogram object and click on the Position control to align the Ink Histogram on the top, bottom, left or
right side of the document. The Ink Histogram object in your document will be updated automatically.

Tip:

When the Ink Histogram is aligned on the top or bottom, the ink histogram zones are calculated
in vertical zones of the document. In case the Ink Histogram is aligned on the right or left size
of the document, the histogram is calculated in horizontal zones.

Orientation: specify the orientation of the ink histogram bars in the ink histogram object.

Histogram Height: specify the height of the ink histogram object in the document.

Ink Key Width: specify the width of a single ink key bar in the histogram. The Ink Key Width is normally
set to the same width as the width of a single ink key zone on the press.
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Number of Ink Keys: specify the number of ink histogram bars or ink key zones on the press.

Attention:

The ink key histogram will not be updated automatically when the Ink Histogram Object is
moved, or when the document is changed or saved. You have to select the Ink Histogram
Object and click on the Update button to update the Ink Histogram.

8.9.11.  Fill Ink Eater Areas... (Paint menu)

Fill Ink Eater Areas is an ink eater adjustment tool that allows you to compensate the ink key histogram
for all separations based on the visualization of the ink key histogram.

The ink consumption on the press is determined by the design of the plate: the design of the plate
dictates which ink percentages are used where. Ink consumption is regulated by ink keys on the press.
Every ink key determines the flow of ink to a specific zone on the press. The goal of the Ink Eater Areas
feature is to achieve a constant ink consumption over the width of the plate. This makes it easier for
press operators to set the ink keys, and results in a faster setup time for the press.

Avoiding "peaks" and "lows" in the ink key histogram also avoids an excess of ink building up on the
press cylinders, which might otherwise spill onto non-printed zones. Adding and filling Ink Eater Areas
to your plate flattens the ink key histogram by filling non-printed zones with a vignette (gradient). A
gradient is used to avoid hard edges in the compensation object, and extra options are available to set
a minimum ink density, minimum ink key value and to indicate when the maximum total area coverage
(TAC) is too high.

Note:

Total ink consumption on the press will be higher when using ink eaters.

Note:

In PackEdge, you have to create Ink Eater Areas manually with contour objects. The Create Ink
Eater Area tool in Plato can automatically determine suitable areas for use as ink eater areas.

Fill Ink Eater Areas wizard
1. Select a contour object or a group of contour objects in the document that can be used for the

compensation. Note that a group of contour objects are linked to one object when using the Fill Ink
Eater Area tool.

2. Choose Fill Ink Eater Areas from the Paint menu to start the wizard.
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3. Select the approprate options:

• Scan: Determine the area the scan has to cover. "All inside Trim box" will take into account all
information within the trim box. "All inside Media Box" will take into account the information
inside the media box.

• Direction: indicate the direction for the compensation. Horizontal means the ink zones are
vertical on the plate and the ink histogram is on the horizontal base of the document. The
direction of the compensation gradient in the ink eater area is horizontal.

• Resolution: indicate the number of intermediate steps of the gradient to be used as
compensation. Use ‘Very Low’ for 5 steps, ‘Low’ for 15 steps, ‘Medium’ for 30 steps, ‘High’ for 45
steps and ‘Very High’ for 60 steps. The compensation is more local when using fewer steps.

• Merge Similar Inks: the Ink Histogram merges the results for inks that are the same but have
different ruling and/or dotshape.

4. Click Next.
 

 
5. In Step 2, define the compensation parameters:

• Preset: indicate the intensity of the compensation gradient.
• Minimum Ink Density: set the minimum ink density of the ink separation in the ink eater area.
• Minimum Inkkey Value: indicate the minimum ink key histogram value for each ink key zone. The

ink density of the gradient is adjusted to make sure the ink key histogram value is higher than
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this settings. Keep in mind that it is not possible to have this minimum inkkey value for all ink key
zones when the ink eater area is not large enough.

• Details: click to open the Compensation Details dialog. Modifying the Preset, Minimum Ink
Density and Miminum Inkkey Value settings in Step 2 of the Fill Ink Eater Areas wizard will adjust
these settings for all separations. Use the Compensation Details dialog to adjust the individual
separations.

6. Click OK to fill the ink eater area.

The Compensation Presets in detail

• Choose the Preset "Small" when you want a light compensation to softly smoothen the Ink key
historgram in a local zone.
 

 

The dark magenta area in the compensation graph is the current ink histogram of the
(uncompensated) document. The white area in the graph is the area that can be used for the
compensation as defined by the ink eater area(s). Light magenta areas have been compensated by
the ink eater.

• Choose the Preset “Medium” to fill the compensation area with a gradient, resulting in a smooth ink
histogram.
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The light magenta area indicates the zones that have been compensated. The ink eater area would
look as follows:

 

 
• Choose the Preset “Very Large” to fill the ink eater area with with a gradient to egalize the ink

histogram as much as possible. It is clear that doing this will use more ink.
 

 

As you can see, the compensation is quite strong in this example. The ink eater area is filled with an
ink-heavy gradient.
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Compensation Details dialog
Use the Compensation Details dialog to adjust how the ink eater area is filled for individual separations.

 

 

Tip:

Turn on the Preview option.

To fine-tune the gradient in the ink eater area, do one or more of the following:

• Click a separation in the Separations list to view the ink histogram and compensation room for that
separation.

• Select a Compensation Preset to apply one of the standard compensation algorithms to the ink
histogram.

• Set the minimum ink density and/or ink key values for every separation.
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• Drag the handles on a bar in the ink histogram to manually tweak the ink key value. The white bars
in the histogram show the allowed compensation room for every bar. You cannot drag a bar higher
than the white area, or below the original uncompensated artwork value.

• Enable the option Maximum TAC and enter a maximum total area coverage (for example, 270%) to
display warnings in those areas of the histogram where the total ink coverage exceeds your limits.
The offending bars in the histogram will be highlighted with a blinking effect.

Tip:

You can select multiple separations to apply the same compensation to multiple separations
simultaneously.

 

 

Tip:

Select multiple separations to apply the same compensation to different separations.
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8.10.  Production Menu

8.10.1.  Bar Code

What is a barcode ?
A barcode is a machine-readable representation of information in a visual format on a surface.
Barcodes can be read by optical scanners, allowing quick and easy identification of all kind of goods.

Originally barcodes stored data in the widths and spacings of printed parallel lines, but today they also
come in patterns of dots, concentric circles, and hidden in images.

The information contained in a barcode varies from numbers to complete ASCII texts. The drive to
encode ever more information in combination with the space requirements of simple barcodes led to
the development of matrix barcodes or 2D barcode, which do not consist of bars but rather a grid of
square cells.

Barcodes are just the visible part of often quite large systems frequently referred to as automated
identification systems. These systems are increasingly proving to be some of the most cost-effective
management tools, since they enable organizations to keep track of their goods and stocks in all kinds
of situations in a fast, accurate and ecient way.

With the Dynamic Barcodes plug-in, you can add a dynamic barcode to your document without leaving
your application. Dynamic means that your barcode settings can be changed later on, even after you
saved, closed and reopened your document.

Dynamic Barcodes Basics

Creating a Barcode

1. Open your CMYK document and go to Production > Bar Code...

This opens the Bar Code dialog:
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2. Define the color of the barcode: in the Colors palette, define a single-color fill style and no stroke.

Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),
• not too light (or the barcode might be dicult to scan).

3. In the Bar Code dialog, select your barcode Type.
4. Choose the Orientation of your barcode using one of the buttons or by entering an angle.
5. Enter the barcode's data in the Code field. For most barcodes, you can choose to also show this

data as a number.

Attention:  Make sure the barcode data you enter is valid for the barcode type you chose. If
it isn't, a warning / error will pop up.

Note:  If you enter a wrong check digit, Bar Code can fix it automatically for you.

6. You can then fill in extra parameters (specific to the barcode type you chose). See Barcode Types on
page 344.

7. Click the Create button.
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Editing a Barcode
With Bar Code, you can also edit existing barcodes.

1. Open the Bar Code dialog.
2. Select the barcode to edit in your document.
3. Change its parameters as you wish in the Dynamic BarcodesBar Code dialog.
4. Click the Apply button to apply your changes to the barcode.

Applying Automation Engine Job Parameters

•

To apply the barcode parameters stored in your Automation Engine job setup, click the  button
at the bottom of the Bar Code dialog.

Expand
By using the Expand function, you can replace a barcode by regular objects (rectangles, text, …) in a
group, without any barcode information.

Note:  Adobe Illustrator also contains an "Expand" function. However, since this does not
remove the barcode metadata, the barcode remains editable.

1. Select the barcode you want to expand
2. From the fly-out menu of the Dynamic Barcodes panel, select Expand

Note:  Barcodes used by Dynamic Marks and Dynamic VDP can't be expanded.

Barcode Recognition
Barcode Recognition is a new function in Dynamic Barcodes to convert vectorized (contourized)
barcodes and images (e.g. a scanned in barcode) back into live editable barcodes.

1. Choose Window > Esko > Dynamic Barcodes to open the Dynamic Barcodes palette.
 

 
2. Select the objects (lineart or image) that you want to convert.
3. Click the Extract button.

Dynamic Barcode will analyse the selected objects, and when possible a Dynamic Barcode is
generated replacing the selection.
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a) Click and hold Hold to View Original to hide the converted barcode and see the original lineart or
image.

b) Change any of the barcode parameters and click Apply to modify the generated barcode.
c) Enable Compare View to show the newly generated barcode semi transparent on top of the

original objects. This allows you to easily change position and parameters of the new barcode to
match the original.

4. When you're happy with the result, click the Finish button.

This will remove the original objects from the document and close the Barcode Recognition
session, leaving you with a barcode object that you can edit as needed.

Note:  You can not do any other barcode recognition as long as the previous session wasn't
ended, either by clicking the Finish or the Cancel button.

Supported Barcode Types and known limitations

The barcodes that are currently supported for Barcode Recognition are these:

• Aztec
• CODABAR
• Code-128
• Code-128 (long)
• Code-39
• DATAMATRIX
• EAN-13 (including add-ons)
• EAN 13 Swissmedic
• EAN-8
• GS1-128
• GS1 DataMatrix
• GS1-QR
• HIBC-128
• HIBC-39
• Int. 2 of 5
• ITF-14
• ITF-16
• NDC-HRI
• PZN
• PZN8
• QR
• UPC-A (including add-ons)
• UPC-E (including add-ons)
• UPC-SCS

The barcode parameters that are currently recognized (when possible) are these:

• Barcode type
• Code
• Add-on presence
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• Color (only when recognizing line art objects)
• HRI presence (only when recognizing line art objects)
• Height (only when recognizing line art objects)
• Rotation
• Magnification
• BWR (only when recognizing line art objects)
• Characters per unit
• Ratio

Other limitations:

• White Box, Light margin indicators, H gauges for ITF barcodes and HRI text parameters are not
recognized.

• Device Compensation and Bar Width Reduction are both combined in the Bar Width Reduction
• An Int. 2 of 5 needs to have at least 6 digits.
• UPC-SCS with add-on is not recognized.
• If the original is an image, rotation is deduced from the rotation of the image. If the barcode inside

the image is rotated over an angle other than a multiple of 90º, the recognizing will not work.
• Pre-defined barcode sizes for PZN barcodes may not always be recognized.

Barcode Types and Parameters

Supported Barcode Types

General Purpose Barcodes

1D 2D

• Code 39

• Code 39 Extended

• Code 93 on page 352

• 2 of 5

• Interleaved 2 of 5

• Codabar

• Code 128

• Code 128 (long)

• Klebrand on page 371

• MSI

• Plessey

• DataMatrix

• QR

• MicroQR
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1D 2D

• SICK Code on page 384

Retail Barcodes

1D 2D

• EAN 13

• EAN 13 Swissmedic

• EAN 8

• UPC-A

• UPC-E

• GS1 DataBar Omnidirectional

• GS1 DataBar Truncated

• GS1 DataBar Stacked

• GS1 DataBar Stacked Omnidirectional

• GS1 DataBar Limited

• GS1 DataBar Expanded

• GS1 DataBar Expanded Stacked

• GS1 128

• GS1 U.S. Coupon Interim

• M+S 7

• Marks & Spencer

• Sick

• GS1 DataMatrix

Pharmaceutical, Healthcare and Cosmetic Barcodes

1D

• Bobst on page 346

• NDC / HRI

• EAN 13 Swissmedic
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1D

• Kurandt on page 372

• Laetus Pharma Code

• CLF-8

• HIBC 39

• HIBC 128

• Paraf Italy

• PZN

• PZN8

Shipment Container Barcodes

1D

• ITF-14

• ITF-16

• UPC-SCS

Publishing Barcode

1D

• ISBN

Identity Document Barcode

2D

• PDF417

• MicroPDF417

GS1 Application Identifiers

These are the GS1 Application Identifiers available in Dynamic Barcodes:

AI Data Content Format *1 FNC1 Required
*5

00 Serial Shipping Container Code (SSCC) N2+N18

01 Global Trade Item Number (GTIN) N2+N14
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02 GTIN of Contained Trade Items N2+N14

10 Batch or Lot Number N2+X..20 (FNC1)

11 *2 Production Date (YYMMDD) N2+N6

12 *2 Due Date (YYMMDD) N2+N6

13 *2 Packaging Date (YYMMDD) N2+N6

15 *2 Best Before Date (YYMMDD) N2+N6

16 *2 Sell By Date (YYMMDD) N2+N6

17 *2 Expiration Date (YYMMDD) N2+N6

20 Internal product variant N2+N2

21 Serial Number N2+X..20 (FNC1)

22 Consumer product variant N2+X..20 (FNC1)

235 Third Party Controlled, Serialised Extension
of GTIN (TPX)

N3+X..28 (FNC1)

240 Additional Item Identification N3+X..30 (FNC1)

241 Customer Part Number N3+X..30 (FNC1)

242 Made-to-Order Variation Number N3+N..6 (FNC1)

243 Packaging Component Number N3+X..20 (FNC1)

250 Secondary Serial Number N3+X..30 (FNC1)

251 Reference to Source Entity N3+X..30 (FNC1)

253 Global Document Type Identifier (GDTI) N3+N13+X..17 (FNC1)

254 GLN Extension Component N3+X..20 (FNC1)

255 Global Coupon Number (GCN) N3+N13+N..12 (FNC1)

30 Variable Count of Items (Variable Measure
Trade Item)

N2+N..8 (FNC1)

310n *3 Net weight, kilograms (Variable Measure
Trade Item)

N4+N6

311n *3 Length or first dimension, metres (Variable
Measure Trade Item)

N4+N6

312n *3 Width, diameter, or second dimension,
metres (Variable Measure Trade Item)

N4+N6

313n *3 Depth, thickness, height, or third dimension,
metres (Variable Measure Trade Item)

N4+N6

314n *3 Area, square metres (Variable Measure Trade
Item)

N4+N6

315n *3 Net volume, litres (Variable Measure Trade
Item)

N4+N6
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316n *3 Net volume, cubic metres (Variable Measure
Trade Item)

N4+N6

320n *3 Net weight, pounds (Variable Measure Trade
Item)

N4+N6

321n *3 Length or first dimension, inches (Variable
Measure Trade Item)

N4+N6

322n *3 Length or first dimension, feet (Variable
Measure Trade Item)

N4+N6

323n *3 Length or first dimension, yards (Variable
Measure Trade Item)

N4+N6

324n *3 Width, diameter, or second dimension, inches
(Variable Measure Trade Item)

N4+N6

325n *3 Width, diameter, or second dimension, feet
(Variable Measure Trade Item)

N4+N6

326n *3 Width, diameter, or second dimension, yards
(Variable Measure Trade Item)

N4+N6

327n *3 Depth, thickness, height, or third dimension,
inches (Variable Measure Trade Item)

N4+N6

328n *3 Depth, thickness, height, or third dimension,
feet (Variable Measure Trade Item)

N4+N6

329n *3 Depth, thickness, height, or third dimension,
yards (Variable Measure Trade Item)

N4+N6

330n *3 Logistic weight, kilograms N4+N6

331n *3 Length or first dimension, metres N4+N6

332n *3 Width, diameter, or second dimension,
metres

N4+N6

333n *3 Depth, thickness, height, or third dimension,
metres

N4+N6

334n *3 Area, square metres N4+N6

335n *3 Logistic volume, litres N4+N6

336n *3 Logistic volume, cubic metres N4+N6

337n *3 Kilograms per square metre N4+N6

340n *3 Logistic weight, pounds N4+N6

341n *3 Length or first dimension, inches N4+N6

342n *3 Length or first dimension, feet N4+N6

343n *3 Length or first dimension, yards N4+N6

344n *3 Width, diameter, or second dimension, inches N4+N6

345n *3 Width, diameter, or second dimension, feet N4+N6

338



8PackEdge

346n *3 Width, diameter, or second dimension, yard N4+N6

347n *3 Depth, thickness, height, or third dimension,
inches

N4+N6

348n *3 Depth, thickness, height, or third dimension,
feet

N4+N6

349n *3 Depth, thickness, height, or third dimension,
yards

N4+N6

350n *3 Area, square inches (Variable Measure Trade
Item)

N4+N6

351n *3 Area, square feet (Variable Measure Trade
Item)

N4+N6

352n *3 Area, square yards (Variable Measure Trade
Item)

N4+N6

353n *3 Area, square inches N4+N6

354n *3 Area, square feet N4+N6

355n *3 Area, square yards N4+N6

356n *3 Net weight, troy ounces (Variable Measure
Trade Item)

N4+N6

357n *3 Net weight (or volume), ounces (Variable
Measure Trade Item)

N4+N6

360n *3 Net volume, quarts (Variable Measure Trade
Item)

N4+N6

361n *3 Net volume, gallons U.S. (Variable Measure
Trade Item)

N4+N6

362n *3 Logistic volume, quarts N4+N6

363n *3 Logistic volume, gallons U.S. N4+N6

364n *3 Net volume, cubic inches (Variable Measure
Trade Item)

N4+N6

365n *3 Net volume, cubic feet (Variable Measure
Trade Item)

N4+N6

366n *3 Net volume, cubic yards (Variable Measure
Trade Item)

N4+N6

367n *3 Logistic volume, cubic inches N4+N6

368n *3 Logistic volume, cubic feet N4+N6

369n *3 Logistic volume, cubic yards N4+N6

37 Count of Trade Items N2+N..8 (FNC1)

390n *3 Applicable Amount Payable or Coupon Value,
local currency

N4+N..15 (FNC1)
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391n *3 Applicable Amount Payable with ISO Currency
Code

N4+N3+N..15 (FNC1)

392n *3 Applicable Amount Payable, single monetary
area (Variable Measure Trade Item)

N4+N..15 (FNC1)

393n *3 Applicable Amount Payable with ISO Currency
Code (Variable Measure Trade Item)

N4+N3+N..15 (FNC1)

394n *3 Percentage discount of a coupon N4+N4 (FNC1)

395n *3 Amount payable per unit of measure single
monetary area (variable measure trade item)

N4+N6 (FNC1)

400 Customer's Purchase Order Number N3+X..30 (FNC1)

401 Global Identification Number for
Consignment (GINC)

N3+X..30 (FNC1)

402 Global Shipment Identification Number (GSIN) N3+N17 (FNC1)

403 Routing Code N3+X..30 (FNC1)

410 Ship to - Deliver to Global Location Number N3+N13

411 Bill to - Invoice to Global Location Number N3+N13

412 Purchased from Global Location Number N3+N13

413 Ship for - Deliver for - Forward to Global
Location Number

N3+N13

414 Identification of a Physical Location - Global
Location Number

N3+N13

415 Global Location Number of the Invoicing
Party

N3+N13

416 GLN of the production or service location N3+N13

417 Party GLN N3+N13

420 Ship to - Deliver to Postal Code Within a
Single Postal Authority

N3+X..20 (FNC1)

421 Ship to - Deliver to Postal Code with ISO
Country Code

N3+N3+X..9 (FNC1)

422 Country of Origin of a Trade Item N3+N3 (FNC1)

423 Country of Initial Processing N3+N3+N..12 (FNC1)

424 Country of Processing N3+N3 (FNC1)

425 Country of Disassembly N3+N3+N..12 (FNC1)

426 Country Covering full Process Chain N3+N3 (FNC1)

427 Country Subdivision of Origin N3+X..3 (FNC1)

4300 Ship-to / Deliver-to company name N4+X..35 (FNC1)

4301 Ship-to / Deliver-to contact N4+X..35 (FNC1)
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4302 Ship-to / Deliver-to address line 1 N4+X..70 (FNC1)

4303 Ship-to / Deliver-to address line 2 N4+X..70 (FNC1)

4304 Ship-to / Deliver-to suburb N4+X..70 (FNC1)

4305 Ship-to / Deliver-to locality N4+X..70 (FNC1)

4306 Ship-to / Deliver-to region N4+X..70 (FNC1)

4307 Ship-to / Deliver-to country code N4+X2 (FNC1)

4308 Ship-to / Deliver-to telephone number N4+X..30 (FNC1)

4309 Ship-to / Deliver-to GEO location N4+N20 (FNC1)

4310 Return-to company name N4+X..35 (FNC1)

4311 Return-to contact N4+X..35 (FNC1)

4312 Return-to address line 1 N4+X..70 (FNC1)

4313 Return-to address line 2 N4+X..70 (FNC1)

4314 Return-to suburb N4+X..70 (FNC1)

4315 Return-to locality N4+X..70 (FNC1)

4316 Return-to region N4+X..70 (FNC1)

4317 Return-to country code N4+X2 (FNC1)

4318 Return-to postal code N4+X..20 (FNC1)

4319 Return-to telephone number N4+X..30 (FNC1)

4320 Service code description N4+X..35 (FNC1)

4321 Dangerous goods flag N4+N1 (FNC1)

4322 Authority to leave N4+N1 (FNC1)

4323 Signature required flag N4+N1 (FNC1)

4324 Not before delivery date time N4+N10 (FNC1)

4325 Not after delivery date time N4+N10 (FNC1)

4326 Release date N4+N6 (FNC1)

7001 NATO Stock Number (NSN) N4+N13 (FNC1)

7002 UN/ECE Meat Carcasses and Cuts
Classification

N4+X..30 (FNC1)

7003 Expiration Date and Time N4+N10 (FNC1)

7004 Active Potency N4+N..4 (FNC1)

7005 Catch Area N4+X..12 (FNC1)

7006 First Freeze Date N4+N6

7007 Harvest Date N4+N6..12 (FNC1)

7008 Species for Fishery Purposes N4+X..3 (FNC1)
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7009 Fishing Gear Type N4+N..10 (FNC1)

7010 Production Method N4+X..2 (FNC1)

7011 *6 Test by date N4-N6+N..4 (FNC1)

7020 Refurbishment lot ID N4+X..20 (FNC1)

7021 Functional status N4+X..20 (FNC1)

7022 Revision status N4+X..20 (FNC1)

7023 Global Individual Asset Identifier (GIAI) of an
assembly

N4+X..30 (FNC1)

703s Number of Processor with ISO Country Code N4+N3+X..27 (FNC1)

7040 GS1 UIC with Extension 1 and Importer index N4+N1X2+X3+X4 (FNC1)

710 National Healthcare Reimbursement Number
(NHRN) – Germany PZN

N3+X..20 (FNC1)

711 National Healthcare Reimbursement Number
(NHRN) – France CIP

N3+X..20 (FNC1)

712 National Healthcare Reimbursement Number
(NHRN) – Spain CN

N3+X..20 (FNC1)

713 National Healthcare Reimbursement Number
(NHRN) – Brasil DRN

N3+X..20 (FNC1)

714 National Healthcare Reimbursement Number
(NHRN) - Portugal AIM

N3+X..20 (FNC1)

715 National Healthcare Reimbursement Number
for US Food & Drug Agency

N3+X..20 (FNC1)

723s *4 Certification reference N4+X2+X...28 (FNC1)

7240 Clinical Trial Protocol ID N4+X..20 (FNC1)

8001 Roll Products (Width, Length, Core Diameter,
Direction, Splices)

N4+N14 (FNC1)

8002 Cellular Mobile Telephone Identifier N4+X..20 (FNC1)

8003 Global Returnable Asset Identifier (GRAI) N4+N14+X..16 (FNC1)

8004 Global Individual Asset Identifier (GIAI) N4+X..30 (FNC1)

8005 Price Per Unit of Measure N4+N6 (FNC1)

8006 Identification of the Components of a Trade
Item

N4+N14+N2+N2 (FNC1)

8007 International Bank Account Number (IBAN) N4+X..34 (FNC1)

8008 Date and Time of Production N4+N8+N..4 (FNC1)

8010 Component / Part Identifier (CPID) N4 + X..30 (FNC1)

8011 Component / Part Identifier Serial Number
(CPID SERIAL)

N4 + N..12 (FNC1)
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8012 Software version N4+X..20 (FNC1)

8013 Global Model Number (GMN) N4+X..30 (FNC1)

8017 Global Service Relation Number to identify
the relationship between an organisation
offering services and the provider of services

N4+N18 (FNC1)

8018 Global Service Relation Number to identify
the relationship between an organisation
offering services and the recipient of
services

N4+N18 (FNC1)

8019 Service Relation Instance Number (SRIN) N4+N..10 (FNC1)

8020 Payment Slip Reference Number N4+X..25 (FNC1)

8026 ITIP of contained pieces N4+N18

8110 Coupon Code Identification for Use in North
America

N4+X..70 (FNC1)

8111 Loyalty points of a coupon N4+N4 (FNC1)

8112 Paperless coupon code identification for use
in North America

N4+X..70 (FNC1)

8200 Extended Packaging URL N4+X..70 (FNC1)

90 Information Mutually Agreed Between Trading
Partners

N2+X..30 (FNC1)

91 to 99 Company Internal Information N2+X..30 (FNC1)

Notes
• *1: The first position indicates the length (number of digits) of the GS1 Application Identifier. The

following value refers to the format of the data content.

The following convention is applied:

n implied decimal point position

N numeric digit

X any character

N3 3 numeric digits, fixed length

N..3 up to 3 numeric digits

X..3 up to 3 characters

• *2: If only year and month are available, DD must be filled with two zeroes.

• *3: The fourth digit of this GS1 Application Identifier indicates the implied decimal point position.
Example:

• 3100 Net weight in kg without a decimal point
• 3102 Net weight in kg with two decimal points

• FNC1: All GS1 Application Identifiers indicated with (FNC1) are defined as of variable length and shall
be delimited unless this Element String is the last one to be encoded in the symbol. The delimiter
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shall be a Function 1 Symbol Character in GS1-128 Symbology, GS1 DataBar Expanded Versions and
GS1 Composite Symbology and should be a Function 1 Symbol Character in GS1 DataMatrix and GS1
QR Code Symbology.

• *4: The fourth digit of this AI indicates the sequence number, allowing multiple occurrences of this
AI

• *5: All GS1 Application Identifiers indicated with (FNC1) are defined as of variable length and shall be
delimited unless this Element String is the last one to be encoded in the symbol. The delimiter shall
be a Function 1 Symbol Character in GS1-128 Symbology, GS1 DataBar Expanded Versions and GS1
Composite Symbology and should be a Function 1 Symbol Character in GS1 DataMatrix and GS1 QR
Code Symbology.

• *6: GS1 specificiation expects exactly 6 or 10 digits (N4+N6+[N4]) for this Application Identifier. Due
to a technical limitation Dynamic Barcodes allows entering any amount of digits from 6 to 10.

Barcode Types
To create a barcode of this type, select it in the Type parameter. This displays parameters specific to
this barcode type in the Bar Code dialog.

2 of 5

About this Barcode...
2 of 5 is a numeric self-checking barcode, which can have a variable length. This barcode only encodes
data in the bars. It is used for industrial applications, article numbering, photo development and
ticketing.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392
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• Characters per unit on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Box on page 398

• Stroke Weight: Bearer Bars on page 400

Aztec

About this Barcode...
The Aztec barcode is a 2-dimensional barcode used to encoded to store a specific set of data.

The square bullseye pattern moves in pixelated layers from the center outwards. The barcode is named
after the resemblance of the central finder pattern (the square bullseye) to an Aztec pyramid.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Additional Parameters

• Minimum Symbol Size on page 397

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Cell Size or Cell Width/Height on page 397

• Width / Height on page 397

• Box on page 398

Specific Parameters
Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can set the
percentage of codewords that can be restored.
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Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check
sums are added to the barcode) and may limit the maximum length of the encoded data.

Bobst

About this Barcode...
The Bobst barcode is part of the same "binary" barcode family as the Laetus Pharma Code, Kurandt and
CLF-8.

When the Decimal Option is enabled, the Bobst code can be entered negative. A minus sign inverts the
thickness of the bars and inverts the binary input. For example:

• 2 in digital = 10 in binary
• -2 in digital = 01 in binary

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

• Decimal Input on page 395

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Wide Bar on page 394

• Gap on page 394

• Decimal Input on page 395

• Box on page 398
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CIP 39

About this Barcode...
Code 39 is a barcode based on the standard Code 39 barcode, used by the French pharma industry. The
barcode accepts 7 (CIP7) or 13 (CIP13) digits. The last digit is a check digit; if 6 or 12 digits are entered,
the check digit is added automatically. The CIP13 code must start with 340.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Narrow Bar on page 394

• Box on page 398

CLF-8

About this Barcode...
The CLF-8 barcode is part of the same "binary" barcode family as the Laetus Pharma Code, Kurandt and
Bobst barcode. It is used in the pharmaceutical industry.
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Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Wide Bar on page 394

• Gap on page 394

• Decimal Input on page 395

Codabar

About this Barcode...
The Codabar barcode is commonly used in libraries, blood banks, and the air parcel business. It can
encode up to 126 characters of data and two control characters, using digits and the “-”, “$”, “:”, “/” and
“+” characters.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388
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Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Rational (Constant Bar Width): By enabling this option, you can create a "Rational" Codabar bar
code.

• Force “992” Prod. Family in UPC on page 390

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Characters per unit on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Box on page 398

Code 128

About this Barcode...
Code 128 is a variable length, high density, alphanumeric barcode. It has the second highest density of
all the 1D barcodes (after the GS1 Databar Expanded).

It can contain a set of control characters. These control characters can change the character encoding
type. In the absence of control characters, the encoding type is chosen automatically, to optimize the
content encoding.

To force the usage of the code-set A, precede your data with the [a] control character. To force
the usage of the code-set B, precede your data with the [b] control character. To obtain an optimal
utilization of the code-sets A and B but prevent the usage of the space saving code-set C, use the Code
128 (long) barcode type instead.

You can include FNC characters in your code by entering [F1] for FNC1, [F2] for FNC2 or [F3] for
FNC3

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388
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Text Parameters

• Add Characters on page 389

• Light Margin Indicator on page 390

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Characters per unit on page 392

• Narrow Bar on page 394

• Width on page 394

• Box on page 398

• Stroke Weight: Bearer Bars on page 400

Code 128 (long)

About this Barcode...
Code 128 (long) is a version of Code 128 that doesn't use the space-saving “C” character set. This makes
Code 128 (long) barcodes generally longer.

You can include FNC characters in your code by entering [F1] for FNC1, [F2] for FNC2 or [F3] for
FNC3

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Light Margin Indicator on page 390

• Alignment on page 390

• Vertical Offset

Additional Parameters
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• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Characters per unit on page 392

• Narrow Bar on page 394

• Width on page 394

• Box on page 398

• Stroke Weight: Bearer Bars on page 400

Code 39

About this Barcode...
Code 39 is a popular barcode in industrial barcoding systems, mainly in the U.S.A. It is used in the
non-retail industry, particularly in the manufacturing, military, and health sectors. It can encode
alphanumeric data.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Characters per unit on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Add Check Digit on page 396
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• Box on page 398

Code 93

About this Barcode...
Code 93 is a variable length, high density, alphanumeric barcode. It's an enhancement of the Code 93
using spaces as well as bars as a data carrier. It contains two check characters for higher data security.
The Code 93 barcode allows encoding the first 128 characters of the ASCII table.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Characters per unit on page 392

• Narrow Bar on page 394

• Box on page 398

• Stroke Weight: Bearer Bars on page 400

DataMatrix

About this Barcode...
DataMatrix is used for encoding large amounts of alphanumeric data and / or marking small objects. It
can encode all the standard ASCII and extended ASCII characters.

The DataMatrix symbol size can adjust automatically depending on the amount of data.

Dynamic Barcodes doesn't generate human readable characters for DataMatrix symbols. The data to be
encoded in a DataMatrix symbol can contain an FNC1 character but only at the beginning of the data.
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Note:  Dynamic Barcodes always generates DataMatrix symbols with the recommended
ECC200 error correction scheme.

 

 

DataMatrix Macro functions
Using DataMatrix Macro sequences, you can reduce the amount of data to encode by omiting obvious
headers and trailers. The structured data uses control characters, entered using their standard
abbreviations between "<" and ">"

The Macro sequence contains different parts:

• The optional Macro header: [)>. This is optional, and can be omited

• One of the starting sequences: <RS>05<GS> or <RS>06<GS>

• The macro content in a structured format

• The ending sequence: <RS><EOT>

Here are a few examples of a valid Macro function:

• [)><RS>05<GS>PAP16559-2<GS>S0<72>017<GS>IPWP4511<RS><EOT>

• <RS>05<GS>PAP16559-2<GS>S0<72>017<GS>IPWP4511<RS><EOT>

Note that apart from the Macro functions, you can enter all control characters to a DataMatrix code.
These are all accepted codes:

<NUL><SOH><STX><ETX><EOT><ENQ><ACK><BEL><BS><HT><LF><VT><FF><CR><SO><SI><DLE><DC1><DC2><DC3><DC4><NAK><SYN><ETB><CAN><EM><SUB><ESC><FS><GS><RS><US>

Note:  If you want to use one of the control character substitutions literally (e.g. "<EOT>") it can
be escaped by doubling the first character: <<EOT>

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Symbol Type on page 396

• Cell Size or Cell Width/Height on page 397

• Width / Height on page 397

• Box on page 398
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EAN 8

About this Barcode...
EAN 8 is an abbreviated version of EAN 13, for use on smaller packages. It can encode eight digits, and
can have two or five additional digits.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Light Margin Indicator on page 390

• Add-on Text On Top on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Magnification on page 391

• Height on page 392

• Output Resolution on page 395

• Box on page 398

EAN 13

About this Barcode...
European Article Numbering system or EAN is the standard for article numbering in Europe. It is also
used in Japan where it is called JAN.

Note:  EAN is the European equivalent of the UPC system in the U.S.A. and Canada. Both
systems use the same size requirements and a similar encoding scheme. This means that most
European and American retail barcode scanners can read both EAN and UPC barcodes. For
more information on UPC, see UPC-A on page 385.
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An EAN 13 is a numeric barcode of thirteen digits, and can have two or five additional digits.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Light Margin Indicator on page 390

• Add-on Text On Top on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Magnification on page 391

• Height on page 392

• Output Resolution on page 395

• Box on page 398

EAN 13 Swissmedic

About this Barcode...
EAN 13 Swissmedic is an EAN 13 barcode used for items licensed by the Swiss Agency for Theraputic
Products
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It always starts with "7680", uses a specific text positioning and adds the text "swissmedic" below the
code.

For EAN 13 Swissmedic barcodes, only the default font settings can be used.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Magnification on page 391

• Height on page 392

• Output Resolution on page 395

• Box on page 398

Eberle

About this Barcode...
Eberle is a barcode using two bar and two space thicknesess to encode the data. The input can be both
in decimal and quarternal numerical systems. In the quarternal numerical system the barcode allows
numbers up to 30 digits (0, 1, 2 or 3).

In non-decimal mode, the minimal number is "0", while in decimal mode it is 1. Decimal "0" is not
allowed.
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Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Narrow Bar on page 394

• Decimal Input on page 395

• Box on page 398

GS1 128

About this Barcode...
GS1 128 (formerly EAN 128) is a Code 128 barcode designed primarily to identify products.

It contains one or more FNC1 (GS1 Function Code 1) control characters and Application Identifiers. It
shows parentheses around the human readable interpretation of the Application Identifiers, but those
parentheses are not encoded in the barcode.

 

 

It is alphanumeric and can also contain composite symbols.
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Parameters
General Parameters

• Orientation on page 388

• Code on page 388

• Composite Component on page 389

Text Parameters

• Add Characters on page 389

• Put on Top on page 389

• Multiple Text Lines

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Narrow Bar on page 394

• Output Resolution on page 395

• Box on page 398

• Stroke Weight: Bearer Bars on page 400

GS1 DataBar Omnidirectional

About this Barcode...
Barcodes of the GS1 DataBar family (formerly Reduced Space Symbols or RSS) can identify small items,
and encode more information than the current EAN or UPC barcodes.

They can include GS1 Application Identifiers such as serial numbers, lot numbers, expiration dates...

Note:  GS1 DataBar codes are expected to replace most common EAN and UPC barcodes from
2010.

GS1 DataBar Omnidirectional encodes Global Trade Item Numbers (GTIN) in a linear symbol that can be
scanned omnidirectionally by suitably programmed slot scanners.
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Parameters
General Parameters

• Orientation on page 388

• Code on page 388

• Composite Component on page 389

Text Parameters

• Add Characters on page 389

• Put on Top on page 389

• Multiple Text Lines

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Narrow Bar on page 394

• Output Resolution on page 395

GS1 DataBar Stacked

About this Barcode...
GS1 DataBar Stacked is a variation of the GS1 DataBar barcode, that is stacked in two rows and used
when the normal barcode would be too wide for the product.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

• Composite Component on page 389

Text Parameters

• Add Characters on page 389

• Multiple Text Lines
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• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Narrow Bar on page 394

• Output Resolution on page 395

GS1 DataBar Stacked Omnidirectional

About this Barcode...
GS1 DataBar14 Stacked Omnidirectional is taller version of GS1 DataBar14 Stacked, that can be read by
omnidirectional scanners.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

• Composite Component on page 389

Text Parameters

• Add Characters on page 389

• Put on Top on page 389

• Multiple Text Lines

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Narrow Bar on page 394
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• Output Resolution on page 395

GS1 DataBar Truncated

About this Barcode...
GS1 DataBar Truncated (formerly RSS Limited) is similar to GS1 DataBar but the height of its bars is
truncated.

It encodes Global Trade Item Numbers in a smaller symbol for use on small items. It cannot be scanned
omnidirectionally.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

• Composite Component on page 389

Text Parameters

• Add Characters on page 389

• Put on Top on page 389

• Multiple Text Lines

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Narrow Bar on page 394

• Output Resolution on page 395

GS1 DataBar Expanded

About this Barcode...
GS1 DataBar Expanded (formerly RSS Expanded) encodes regular barcode data (“primary item
identification” data) and Application Identifiers. It can encode alphanumeric characters.

This barcode can be scanned omnidirectionally by suitably programmed slot scanners.
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Parameters
General Parameters

• Orientation on page 388

• Code on page 388

• Composite Component on page 389

Text Parameters

• Add Characters on page 389

• Put on Top on page 389

• Multiple Text Lines

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Narrow Bar on page 394

• Output Resolution on page 395

GS1 DataBar Expanded Stacked

About this Barcode...
GS1 DataBar Expanded Stacked can encode the same amount of data as GS1 DataBar Expanded, but
can also “stack” the barcode into several rows to save space.
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Parameters
General Parameters

• Orientation on page 388

• Code on page 388

• Composite Component on page 389

Text Parameters

• Add Characters on page 389

• Put on Top on page 389

• Multiple Text Lines

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Max. Row Width on page 390

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Narrow Bar on page 394

• Output Resolution on page 395

GS1 DataBar Limited

About this Barcode...
GS1 Databar Limited is smaller than the GS1 DataBar barcode and can only encode Global Trade Item
Numbers whose data part starts with “1”.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

• Composite Component on page 389

Text Parameters

• Add Characters on page 389
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• Put on Top on page 389

• Multiple Text Lines

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Narrow Bar on page 394

• Output Resolution on page 395

GS1 DataMatrix

About this Barcode...
The GS1 Data Matrix barcode is a high density, high capacity, scalable 2D barcode. It is used to
concentrate a lot of (alphanumeric) information in a very small space.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Put on Top on page 389

• Multiple Text Lines

• Light Margin Indicator on page 390

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Symbol Type on page 396
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• Cell Size or Cell Width/Height on page 397

• Width / Height on page 397

• Box on page 398

GS1 QR

About this Barcode...
The GS1 QR barcode is a high density, high capacity, scalable 2D barcode. It is used to assembly
multiple GS1 Application Identifiers to a barcode with limited space needs. The GS1 QR barcode can
contain numbers, 0 - 9, upper case letters A -Z, and nine special characters: space $ % * + - . /

For more technical information on the QR code, see QR on page 382

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Put on Top on page 389

• Multiple Text Lines

• Light Margin Indicator on page 390

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Minimum Symbol Size on page 397

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Symbol Type on page 396

• Cell Size or Cell Width/Height on page 397

• Width / Height on page 397

• Box on page 398

Specific Parameters
Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.
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• Level M: 15% of codewords can be restored.

• Level Q: 25% of codewords can be restored.

• Level H: 30% of codewords can be restored.

Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check
sums are added to the barcode) and may limit the maximum length of the encoded data.

GS1 U.S. Coupon Interim

About this Barcode...
GS1 U.S. Coupon Interim is an interim coupon barcode. It is used during the transition between UPC-A
coupons and the new GS1 Databar Expanded Stacked coupons, that can encode more information.

It is made of both an old UPC-A coupon barcode, and a new Databar Expanded Stacked coupon
barcode, to be readable by both old and new scanners.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

Additional Parameters

• Force “992” Prod. Family in UPC on page 390

• Max. Row Width on page 390

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Magnification on page 391

• Narrow Bar on page 394

• Gap on page 394

• Vertical alignment on page 394
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HIBC 128

About this Barcode...
This barcode is based on the Code 128 symbology.

It encodes the organization's primary and / or secondary Labeler Identification Code (LIC). This
encoding begins with the “+” character. If both primary and secondary Labeler Identification Codes are
encoded in one barcode, they are divided by the “/” character.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Characters per unit on page 392

• Narrow Bar on page 394

• Width on page 394

• Box on page 398

• Stroke Weight: Bearer Bars on page 400

HIBC 39

About this Barcode...
This barcode is based on the Code 39 symbology.

It encodes the organization's primary and / or secondary Labeler Identification Code (LIC). This
encoding begins with the “+” character. If both primary and secondary Labeler Identification Codes are
encoded in one barcode, they are divided by the “/” character.
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Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Characters per unit on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Box on page 398

ITF-14

About this Barcode...
ITF-14 is a standardized version of the Interleaved 2 of 5 barcode, containing 14 digits, the last being a
check digit.

 

 

Parameters
General Parameters
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• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Vertical Offset

Additional Parameters

• Text Format on page 391

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Magnification on page 391

• Height on page 392

• Output Resolution on page 395

• Total Height on page 397

• Smax / Smin on page 398

• Box on page 398

ITF-16

About this Barcode...
ITF-16 is a standardized version of the Interleaved 2 of 5 barcode, containing 16 digits, the last being a
check digit.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Vertical Offset
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Additional Parameters

• Text Format on page 391

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Magnification on page 391

• Height on page 392

• Output Resolution on page 395

• Total Height on page 397

• Smax / Smin on page 398

• Box on page 398

Interleaved 2 of 5

About this Barcode...
Interleaved 2 of 5 (or Int. 2 of 5) is a barcode originally used for transportation packaging, that can have
any even number of digits. Since this type of packaging consists mainly of cardboard boxes printed in
low quality, the Interleaved 2 of 5 barcode is more tolerant to distortion than other barcodes.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Characters per unit on page 392

• Ratio on page 394
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• Narrow Bar on page 394

• Box on page 398

• Stroke Weight: Bearer Bars on page 400

Klebrand

About this Barcode...
Klebrand is a barcode used in the packaging industry. It uses four different bar thicknesess to encode
the data. The barcode uses the quarternal numerical system and each bar thickness represents one of
four numbers allowed in the non-decimal input (0, 1, 2 and 3). It can have up to 30 bars. The input can be
both in decimal and quarternal numerical systems.

• In non-decimal (quarternal) mode all digits are encoded, including any leading zeroes. For example
"0031" is encoded to 4 bars.

• In decimal mode you can define the number of bars in total, by enter e.g. "6/4". The first number
(6) defines the total number of bars, the second (4) defines the value to be encoded. If you you
enter a single number without defining the number of bars, the minimal number of bars needed
for the value is used, and the code is adjusted accordingly. If you for example enter "9", the value
will change to "4/9", as you need at least 4 bars to encode this value. The text below the barcode (if
enabled) only shows the decimal value itself.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Wide Bar on page 394

• Gap on page 394
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• Decimal Input on page 395

• Box on page 398

Kurandt

About this Barcode...
The Kurandt barcode is part of the same "binary" barcode family as the Laetus Pharma Code, Bobst and
CLF-8. It is used in the pharmaceutical industry.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Wide Bar on page 394

• Gap on page 394

• Decimal Input on page 395

• Box on page 398

Laetus Pharma Code

About this Barcode...
The Laetus Pharma Code is part of the same barcode family as the Kurandt, Bobst and CLF-8 barcode.
It was developed specifically to meet the requirements of the pharmaceutical packaging process.
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It has established itself as the worldwide pharmaceutical industry barcode standard. It can encode
numeric or binary data.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Miniature: Use this option to create a miniature version of the bar code

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Wide Bar on page 394

• Gap on page 394

• Decimal Input on page 395

• Box on page 398

M+S 7

About this Barcode...
The M+S 7 barcode is an EAN 8 barcode modified by Marks & Spencer's, for use on own-brand products
sold in their stores.

To make the M+S 7 barcode, the initial “0” is removed and the extra letters “M” and “S” are added to the
human readable characters.

This means that the human readable characters contain seven digits plus the “M” and “S” letters.

Note:  This doesn't affect the data encoded in the barcode (it still encodes eight digits), so you
should enter eight digits when creating a M+S 7 barcode.
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Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Magnification on page 391

• Height on page 392

• Output Resolution on page 395

• Box on page 398

MSI

About this Barcode...
MSI, also known as Modified Plessey, was developed by the MSI Data Corporation, based on the original
Plessey Code. It is a numeric barcode used primarily to mark retail shelves for inventory control.

 

 

Parameters
General Parameters
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• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Characters per unit on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Box on page 398

Marks & Spencer's

About this Barcode...
The Marks & Spencer's barcode is also an EAN 8 barcode modified by Marks & Spencer's for use on
own-brand products.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Vertical Offset

Additional Parameters
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• Bar Width Reduction on page 391

• Device Compensation on page 391

• Magnification on page 391

• Height on page 392

• Output Resolution on page 395

• Box on page 398

NDC / HRI

About this Barcode...
The NDC / HRI barcode is a variant of the UPC barcode with special human readable interpretation
formats compliant to the US National Drug Code definition.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Vertical Offset

Additional Parameters

• Text Format on page 391

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Magnification on page 391

• Height on page 392

• Output Resolution on page 395
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• Box on page 398

Paraf Italy

About this Barcode...
This barcode is a variant of Code 39 used by the Italian Health and Cosmetics Industry. It is also called
Code 32.

 

 

Use Code Base32 when your barcode data is encoded in the Base 32 format. This format uses case-
insensitive alphanumeric characters to encode data.

Use Code Base10 when your barcode data is in decimal format. Paraf Italy barcodes in decimal format
should start with an “A” (included automatically by the Bar Code functionality), have 8 digits of data and
end with a check digit (calculated automatically).

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Narrow Bar on page 394

• Box on page 398

PDF417

About this Barcode...
PDF417 is a 2D barcode mainly used in security printing (passports, identity cards, driving licences...).

It is a “self-checking” barcode that can have different levels of error correction.

It can encode data using one of three “compaction” modes: Text (to encode all alphanumeric and
punctuation characters in the ISO-8859-1 character set), Numeric (to encode only numeric characters)
or Binary (to encode 8-bit characters).

It can use the three compaction modes in a single barcode if necessary, but you can choose to disable
the Text and/or Numeric compaction modes.
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Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Narrow Bar on page 394

• Box on page 398

Specific Parameters
Element Size

Enter the width and height you want to give a single element of your barcode (below in red).

 

 

Dimensions
Enter the number of Columns and Rows you want to give your barcode.

Options
Choose Truncated PDF to make the symbol less wide by truncating the end character (which is not
part of the encoded data) and the end pattern. In the example below, the top PDF417 barcode is not
truncated, and the bottom barcode is truncated (but encodes the same data).
 

 
Choose Initialize Alpha to generate a “shift to Text mode” character at the beginning of the barcode
when using Text compaction mode. This makes the encoding clear for barcode scanners.

Choose Text compact. allowed to let PackEdge switch to Text compaction mode automatically when
your barcode contains text data.
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This encodes the text data in your barcode more eciently (it makes that part of your barcode
smaller).

Choose Numeric compact. allowed to let PackEdge switch to Numeric compaction mode
automatically when your barcode contains numeric data.

This encodes the numeric data in your barcode more eciently.

Note:

PackEdge can always switch to the Binary compaction mode if your barcode contains binary
data.

If you don't enable either Text compact. allowed or Numeric compact. allowed, PackEdge
will only use Binary compaction mode.

Error detection and correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose an Error correction level from 0 to 8.

The higher the correction level, the more check sums are added to the barcode and the more incorrect
data can be corrected. Keep in mind that a higher correction level makes the barcode bigger and may
limit the maximum length of the encoded data.

Note:  Level 0 means that there is only one check sum added to the data, so incorrect data
can be detected but not corrected.

You can choose Automatic to let the application pick the best error correction level for the data
encoded.

MicroPDF417

About this Barcode...
MicroPDF417 is a 2D multi-row barcode derived from PDF417, for use on smaller areas. It can encode up
to 150 bytes.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Narrow Bar on page 394
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• Output Resolution on page 395

• Box on page 398

Specific Parameters
Dimensions
Enter the number of Columns and Rows you want to give your barcode.

Options

Choose Text compact. allowed to let PackEdge switch to Text compaction mode automatically when
your barcode contains text data.

This encodes the text data in your barcode more eciently (it makes that part of your barcode
smaller).

Choose Numeric compact. allowed to let PackEdge switch to Numeric compaction mode
automatically when your barcode contains numeric data.

This encodes the numeric data in your barcode more eciently.

Note:

PackEdge can always switch to the Binary compaction mode if your barcode contains binary
data.

If you don't enable either Text compact. allowed or Numeric compact. allowed, PackEdge
will only use Binary compaction mode.

PZN

About this Barcode...
The PZN (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and healthcare
products in Germany. The PZN code is written in the format “PZN-nnnnnnn” but only the numeric part
including the leading dash is encoded.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390
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• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Size on page 392

• Height on page 392

• Characters per unit on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Box on page 398

PZN8

About this Barcode...
The PZN8 (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and
healthcare products in Germany. The PZN code is written in the format “PZN-nnnnnnnn” but only the
numeric part including the leading dash is encoded.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Font Family, Style and Size

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391
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• Size on page 392

• Height on page 392

• Characters per unit on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Box on page 398

QR

About this Barcode...
The QR barcode is a 2-dimensional barcode used for commercial tracking and convenience-oriented
applications aimed at mobile phone users (known as "mobile tagging").

QR codes storing addresses and URLs may appear in magazines, on signs, buses, business cards, or
other objects... Users with a camera phone equipped with the correct reader application can scan the
QR code to display text, contact information, connect to a wireless network, or open a web page in the
phone's browser.

 

 

QR codes have the following structure:

 

 

•

 Position pattern (required)

•

 Alignment pattern (required)

•

 Timing pattern (required)

•
 Version information
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•
 Format information

•
 Data and error correction keys

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Additional Parameters

• Minimum Symbol Size on page 397

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Cell Size or Cell Width/Height on page 397

• Width / Height on page 397

• Box on page 398

Specific Parameters
Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.

• Level M: 15% of codewords can be restored.

• Level Q: 25% of codewords can be restored.

• Level H: 30% of codewords can be restored.

Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check
sums are added to the barcode) and may limit the maximum length of the encoded data.

MicroQR

About this Barcode...
The Micro QR Code is a very small QR Code for use on smaller spaces (for example to encode the ID of
printed circuit boards and electronics parts).

It works with smaller amounts of data (maximum 35 numeric characters), and uses only one position
pattern.
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Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Additional Parameters

• Minimum Symbol Size on page 397

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Cell Size or Cell Width/Height on page 397

• Width / Height on page 397

• Box on page 398

Specific Parameters
Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.

• Level M: 15% of codewords can be restored.

• Level Q: 25% of codewords can be restored.

• Level H: 30% of codewords can be restored.

Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check
sums are added to the barcode) and may limit the maximum length of the encoded data.

SICK Code

About this Barcode...
SICK is a bar code used in the German packaging industry. It's a binary bar code, using a thick bar for a
0, and a thin bar for a 1. It can have up to 12 bars. It can encode numeric or binary data.

• In binary mode all digits are encoded including leading zeroes, ie. "0001" is encoded as a three thin
and one thick bar.

• In decimal mode you can define the number of bars in total, by enter e.g. "6/4". The first number (6)
defines  the total number of bars, the second (4) defines the valueto be encoded. If you don't define
the number of bars, in other words if you enter a single number, the minimal number of bars needed
for the value is used, and the code is adjusted accordingly. If you for example enter "9", the value will
change to "4/9", as you need at least 4 bars to encode this value.

• The defaults follow the mostly used standard "Codetype A", for generating the "Codetype B" should
be changed the barcode parameters as following: Narrow Bar to 1.25mm (from 0.5mm), Wide Bar to
3.75mm (from 1.5mm) and Gap to 2.5mm (from 1mm)
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By default, the values for the Narrow Bar (0.5mm), Wide Bar (1.5mm) and Gap (1mm) are set for the
mostly used standard "Codetype A". If you want to generate a SICK code using "Codetype B", you should
set the Narrow Bar to 1.25mm, the Wide Bar to 3.75mm and the Gap to 2.5mm

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Alignment on page 390

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Height on page 392

• Ratio on page 394

• Narrow Bar on page 394

• Wide Bar on page 394

• Gap on page 394

• Decimal Input on page 395

• Box on page 398

UPC-A

About this Barcode...
Universal Product Code or UPC is the standard for article numbering in the U.S.A. and Canada. It is
similar to the EAN system and compatible with it. For more information on EAN, see EAN 13 on page
354.
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UPC-A is a numeric barcode of up to twelve digits, plus two or five additional digits.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Font Family, Style and Size

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Magnification on page 391

• Height on page 392

• Output Resolution on page 395

• Box on page 398

UPC-E

About this Barcode...
UPC-E is an abbreviated version of UPC-A, for use on smaller packages. It is a numeric barcode of
eight digits, with an optional 2 or 5 digits add-on. You can also directly enter the 12-digit code of UPC-A
codes that can be represented in 8 digits.
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Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389

• Vertical Offset

Additional Parameters

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Magnification on page 391

• Height on page 392

• Output Resolution on page 395

• Box on page 398

UPC-SCS

About this Barcode...
The UPC–SCS (Shipping Container Symbol) barcode is a version of the Interleaved 2 of 5 barcode that
has a structure very similar to the Universal Product Code's (UPC) and specific formatting of the human
readable interpretation.

 

 

Parameters
General Parameters

• Orientation on page 388

• Code on page 388

Text Parameters

• Add Characters on page 389
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• Vertical Offset

Additional Parameters

• Text Format on page 391

• Bar Width Reduction on page 391

• Device Compensation on page 391

• Magnification on page 391

• Height on page 392

• Output Resolution on page 395

• Total Height on page 397

• Box on page 398

• Stroke Weight: Bearer Bars on page 400

Barcode Parameters

Orientation

To keep your barcode as it is or rotate it by 90, 180 or 270 degrees, use the first 4 Orientation buttons.

To rotate it by any other angle, use the 5th Orientation button and enter the rotation angle in the field
below.

 

 

Code

Enter the data to encode in your bar code.

The Bar Code functionality checks that the data you have entered is valid for your chosen bar code
Type. If it isn't, a warning / error will pop up.

Code for GS1 Bar Codes
When entering data to be encoded in GS1 bar codes, you can either enter Application Identifiers (AI)
including the brackets, or you can enter the code without brackets, using FNC1 code at the end of
each variable-length element in the data. The FNC1 code will be represented by [F1] when entering the
code (with an exception for the GS1 DataMatrix barcode, which also allows the ASCII 29 <GS> control
character as a seprator).While entering GS1 data, following remarks should be taken into account:

• Do not add the mandatory FNC1 character at the beginning of the data. PackEdge will add it
automatically.

• For GS1 bar codes intended for encoding AI (01) only, AI has to be omitted, i.e. don't enter '01' at the
beginning. It doesn't matter if entered with or without brackets.
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• The Composite Component can be created using the same rules for using brackets and [F1]. It's not
necessary to keep the same way of entering the Composite Component and the main code.

• If you don't use brackets for entering AI, type [F1] at the end of each variable-length element in the
data, to represent a FNC1 terminating character, except when the variable-length element is placed
at the end of the whole code.

• You don't need to type [F1] at the end of fixed-length elements.

• Do not mix using [F1] as terminators of variable AI and entering brackets around the AI.

 

 

PackEdge also checks the validity of the Application Identifiers you enter in the Code and / or in the
Composite Component of GS1 bar codes.

Composite Component

A Composite Component is a 2D symbol placed on top of a GS1 barcode, that encodes extra
information (batch number, expiration date...).

If you want your barcode to have a Composite Component, enter the (alphanumeric) data to encode in
this field.

Note:  PackEdge checks the data you enter for the Composite Component (for example to see
if the Application Identifiers you entered are correct), and displays a warning if it is invalid.

Add Characters

This parameter adds “human readable” characters (numeric or alphanumeric characters) under your
barcode.

This is the same barcode with and without characters:

 

 

Put on Top

This parameter allows you to put the Human Readable Characters above instead of below the barcode
bars.
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Light Margin Indicator

This parameter adds “<“ and “>” signs (or only “>” depending on the barcode type) at the bottom of your
barcode. This indicates the width the barcode should have for optimal reading.

 

 

Note:  When creating a bar code, the current Light Margin Indicator setting is stored for the
specific barcode type. This means that the next time you select the same barcode type (e.g.
when creating a new barcode of that same type) the Light Margin Indicator setting will be
adjusted.

Add-on Text On Top

This parameter allows you to put the add-on HRI text above instead of below the barcode bars. By
default, this option is enabled.

Alignment

When using human readable characters, in combination with custom font settings, you can set text
alignment to Left, Center or Right.

Force “992” Prod. Family in UPC

Enable this parameter to use the special “992” product family in your barcode (for specific offers like
discounts on the customer's next purchase or on variable weight items...).

Max. Row Width

Use this parameter to define how many segments of data (groups of bars encoding several digits) can
fit in one row. If the barcode contains more segments, they will be stacked.

In the example below, the first barcode has a Max. Row Width of 8 segments. When reducing this to
4 segments, the segments that don't fit in the row width anymore are stacked, forming a second row
(second barcode).
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The GS1 Max Row Width parameter applies to the GS1 Databar Expanded Stacked component of the GS1
U.S. Coupon Interim barcode.

Text Format

Choose a text format for the characters of your barcode.

For NDC/HRI barcodes, you can choose a variant of the U.S. National Drug Code.

For ITF-14, ITF-16 and UPC-SCS barcodes, you can choose a variant of the Shipping Container Symbol.

Bar Width Reduction

Use this to adjust the width of barcode bars, in order to compensate for ink bleeding when printing on
your substrate.

Your printer or customer will usually provide you with the value to use. For example if your printer tells
you that the line width will increase by 0.01mm, you should use a Bar Width Reduction value of 0.01
mm.

Tip:  You can enter a negative value if you want to print thicker and not thinner bars.

Device Compensation

Use this if your printer gave you a separate device bleed value. This parameter adjusts the bar's width
to compensate for bleed caused by the plate or film making process.

Note:  If you use both a Bar Width Reduction and a Device Compensation value, the Bar Code
dialog will add them to adjust the bar's width.

Tip:  You can enter a negative value if you want to print thicker and not thinner bars.

Magnification

Use this parameter to increase or decrease the barcode size proportionally.

In the example below, you can see the same barcode at 80%, 100% and 120% magnification.
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Size

Choose to give your PZN barcode a Small, Normal or Large size. Those are predefined sizes for this
barcode. The actual Height, Characters per unit, Ratio and Narrow Bar values are shown underneath.

By selecting Custom, you can manually edit these four parameters.

Height

Enter the height to give to your barcode's bars. They need to be tall enough to be read easily by barcode
scanners.

Bars and Digits
For:

• EAN 8 & 13
• HIBC 128 and 39
• M+S 7, and Marks & Spencer's
• NDC / HRI
• UPC-A and UPC-E

For the bar codes listed above, the height you enter is the combined height of the bars and the
characters). Your barcode needs to be tall enough to be read easily by barcode scanners.

Attention:  Do not change the Height of the barcode before entering a Magnification value.
The Height will change again according to the Magnification factor you define.

Characters per unit

This parameter allows you to define your barcode's width based on the encoding of (numeric or
alphanumeric) characters.

For example, if you are using millimeters for your document, enter 1 Character per unit if you want the
bars needed to encode one character to take up 1 mm.
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Increase the Characters per unit value to make the barcode narrower, or decrease it to make the
barcode wider. For example, if you choose 0.5 Character per unit, the bars needed to encode one
character will take up 2 mm.

 

 

Note:  Barcodes like Interleaved 2 of 5 encode two characters together in a group of black and
white bars. For these barcodes, Packedge takes half of the group of black and white bars to
measure one character.

 

393



8 PackEdge

 

Ratio

The Ratio is the factor between the width of the narrow bar and the width of the wide bar in your
barcode. For example, enter 3 if you want your wide bar to be three times as wide as your narrow bar.

Narrow Bar

This parameter determines the width of the narrowest bar of your barcode. In some cases (for example
GS1 DataBar barcodes) this affects the size (height and width) of your barcode proportionally.

Width

This parameter determines the width of the barcode from the leftmost bar to the rightmost bar.
Changing the Width will update the Narrow Bar and Characters per unit settings to achieve the desired
size.

The Light Margin Indicators and Box are not included.

Wide Bar

This parameter determines the width of the widest bar of your barcode.

Gap

Enter the width of the white space between the bars.

Note:  The Ratio influences the Gap size: increasing the Ratio also increases the Gap size.

Vertical alignment

PackEdge allows you to resize either the UPC-A or the GS1 Databar Expanded Stacked coupon barcode,
so they are aligned vertically with each other. You can choose:
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• None to keep the original size of both the UPC and the GS1 barcodes,
 

 

• Resize UPC to GS1 to resize the UPC barcode so it has the same height as the GS1 barcode,
 

 

• Resize GS1 to UPC to resize the GS1 barcode so it has the same height as the UPC barcode.
 

 

Output Resolution

Use this to adjust the barcode size parameters (Bar Width Reduction, Device Compensation and
Magnification) so that the bars' width and height take up a complete number of pixels or dots.

Enter the resolution you will use to print your barcode in ppi.

If you don't want to adjust the barcode size parameters to the output resolution, click the link symbol to
make it look detached.
 

 

Decimal Input

Use this parameter to change the type of data you can enter in the Code field.

• Disable it to enter the data to encode in binary or quaternal format.

• Enable it to enter the data in decimal instead of binary/quaternal format.
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Note:  When using binary format for the Laetus Pharma Code, CLF-8, Bobst or Kurandt barcode
data, you need to use a special "Pharma" binary format.

To convert a decimal number into a Pharma binary number, do the following:

1. Add 1 to your decimal number.
2. Convert the result to a binary number using a regular binary conversion algorithm.
3. Remove the first digit (which is 1).

You now have your Pharma binary input for the Laetus Pharma Code, CLF-8, Bobst or Kurandt
barcode.

For example, you want to encode the number 3.

1. 3+1=4
2. 4 in binary is 100.
3. Without the first digit, it's 00.

Enter 00 in the Code field of your Laetus Pharma Code, CLF-8, Bobst or Kurandt barcode.

Add Check Digit

Use this parameter to add a check digit to your barcode data.

Note:  Code 39 doesn't usually contain a check digit but it can be required in some cases.

Symbol Type

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note:  If the number of cells you choose for your symbol is too small to encode the data you
entered in Code, PackEdge will display an error.
 

 

You can choose Best Fit to make PackEdge automatically adapt the number of cells to the amount of
data you entered in Code.
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Minimum Symbol Size

Choose the minimum number of cells to use for your barcode (in the format “horizontal cells x vertical
cells”). If the number of cells you choose for your symbol is too small to encode the data you entered,
PackEdge automatically adapts the number of cells to the amount of data you entered in Code.

Cell Size or Cell Width/Height

Enter the size you want to give to each cell of the symbol. Cell Size defines both the width and height of
the cell, while with Cell Width and Cell Heigth you can set these parameters separately.

In the example below, the first symbol has a 1 mm cell size (cells sides are 1 mm), and the second one a 2
mm cell size.

 

 

Width / Height

The Width and Height parameters depend on the Cell Size and the number of cells used for the symbol
(defined by Symbol Type or Minimum Symbol Size).

In the example below, a symbol of 10 x 10 cells where each cell is 3 mm gives a Width and Height of 30 x
30 mm.

 

 

Total Height

Enter the total height you want to give to your barcode. This is the combined height of the bars,
thecharacters and the box. If your barcode doesn't contain characters or a box, the Total Height is the
same as the bars' Height.
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Smax / Smin

Use these parameters to define the width of the printability gauges (“H” marks) either side of your
barcode. Smax defines the width of the left “H”, Smin defines the width of the right “H”. Enter 0 in both
fields if you don't want printability gauges.

In the example below, the top barcode has a value of 0 for both Smax and Smin, the middle one has a
value of 4 and the bottom one has a value of 8 (the maximum).
 

 

Box
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In the Box tab, enable the Box checkbox to create an opaque white box under your barcode.

 

 

Use the fields on the top, bottom, right and left to add a white margin around your barcode and make
the box bigger.
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By default, Packedge links the four margins' values so that when you change one of them, the other
ones are updated automatically.

If you want to change them independently, click the link symbol to make it look detached  .

For ITF, UCP and UPC-SCS bar codes, the box will be transparent.

Note:  When creating a bar code, the current Box parameters are stored for the specific
barcode type. This means that the next time you select the same barcode type (e.g. when
creating a new barcode of that type) the Box parameters will be adjusted.

Stroke Weight: Bearer Bars

For ITF-14, ITF-16 and UPC-SCS barcodes, enabling the Box option will create a transparent box, always
with bearer bars around it. The Stroke Weight parameter defines the width of the bearer bars. In this
case, it can't be set to zero.

For 2 of 5, Code 128,Code 128 long, Code 93,GS1 128, HIBC 128 and Int 2 of 5 barcodes, the Stroke
Weight defines the width of the bearer bars, but also define if bearer bars should be added: if the value
is set to zero, no bearer bars are added, even if Box is enabled. If the value is not zero, bearer bars will
be added, even if the Box option is disabled.

The bearer bars are positioned at the outside of the defined box, taking into account the margins (even
if the box option is disabled for the barcode types mentioned above). See also Box on page 398.

The option Only Top and Bottom Bars limits the bearer bars to only the top and bottom line.

8.10.2.  SmartMarks... (Production Menu)

Allows you to create, save, open and edit sets of SmartMarks. Sets can be saved to disk and can be
used during output. SmartMarks are regenerated as soon as something in the job changes: job size, ink
definitions...

SmartMarks can be attached to

•
borders 

•
margins 

•
visible objects 

• named objects (objects in your job which have an object name, see Objects and Object Name in the
chapter on the Status Bar.
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Click  to add a SmartMark. A list of available SmartMarks will pop up.

Note:

The list of available SmartMarks will change according to the 'object' you want to attach the
SmartMark to. For example you cannot attach a Gallus Mark to a visible object.

Clicking the black arrow  opens a list with extra options.

• Options...: Opens the SmartMarks dialogbox for the selected mark.

• Turn: Relocates the SmartMark, using the vertical axis of your job.
 

 

• Tumble: Relocates the SmartMark, using the horizontal axis of your job.
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• Convert to Objects: this converts the selected SmartMarks to objects. These objects will look like
marks in your job, but they are in fact dynamic objects and will behave like ordinary objects: they
can be edited, rotated, scaled...

• Delete Removes the selected mark from your list.
• Clear Object Name: If the SmartMark has an object name, you can clear it here.
• New Set...: empties your list of marks.
• Open Set...: opens a saved set.
• Load Set...: adds a saved set to your list.
• Save Set...: saves your list.
• Save as Set...: saves your list under a new name.

Custom Inks in SmartMarks
Custom Ink allows to pick any number of inks, by name, number or attribute.

Click Select Inks... to seelct the Inks. You can select inks in three ways:

• Select Custom Ink by Name on page 402
• Select Custom Ink by Number on page 403
• Select Custom Ink by Attribute on page 403

Select Custom Ink by Name
To select Custom Inks by Name, select "Name" from the dropdown list.
 

 

Only the inks that are used in the current document are displayed. Activate an ink by clicking the
"check" area in front of the ink.

If the "Create if not present" option is selected, the ink will be created if it is not available in the
document you want to apply the mark in.
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Select Custom Ink by Number
To select Custom Inks by number, select "Number" from the dropdown list.
 

 

The inks that are used in the current document are displayed. Activate an ink by clicking the "check"
area in front of the ink.

When building SmartMarks using a custom color in an empty document, or in the list below the used
inks, the list shows the color "unknown [n]" whereas [n] is the number of the ink.

Select Custom Ink by Attribute
Selecting Custom Inks by Attribute allows to apply a filter on all inks.

You can select an Attributes Filter from the dropdown.

Note:

If no Attributes Filter is defined, PackEdge will make a "Default" filter, selecting all Inks.
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Using the fly-out next to the Attributes Filter dropdown, you can create a new filter, edit an existing
filter or delete one.

 

 

A filter is defined by one or more "rules". You can add or remove rules by clicking the + or - button. A rule
can select inks based on the name, ink book, ruling, angle, dot shape, type or printing method.

An ink will be selected if it matches all of the highest level rules (a logical "AND" function: the ink is
selected if rule 1 AND rule 2 is fulfilled).
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By holding down the ALT-key, the + button will change to "...". Clicking this button will add a logical
operator, allowing to combine rules using logical expressions: "All of the following rules" (AND), "Any of
the following rules (OR), or "None of the following rules" (NOT).

The top example will select inks with "Pantone" in their ink name, and that are either have "Offset" as
printing method, or come from an ink book which name begins with "Custom". The second example will
select inks with "Pantone" in their ink name, except if they have "Offset" as printing method

The "Result" underneath shows what inks from the current document would be selected using the
current filter.

Note:  Filters are stored on the Automation Engine server (when connected), so they can be
used in all connected PackEdge / Plato stations, and in the SmartMarks Automation Engine
tasks.

Custom Color
When you select a Custom Color ink from the Ink dropdown list, you can define a color and use it
afterwards in a SmartMark. Custom color inks can be applied e.g. in text marks...
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Click 'Define Color...' to define a custom color. Custom colors can be defined in three ways:

• By Ink Number

• By Ink Name

• By Color Name

 

 

By Ink Number

To define a Custom Color by means of an ink number, select 'Ink Numbers' from the dropdown list. The
inks that are used in the current document are displayed. Activate the ink by clicking the "check" area
in front of the ink and its value will be set to 100%. You can click the value if you want to change the
percentage. The color patch will show you the resulting color.
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You can drag a color swatch from the Colors palette to the color sample at the top right of the dialog
box and the list in the "Define Color" dialog box will be updated immediately.

 

 

When building SmartMarks using a custom color in an empty document, the color patch shows the
color "unknown".

 

 

By Ink Name

When you select Ink Name from the dropdown list, only the inks that are used in the current document
are displayed. Activate the ink by clicking the "check" area in front of the ink and its value will be set to
100%. You can click the value if you want to change the percentage. The color patch will show you the
resulting color.
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By Color Name

All named colors are displayed in the list. Select one of them by selecting the button in front of the
color. To create a new color, you can simply drop a color from the Colors palette on the patch. This
color will be added to the list and gets a default name (Color 1, Color 2...). The color name will also
be displayed in the Colors palette. At any time you are able to change this name in the "Define Color"
dialog box. When changing the name in the 'Define Color' dialog box, the Colors palette will updated
automatically.

 

 

Span Area
The Span Area SmartMark allows to create new named objects which span a (rectangular) area using
the bounding box of two or more points.

This can be used to create named objects, that can be used as anchor points to position other
SmartMarks.
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The SmartMark is defined by

• The Name for the named object

• The Position of the different points. Position is defined as for regular SmartMarks. See
SmartMarks... (Production Menu) on page 400

You can click the + to add an extra point, or x to remove a point.

If the Skip Missing Positions option is enabled, any missing position (e.g. because it's attached to a non
existing named object) will be ignored. If a position is missing and the option is off, or if there are less
than two positions defining the Span Area, the Span Area SmartMark will fail.

Image Mark
The Image Mark allows you to enter CT, LP, LC, TIFF, Jpeg or Esko native files as a mark.

• Monochrome images:

• LP, LC, monochrome CT
• Esko native files containing only one ink
• Tiff

• Colored images:

• CMYK and multi channel CT
• Esko native files containing more than one ink
• TIFF, jpeg

The Image Mark options dialog consists of three tabsheets: Image on page 409, Inks on page 410,
Position on page 415.

Tip:

The Image Mark can be moved in your job by simply using the Move Tool  in the toolbar.

Image
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Name: Enter the name of the Image Mark you want to use, hit the browse button to browse to a Esko
native, LC, LP file you want to use.

Tip:

If you want to incorporate SmartNames in your filename, hit the 'SmartNames' button.

When placing [taskinputfile], you have the option to Hide trap layer(s) . This will remove all trapping
layers which were generated in PackEdge or Automation Engine. If this option is on, the [taskinputfile]
will no longer be placed as an external reference, so the resulting output file can be larger.

Scale: You can scale the Image Mark. If the Image Mark is attached to a named object, other scale
options are possible: Scale to fit, Downscale to fit, Autorotate and scale to fit.

To fit to the borders, clip or repeat the image vertically or horizontally, click the toggle. You can extend
the mark.

Rerun SmartMarks: The 'rerun SmartMarks' will update the SmartMarks that are embedded inside the
selected image. So suppose you place a GRS as imagemark and this GRS contains a textmark with the
field [time].

• without 'rerun' the [time] field will simply reflect that time when the GRS used as imagemark was
saved.

• with 'rerun' active, the textmark will be regenerated and as a result, the [time] field will show the
current time.

Inks
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Ink

• Registration
• Darkest
• Black or Darkest

Note:

Black or Darkest selects any black (process, pantone) if it exists. If they dont exist, the
darkest ink is taken. This option ensures that a black ink is used for the marks, even if the
job contains a (darker) ink like Reflex Blue

• Black

Note:

This option will select any black (process or pantone). If no such ink exists, process black is
added to the ink table.

• Knock Out
• Custom Ink allows to pick any number of inks, either by name or by position (in the inks list).
• Custom Color allows you to pick a color, based on the ink name, ink number or color name.

Overprint

• Opaque
• Darken ('Esko overprint')
• Postscript
• Add
• Reverse: Knocks out the selected ink in the underlying separation. If you select for instance

Magenta, it will be knocked out in the Magenta separation.
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Ignore Similar Inks: This option becomes available when you selected Registration ink.

Tip:

This is useful when you have similar inks in your job, e.g. two cyans with a different angle, and
you want to step all the inks but you only want to have one cyan.

Ignore Technical Inks: Technical inks will not be used in the SmartMark. This option becomes available
when you selected Registration ink.

Ignore Varnish Inks: Varnish inks will not be used in the SmartMark.

With Step: define a step between two parts of the image mark.

Interleaved with (select an) ink. The 'Start with' toggle allows you to decide whether you begin with an
ink from the image or with the ink you chose to interleave with.

Ignore darkest ink the darkest ink will not be used.

Use isolated blending group will put the mark in a group with the Isolated blending option enabled.
This will ensure that blend modes used in the mark will not affect underlying objects

The Preserve Screening option allows to place the mark in all separations of the current job, but keep
the screening (dot shape, lpi, angle) from the original image.

White underprint: allows you to add white underprint to the mark. Click the 'Setting' button, the White
Underprint settings dialog pops up.
 

 

Select Keep original inks if you want to use the original inks of the image when placing this mark.
Image inks that do not yet appear in the job's ink list will be added to that list. Inks that do appear in the
job's ink list, but which have different ink settings will also be added to that list.

Select Map inks if you want the inks of the image mark to be mapped to the job's inks.

Keep ink names is almost the same as 'Keep original inks' except that image inks that already appear in
the job's ink list with the same name (but with a different ruling, angle or dotshape) will be replaced by
the corresponding ink from the current job. Inks that do not yet appear in the job's ink list will be added.

Inks (special case: the task input file)
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When you use the Image Mark to prepare a Automation Engine Report Maker task template, you can
use the SmartName [taskinputfile] as image. When you do that, you get extra options in the Image
Mark Inks tab.

Show Separations: the image mark will show the separations of the input file.

With step: separations are shown with a step:
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Repeat Separation on new page: every separation is put on an other page.

Progressive Separations: the separations are not shown separately, each separation is added to the
one before it:
 

 

Separations in Black and White: each separation is shown in black and white, not in color:
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Position

 Selects the position of the mark by moving the red rectangle (the mark) in the blue
rectangle (the job borders).

Attach to: Margins, Borders, Visible Objects, objects.

Offset 

Allows to apply an extra offset to the chosen position using .

 Selects the orientation of your mark.

Center Mark
The Center Mark Options dialog has two tabsheets: Mark and Inks.
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Mark

There are four kinds of Center Marks:

•

•

•

• From file: 

Marks
Attach to: Margins, borders, objects, visible objects.

Object Name: enter the object name of the object you want to attach the mark to.

Define the vertical and horizontal dimensions 

Define the diameter: 

Define the thickness of the mark's lines.

Defines the distance between the mark and the jobborders. 

Mark
Attach to: Margins, borders, objects, visible objects.

Object Name: enter the object name of the object you want to attach the mark to.

Every aspect of this Center Mark can be defined:
 

 

From file: mark
If you have really specific needs, you can always design your own mark and use this option to place it as
a Center Mark.

416



8PackEdge

Attach to: margins, borders, objects, visible objects

Object Name: enter the object name of the object you want to attach the mark to.

 Defines the distance between the mark and the jobborders.

Inks
Ink

• Registration
• Darkest
• Black or Darkest

Note:

Black or Darkest selects any black (process, pantone) if it exists. If they dont exist, the
darkest ink is taken. This option ensures that a black ink is used for the marks, even if the
job contains a (darker) ink like Reflex Blue

• Black

Note:

This option will select any black (process or pantone). If no such ink exists, process black is
added to the ink table.

• Knock Out
• Custom Ink allows to pick any number of inks, either by name or by position (in the inks list).
• Custom Color allows you to pick a color, based on the ink name, ink number or color name.

Overprint

• Opaque
• Darken ('Esko overprint')
• Postscript
• Add
• Reverse: Knocks out the selected ink in the underlying separation. If you select for instance

Magenta, it will be knocked out in the Magenta separation.

Ignore Similar Inks: This option becomes available when you selected Registration ink

Tip:

This is useful when you have similar inks in your job, e.g. two cyans with a different angle, and
you want to step all the inks but you only want to have one cyan.

Ignore Technical Inks: Technical inks will not be used in the SmartMark. This option becomes available
when you selected Registration ink.

Ignore Varnish Inks: Varnish inks will not be used in the SmartMark.

Corner Mark
The Corner Mark Options dialog has two tabsheets: Mark and Inks (This tab is the same as the Center
Mark's Inks tab, see Inks on page 417).
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Mark

There are five kinds of Corner Marks: , , , , from file: 

 

 
 

 

Changes the vertical / horizontal size of the mark.

 

 

Changes the thickness of the lines of the mark.

 

 

Allows you to change the position of the mark.

 

 

Allows you to define the vertical / horizontal distance between multiple corner lines.

Dimension Line
The Dimension Line measures and displays the horizontal and/or vertical dimensions of an object, job
borders and/or margins.

The Dimension Line Mark has four tabsheets: Text on page 418, Inks on page 417, Position on page
415 and Value on page 419.

Text
Allows you to define the font, weight, size, style.

Settings
Allows you to indicate where you want to place the Dimension Line: (Click the white arrow to position
the Dimension Line, the arrows turn black).
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Attach to: margins, borders, objects, visible objects.

Object Name: enter the object name of the object you want to attach the mark to.

Define the distance between the Dimension Line and the border, margin, object. 

Define the thickness of the mark's lines. 

Value
 

 

Values are expressed in: choose units, the default unit is the one defined in the document set -up.

Enter the number of decimals, check the 'Add Unit' toggle if you want to add the unit to the value.
 

 

Gallus
Allows you to define the positioning of Gallus strips left and right with your specific values.
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Icon/name Explanation

 

 

You can enter your values in the boxes.

Tip:

Enter negative values in  if you want the gallusmarks
to appear inside the borders.

 

 

Allows you to select the Gallus mark by clicking  and/or 

OK When you click OK, the settings will be activated in the job and the dialog box
closes.

Cancel This closes the dialog box without changing the settings.

Apply This applies changes to the settings but the dialog box will not close.

Ellipse
The ellipse mark has three tabsheets: Ellipse, Inks on page 417 and Position on page 415.

Ellipse
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Enter the height and width of the ellipse.

Select the Fit to Trim Box (Borders) toggle if you want the width and height to be fitted to the trim box
dimensions. This will activate the Extra Length input box and will allow you to make the mark as long as
the anchor object (borders, margins, named object...) of your job.

You may opt to give the mark a stroke instead of a fill. Select the Stroke toggle and enter a width.

Tint: Enter a percentage. If you enter 50 %, the mark will be shown using 50 percent of the inks.

Bar code
The Bar code has four tabsheets:

Bar code
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For more information, please refer to the chapter on Bar Code on page 330.

Box
 

 

For more information, please refer to the chapter on Bar Code on page 330.

Inks
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Ink

• Registration
• Darkest
• Black or Darkest

Note:

Black or Darkest selects any black (process, pantone) if it exists. If they dont exist, the
darkest ink is taken. This option ensures that a black ink is used for the marks, even if the
job contains a (darker) ink like Reflex Blue

• Black

Note:

This option will select any black (process or pantone). If no such ink exists, process black is
added to the ink table.

• Knock Out

• Custom Ink allows to pick any number of inks, either by name or by position (in the inks list).
• Custom Color allows you to pick a color, based on the ink name, ink number or color name.

Overprint

• Opaque
• Darken ('Esko overprint')
• Postscript
• Add
• Reverse: Knocks out the selected ink in the underlying separation. If you select for instance

Magenta, it will be knocked out in the Magenta separation.

Ignore Similar Inks: This option becomes available when you selected Registration ink
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Tip:

This is useful when you have similar inks in your job, e.g. two cyans with a different angle, and
you want to step all the inks but you only want to have one cyan.

Ignore Technical Inks: Technical inks will not be used in the SmartMark. This option becomes available
when you selected Registration ink.

Ignore Varnish Inks: Varnish inks will not be used in the SmartMark.

Position
 

 

 Selects the position of the mark by moving the red rectangle (the mark) in the blue
rectangle (the job borders).

Attach to: Margins, Borders, Visible Objects, (named) objects.

Offset 

Allows to apply an extra offset to the chosen position using .

 Selects the orientation of your mark.
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Gradation Strip
The Gradation Strip allows you to create a strip for all the inks in the job.

Tip:

The Gradation Strip can be moved in your job by simply using the Move Tool  in the toolbar.

The Gradation Strip dialog box has four tabsheets:

• Gradation
• Numbers
• Position
• Inks on page 417 (this tab is the same as the Center Mark's Inks tab).

Gradation

Length Choose the length of your mark from the dropdownlist.

• Specific: define the specific length of the strip
• Fit: the strip fits in your job. You can add an extra length.
• Single copy: puts the strip one time in your job, no matter how big the job is.

Gradations Allows you to specify the list of comma separated percentages and at the same time the
amount of gradations boxes per ink.

Example: In the menu the sizes of the gradation boxes are 5x5 and the gradations are 3, 25, 50, 75, 98,
99, 100.If the job has 4 inks this will generate a strip with 4 parts, a part for each ink, and per part you
will have 7 gradation boxes. These 4 parts will be repeated until the length of the strip specified in the
menu is reached.

 Specifies the height/width of your gradation box.

Add Gradation Numbers Makes the Gradation Numbers tab sheet available.

Numbers

When you activate the 'Add Gradation Numbers' toggle you can access the 'Gradation Numbers' tab
sheet. In this sheet you can define the Gradation Numbers' position, font and ink.

 To choose the location of the Gradation Numbers. The numbers can be placed
above, in or under the strip.

 To choose the orientation of the Gradation Numbers.

 To choose the distance between the Gradation Numbers and the Gradation Strip.

Font: To choose a font from the dropdown list.
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Weight To choose a weight ('Roman' or 'Bold') from a dropdown list.

Style To choose a style ('Upright' or 'Italic') from the dropdown list.

Available styles depend on the selected font.

Size To choose a size from the dropdown list.

Ink You can choose two things.You can choose the overprint mode and you can choose the color of the
ink.

The Overprint Mode:

• Opaque
• Darken ('Esko overprint')
• Postscript
• Add

The color of the ink:

• Follow ink and gradation: the number has the same percentage of the ink of the corresponding
gradation box.

• Follow ink: the number has 100% of the ink of the corresponding gradation box.
• Registration
• Darkest Ink

Position

 Selects the position of the mark by moving the red rectangle (the mark) in the blue
rectangle (the job borders).

Attach to: Margins, Borders, Visible Objects, (named) objects.

Offset 

Allows to apply an extra offset to the chosen position using .

 Selects the orientation of your mark.

Inks
Ink

• Registration
• Darkest
• Black or Darkest
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Note:

Black or Darkest selects any black (process, pantone) if it exists. If they dont exist, the
darkest ink is taken. This option ensures that a black ink is used for the marks, even if the
job contains a (darker) ink like Reflex Blue

• Black

Note:

This option will select any black (process or pantone). If no such ink exists, process black is
added to the ink table.

• Knock Out

• Custom Ink allows to pick any number of inks, either by name or by position (in the inks list).
• Custom Color allows you to pick a color, based on the ink name, ink number or color name.

Overprint

• Opaque
• Darken ('Esko overprint')
• Postscript
• Add
• Reverse: Knocks out the selected ink in the underlying separation. If you select for instance

Magenta, it will be knocked out in the Magenta separation.

Ignore Similar Inks: This option becomes available when you selected Registration ink

Tip:

This is useful when you have similar inks in your job, e.g. two cyans with a different angle, and
you want to step all the inks but you only want to have one cyan.

Ignore Technical Inks: Technical inks will not be used in the SmartMark. This option becomes available
when you selected Registration ink.

Ignore Varnish Inks: Varnish inks will not be used in the SmartMark.

Grid Mark
Places marks on the vertical sides of external references. Is meant mainly for repetition blocks
(microdots...) The Grid marks has three tabs:

• Mark on page 427

• Inks on page 417

• Position on page 428

Mark
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The Grid Mark works with circles, rectangles or images. Choose the type of mark and fill out the
dimensions, or browse to the image you want to use.

Position
 

 

1. Define the horizontal copies. Put a mark on the left/ right and / or middle stations.
2. Define the vertical copies: 1 per column or one mark every x rows (enter the number of rows).
3. The position of the marks: define the horizontal shift (only affects the marks attached to the left

and right stations)
4. The vertical position of the marks: attach them to the left station/column or to the right one.

Select the relative position of the mark by moving the red rectangle (the mark) in the blue rectangle
(the stations). Define an offset if needed.

Rectangle
The Rectangle Mark has three tabsheets:

• Rectangle on page 429
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• Inks on page 417 (this tab is the same as the Center Mark's Inks tab)

• Position (it's the same tab as the position tab in the Gradation strip Mark.)

Tip:

The Rectangle can be moved in your job by simply using the Move Tool  in the toolbar.

Rectangle

 Enter the Rectangle's vertical and horizontal dimensions.

Select the Fit to Borders toggle to make the mark as long as the borders of your jobYou can even add
extra length when the 'Fit to borders' toggle is selected.

You may opt to give the Rectangle Mark a stroke instead of a fill. Select the Stroke toggle and enter a
width.

Standard Mark
The Standard Mark dialog box consists of two tab sheets:

• Marks: The Standard Mark allows you to add various items to your job. To activate a specific item,
just click on it (the item will turn black). To insert a text, click on the word 'text' and you will be able
to type.

• Settings on page 429: allows you to define size, fonts, distances of the Standard Marks.

Settings
General: Define the 'Distance to borders'.

Cut/Bleed Marks:

 To select the vertical size of cut/bleed marks.

 To select the thickness of the cut/bleed marks.

Bleed: To change the distance between the marks and the job borders.

Center Marks

 To change the size of the center marks.

 To change the diameter of the center mark.

 To define the thickness of the cut/bleed marks.

Gradation Strip

 To specify the height of your gradation box.
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 To specify the width of your gradation box.

Start: define the percentage of the first (top) grayscale box. The default value for the start is 100%.

Stop: define the percentage of the last (bottom) grayscale box.

Step: define the percentage step between two grayscale boxes.

Style:

Font: choose a font from a dropdown list.

Weight: choose a weight ('Roman' or 'Bold') from a dropdown list.

Style: choose a style ('Upright' or 'Italic') from a dropdown list.

Size: choose a size from a dropdown list.

Standard Strip
The Standard Strip has three tabsheets:

• Strip

Extra Length: if the 'Fit to' (borders/margins/objects) toggle is selected, you can define extra
length.

Resolution: enter the mark's resolution in ppi.
• Inks on page 417 (this tab is the same as the Center Mark's Inks tab)
• Position on page 426 (it's the same tab as the Gradation Strip's position tab.)

Tip:

Note that the Strip can be moved in your job by simply using the Move Tool in the toolbar.

Text Mark
The text Mark consists of three tabsheets:

• Text tab
• Inks on page 417 (this tab is the same as the Center Mark's Inks tab).
• Position on page 415 (it's the same tab as the Image Mark's position tab.)

Text tab

To create additional text on a specified position and orientation.

Tip:

The Text Mark can be moved in your job by simply using the Move Tool  in the toolbar.

Also note that you can resize the Text Mark dialog window to fit your needs. Just click and drag
one of the corners of the dialog box.

Automatic Size If 'Automatic Size' is selected, the text box will be generated automatically. The size of
the box will depend on the size of the text.
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When choosing 'Automatic Size', quadding modes will be ignored.If you deselect 'Automatic Size', you
can enter the values for the text box yourself.

Text

You can write the text in the window.

Style...
Clicking 'Style...' opens the Text Style dialog box:

Tip:

For more info on the Style options, please refer to the chapter on the Text Style Bar in the Text
Menu

• Font
• Font Weight
• Leading
• Size
• Style
• Horizontal Quadding
• Vertical Quadding

When you select 'Advanced', the Text Style dialog box expands (  and 'Apply Fully' become available)

Note:

In 'normal' mode, style changes are always applied to the complete text. In 'Advanced' mode,
style changes are inserted at the current cursor position, except when you click 'Apply Fully'.
When 'Apply Fully' is clicked, the settings are applied to the mark.

When you click the envelope, other options are added to the Text Style dialog box:

•
Superscript 

•
Subscript 

•
Underscore 

•

Slant 
•

Distort 
•

Track 

Smart Text
Smart text fields are text codes that correspond to certain attributes of the job. During text lay out,
these text codes are replaced by their value. If during editing these values should happen to change,
the smart text field will be recalculated.

Clicking 'Smart Text...' opens the Smart Text dialog box.
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Select a category from the left column and a topic from the right column.

The categories are:

• Ink / Color on page 432
• Document on page 432
• Date / Time on page 433
• Typographic on page 433
• User Information on page 433
• ReportMaker on page 433
• SmartNames: Lists all the SmartNames known on the Automation Engine server
• Output Parameter on page 433
• CAD Data on page 434
• XMP Data on page 434

Ink / Color

Ink name Inserts ink names, you can select the inks by the ink colors.

All ink names Inserts the names of all the inks in your job

Ink attribute Inserts attributes of inks. You select the ink by the ink number.

Available attributes are

• name: the name of the ink as shown in the inks dialog

• shortname: e.g. Reb for Reflex Blue

• angle: the ink's angle

• lpi / lpmm / lpcm: the lineature of the ink

• inkbook: (only fo rPantone Ink books) returns C, M or U for coated,
matte and uncoated inkbooks.

• dot: the inks dotshape

• group: the ink's group (Process, PANTONE)

• type: the ink's type (Normal, Opaque, Varnish, Technical)

• number: the ink's number

Ink coverage Inserts the Ink coverage. Select the ink by entering the number. Choose a
unit (percent, mm, cm, inches).

Ink coverage (all pages) Inserts the Ink coverage (all pages). Select the ink by entering the number.
Choose a unit (percent, mm, cm, inches).

Total Ink Coverage Inserts total ink coverage value. Choose a unit (percent, mm, cm, inches).

Document

File name Inserts the name of the file.

Job V size Inserts the vertical size of the job.
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Job H size Inserts the horizontal size of the job.

Job sizes Inserts the vertical and horizontal job sizes

Page number Inserts the page number.

Document info Inserts the text that was entered in the Document Info dialog box.

Document version Inserts the version number of the document. See Document Info.

Modification date Inserts the modification date.

Localized Modification
Date

Inserts the job's localized modification date. Choose a format: date, long
date, time...

Colorspace profile Inserts the document's color space profile name..

Date / Time

Date Inserts the current date (dd-MMM-yy)

Time Inserts the current time (hh:mm:ss)

Localized Date and Time Inserts localized date and time. Choose a format: date, long date, time...

Typographic

Superscript Puts text in superscript.

Subscript Puts text in subscript.

Normal Makes text normal (without characteristics).

Underline On Underlines the text.

Underline Off Counters the Underline On option.

Elastic Inserts an elastic whitespace.

Space Inserts an fixed white space. You can define the fixed space.

Vertical space Inserts a vertical fixed space. You can define this space yourself.

User Information

User Name Inserts the user name.

Workstation Name Inserts the workstation name.

ReportMaker

Scale factor inserts a scale factor applied to the task input file.

Output Parameter
These strings of information are derived from the output settings in the editor, or from the ticket used
on the server.

Resolution Inserts the resolution.

Color Strategy Inserts the color strategy used.
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Screen Based DGC Inserts the curve strategy used.

DGC Inserts the DGC settings.

Dotshape Inserts the dotshape used in the job.

V /H Distortion Inserts the used vertical/horizontal distortion settings used.

V/H Scale Inserts the used vertical/horizontal scale settings used.

Device Inserts the device name.

Configuration Inserts the color strategy used.

Emulsion Inserts the emulsion settings.

Image Inserts the used image settings..

Screen Angle Direction Inserts "CCW" (counterclockwise) when used in an expose ticket on
imaging engine when screen angles are set to counterclockwise. In all
other situations, it will be "CW" (clockwise).

CAD Data

Design Inserts data from the CAD design (if available): Description, Name,
Length, Width, Depth

Customer Inserts customer information (if available): Name, Adress1, Adress2,
City

Board Inserts data from the CAD database (if available): Code, Description,
Flute, Caliper

XMP Data

Artwork Inserts Artwork information, choose from the dropdown list.

Bar codes Inserts bar code xmp information, toggle the ones you need: type,
code, bar width reduction, device compensation, magnification,
magnification in percentage, X- dimension, ratio.

External References Inserts all external references, choose a separator: dash, space, new
line.

Fonts Inserts all font names, choose a separator: dash, space, new line.

Inks Inserts XMP ink data, toggle the ones you want: name, group, lpi, angle,
dotshape, type. also choose a separator: dash, space, new line.

Layers Inserts all layer names, choose a separator: dash, space, new line.

Job Inserts XMP information on a Job, choose between Description, Order
ID, SubOrder ID

Trim Mark
The Trim Mark places itself only around externally placed jobs (Esko native, PLA, STA files), the user
interface is the same as the Corner Mark's user interface.
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When you select the second type of corner mark  an extra option becomes available. Check the
left option to put trim marks around the stations, taking into account only the outer stations. Check the
right option to put trim marks around the stations, but taking all stations into account. Trim marks will
be put outside the bounding box.

8.10.3.  Keyline... (Production Menu)

A lot of customers who prepare files for the Gravure and Flexo printing, need a mechanism to easily
create basic keyline layouts. The layouts normally come as part of a conventional artwork or as part of
a technical job description diagram.
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Overview

Icon Explanation

 

 

The vertical and horizontal dimensions of the job borders can be defined in the input
fields. The values are by default those of the document size. Changing the values will
modify the document size.

 

 
 

 

You can fill in as many values for horizontal and vertical lines as is needed.

 

 

Allows you to define lines and text for total format. Please refer to Options on page 437.

 

 

Allows you to define lines and text for the different vertical and horizontal parts. Please
refer to Options on page 437.

How do you use the Keyline tool

1. Check or set the vertical and horizontal dimensions of the job.
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2. Specify the different vertical and horizontal subregions. If the total of the subregions do not match
the vertical and or horizontal jobsize, a warning will be generated.

3. Set the parameters for the global dimension lines.
4. Set the parameters for the dimension lines corresponding with the different subregions.

Options

The Keyline dialog box has two tabsheets: one for the dimensions of the whole job , and one for

the dimensions of the subregions  .

Icon/name Explanation

 

 

To display the lines.

 

 

To display the numbers.

 

 

Selecting this toggle adds a markup grid with the same values of the different
vertical and horizontal parts.

Note:

This option is only available on the  tab sheet.

 

 

To define the distance between the Keyline and the job borders.

 

 

To define the thickness of the lines.

Font To choose a font from a dropdown list.

Weight To choose a weight ('Roman' or 'Bold') from a dropdown list.

Style To choose a style ('Upright' or 'Italic') from a dropdown list.

Size To choose a size from a dropdown list.
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Note:

• The use of the Keyline tool will introduce a new ink to your job. This ink is always called

Keyline and is marked as a technical link .

• Note also that the keylines are part of a separate layer, so they can be viewed, modified...
accordingly. See Layer Browser (Window menu) on page 535.

8.10.4.  Seamless... (Production Menu)

The Seamless Tool allows you to repeat red selected objects.

Repeat size overview

Icon/name Explanation

 and 

To define the vertical/horizontal repeat size. Default, this is the size of
the job borders.

 and 

To select or deselect the seamless repeat directions. If you want to
repeat an object for instance seamless only in the vertical direction,

make sure to select only .

Basic cell overview

Icon/name Explanation

 

 

To define the angle.

 

 

To define the verticalstep. Clicking this icon gives you the possibility to select
three repeat options.

•
 You can define the 'gaps'.

•
 You can define the distance from 'center to center'.

•

 You can select 'scale to fit'.

  Allows you to define the horizontal step. Clicking this icon gives you the
possibility to select a repeat option.
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Icon/name Explanation

 

•
 You can define the 'gaps'.

•
 You can define the distance from 'center to center'.

•  You can select 'scale to fit'. The selection is repeated without gaps,
the cell is scaled so that it fits seamlessly.

 

 

Allows you to define the indentation. Clicking the icon gives you the possibility
to select between:

•
 You can define the indentation with numbers.

•
 You can define the indentation with a percentage of the step between

two cells (the step = the width of the cell plus the horizontal gap between the
cells).

List Top X
Suggestions

It is not unlikely that the system generates an lot of possible matches. This
feature allows you to define the number of matches you want to see.

 

 

To resize the dialog box.

8.10.5.  Die Object Properties... (Production Menu)

Importing CAD files (CFF2, DDES, DXF, ARD, MFG), results in a 'die object'. This object remembers the
name of the file is was generated from. This information is also stored in the header of the Esko native
file (allowing LinkEdge to pack the cad file as well, VRML export to create a 3D output, CADX Textfields
to retrieve CAD properties).

Die objects can only be moved, they can not be scaled or rotated using the normal transform tools.
Rotation be done through the 'die object properties' dialog (using the 'Degrade to objects' option in the
Arrange Menu [Alt+i]). Die objects can be degraded to normal objects.

Die objects can be visualised using all structural lines  or cut lines only . Using a die
object, it is possible to generate a bleed line by selectively remove flaps from the cad design.

Note:

A name is automatically assigned to a die object: 'Die'. A Die object is also a Named Object and
can be used to attach SmartMarks to.
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When a CAD file has no bleed lines, the 'Load from Die' option will be grayed out. It should however
always be possible to generate bleed lines based on the original CAD data. When generating bleed
lines, the original CAD file is opened (for DXF files, the original rule mapping table is used) and CAD-X
will generate a bleed contour.
 

 

Clicking inside a flap will remove the flap from the bleed contour. Your mouse pointer will become
different. Undo (ctrl-z) will re-add the previous flap, clicking on the reset button will restore the original
situation (all flaps used).

Clicking on the 'Accept' button will add the current bleed contour to the editor's database. This contour
is a normal editable contour (in other words, not part of the die-object).
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Note:

The Die Object Properties dialog is also used to show the File Name of the selected Studio
Toolkit for Flexibles BAG file in the document. You can change the BAG Object's rotation
by using the orientation buttons in this dialog. The other functionality of this dialog is not
available when a BAG object is selected.

8.10.6.  Shrink Sleeve Warp... (Production Menu)

The use of thermo-shrinkable sleeves is becoming more popular. These sleeves are printed and
glued as normal cylindrical sleeves and 'shrunk' around an object by applying hot air. 'Shrink sleeve
warping' offers a set of warp tools to compensate for the distortion that is applied to the graphics while
shrinking the sleeve.
 

 

The basic principle of this module is that the distortion is proportional to the diameter of the object.
The diameter of the object is defined by a green selected contour that represents the right hand
side of the profile of the object. While this assumption makes the definition of the warp grids
straightforward (only a description of the profile is needed) - it's up to the operator to decide how
certain objects need to be compensated (if any compensation is necessary).

As soon as a valid profile contour is selected in green, the 'Bottle' and 'Sleeve' group will show the height
and the width of the corresponding object. Increasing the height and the width of the sleeve will add an
extra overall scaling to the design.
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Note:

The tool calculates the diameter of your bottle by looking at the contour and the distance from
the crosshair. Take this in account If the system warns you that the green selection is not valid.

The 'warp type' group contains 4 possible warp modes. All warp modes will compensate proportional to
the ratio of the sleeve width to the diameter of the object (indicated by the profile contour).

• The first warp type creates a warp grid centered on all red selected objects and warps these
objects. As the warp tries to compensate for changes in the horizontal distances during shrinking,
parallel vertical lines will not remain parallel.

• The second warp type creates a similar warp grid but centers this warp grid on each group found in
the red selected contours.

• The third and forth warp type apply a 'constrained' warp - they apply a scaling and offset
corresponding to the shrink at the center of each object. As a result, there's a compensation for the
shrinking but the object itself is not distorted (vertical lines remain vertical).

The 'Export to VRML...' button exports your file to a wrl file, which can be visualized with a VRML
viewer. (Virtual Reality Modeling Language)

In this example, the clock becomes distorted when shrinkwrapped.
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To remedy this, we use the Shrink Sleeve Warp tool.

 

 

The clock is warped, but when shrunk, it fits:

 

 

8.10.7.  Inspection Setup

Inspection Setup allows you to define Inspection points or Inspection boxes in your job.

For each of these Inspection points, you will see the Lab value and DeltaE. For every Inspection box,
you can set the Profile. Inspection points and boxes will be exported, e.g. to be used in an Inspection
System in inline presses. This Inspection System will warn if the values measured at a specific position
are more different from the entered Lab values than the allowed deltaE, or if the Inspection box doesn't
match the defined profile.

Inspection Setup consists of

•
the Inspection Setup tool , under the Eyedropper tool in the toolbar

• the Inspection Setup palette, which can be opened by selecting the Inspection Setup tool, or by
adding an Inspection point.
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Adding and changing Inspection points
The Inspection Setup palette shows all the Inspection points, indicating the coordinates (distance
from the top left corner of the trim box), Lab value and default deltaE value.

•
Select the Inspection Setup tool  from the eye dropper toolbar and click in the job to insert a
new Inspection point.

The Inspection point will be visible in the job, with its number next to it.
• Select an Inspection point in the palette to highlight the corresponding Inspection point on the

document. You can select multiple Inspection points
•

Select one or more Inspection points and click the delete button  to delete the Inspection
points

• You can manually change the Lab and deltaE value for every Inspection Point.
•

Click the Refresh button  to update the Inspection Point list.
• You can move an Inspection point in two ways:

• Click within the Inspection point, and drag it to the new location
• In the Inspection Point list, change the coordinates for the Inspection point.
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Adding and changing Inspection boxes
The Inspection Setup palette shows all the Inspection boxes.

•
Select the Inspection Setup tool  from the eye dropper toolbar and click and drag in the job
to insert a new Inspection box.

The Inspection box will be visible in the job, with its number next to it. When creating a new
Inspection box, the Default Profile is used

• Select an Inspection box in the palette to highlight the corresponding Inspection box on the
document. You can select multiple Inspection boxes.

•
Select one or more Inspection boxes and click the delete button  to delete the Inspection
boxes

• You can manually change the Profile.
• You can move or change an Inspection box in different ways:

• Click on the center point of the Inspection box, and drag it to move the Inspection box to a new
location

• Click one of the 8 handles on the Inspection box, and drag to modify the Inspection box

Import and Export
When saving as normalized PDF, Inspection points and boxes added to a job are saved in the PDF file,
and these Inspection points and boxes will be recognized by DeskPack and Automation Engine.

Also, when opening a normalized PDF from another Esko product (such as DeskPack), the Inspection
points and boxes information stored in the PDF document will be shown in the Inspection Setup
palette.

8.10.8.  Studio Designer (Production Menu)

See Studio Designer on page 78

8.10.9.  InkWizard... (Production Menu)

InkWizard is a tool to convert some objects or a whole job into another color space. InkWizard can
convert both linework and images.

Why use InkWizard

Convert a job to a multi-color process
A multi-color process is a fixed set of inks that be used to print a wide variety of colors. CMYK is by far
the best known multi-color process. But CMYK is not capable of reaching the bright saturated colors
that a lot of packaging designs require.
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The common practice for these bright colors is to use a spot color, this is an ink that's only used to print
one (or a few) colors in the design.

An alternative is use a multi-color process of more than four inks that can achieve a wide color gamut.
instead of printing with special inks that are defined by the design, a fixed set of inks is used to
compose all the required colors.

A lot of money can be saved by printing different jobs in the same inkset. This reduces washout times,
ink waste and press downtime. Different jobs could also be printed next to each other in the same
press run without requiring more inks.

InkWizard will help you converting your jobs to any multi-color process.

Match one press to another press
A job has been printed on one press and now it needs to be printed on another with identical colors. To
do this, InkWizard can convert all CMYK linework and images in the job from one color profile to another
color profile.

The InkWizard dialog
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Settings
All InkWizard settings (including ink settings and exceptions) can be saved in an XML file. Use the flyout
menu at the topright corner of the InkWizard dialog to load and save the settings. Click on the arrow to
the left to hide and show the settings.

If you bought an InkWizard Opaltone license you can load your Opaltone settings directly from the flyout
menu.
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Destination Space
Destination Profile: Choose a color profile for your destination color space. The list shows all print
profiles in the color database. These profiles are either measured in Kaleidoscope or imported ICC-
profiles. The small inkpatches show the number of inks and their color.

Set Profile as document Profile: the selected profile will be set as document profile, if a document
profile was defined already it will be changed.

Blend Mode for Composite Colors: Select a blend mode from the dropdown list. This settings applies
to all objects that are composed of several inks and that are not pure CMYK. This includes multi-
channel images, fills with two or more spot colors and vignettes with two or more spot colors. To
calculate a new color for these objects, InkWizard converts the different ink components separately
and blends those results into a single color. With this settings you can choose what blend mode is used
to calculate this final color.

Example: Consider a mixed color of 10% black and 100% Pantone 200 (Dark red).

"Darken" is the default option and the only option in earlier versions of PackEdge. With this option
the effect of converting the mixed color is the same as putting the dark red and the 10% black into
separate objects in overprint (or in darken blend mode) and then converting both objects. Because of
the nature of the darken blend mode, the 10% black isn't making the dark red any darker (the dark red
might already have 10% or more of black). So this might not give the expected result.

The option "Multiply" ofter does a better job simulating the appearance of overprinting inks. The effect
of converting the mixed color with this option is the same as putting the dark red and the 10% black in
separate objects with blend mode "multiply" and then converting both objects.

Inks: Push this button to show the Destination Inks dialog. In this dialog you can set the ink and
screening settings that will be used by all the converted colors. By default the ink name is read from
the destination profile, but it can be overridden by typing in another name.

Render Intent:  When colors are converted to the destination color space, this render intent will be
used.

Minimal Linework: To prevent very small percentages in the converted colors, specify a minimal
linework percentage. Percentages lower than this value will simply be deleted from the converted
colors. This value does not affect the conversion of images.

Flatten document: To prevent unexpected results when converting a job that contains transparencies
or blend modes, the Flatten document can be used to flatten the job first. All blend modes and
transparencies will be replaced by objects that do not contain blend modes, but give the same final
result. The flattening is done before any remapping, using default settings. See also Flatten Objects on
page 46.

Composite CMYK
Convert CMYK Linework: When toggled on, linework objects with CMYK colors will be converted to the
destination color space. If this toggle is off, the linework objects keep their CMYK percentages, but the
inks will be replaced by the first four destination inks.
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Convert CMYK Images: When toggled on, CMYK images will be converted to the destination color
space. This is done by creating a new CT file next to the original one and replacing the image in the job
by the new file. So the original image is not lost.When this toggle is off, CMYK images will still be plane
mapped to the first four destination inks. (See below for spot color images)

Link Profile: Link profiles describe a transformation from 1 device dependent color space to another.
This is actually a concatenation of a forward transformation of 1 profile and a backward transformation
of another profile. the dropdown list only shows those link profiles that have the document profile as
source profile.

Map Black on Black: This option is only available when converting from CMYK to CMYK. When toggled
on, the CMY-part of the composite colors are converted separately from the black component. As a
result, the type of black separation (Skeleton, UCR, GCR...) is preserved by the conversion. (It is still
possible that the black percentage changes slightly due to different dot gain in the color profiles.)
When toggled off, the converted CMYK colors are completely re-separated into the black behavior that
is built into the destination profile.

This option is only available when converting CMYK colors to a Kaleidoscope CMYK profile.

If you want to preserve just the gray tones, then add process black as an exception ink (see Exceptions
and Designer Inks on page 449).

Converting Pantone Inks
Convert Pantone Inks: If toggled on, Pantone inks in the job/selection will be converted to an
equivalent mixed color in the destination color space. If toggled off, the Pantone inks in the job/
selection will not be converted and will still exist after the conversion.

InkWizard supports different methods of converting Pantone colors:

• Use destination profile

This method will match the measurements of the Pantone color (as they are stored in the color
database) to the destination profile using the specified render intent. The quality of the color-
match and the type of separations are defined by the destination profile.

• Smallest delta E

This method is similar to the one above, but InkWizard will overrule the separation behavior that
was built into the profile and look for the closest match while using as little inks as possible.

To do this, InkWizard still needs the destination profile but only for the measurements, not for the
separation behavior. This method can be a very good choice in case you have an ICC destination
profile that is good at predicting the press output but doesn't generate the separations that you
were hoping for.

• Pantone Solid to Process (Euroscale) Pantone Solid to Process (SWOP) With these methods, the
Pantone inks are converted to Euroscale/SWOP CMYK according to the percentages published by
Pantone. InkWizard will use the first four destination inks to create the equivalent colors.

• Pantone Solid to Hexachrome Coated With this method, the Pantone inks are converted to Pantone
Hexachrome according to the percentages published by Pantone. InkWizard will use the first six
destination inks to create the equivalent colors.

• hp IndiChrome color guide With this method, the Pantone inks are converted to the hp IndiChrome
process according to the percentages published by Hewlett-Packard. InkWizard will use the first six
destination inks to create the equivalent colors.

Exceptions and Designer Inks
By default only CMYK colors and Pantone inks are converted (see above). To finetune this conversion
process and to allow other colors (designer inks) to be converted, you can define a list of exceptions.
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For every exception color you can manually define the conversion. To see the list of exceptions, press
the Edit... button (see Exceptions and Designer Inks dialog)

Keep Technical/Opaque/Varnish inks: If toggled on, the inks that have the inktype "Technical", "Opaque"
or "Varnish" will not be converted, ignoring all the other InkWizard settings (including the exceptions). If
toggled off, these inks will follow the same rules as normal inks.

Exceptions and Designer Inks dialog

 

 

The list shows all exceptions. If you select an exception, its details are shown at the bottom.

There are two kind of exceptions: Inks and CMYK colors For Inks you have to specify the name, or the
LAB values, for CMYK colors you have to specify all four percentages.

You can import / export the exceptions list from/to a CSV file, This is a way to add new inks quickly.

The 'Add Ink Book': add a complete Ink Book to the exceptions list. This does not work for the PANTONE
ink bookwhen FM6Spot Color Conversion is selected in the PANTONE Inks group.

Sort the exceptions list: process inks first, then PANTONE inks and Designer inks.

Convert: When toggled on, the exception color will be converted according to the percentages set
below. If the exception color is known to the color database, a Delta-e value is calculated and displayed,
showing the estimated difference between the original color and the converted color.

When toggled off, the exception color will not be converted.

To create a new CMYK color exception, press the Add CMYK button. To create a new ink exception, just
click on the (new exception ink) and type in a name. (Use the Preview tool to add the inks in the current
job to the exception list).

Unregistered exceptions You can create exceptions for inks that are not (yet) known to PackEdge.

Export to Illustrator Palette

This option is available in the popupmenu at the topright corner of the dialog box. This option will write
a file that can be used as a Swatch Library in Adobe Illustrator.

With this feature you can create a big library of custom colors with a multi-color equivalent in the
exception list. Then you export this list to a Swatch Library and have the Illustrator designers use that
to create their designs. If such a design is imported into PackEdge, these colors will be unregistered
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designer inks. Now you can use InkWizard and your exception list to convert them automatically to the
intended multi-color equivalent.

Preview
The preview dialog can preview the conversion of all special inks (Pantone and designer) in the job (or
selection). If you press the preview button, the Preview Dialog is shown.

The preview dialog lists all the Pantone and designer inks in the current selection (or the whole job).
The small colorpatches show the conversion. The original color is at the left, the converted color is at
the right. If there is no converted color, the ink will not be converted and preserved.

If the original color is known to the color database and the color is converted, a Delta-E value is
calculated and displayed. The colors in the preview dialog are sorted by Delta-E.

You can keep the preview dialog open when changing the InkWizard settings to see the effect on the
conversion and the delta-E values.

The selected color is shown in detail at the bottom. If you would like to fine-tune the conversion, press
the Add Exception Ink (or Edit Exception Ink) button. This will open the exceptions dialog (see above)
and add the selected ink so you can start finetuning its conversion.

The process inks (cyan, magenta, yellow and black) are not shown in the preview dialog.

Convert
If you press the convert button, all selected objects will be converted according to the rules set above.
If nothing is selected, the whole job will be converted.

Note:

After being converted, the colors in the palette will be named to show what their original color
was.

How are objects converted

CMYK Images: When 'convert CMYK Images' is toggled on, then a new CT-file is created in the
destination color space. This file is written on the same folder as the original image file. The image
in the job is then replaced by this new file. The new CT-file can of course be edited in Photoshop or
ColorTone.When 'convert CMYK images' is toggled off, then the CT-file is not touched. However, in the
job, the image is planemapped to the first four destination inks.

Other Images: Any other image (typically with spot-colors) will be converted plane by plane. Every plane
is treated like a 'color'. i.e. if one of the image planes is in a Pantone color, the Pantone conversion
method is used. If an image plane is converting, then it is planemapped to the equivalent color in the
destination color space. Because InkWizard uses plane-mapping, there is no need to write another
image file. If you would like to edit the image in its converted form, then use the Save As... feature in
the PackEdge Image plane-mapping dialog. If the "Blend mode for Composite Colors" is set to "Multiply"
planemapping is not used and a new image is always created.

Linework colors (Fills and strokes) are converted one by one.

Vignette colors: The end-points are converted and a new vignette is created between the converted
end-points.

Spot color tones and mixed spot colors: The conversion of a certain percentage of a spot color will
be based on the conversion of the solid spot color.The conversion of a mixture of inks will be based
on the conversion of the separate components.To keep the job as editable as possible the object are
converted one by one. But sometimes a color in a design is achieved by putting several objects on top
of each other using transparency or blend modes. The InkWizard conversion tries to keep the color
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appearance of the separate objects intact, yet this can sometimes change the appearance of the
blended result drastically. Therefor it is always adviced to visually compare the converted job with
the original design file and make manual adjustments where needed. For example: The blend mode
"Darken" is very sensitive to what inks are used and the appearance can be very different after an
InkWizard conversion. Often this can be fixed by switching to blend mode "Multiply".

8.10.10.  Equinox (Production Menu)

For information about Equinox, we refer to the Equinox documentation. See https://www.esko.com/
en/support/product?id=Equinox

8.10.11.  Design Wizard... (Production Menu)

Design Wizard is a tool to create variations in an automated way. Design wizard is based on SmartMark
technology:: scripted objects such as boxes, images, text, bar codes...

This task is intended for generation of template based jobs with different content. The objects
that vary between the different versions are generated by SmartMarks. Design Wizard will simply
regenerate the SmartMarks using different data sets. These data sets come from a field in a database
(accessible from the Automation Engine server through ODBC) and are saved as an XML file in
Automation Engine.

To apply data to a design, you select and load an XML file, and you choose the Data Set. Define output
location and the file name. Click 'Save' to save the variant.
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These labels are basically the same, but the text is a bit different. The task gets the correct input from
an XML file:
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8.11.  PRC (Print Rule Checker) Menu

The common use of digital equipment in graphics arts has made it even more dicult to control the
quality of the work at stages prior to film or plate generation or, worse still, prior to printing. Detecting
an error that should have been fixed in pre-press, not earlier than on the press itself is a most annoying
and costly matter.

Print Rule Checker can help you to avoid these belated discoveries as much as possible. It inspects
jobs, completely or partially, for potential printing problems and violations of standard printing
conventions. Insucient line thickness or object dimensions, wrong halftone densities, the use of too
many inks, and various other production related issues are instantly brought up. A report file with a list
of all the errors that were found in the job can be generated.

PRC consists of three modules:

• Rules...

Consists of all possible sets of rules. In these module the rules which will be active during the check
phase will be selected. Device dependent parameters can also be initialized.

• Check...

Searches the job and the problems are detected and highlighted in real time. Additional information
or suggestions help you to decide if and how the problem needs to be fixed. All the tools in
PackEdge are at hand to do so. In some cases, automatic fixing is possible.

• Report...

Allows you to view the PRC report that was generated in the Check phase.

PRC is available as an option on PackEdge Stand-alone workstations.

Tip:

The performance of PRC can improve dramatically by using PSFix first.

8.11.1.  Rules...

To activate, edit or define specific rules you want PRC to use to check your job.

Before you start checking a file for errors, you have to edit the required Rule Settings file and activate
the rules (with their parameters) that you want to use for checking your job. PRC can save various Rule
Setting files, for every device or required quality. PRC saves the parameters in a file, which gives you
the possibility to select the Settings file of someone else.

Once the settings are initialized, every designer or operator can check a file with one of the created
settings.

When you choose Rules... from the PRC menu the Rules dialog box appears.
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Rules dialog box
The Rules dialog box allows you to select, create, modify, lock, unlock or delete Rule Settings files.The
Rules dialog box contains the following functions:

• Rule Settings files on page 455

• New on page 455

• Edit on page 455

• Lock/Unlock on page 456

• Delete on page 456

• Information box on page 456

PRC provides you with a standard package of Rule Setting files, created by Esko containing specific
parameters for different printing methods.

Rule Settings files
The Rule Settings files selector box lists all Rule Settings files available on your workstation. To select a
Rule Settings file you click its name.

PRC also contains a standard package of Rule Settings files, created by Esko containing specific
parameters for different printing methods. The following Rule Settings files are delivered by Esko:

• corrugated_hiq
• corrugated_loq
• flexo_flexiblepackaging
• flexo_foldingcartons
• flexo_labels
• gravure_chemical
• gravure_mechanical
• offset_sheetfed_commercial
• offset_sheetfed_pack

The Rule Settings files are Locked by default but can be personalized after locking / unlocking them.

Tip:

It is recommended not to change the Rule Settings files but in case you want to personalize
them, unlock them and save them under another name with the Save As button and then
perform the changes.

New
To create a new Rule Settings file.

When you click New, the New Rule dialog box displays.

Edit
To edit the selected Rule Setting file for modification.

Clicking the Edit button opens the PRC Rules Settings dialog box.
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Lock/Unlock
To protect your Rule Settings file with a password. When a Rule Settings file is Locked the Unlock
button is displayed in the Rule Settings dialog box. All the settings of the Rule Settings file display
dimmed.Clicking the Lock or Unlock button opens the PRC Lock Rulename dialog box or PRC Unlock
Rulename dialog box. Enter a password and hit 'OK'

Delete
To delete the selected Rule Settings file. When a Rule Settings file is Locked, it is not possible to delete
it. The Delete button displays dimmed.

Information box
Displays the selected Rule Setting file.

New Rule dialog box

To define the PRC Rule Settings for the new Rule Settings file.

Rule name The New Name input box allows you to define the file name for the new Rule Settings file.

OK To confirm the file name of the new Rule Settings file and to open the PRC Rule Settings dialog box.

Cancel To cancel the creation of a new Rule Settings file.

PRC Rule Settings dialog box

In the PRC Rule Settings dialog box you activate the Rules and define their values, that you want PRC to
check your job with.The different Rules and their parameters are grouped on tab sheets, according to
their application field. You find the following tab sheets in the dialog box.

• Paint tab sheet
• Small tab sheet
• Text tab sheet
• CT tab sheet
• Bar code tab sheet
• Registration Mark tab sheet
• Die Cut tab sheet
• OK
• Cancel
• Save as

Information input box
Displays the defined settings for the selected Rule Settings file. The operator is also allowed to write
personal notes, remarks and messages for himself or colleagues of another shift.

OK
To confirm and save the new Rule Settings file.

Cancel
To cancel the creation of a new Rule Settings file.
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Save As
To save the PRC Rule Settings file with a new name.The Save As button is not available when you are
creating a New PRC Rule Settings file.The Save As buttons displays dimmed when the PRC Rules File
has not been unlocked (see Lock/Unlock on page 456).

Paint tab sheet

To check paint characteristics like density, screen rulings, screen angles, number of inks and used dot
used in your job.

 

 

Critical densities
With Critical densities, you can define a minimum screen dot percentage and a maximum screen dot
percentage for vignettes and flat screen areas (solids), depending on the requirements of the output
device you will use. For flat screen areas, you can also define Keep 0% and Keep 100%.

In Gravure, for example, you can never have a screen dot percentage of 100%, because the Gravure
printing technique can not cope with this.

When you check whether your job complies with this rule, PRC will protest against inks that have
screen dot percentages

• Between 0% and the defined minimum

Typical for vignettes is that low dot screen percentages such as 1% up to 5% will be printed as dust
or not printed at all.

• Between the defined maximum and 100%

Typical for vignettes is that high dot percentages such as 95% up to 99% will not be printed, they
become 100%.

Note:

When you check the screen dot percentages, PRC will not detect 0% and/or 100% as a wrong
value when Keep 0% and/or Keep 100% are activated.
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Number Of Inks
To set the allowed number of inks, depending on the number of plates used on the printing
press.Technical inks (e.g. used for die, key line...) are not accounted for by PRC.

Angle Conflict

Note:

When all the ink densities of paint are 100%, PRC does not check the screening rules: Angle
Conflict, LPI Conflict and Dotshape Conflict.

With Angle Conflict, you define whether your job has to be checked for allowed screen rulings for offset
or flexo.Screening Rules are based on the mathematical moiré rules as should be followed when using
Esko screening technology.When the process is not an offset nor a flexo program, activate Other. In
that case PRC does not check any angles or screens.

Screen angles ALLOWED for...

• Offset: 0, 15, 45, 75, 90, 105, 165, 180 degrees

• Flexo: 7, 22, 37, 52, 67, 82, 97, 112, 127, 142, 157, 172 degrees8, 23, 38, 53, 68, 88, 98, 113, 128, 143, 158,
173 degrees

Furthermore, PRC checks the screen angle depending on the type of screens that you use.

• For Monet screens: the screen angles of ALL the separations must be different
• For Line screens and Eccentric Screens: the screen angles of the three darkest Inks must have a

difference of 60 degrees.
• For jobs that contain C, M and K (the main separations) , the screen angles of C, M and K have to

have a difference of 30 degrees.

LPI Conflict
The screen rulings of the inks have to be equal in one object, if not, moiré effect will occur in your
printed result.Activating LPI Conflict makes that the objects in your job are checked on their screen
ruling settings based upon this Rule Settings file.

Note:

When all the densities of paint are 100%, PRC does not check the screening rules: Angle
Conflict, LPI conflict and Dotshape Conflict.

LPI Range
With LPI Range you can specify the screen rulings that are used in your company, PRC will check if your
jobs comply with these screen rulings.

Example: When you specify that the screen rulings used in your company range from 80 lines per inch
to 120 lines per inch, PRC will protest when your job contains screen rulings different from this range.

Dotshape Conflict
Activate this button when you want to check if all the inks in an object have the same dot shape.

To print a job on the press, all the inks in an object have to have the same dot shape. Mixing dot shapes
within an object leads generally to worse printing results such as grey balance, possible slight moiré...
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Note:

When all ink densities of paint are 100%, PRC does not check the screening rules: Angle
Conflict, LPI conflict and Dotshape Conflict.

Note:

The exception on this rule are combinations with Monet Screens, which combine with every
possible dot shape.

Small tab sheet

The Small Tab sheet contains rules and parameters to check your job for insucient stroke widths and
objects that are too close.

 

 

Minimum
You have to fill out a minimum value for the positive status as well as for the negative status of an
object or stroke.

Tolerance
You can set a Tolerance percentage for the minimum line distance and minimum stroke width. However
when PRC detects a stroke width or line distance value lower then the defined minimum, but still in the
range of the defined tolerance percentage, the object will be ignored and PRC will not protest against
it.

Small Parts
When parts of the contour lines of one single object lie to close to each other, the space or distance
between these contour lines will not be visible anymore on the printed result and will appear as a whole.
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Tip:

Distance of 1mm is very strict, most presses easily print 0.2mm.

Example: The following image shows you the original job on screen and the bad printed result, PRC was
not used. On screen:
 

 

PRC was not used, see underneath the bad printed result.
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Close objects
The system checks for the contour line distances of different objects.

Bad printed result, where the objects lie to close to each other.
 

 

Correction 1: Put the objects more apart.
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Correction 2: Put the objects closer.
 

 

Small Strokes
Activate Small Strokes if you want PRC to check your job for problematic stroke widths.

The definition of parameters depend on the printing process that you will use. Check with the printer
operator the minimum stroke width the press can handle. Good starting points can be found in the
standard Esko Rule Settings files.
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Small strokes, Multiple Inks
When a stroke is made out of more than one ink, this stroke has to have a minimal stroke width, to
insure that all these inks are printed on top of each other when the printing press is out of registration.

Original on screen:
 

 

Result: Separations are shifted due to press misregistration.
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Small Strokes, Screened
When a stroke is made out of a screened ink, this stroke has to have a minimal stroke width to avoid a
jagged edge on the printed result.

Text tab sheet

The text tab sheet groups rules and parameters to check the printability of Text. You have to define a
minimum value.

Text can be compared with linework, and has the same attributes as linework.

 

 

Small Text
Activate Small Text if you want PRC to check your job for text that has a smaller pointsize than the value
you defined.If your text is too small, it is possible that the printable result is not readable anymore.
To solve this you set a minimum pointsize for positive text as well as for the negative text.Typically,
negative text is more dicult to print, while trying to keep it readable than positive text. Therefor the
pointsize for negative text is normally bigger than for positive text. Avoid setting the rules too strict.

Small Text, Multiple Inks
Activate Small Text, Multiple Inks when you want PRC to check your job for text with multiple inks that
have a smaller pointsize than the value you defined.When text is made out of more than one ink, the
font has to have a minimal pointsize, to insure that all these inks are printed on top of each other when
the printing press is out of registration.

Small text, Screened
Activate Small Text, Screened when you want PRC to look for screened text that has a smaller pointsize
than the set value in your job.When text is made out of a screened ink, the font has to have a minimal
pointsize to avoid a jagged edge on the printed result.
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Force Dark Text in Overprint
Activate this button if you want PRC to check your job for text that is not put in overprint. During
the error check of your job the text is set in Darken ('Darken ('Esko overprint') overprint').The
system measures the luminance of the paint to determine if the text is dark in comparison with the
background. The background has to be a solid object.The luminance does not take the ink coverage
into account. PRC does this internally:

• 100% luminance = white
• 0% luminance = black

PRC uses the formula:A - 100 * T / 400 > 0 where T = dark text and A = light background.

The following examples will clarify this:

Dark text on a light background with text not in overprint and press is in registration.

 

 

Dark text on a light background with text not in overprint and press is out of registration.

 

 

Dark text in overprint on a light background with press in registration.

 

 

CT tab sheet

 

465



8 PackEdge

 

The CT tab sheets groups rules and parameters to check

• CT's for gaps with their clipping path
• the resolution range of the CT's in your job
• CT overprint

CT Clip on Mask
Activate CT Clip on Mask when you want PRC to check if the clipping mask is placed completely inside
the CT.

When the CT is not placed within the mask completely and you apply the automatic correction, the CT
is fitted into mask respecting the following rules:

• Shift: the maximum distance over which the CT can be moved to fit in the clipping mask.
• Scale: the maximum scaling percentage that can be applied to the CT to fit the clipping mask.
• Margin: the minimum allowed space between the CT and the clipping mask.

CT Resolution
Activate the CT Resolution button when:

• During the elaboration of your job, you worked with low resolution CT's to avoid the slowing down of
the system and you forgot to replace them.

• You scaled up CT's in such a way that they have become too low in resolution and surpass the
minimum resolution value.

• You scaled down CT's very much. In this case, the resolution of these CT"s can surpass the allowed
maximum value you specified.

When CT Resolution is activated, PRC reports the too low/too high resolution CT's as an error against
the CT resolution range specified in the Rule Settings.

Force CT in Overprint
Activate this button when you want PRC to check your job for CT's that have not been put in Darken
('Esko overprint').
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Bar Code tab sheet

The Bar code tab sheet groups rules that allow you to make a bar code check in your job.

PRC recognizes BG bar codes. For bar codes coming from other applications, you can attribute a label
to the selected bar code object with the Annotations tool in the status bar.

Note:

You cannot remove the Bar Code Annotation of a BG bar code.

 

 

Bar Code present
Activate Bar Code present when you want PRC to check if the bar code is present on each page in your
job.

Bar Code Paints
Activate Bar code paint to check if the bar code in your job complies with the following bar code rules:

• The bars of the bar code have to have a Fill attributeelse it will not be printed.
• The fill attribute can only have one inkelse register errors will make the bar code unreadable.
• The ink has to be 100%else the bar code will be unreadable.
• A stroke attribute is NOT allowed for the bars of a bar codeelse the bar code will be unreadable.
• The bar code has to be in overprintif there is a colored background.

Registration Marks tab sheet

The Registration Marks tab sheet groups rules that allow you to perform a Registration Marks check on
your job.

Note:

You cannot remove the Annotation of a BG registration mark.
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Registration Mark Present
Activate Registration Mark present when you want PRC to check if the Registration Mark is present on
each page on your job.

Registration Mark in All Inks
Activate Registration Mark in All Inks when you want PRC to check if the Registration Mark is present in
all the inks of your job, so that it appears in every separation.

Note:

PRC will not warn when the registration mark is not in the separation of the die cut.

Die Cut tab sheet

The Die Cut tab sheet allows you to check the Die Cuts in your job.

Note:

You cannot remove the Annotation of a BG Die Cut.
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Die Cut Present
Activate Die Cut Present when you want PRC to check:

• If there is a die cut present in your job.
• If there is only one die cut present in your job.
• If the die cut is in overprint.
• If the die cut has a fill attribute, which is not allowed when the die cut is represented by a stroke.

Note:

It is possible that the outline of the die cut is defined as a set of linked lines instead of a line
and a stroke. In this case a fill attribute is allowed.

• If the die cut has a stroke attribute, which is mandatory when the die cut outline is represented by a
stroke.

Distance to Die Cut
When activating the Distance to Die Cut button you allow PRC to check if the build up of your job is
conform to your specified requirements after having filled out the values for Distance to cut and
Bleed.When designing a package you can place the object(s) in a die cut outline in two ways, either:

• With a certain space between the object(s) and the edge of the die cut

Or

• You can have the object(s) inserted in the die cut with a certain bleed value.

8.11.2.  Check...

To check your job for potential printing problems and violations of standard printing conventions.
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Check scans your job based upon the rules selected in the check box. It detects the problems and
displays the errors in separate error dialogue boxes, which you can scroll through.

Additional information suggestions and proposals for auto-correction help you decide if and how the
problems need to be fixed. All the tools are available PackEdge and all necessary dialog boxes are
started automatically. In some cases automatic fixing is possible.

PRC checks your job page per page and makes a report for each page.

When you click on Check... in the PRC menu the PRC Check dialog box  appears.

PRC Check dialog box
In the PRC Check dialog box you see three parts:
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• The Rule Settings file drop down list.

To select the rule settings file you want PRC to check your job with.

• The activated Rule Settings from your selected Rule Settings file.

The following list shows you all the possible types of Rule buttons:

• Number Of Inks

• Screening

• Critical densities

• Small Strokes

• Close Objects

• Small Text

• Small Parts

• Force Dark Text in Overprint

• Bar Codes

• CT

• Registration Marks

• Die Cut

• The Check button

Clicking Check activates the PRC Options dialog box.

PRC Options dialog box
The amount of PRC check options visible in this dialog box depends on whether PRC has been
performed or not and if you specified some objects to be ignored for a next check.

 

 

The list below describes all possible PRC Check Options:

• Check Only on Blue Selection on page 472
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• Check Ignored Objects on page 472

• Generate Report on page 472

Click the OK button to start the PRC Check.Click the Cancel button to stop the PRC Check.

Check Only on Blue Selection
If you only want to check some objects in your job, select those objects in blue before starting the
actual check and activate Check Only on Blue Selection

Tip:

By selecting the objects in blue and activating the Check Only on Blue Selection , the Print Rule
check program will perform quicker.

Check Ignored Objects
When leafing through a PRC session, you can mark objects as objects to be ignored. The ignore status
of an object is saved with the Rule Settings file. A next perform of PRC will not check these objects.

Activate the Check Ignored Objects when your job contains ignored objects you want to check anyway.

To visualize the ignored objects, press  in the dialog box. The ignored objects will display red
selected and a message displays in which rule ignored objects are present.

 

 

Note:

This option only appears in the PRC Check Options dialog box when your job contains ignored
objects.

Generate Report
Activate this option to save the Print Rule Check result in a file on the chosen directory.The Report is
a simple ASCII-file and contains a list of all the errors found in the checked job. The Report is build up
step by step, during the detection of an error. One error on an object is written only once in the report,
even when this object is checked several times.

 to specify the Report file name and its path.
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The PRC Errors dialog box
Informs you which PRC Rules were violated. The PRC Errors dialog box is a navigation window you
can scroll through. It allows you to display the Print Rule errors one by one. The PRC Errors dialog box
displays the first encountered Print Rule Error. Furthermore the display zooms in and highlights the
error mentioned in the dialog box.

 

 

Structure of the Errors dialog box

• The upper part of the Errors dialog box displays the current error.

• The underneath part displays the button of the violated rule. Next to this button the proposed
correction is displayed. When there are different proposed corrections, the rule button appears as
many times as there are different proposed solutions.

When the rule button is dimmed, the proposed correction cannot be applied automatically, it needs
some interaction of your part.

When the rule button is not dimmed, the proposed correction can be applied immediately.

Next Error
Allows you to look for the next object. After all objects have been found, an information box appears to
inform you the PRC Check is complete. It allows you to Recheck your job or to quit the PRC session.

Error Status Light
The Error Status Light can be red or green

• Red: the error is still present in your job

• Green: the error has been solved by applying the automatic proposed solution.

Attention:

When you solve a PRC Error manually the Error Status Light will stay red. When rescanning the
job, the error will not appear anymore unless the problem was not solved completely solved by
your manual solution.

Previous error
Allows you to go back to the errors that were already checked.
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Recheck Error
Allows you to recheck an object, you modified to solve an error. PRC will not mention the object again,
if the error was solved correctly, and passes on to the next error.

Apply
Allows you to apply a proposed automatic solution. Apply corrects the objects according to the
relevant minimal values defined in the Rules Settings File. Other errors where no automatic solution
was proposed, have to be fixed manually by modifying the attributes and/or shape of the object.

Select All
Allows you to select in red all the objects in your job that violate the current Rule. Consequently:

• The Apply button changes into Apply All.

• The Select All button changes into Select Previous.

Apply All
Allows you to automatically apply the proposed and selected solution to all objects violating the
displayed rule.

Previous
Allows you to return to the object of the previous error.

Ignore Object
Allows you to let PRC assume that the currently selected object does not violate the displayed rule in
the Errors dialog box. During further checking PRC will not take this into account anymore.

Note:

Ignore Objects works only per selected object. Other objects violating the same rule but that
were not ignored will still be highlighted.

Errors envelope
Allows you to extend your Errors dialog box with possibilities to zoom in on your objects.

On Object (Errors envelope)
Allows you to let PRC zoom in on every object violating the PRC rules. The Zoom will never be larger
than the Maximum zoom value.

No Zoom (Errors envelope)
Allows you to specify that PRC does not have to zoom in on any object.

8.11.3.  Report...

To view the PRC report

The PRC Report is a text file that contains all the scanning information.
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8.12.  Trapping Menu

8.12.1.  PowerTrapper

The Trap Dialog
The Trap dialog is where you define all your trapping settings.

1. Go to Trapping > PowerTrapper or double-click the Trap Select tool to open the Trap dialog.
 

 
2. Choose your trapping settings in the Distance & Direction, Color & Shape, and Processing tabs.
3. If needed, define trapping rules.
4. Save your trapping settings as a trap preset to be able to reuse them on another document.

Note:  The Trap Preset List contains 6 default presets.

Distance and Direction Settings
Trapping
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You can choose between two trapping modes:

• Normal Trapping: This selects adjoining color pairs, which are likely to cause registration problems
like ugly light gaps, and unwanted halo effects.

PowerTrapper Classic automatically chooses the most appropriate trap direction based on the
relative luminance of the adjoining colors. Lighter colors are generally trapped into darker colors to
minimize the visual effect of the trap.

• Reverse Trapping: This prevents overprint of adjoining color areas by trapping these color pairs
with a white knockout (erasing) trap. The white knockout trap is put on top of the lighter of the two
colors.

This is useful to prepare a job for Dry Offset printing (e.g. metal beverage cans) where overprinting
of inks is not allowed as the inks would contaminate each other on the blanket.

Trapping Distance

Enter the width you want to give your traps.

The default trap width is 0.2 mm (or equivalent in your chosen unit).

Minimum Ink Difference

Trapping is applied to two adjoining colors when either:

• The two colors each consist of at least one ink but they have no common inks.
• The two colors have common inks but there is a difference of at least the Minimum Ink Difference

percentage for two or more inks making up these colors.

These differences in ink percentages must be in opposite directions.

For example, with the default minimum ink difference percentage of 10%, the following two colors
will be trapped:

1st color: C 5% M 10% Y 50% K 15% (+10% K)

2nd color: C 5% M 10% Y 85% K 5% (+35% Y)

Increase the minimum ink difference to trap colors that are more different, lower it to trap colors that
are more similar.

Image Trapping

• Automatic (default): this determines the most suitable trap direction automatically, by comparing
the average lightness of the CT image with the lightness of the adjoining area, then traps the lighter
color into the darker one.

• Always Towards Images: this always traps line art under adjoining CT images.

• Always Towards Line Art: this always traps CT images under adjoining line art.

Pull Back

An ink pull back keeps away all but the darkest ink of a color area composed of multiple inks that
borders to a very light background.

It prevents individual inks from the composed color to become visible on the background due to
registration errors during the printing process.

Ink pull back is also known as “Cutbacks” or “Keepaways”.

The example below shows an object with 100% dark blue and 50% magenta on an empty background.
50% magenta is pulled back and a fine line of 100% dark blue remains. The color that remains (dark
blue) is the pull back ink.
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• Automatic (default): this creates pull backs on rich black or rich colors, when the color left in the
pull back area is not very different from the composed color.

In the example below, the left color is composed of 100% purple ink and 20% cyan. The darkest ink
(purple) is not very different from the composed color, so using the Automatic pull back option will
create a pull back.

The right color is composed of 100% dark red ink and 20% blue ink. The darkest ink (dark red) is very
different from the composed color, so using the Automatic pull back option will not create a pull
back.

 

 

• Only Pull Back Rich Black: this only creates pull backs on rich black.

• Do Not Pull Back: this never creates any pull back.

Advanced Settings

Click the triangle beside Advanced Settings to show the advanced settings.

Trapping Distance

If you want to use a different distance when trapping into black, spot colors or images or when creating
pull backs, enable the corresponding option and enter the trapping distance to use.
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Image Trapping

If you don’t want images to be trapped with each other, disable Trap images to images.

Pull Back

If you chose to use Automatic pull back (see Pull Back), the Also pull back light inks option is available.
Enable it if you want to create pull backs even when the pullback ink (ink remaining in the pull back
area) is visibly different from the composed color.

Enable Pull back images and gradients if you want to create pull backs on images and gradients.

Trap decision

• By default, PowerTrapper Classic uses the color luminance (Use Lightness) to define the trapping
direction, except for opaque inks, for which the Inks order is used.

• trap direction: from brightest to darkest
• If the Treat spot colors as opaque option is chosen, color luminance is used only for CMYK. For

opaque and spot inks, the trap direction is determined by the ink sequence.

• trap direction for spot colors only: towards the separation listed the lowest in the Separations
palette darkest

• trap direction goes from the process to the spot color if the spot color is below the process color
in the Separations list

• trap direction if the spot color is above the process color: from brightest to darkest
• By selecting Use separation order, the trap direction is determined by the ink sequence for all inks,

including CMYK.

• trap direction: towards the separation listed the lowest in the Separations palette darkest
• Use reverse separation order does the same, using the reversed ink sequence.

• trap direction: towards the separation listed the highest in the Separations palette darkest

Note:  Using the Separation Order option will give the same result as changing all inks
(including CMYK) to Opaque.

Overshoot Mode

You can choose between the following three overshoot modes:

• Automatic (default): The centerline behavior is according the rules determined in the color pair list.
• Never on Dark Areas: The centerline is forced not to get beyond the center of dark areas.
• Never: The centerline is forced not to get beyond the center of any area.

An example:

During trapping, this example will generate the following color pairs:
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By default (Automatic), this color pair list results in the following traps:

If the parameter is set to Never on Dark Areas, this will result into:

If the parameter is set to Never, this will result into:

Color and Shape Settings
Trap Color Intensity
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By default, PowerTrapper Classic uses the full color of the object to spread in the trap (100% trap color
intensity).

However, you can create a trap of a lighter color by reducing the trap color intensity percentage.

Image Trap Color

Choose how to trap your images:

1. Use Original Image Data (default): when spreading an image, PowerTrapper Classic uses the
underlying image data (when the image is clipped) to create the trap (see example 1 below).

Note:  When there is no underlying image data (the image isn’t clipped), it will create an
empty trap.

2. Extend Image Data: PowerTrapper Classic will automatically extrapolate the image along its
clipping path edge to ensure the trap looks as expected even if there is no clipped image data
outside the visible image (see example 2 below).

3. Use an Approximate Flat Color: Instead of using existing or extrapolated image data in the trap,
PowerTrapper Classic will use a solid color. A suitable color is determined by averaging the image’s
colors along its boundary with the object to trap (see example 3 below).

 

 

Truncate Traps

PowerTrapper Classic can truncate the trap so that it doesn’t stick out on another color. There are two
truncation modes:

•
On Center  (default): when a portion of a trap comes too close to the contour of another object,
PowerTrapper Classic limits it to half the distance between the trapped object and the other object.

•
On Edge : when a portion of a trap comes too close to the contour of another object, it is
truncated on the other object’s edge.

 

 

End Caps

This option specifies how to shape the ends of an open trap.
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•
Square  (default): this option ends the trap at right angle to the adjoining object.

•
Round : this rounds the ends of the trap. This option is typically only used in combination with
white knockout (reverse trapping).

Attention:

We recommend not to use Round End Caps together with Truncate Traps On Center, as this
can generate some artefacts (the round caps will be truncated).

•
Object Dependent : with this option, the trap is a logical continuation of the contour of the
spread object.

 

 

Trap Corners

This option allows you to change how the traps’ sharp corners will be handled.

•
Round  (default): a round cap will be placed at all corners.

•
Beveled : this will cut sharp corners off.

•
Mitered : this option works with a miter ratio.

The miter ratio serves to limit the length of the sharp corner (the distance from the base of the trap
to the corner point).

The default miter ratio value is 4. This means that if the length of the sharp corner is more than 4
times the Trapping Distance, then the corner will be cut off (beveled). If it is less than 4 times the
Trapping Distance, the corner will be left as it is.
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Advanced Settings

Click the triangle beside Advanced Settings to show the advanced settings.

Truncate Traps

If you want to truncate traps into black differently, select Into black and choose the truncation mode
(On Center or On Edge). For more information about truncation modes, see Truncate Traps.

Processing Settings
Color Pairs

PowerTrapper Classic can trap all hits (occurrences) of a color pair the same way, or recalculate the
trap direction for different hits.

• Each hit can have its own decision (default): this recalculates the trap direction for each hit of a
color pair.

• Same decision for all hits: this traps all hits of the same color pair in the same direction.

• Same decision for objects smaller than: this uses the same trap direction for hits of a color pair
belonging to small objects, and recalculates the trap direction for hits belonging to bigger objects.

Use the field next to the option to determine the maximum size of small objects.

The default size is 1 mm.

Restrictions

In some cases PowerTrapper Classic can safely ignore certain object types to speed up the trapping.

• Respect existing traps: if your document has already been trapped, select this option to keep the
existing trap layer out of the trapping process.

• Ignore bitmaps : this keeps bitmap pixel data from being trapped. Bitmap data is contourized
before trapping, which may slow down trapping depending on the bitmap’s contents. Bitmaps with
lots of small isolated islands will typically take a longer time to trap.

Attention:  When you indicate an object type to ignore, it will be ignored completely as if it did
not exist in the job. Also, the ignored objects will not truncate trapping areas resulting from
other objects below them.
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If the Respect existing traps is enabled, traps in the selection will be kept, and no trapping is
performed on these locations. If the option is off, selected traps will be removed, and will be re-
trapped. This only works for traps created by PowerTrapper Classic or Instant Trapper.

Small Gaps

Some input jobs contain very small unintentional gaps between neighboring objects, preventing
the correct trapping of these objects. Although it is better to clean up such jobs before trapping,
PowerTrapper Classic can ignore these gaps automatically.

To use this option, select Close when smaller than and enter the maximum size small gaps can have.

The default size is 0.01 mm.

Attention:  If you set a big gap size, trapping may become slower, and small parts of the job
may be ignored during trapping.

Rules

Rules allow you to define custom trapping settings for specific trapping pairs.

When to Use Rules?

In most cases the general trapping settings you enter in the Trap dialog will give you excellent results,
but in some cases you will need to refine them using rules.

Rules allow you to specify exceptions to the general trapping settings for certain color pairs. They are
an advanced feature and should be used only by experienced users.

For example, you can use them in the cases below:

• To set a different trap distance for a specific spot ink.

Sometimes you need a larger trap distance for spot inks if there is no other ink to help cover leaks
on the press.

• To prevent trapping or ink pull back in specific cases.

Depending on the type of the adjoining colors, trapping and / or pull back may be undesirable.

• To force a specific trap direction.

PowerTrapper Classic determines the trap direction based on the relative lightness of the adjoining
colors. If the colors have a similar lightness level, it selects an arbitrary direction. You can use a rule
to make it always use a particular direction for a color pair.

• To specify a different shape and / or truncation mode for certain color pairs.

For example you can choose to use “On Center” truncation when trapping under a 100% black line
and “On Edge” truncation on all other color pairs.

Creating a Rule

1. Click the Add Rule button at the bottom of the Trap dialog.
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2. In the pop-up that opens, choose the trapping pair to apply the rule to using the From and To lists.

You can create a rule to trap from/to:

• any color,

• a particular ink (process, spot or opaque),

Note:

In this case, you can choose the ink name, from which Minimum Density the rule will
apply, and if the color must be pure (no other separation in the color object) to apply the
rule.

 

 

If Spot Ink is selected, the dropdown underneath will contain all Spot Colors used in the
document.

• A specific Printing Method

• a particular object (image, gradient or empty background),

• the registration color.
3. Choose the contents of the rule.
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Options Description

Trap • Automatic lets PowerTrapper Classic calculate the trapping
direction.

• Always Trap always spreads the “From” color/object on the “To”
color/object.

• Do Not Trap never traps the “From” and “To” colors/objects together.

Trapping Distance Use this to define a special trapping distance for the trapping pair.

Trap Color Intensity Use this to define a special trap color intensity for the trapping pair.

Pull Back • Automatic lets PowerTrapper Classic decide if there should be a pull
back on the trapping pair.

• Always Pull Back always creates a pull back on the trapping pair.
The darkest ink of the pair is the pullback ink (remaining ink in the
pull back area).

• Do Not Pull Back never creates a pull back on the trapping pair.

Pull Back Distance Use this to define a special pull back distance for the trapping pair.

Pull Back Fill Mode • Normal gives normal pull backs.

• Sharpen allows sharpening on pull backs. This sharpening is used
e.g. for white text on images, on CD's or DVD's. Sharpening is done by
pulling back the image, and adding 100% black in the trapping area.

Reverse • Automatic lets PowerTrapper Classic decide if the trapping pair
should have a reversed trap.

• Always Trap Reversed always generates a reversed trap for the
trapping pair.

• Do Not Trap Reversed never generates a reversed trap for the
trapping pair.

Truncate Traps Choose if traps generated for the trapping pair should be truncated on
center or on edge. See Truncate Traps for details.

End Caps Choose how to shape the ends of open traps for the trapping pair
(square, round or object dependent). See End Caps for details.

Trap Corners Choose how to shape the trapping pair’s trap corners (round, beveled or
mitered). See Trap Corners for details.
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Options Description

Direction Mode Select into both colors to use bidirectional trapping. In case of
bidirectional trapping, the trap will go half the trapping distance in each
direction.

Horizontal / Vertical
distortion

Set the percentage of the trapping distance to be used in vertical /
horizontal direction. In the example underneath, the trap was generated
with no vertical distortion (so 100%, i.e. using the entered trap
distance) and horizontal distortion set to 50% (i.e. half the trap
distance).

4.
If necessary, use the  button to add contents to your rule.
 

 

You can use the  button to remove contents.
5. When you are done defining your rule, click OK.

You can now see your rule at the bottom of the Trap dialog.
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When trapping your document, PowerTrapper Classic will trap the trapping pairs that match rules
according to those rules, and the rest of your document according to the main trapping settings.

If necessary, you can add another rule, or remove a rule previously created. You can also edit a rule by
double-clicking it in the Trap dialog.

Trap Presets
With PowerTrapper Classic , you can save all your trapping settings as a preset to be able to reuse them
on other documents.

Trap Presets can be shared between different Esko Applications (PackEdge, ArtPro, DeskPack, ...)

The icon next to the Trap Preset dropdown shows if the current Trap Preset is local or server based.
When holding the cursor over the icon, PackEdge will show the full location of the current Trap Presets,
e.g. C:\Esko\bg_data_custom_v010\dat\trap

The Trap Presets list contains 6 default Presets that can't be changed or removed:

• Default
• Bi-directional (including a rule to trap into both colors)
• Combipress (including a rule based on Printing Method)
• Offset (optimized for offset printing)
• Reverse
• Sharpening (including a rule optimized for sharpening)

Defining a Trap Preset

1. Define your trapping settings in the Trap dialog. Add rules if you need to.

2. In the Trap Preset list, choose Save...
3. Give your preset a name and click OK.

You can now see your preset in the Trap Preset list. To reuse it in the future, just select it in the list.

• To delete a preset, select it in the Trap Preset list then select Remove.

• To edit a preset, select it in the Trap Preset list, make your changes in the trapping settings, then
save it again with the same name.

The Trap Layer
PowerTrapper Classic creates traps in your document’s Trap Layer, and leaves the other layers intact. If
your document doesn’t contain a trap layer, PowerTrapper Classic will create one.
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The Trap Select Edge Tool

You can find the Trap Select tool  in the Tools panel. Use it to select trap areas in your job, or
double-click it to open the Trapping dialog.

You can:

• click between two adjoining color areas to highlight the edge and select the trap,
• make a rectangle selection to highlight all edges and select all traps in that rectangle.

Note:  Selecting one or more traps in your document using the Trap Select Tool also selects the
corresponding color pair(s) in the Color Pairs palette. See The Color Pairs Palette on page 488.

8.12.2.  The Color Pairs Palette

After trapping your document, the Color Pairs palette shows the trapping settings associated with
each of your document’s color pairs.

It pops up automatically after trapping, or you can go to Trapping > Color Pairs to open it.

 

 

For each color pair, the palette shows:

• the number of Hits (occurences of that color pair) in the document,
•

the type of object in the pair (empty background , flat color , image  or gradient ),

Note:  When you click on the flat color icon, you will see the ink percentages.

• the type of trap performed on that color pair (normal trap , pullback , reverse trap ),
• the trapping Distance used,
•

the traps’ Shape (truncation , caps , corners ),
• the Intensity of the trap color,
• the Pullback Ink (when the trap is a pullback).

Viewing Traps
• To select all the traps of a color pair in your document, click that color pair in the Color Pairs

palette.
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Note:  Use Shift to select several color pairs, and highlight all the corresponding traps in
your document.

•
To zoom on selected traps, click  or select Zoom to Selected Hits in the menu.

To revert to the previous zoom, click  again or select Don’t Zoom to Selected Hits in the
menu.

• If the Trap Select Edge tool is active, use the arrow keys to browse through the color pairs. Activate
the Zoom to Selected Hits to browse and visualize your traps one by one in your job.

Note:  Use Arrow left-right to expand or collapse the trapping pair list.

Viewing Trap Settings
You can hide trapping settings that you are not using to make the Color Pairs palette smaller.

• To hide all color pairs that are not trapped with each other, select Hide Non-trapping Color Pairs in
the palette’s fly-out menu.

To show them again, select Show All Color Pairs in the fly-out menu.
•

To hide all color pairs that don’t have traps selected in your document, click  or choose Hide
Unselected Color Pairs in the palette’s fly-out menu.

To show them again, click  again or select Show Unselected Color Pairs in the menu.
• To hide the Distance, Shape, Intensity or Pullback Ink column, select Hide Distance/Shape/

Intensity/Pullback Ink Column in the palette’s fly-out menu.

To show the column again, select Show Distance/Shape/Intensity/Pullback Ink Column in the fly-
out menu.

Refining your Traps
You can use the Color Pairs palette to select certain traps and change their trapping settings.

1. Select either:

• the color pair(s) to edit in the palette,
• the traps to edit in your document (if you want to only edit certain traps of a color pair).

2. Make your desired changes as explained below:

to change a color pair’s... do...

trapping direction
click Swap Trap Direction . Trap direction
can be from left to right, from right to left, or
bidirectional. In case of bidirectional trapping,
the trap will go half the trapping distance in each
direction.
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to change a color pair’s... do...

Note:

When you change the direction for only
certain traps of the color pair, the color pair
will be duplicated in the palette (e.g. one
entry for spread and one for choke).
 

 

trap type choose Normal Trap , Pullback  or Reverse Trap

 in the Trap column.

You can also use this to trap a non-trapping color
pair.

trap distance click the Distance value to edit it.

trap truncation
choose On Center  or On Edge  in the Shape
column.

end caps
choose Square , Round  or Object Dependent

 in the Shape column.

trap corners
choose Round , Beveled  or Mitered  in
the Shape column.

trap color intensity click the Intensity value to edit it.

pullback ink (for pull back traps only) click the pullback ink to change it to another ink.

3.
Click Update Traps  to apply your changes to your document’s traps.

Note:  To change several color pairs the same way, use Shift to select them, then make the
changes in one color pair. Clicking Update Traps will apply your changes to all selected color
pairs.

Saving and Loading Color Pairs
After trapping a document with PowerTrapper Classic, you can save its color pairs. This ensures you
won’t need to re-edit the color pairs if you need to change the traps later on.
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When to Save Color Pairs?
You can save color pairs as soon as you are finished editing them.

If you haven’t saved your color pairs, doing the following will discard them:

• closing your document,

•

Note:  This doesn’t affect your document’s traps.

Where are Color Pairs Saved?
Your color pairs are saved in a file next to your document. This file has the same name as your
document and “.tcp” as extension.

Note:

There can be only one color pairs file per document. If you make changes to your color pairs
and save them again, your color pairs file will be updated.

If for some reason you need another version of your color pairs file, first save your document
under a different name then save the color pairs again.

Saving Color Pairs

• To save your color pairs, select Save Color Pairs in the Color Pairs palette’s fly-out menu.

Note:  This is only available when you have unsaved color pairs.

Loading Color Pairs

• To load color pairs that you saved previously, select Load Color Pairs in the fly-out menu.

Note:

This is only available if you have saved color pairs for the current document.

You cannot load another document’s color pairs.

You cannot load color pairs if you have changed the document after trapping.

8.12.3.  Trap Red Under Green... (Trapping Menu)

To trap adjoining objects manually.

Trap Red under Green is the manual trapping mode. Adjoining objects (contours, text, CT's, blend
objects...) need trapping to avoid the (white) gap that appears between the objects on the printed
result.

The adjoining objects, that need a fill attribute, have to touch or overlap. If they overlap and if the color
that lies on top masks out (cuts away) the colors below, a trapping area is generated on the boundary of
the objects.
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To apply Trap Red under Green, you have to

• Select the objects in red that need to be trapped underneath an adjoining object.

• Select the objects in green under which adjoining red selected objects are trapped.

• Indicate the distance.

• Indicate the truncation type.

The red objects are trapped underneath the green objects.

Note:

The trapping area is placed in a separate layer. This way, you can easily edit or remove the
trapping area, without affecting the rest of your job.

When you choose Trap Red under Green in the Trapping menu, the Trap Red under Green dialog box
appears.

Trap Red under Green dialog box
 

 

Distance Defines the trapping distance. Only positive values are allowed.

Truncate The trap area is truncated to avoid that it exceeds the edge(s) of the color area under which
is trapped. There are two different truncation modes:

•
On Edge  The trapping area is truncated on the object edge, even if a larger distance has been
defined. This is to avoid that the trapping area of an object exceeds the edge of the object under
which is trapped. This is the default truncation mode (default)

•
On Center  The system recalculates the trapping distance for the areas where a trapping area
comes too close to the contour of an object. In that case, the trapping area stops halfway the
object. In all the other areas, the complete trapping distance is applied.

 

492



8PackEdge

 

End Caps This option specifies how the ends of an open trap area are constructed.

•
Square  When this mode is selected, the trapping areas are placed at right angles relative to
the boundaries of the adjoining color areas.

•
Object dependent  When this mode is selected the trapping areas are a logical continuation of
the contour of the object that is spread. (default)

•
Round  When this mode is selected the trapping areas are ended with circular arcs. This mode
is typically used in combination with white knockout (= reverse trapping) or ink pullback.

 

 

Corners This option allows you to change the way sharp corners in the trap areas will be handled.

• Mitered  If the distance from the base of the trap to the corner point is larger than the miter
ratio multiplied by the trap distance then the corner will be beveled otherwise it will remain sharp.
See also miter ratio option. (default)

493



8 PackEdge

• Round  A round cap will be placed at all corners.

• Beveled  Similar to mitered, but with miter cut off with straight line (= mitered with miter ratio 1).

 

 

Trap button

To apply the trapping, following the parameters defined in the dialog box.

8.12.4.  Keep Red Away From Green... (Trapping Menu)

To introduce a distance between two adjoining contours in such a way that, when printed, the adjoining
inks do not overlap or mix.

In certain printing processes, the nature of the inks or the printing surface cause an unwanted mixing
of adjoining inks. Keep Red away from Green compensates these effects.

Keep Red away from Green can also be used to create graphic effects, for example a white outline
around text. The red selected object is reduced with the defined distance, to keep it away from the
green selected object.

Note:

The reduced distance of the red selected object is in fact a trapping area that is placed in a
separate layer. This way, you can edit or remove it, without affecting your job.

When you choose Keep Red away from Green in the Trapping menu, the Keep Red away from Green
dialog box appears.

Keep Red away from Green dialog box
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Distance

Defines the trapping distance. Only positive values are allowed.

Truncate The trap area is truncated to avoid that it exceeds the edge(s) of the color area under which
is trapped. There are two different truncation modes:

•
On Edge:  The trapping area is truncated on the object edge, even if a larger distance has been
defined. This is to avoid that the trapping area of an object exceeds the edge of the object under
which is trapped. This is the default truncation mode (default)

•
On Center:  The system recalculates the trapping distance for the areas where a trapping area
comes too close to the contour of an object. In that case, the trapping area stops halfway the
object. In all the other areas, the complete trapping distance is applied.

 

 

End Caps This option specifies how the ends of an open trap area are constructed.

•
Square:  When this mode is selected, the trapping areas are placed at right angles relative to
the boundaries of the adjoining color areas.
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•
Object Dependant:  When this mode is selected the trapping areas are a logical continuation of
the contour of the object that is spread (default)

•
Round:  When this mode is selected the trapping areas are ended with circular arcs. This mode
is typically used in combination with white knockout (= reverse trapping) or ink pullback.

 

 

Corners This option allows you to change the way sharp corners in the trap areas will be handled.

• Mitered:  If the distance from the base of the trap to the corner point is larger than the miter
ratio multiplied by the trap distance then the corner will be beveled else it will remain sharp. See
also miter ratio option (default)

• Round:  A round cap will be placed at all corners.

• Beveled:  Similar to mitered, but with miter cut off with straight line (= mitered with miter ratio 1)
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8.12.5.  Rich Black... (Trapping Menu)

Use the Rich Black tool to obtain a darker black by overprinting all black areas with the ink that you
specify.

Note:

You can use this tool also to make other inks in your job richer.
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Add

Choose an ink from the ink list, define the percentage and the pullback distance ( the distance between
the edge of the defined ink and the edge of the black object).

Corners

This option allows you to change the way sharp corners in the trap areas will be handled.

•
Mitered:  If the distance from the base of the trap to the corner point is larger than the miter
ratio multiplied by the trap distance then the corner will be beveled else it will remain sharp. See
also miter ratio option. (default)

•
Round:  A round cap will be placed at all corners.

• Beveled: 

 

 

Miter Ratio

Determines when a sharp corner is beveled. If the Distance from the base of the trap to the corner
point is larger than the miter ratio multiplied by the trap distance then the corner will be beveled else it
will remain sharp. This option is only available when mitered corners are selected. (default value 4)

ToSelect the ink you want to make richer. Also define the minimum density the destination ink must
have before the system may enrich it.

Hit 'Create'. The system will generate a 'Rich Ink' layer which contains the added objects.

498



8PackEdge

Note:

If you want to add more than one ink to make another ink richer, you could use the Rich Black
tool again, but that takes time. You can also opt to add inks to the ink used in Rich Ink layer (you
can do so in the Color Factory).

8.12.6.  White Underprint... (Trapping Menu)

To create a white background when printing on transparent or metal material. The White Underprint
area has the same shape but a smaller size than the object under which it is printed.

 

 

Direction:Do you want the White Underprint to be smaller  or bigger  than the original object

Define the distance between the edge of the White Underprint layer and the edge of the object under
which White Underprint is applied.

Define an ink for the white underprint area. You can define an ink name in the drop down list. The
default ink for White Underprint is TrW (Transparent White).

Tip:

Objects selected in blue will be ignored by the white Underprint tool.

Corners This option allows you to change the way sharp corners in the trap areas will be handled.

•
Mitered:  If the distance from the base of the trap to the corner point is larger than the miter
ratio multiplied by the trap distance then the corner will be beveled else it will remain sharp. See
also miter ratio option. (default)

•
Round:  A round cap will be placed at all corners.

• Beveled: 

•  
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Miter Ratio  Determines when a sharp corner is beveled. If the Distance from the base of the
trap to the corner point is larger than the miter ratio multiplied by the trap distance then the corner
will be beveled else it will remain sharp. This option is only available when mitered corners are selected
(default value 4).

8.13.  PSFix Menu

With PSFix, you can clean up:

• Imported PostScript files
• Native Esko files

To decrease the complexity and size of your job, and thus speed up the further processing of that job.

The most ecient way of using PSFix is to perform PSFix as a first action, immediately after importing
the job. Furthermore, you execute the different menu functions of PSFix preferably in the order of
appearance in the menu.

Tip:

Once you have performed the PSFix functions on your job, you can perform a further cleanup
with PSFix for objects that were not traceable before the first cleanup operation.

When you want to apply PSFix on all the pages of a multi page job, use Process, where you can define if
you want to apply PSFix on the current page or on all pages.

Click PSFix in the menu bar to open the PSFix menu.

8.13.1.  Fix... (PSFix menu)

To group the PSFix functions that delete objects and change or correct the job.
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When you choose Fix from the PSFix menu, the Fix dialog box appears.

Tip:

Define and save the PSFix functions in the Process dialog box when you have to repeat the
same PSFix functions on different files.

Fix dialog box

Delete
Spurious Contours

To select and delete contours that do not generate any output. For more information, refer to Remove
Spurious Contours.

Double Contours

To remove double contours by recombining the fill and stroke attribute of two identical objects into
one object again. Double contours are created when importing PostScript files, where an object with a
fill and a stroke attribute is split into two objects with each one attribute. For more information, refer to
Remove Double Contours.

Gross Clipping
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To select and delete the objects whose bounding boxes fall completely outside the bounding box of the
clipping path. Gross Clipping can also be applied on composed text and externally referenced objects.
For more information, refer to Clips.

Useless Clips

To select and delete useless clipping paths, objects that are totally clipped away or objects that are
totally covered by other objects. For more information, refer to Clips.

Hidden Objects

To select and delete objects that are covered completely with another object, because the designer
did not want to delete them or could not delete them on a certain page, as they were components of a
master page. For more information, refer to Clips.

Contours outside margins: Deletes all contours outside the margins.

Cleanup unused inks To remove automatically all unused inks (inks that are not used in the colors of
the Color Palette).

Cleanup unused inks and colors

To remove automatically all colors and inks that are not used in the job.

Strokes
Regenerate Strokes

Searches and selects simple objects that contain 20 points or less and converts them to the equivalent
strokes. For more information, refer to Strokes.

Complex Objects too

Searches all objects that might be degenerated strokes, and does not limit the search to objects of less
than 20 points.

Minimal Line Width

To define the minimal width for strokes.

Activate the toggle box and define the minimal stroke width in the Minimal Stroke Width input box.

For more information, refer to the Strokes dialog box.

Minimal Stroke Width input box

To define the value of the minimal width for the stroke.

Correct
Blend to Image

To convert all recognized blends in the whole job to externally referenced CT objects.

For more information, refer to Blend to CT in the PSFix menu.

Simplify Linked Mask Objects: Simplify Complex Linked Mask Objects will try to reduce the number
of linked contours for complex mask objects. This option is only useful for linked mask objects with a
huge number of contours (>50). When used with a lower number, PSFix will become less powerful and it
will have no effect whatsoever on the complexity of the mask object.

Reduce Inks

To reduce the number of inks in your job by converting colors containing inks from the PANTONE Guide
selectively into colors containing CMYK Inks and by mapping multiple screen rulings of the same ink to
one.
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For more information, refer to Reduce Inks in the PSFix menu.

Adjust Borders

Allows you

• to move any of the four borders numerically.
• to measure manipulations applied to borders.
• to save the borders manipulation to an option file.

The numeric control and measure button are available for odd and even pages. For more information,
refer to Adjust Borders.

Tight Image Clip

Searches for all images that have tight clipping paths and modifies the clipping paths of these images
to the centerline of the stroke.

When importing QuarkXPress jobs, a frame is created to position the image and after having placed the
image in the frame, a stroke is assigned to that frame. After PostScript conversion, the clipping path
on the image will be too small, because it is placed exactly on the inside outline of the stroke, instead
of on the center. For more information, refer to Clips .

Black Limit

To define the minimum amount of the black ink in the contour color of the tight clipping path. The
clipping paths that contain a smaller amount of Black than specified in this input box are not selected.

Fix bleed

It is a common occurence for pages to be supplied without any bleed. This means that either a new
page has to be sent or the page has to be manually corrected in Packedge. Especially the latter can be
a time-consuming process. "Optimize and Clean" (PSFix) now has the capability of automatically fixing
this problem, by adding bleed where none, or not enough, is present. There are three parameters to
control the process:

• Bleed distance: this is the amount of bleed that is required. For any object that does not have this
amount of bleed the correct bleed will be created.

• Margin: any object that is inside the borders, and that is closer than this distance to the borders
will be considered to require bleed. This value will typically be small and serves to make sure that
objects which do not really touch the borders because of inaccuracies in the design, will be taken
into acount for bleed creation anyhow.

• Maximum image scaling: in the case of linework objects all the bleeds that are created are added to
an additional layer called 'Bleedlayer'. This layer can be removed at all times to return to the original
file. This is not possible with images, however. Images are modified in their original location. There
are two possible ways in which images can be handled. When an image is larger than its clip mask,
it is possible to create bleed by extending the clip mask of the image; hidden pixels will become
visible and the missing bleed problem is fixed. When the image is not larger than its clip mask, the
only way in which bleed can be created is by scaling the image. When doing so, the position of the
image inside the page does not change, but it is disproportionately scaled to create the correct
bleed. To avoid an unacceptable distortion of the image this parameter determines how much
scaling of an image is allowed. If no scaling is desired, then the value can be set to 0.

Pages
Current

To apply the PSFix parameters in the Process dialog box only to the current page of the job.
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Note:

The settings for Borders, Ink Reduction and Color Mapping are always applied to the complete
job.

All

To apply the PSFix parameters of the Process dialog box to all the pages of the job.

Save...
To save the defined parameters in a PSFix Process Options file (extension .psfp), in order to use it for
other jobs.

Load...
To load a PSFix Process Options file (extension .psfp) with the PSFix parameters that you want to apply
to your current job.

Process
Executes the defined parameters in the Process dialog box on your current job.

8.13.2.  Remove Spurious Contours (PSFix menu)

To remove contours that do not generate any output.

Spurious contours are:

• Single points that only have a fill attribute
• Single points that have a stroke attribute with but or square caps
• Contours that contain two points, that have a mask attribute, but do not mask out any object.

These contours can be created by accident or generated by PostScript printer drivers.

Choose Remove Spurious Contours from the PSFix menu to start the application of the function to your
job.

If the Reporting check box in the Preferences dialog box is activated, an information box shows the
number of spurious contours that were found and removed.

Tip:

To apply this function only to a certain area of the job, select that area in blue.

Note:

As spurious contours are in general very small elements, the removing action can be hardly
visible or not at all.
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Tip:

When you want to look for spurious contours in your job and zoom in on them, use Select by
Attribute.

8.13.3.  Remove Double Contours (PSFix menu)

To remove double contours by recombining the fill and stroke attribute of 2 identical objects into one
object again.

Double contours are created when generating PostScript files, where an object with a fill and a stroke
attribute is split into two objects with each one attribute.

Choose Remove Double Contours from the PSFix menu to start the application of the function to your
job.

When Reporting is activated in the PSFix Preferences dialog box, the system displays an information
box with the number of double contours that were found and removed.

Attention:

The system will not recognize double contours, if functions of the Contours menu have been
performed on these double contours before executing Remove Double Contours.

Tip:

To apply this function only in a certain area of the job, select that area in blue.

8.13.4.  Clips... (PSFix menu)

To clean up useless clipping paths, hidden objects or gross clips to reduce the complexity of the job.
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If Reporting is On, an information box informs you on the number of contours that were selected or
deleted.

Tip:

To apply this function only in a certain area of the job, select that area in blue (see Select
Linework Objects in Blue on page 40).

Tip:

When you want to display and zoom in on useless clipping paths, hidden objects or gross clips,
use Select by Attribute... (Select menu) on page 231.

When you choose Clips from the PSFix menu, the Clips dialog box appears.

Clips dialog box
Useless Clips

To select and delete useless clipping paths. Useless Clips are clipping paths that can be created by
PostScript printer drivers or by frame-based DTP packages, that make a clipping path for each frame
that is processed.

Hidden Objects
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To select and delete objects that lie completely under other objects and that generate no output.
A hidden object can be for example an unwanted object that a designer covered completely with
another object, because he did not want to delete it or could not delete it on a certain page, as it was a
component of a master page.

Gross Clip

To select and delete the objects whose bounding boxes fall completely outside the bounding box of the
clipping path. Gross Clipping can be applied on composed text and externally referenced objects.

Hit the 'Select' button to scan the current job and select useless clips, hidden objects or objects with
a bounding box that falls completely outside the clipping path. These objects can be removed without
affecting the job. With Select, you can still modify the selection if necessary, before deleting the
selected objects.

Tight Image Clip

Searches for all the images that have tight clipping paths and modifies these clipping paths to the
centerline of the stroke.

When importing QuarkXPress jobs (version 3.2 and lower), a frame is created to position the image
and after having placed the image in the frame, a stroke is assigned to that frame. In the generated
PostScript file, the clipping path on the image will be too small, because it is placed exactly on the
inside outline of the stroke, instead of on the center.

All Inks: To search all tight clipping paths, without limiting the search to clipping paths with a Black ink
percentage in the contour color.Black only: To search only tight clipping paths of which the contour
color contains Black. The minimum amount of Black is defined in the Black Limit input box.Black Limit:
To define the minimum amount of the Black ink in the contour color of the tight clipping path. The
clipping paths that contain a smaller amount of Black than specified in this input box are not selected.

Hit the 'Adapt' button to search and modify the tight CT clipping paths.

8.13.5.  Strokes... (PSFix menu)

To correct degenerated strokes and to modify the overall width of strokes in a job, to make the stroked
objects in the job printable.
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If Reporting is On, an information box shows the number of strokes that were modified.

Tip:

To apply this function only in a certain area of the job, select that area in blue (see Select
Linework Objects in Blue on page 40).

When you choose Strokes from the PSFix menu, the Strokes dialog box appears.

Strokes dialog box

Degenerated Strokes
Select Searches and selects in red objects containing 20 points or less.

Regenerate Converts the selected objects to the minimal stroke width that has been defined in the
Minimal Stroke Width input box under Modify Stroke. When finished, the red selection turns into a
green selection.
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Tip:

When you are not satisfied with the stroke width after the regeneration, select the stroke in
red and define the desired stroke in the Map Stroke Width input box of the Strokes dialog box
and click Apply.

Complex Objects too (>20 Points)

When activated, objects of more than 20 points, that might be degenerated strokes, are selected as
well.

Modify Stroke
Modify Stroke width To define a range of stroke widths that you want to modify. For example, all
strokes with a width value between 0 and 1. The changes you can apply to this stroke width selection is
Scale, Add or Map.

• Scale Multiplies the original width with the defined factor (2=200%, 0.5=50%). This results in wider
or thinner strokes.

• Add Adds the specified value to all strokes. You can fill in a positive or a negative value.

•

 Maps the selected strokes to the defined stroke width.

Note:

The value in this input box also acts as a minimum width in Scale and Add.

8.13.6.  Blend to Image (PSFix menu)

To convert all recognized blends in your job to externally referenced CT objects.

In PostScript files, blends are constructed by a large amount of contours that lie close to each other
and that have slightly different colors. The more accurate the blend, the more contours and colors.
This leads to very large jobs and decreases the processing speed.

For each detected blend, 'Blend to image' creates 1 image.

Attention:

After conversion to different images, the display of the blend can change. However, the
conversion does not affect the printed result.

Choose Blend to CT from the PSFix menu to start the application of the function to your job.

When Reporting is On, the system displays an information box with the number of blends that have
been processed.

509



8 PackEdge

Tip:

To apply this function only in a certain area of the job, select that area in blue.

8.13.7.  Reduce Inks... (PSFix menu)

To reduce the number of inks in your job by converting colors containing inks from the PANTONE Guide
selectively into colors containing CMYK Inks and by mapping multiple screen rulings of the same ink to
one.

 

 

Jobs can have too many inks because of the following reasons:

• A PANTONE Guide can easily be (mis)used as a color picker. For example, when you build up your job
with 200 PANTONE colors, you can end up with a job with 200 different inks.

• When importing jobs that contain inks with multiple screen rulings, these inks are converted to
multiple inks.

Note:

Reduce Inks affects only the inks of objects that are part of the job. Externally referenced
objects (such as CT files) are not affected.

Tip:

When you have a job with externally referenced objects and you want to reduce the ink of these
objects, use Job Ink Mapping in the Paint menu

When you choose Reduce Inks from the PSFix menu, the Reduce Inks dialog box appears.
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Reduce Inks dialog box

Original Ink Table
Contains all the inks of the current job. Each ink has a separate ink box, next to which the full ink name
is displayed. When "Map Angles and Rulings" is activated (see further), the screen angle and ruling of
that ink are displayed as well.

A "plus" sign on the left side of the ink box indicates that the ink also appears in the New Ink table and
that it will be kept after reducing the inks.

New Ink table
To specify the inks that you want to retain after reducing the inks, drag and drop these inks from
the Original Ink table to the New Ink table. The Process Inks (C,M,Y,K) appear by default and have a
default screen angle and ruling. You can change the angle and ruling by double-clicking the ink box and
adapting the values in the dialog box of that ink.

Screen angle Screen ruling

Process Cyan (C) 15 120

Process Magenta (M) 75 120

Process Yellow (Y) 0 120

Process Black (K) 45 120

Copy All
To copy all the inks from the Original Ink Table to the New Ink Table.

Tip:

Use Copy All when you want to keep nearly all the original inks. It is quicker to delete the inks
that you do want to keep in the New Ink Table than to drag and drop all the inks that you want to
keep one by one from the Original Ink Table to the New Ink Table.

Copy CMYK
To copy only the Process Inks from the Original Ink table to the New Ink Table. When the same process
ink appears more than once in the Original Ink Table with a different screen angle and/or rule, only the
first ink of the Original Ink Table is copied to the New Ink Table.

Reset All
To reset the New Ink Table to its original contents.

The New Ink Table originally contains the Process Inks (C, M, Y, K) with their default screen angles and
rulings.

Reset CMYK
To reset the process inks in the New Ink Table to the Process Inks with their default screen angles and
rulings. The other inks in the New Ink Table remain unchanged.
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Map Rulings and Angles
When an ink of the Original Ink Table is put in the New Ink Table, you can decide whether to use the
screen ruling and angle of that ink in the Original Ink Table or the screen ruling and angle of that ink in
the New Ink Table.

• If Map Rulings and Angles is activated, the system takes the screen ruling and angle of the ink in the
New Ink Table.

Note:

With Map Rulings and Angles activated, the "plus" sign on the left side of the ink boxes in
the Original Ink Table disappears when you change the ruling and/or angle of that ink in the
New Ink Table, because the ink in the New Ink Table is not identical anymore to the ink in the
Original Ink Table.

• If Map Rulings and Angles is NOT active, the system uses the ruling and angle of the ink in the
Original Ink Table.

Note:

If Map Rulings and Angles is not active, the "plus" sign on the left side of the ink boxes in
the Original Ink Table is not affected by the ruling and/or angle of that ink in the New Ink
Table, because the screen angle and ruling of the inks in the New Ink Table are not taken
into account.

Tip:

When you want to change the screen rulings and/or angles, double-click the ink box with the
right mouse button. The rulings and angles dialog box of the selected ink appears, where you
can apply the required changes.

Apply
To reduce the inks as specified.

Save...
To save the settings of the Reduce Inks dialog box in a file for later use on similar files. The new inks are
saved in a file with extension .PSFIL (PSFix Ink List).

Load...
To load a PSFIL-file in the New Ink Table.

8.13.8.  ColorMap... (PSFix menu)

To change basic colors in your job.

Basic colors are:

• The primary colors of a blend.
• The color with the highest density.
• Vignette colors.

Tones are:
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• the intermediate colors of a blend
• the colors with a lower density (tints)

When you change basic colors in your job, the tones change accordingly.

When you choose ColorMap from the PSFix menu, the ColorMap dialog box appears.

ColorMap dialog box

Basic Colors
Displays the basic colors of your job. For each basic color there are two color swatches: the original
color swatch on the left and the new color swatch on the right.

Note:

To display the relationship between a basic color and a derived color, click the color swatch on
the right of the basic or the derived color. A '>'-sign appears that marks the relation between
these colors.

To change a basic color, you can:

• Drag and drop the basic color on the To CMYK or the To PANTONE color swatch.

The converted color appears in the color swatch on the right of the original basic color.

• Drag and drop a desired color directly in the color swatch on the right side of the original basic
color.

Tip:

Create a new color in the Color Factory and drag and drop it in the new color swatch of the
Basic Colors.

The conversion is executed when you click Apply.

Tones
Displays the colors that are derived from the basic colors. When you change basic colors, the tones
change accordingly. For each derived color, there are two color swatches: the original color swatch on
the left and the new color swatch on the right.

A color appears in the new color swatch:

• After having dragged and dropped the basic or the derived color on the To CMYK or the To PANTONE
color swatch.

• After having dragged and dropped a desired color directly in the color swatch on the right side of
the basic or derived color swatch.

Tip:

Create a new color in the Color Factory and drag and drop it in the new basic color swatch.

The conversion is executed when you click Apply.
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Convert to CMYK
Drag a color to the empty color swatch underneath the To CMYK icon to convert it to CMYK. The new
color appears in the color swatch on the right side of the original color. When you click Apply, the color
is converted and appears in the original color swatch.

Convert to PANTONE
Drag a color to the empty color swatch underneath the To PANTONE icon to convert it to a PANTONE
color. The color appears in the color swatch on the right side of the original color. When you click Apply,
the color is converted and appears in the original color swatch.

Load
Loads the basic colors and tones of your job.

Apply
Converts the original colors into the desired colors and updates the original color swatches of the basic
and tones.

8.13.9.  Adjust Trim Box (Borders)... (PSFix menu)

To move any of the four borders numerically, to measure manipulations applied to borders and to save
the borders manipulation to an option file.

This can be done separately for odd and even pages.

When you choose Adjust Borders from the PSFix menu, the Adjust Borders dialog box appears.
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Adjust Borders dialog box
Auto-fit borders on trimmarks: automatically fits the borders on the trimmarks (if any).

HeightDisplays the height of the current job.

WidthDisplays the width of the current job.

Odd Page/Even Page  Click the Odd and/or Even Page button to be able
to fill out the Adjust Borders parameters for the Top, Bottom, Left and Right border.

Attention:

When you activate both Odd and Even pages, be aware that the new borders in the Odd/Even
input boxes must have the same size.

Note:

When only one of the buttons is activated, the parameters are applied to all the pages of a
multi-page job.

8.13.10.  PSFix Preferences... (PSFix menu)

To define whether you want to be informed each time PSFix performs an operation and/or to define
some Blend To CT output options.

When you click Preferences... the Preferences dialog box appears.

Preferences dialog box
 

 

Report PostScript-Fix messages in pop up messagebox The Reporting check box is activated per
default, an information box appears after each PSFix operation to indicate the number of items
that were affected by the performed operation. When the Reporting check box is deactivated, no
information box appears.
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Noise for Blend To Image To apply an amount of noise to the CT (0 = 0% noise) to avoid banding.

Tip:

Enough steps defined in Blend To CT avoids the need to add noise.

Resolution for Blend To Image Enter the final resolution for a CT. The default is 12 pixels/mm.

8.14.  FastVariants Menu

Printed work is frequently published in different versions. Most obvious application is the variants for
different languages, another application is different prices for different regions, for instance Canadian
$ versus US $. It would be a waste of material and time to make all four separations for each variant,
since only the black is changing between the variants. The process to recycle the printing plates for the
non-variant separations is what we call "double burn" (FastVariant).

Note:

To evaluate the result of your operations you have to use the 'extended preview' display mode.

Note:

Make sure that the display setting of the external referenced files is set on 'Real'. The 'Check
visually' tool works with a reference layer that is external referenced. (Please refer to File Menu
> Preferences > Files).

8.14.1.  Split... (FastVariants Menu)

The Split Menu is used to split a complete (full inks) job into a single master or a single variant part.

 

 

Variant ink: This is the ink in which the variant objects are created. All variant objects should be
created only in this ink. Most of the time this ink will be black but you can change it optionally.

The 'All Pages' toggle: If enabled, all pages will be taken into account

Extract Master: Click this button to extract the master part.

Extract Variant: Click this button to extract the variant part.
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Note:

No objects are deleted, they're just put in another overprint mode, so the result is correct. If
you put the display mode in contour mode, you'll see that the objects are still there.

8.14.2.  Combine... (FastVariants Menu)

Combining the master part of a job with the variant parts in separate layers is something that is
typically done in FastImpose. However, it may sometimes be necessary that some editing is required
after the combination of the master and the variant. An example of this is the combination of the
different scans that make up the pages of a cartoon. There are usually three scans, the image, the
black keyline and the text. As these scans are done on different scanners with different resolutions,
it is often necessary to manually modify the position and scaling of the different scans on top of each
other.

 

 

Add the variant on top of the loaded master using the 'add'-button. In case the master part is a multi-
page job, you'll get a pagelist to which several single-page variants can be added. In this list of variants
you can cut and paste, clear or invert the separate files.

Into Layer: allows you to specify the name of the variant layer.

Insert Layer: allows you to specify the order of the layers.

Keep as External Image: If enabled it will keep the variant as an external image. This toggle is
disgarded when CT images are being placed.

Bleed: Allows you to add x mm of bleed to the variant.
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Offsets: Allows you to move the variant compared to the master.

8.14.3.  Check Visually (FastVariants Menu)

This dialog is useful only when a file has been processed first by the FastVariants Checker task in
Automation Engine. It is recommended, while preparing this taks in Automation Engine, to activate the
options to save the differences and to include an external reference to the reference file against which
a file was checked. When the Automation Engine task has reported that a file contains errors, you can
inspect it visually using this dialog. The Automation Engine task will have added extra layers to the file
and the purpose of the dialog is to give the user ecient methods to see where the differences are and
what they are.

 

 

By selecting the appropriate eye-icon in the dialog box you can easily switch on or off the group of
layers you want to see. Visualizing the FVC layers only gives the user an immediate idea of where the
differences are.

When you zoom in on an area of difference it may be helpful to quickly alternate between the Job
Layers and the Reference Layer. Make sure the FVC Layers are switched off, Job Layers and the
Reference Layer on, and click on 'Blink'. This function is useful only when two groups of layers are
active. When only one of the layer groups is active, there is obviously nothing to blink, and when all
three are active blinking would be very unclear. You can adjust the numbers of blinks and interval.

8.14.4.  Remove White Boxes... (FastVariants Menu)

'Remove white boxes' solves the problem with obtrusive white opaque boxes present in the variant part
of the job (usually black text). This function removes these boxes, but white opaque text (contourized
or not), will not be touched. White opaque strokes can be kept when the toggle has been enabled.
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Keep strokes: Enable to keep strokes with a maximum width of x mm. All strokes smaller than the
selected width will not be removed.

All Pages: If enabled, all pages will be taken into account.

8.15.  Window Menu

To display, resize and reposition windows.

The following icons represent the window display modes. You can always resize and reposition
windows, according to your specific needs.

Note:

• Whenever more than one window is displayed, you can use a different display mode per
window.

• You can use several windows to work very accurately and at the same time have a general
overview of your job.

8.15.1.  One Window (Window menu)

Displays 1 window to represent the job in only one window.

8.15.2.  Two Vertical Windows (Window menu)
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Displays 2 windows on top of each other.

8.15.3.  Three Windows (Window menu)

Displays 3 windows to represent the job in three windows.

8.15.4.  Two Horizontal Windows (Window menu)

Displays 2 windows side by side to represent the job: contours on the left, ink based on the right.

8.15.5.  Workspace (Window menu)

The positions of all open palettes and dialog boxes are saved when exiting the application. You can
start with default palette positions or restore default positions.

You can also save multiple layouts as different workspaces.

Save a workspace and use Manage to rename or delete previously saved workspaces.

8.15.6.  Toolbars (Window menu)

To display the toolbar.

Activate Tools in the Windows menu to display the toolbar.

File & Edit
The file and Edit toolbar offers generic functionality.

 

 

• New File
• Open
• Save
• Cut
• Copy
• Paste
• Delete
• Undo
• Redo
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Status
For more information please refer to Status bar on page 590.

Tools
For more information please refer to The Toolbar on page 548.

View
For more information please refer to View Bar on page 593.

8.15.7.  Align (Window menu)

To display the Align dialog box.

Choose Align from the Windows menu.

Use the alignment options to align a file or selected objects based on the crosshair or reference points
or based on two clicked points or to position a selected object or place a file within another object.

When you use Copy, Paste (all Paste options), Place or Place Inside the objects can be positioned
according the settings in the Align box, and automatically scaled and rotated (depending on the
selected Alignment options), if the Align dialog box is displayed.

Align and Distribute Objects
 

 

Align Object by Crosshair
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Align by Two Points
 

 

Align by Reference Point
 

 

Align by Two Points
 

522



8PackEdge

 

Fit Red Selecting into the Green Selection
 

 

8.15.8.  Annotation (Window menu)

Opens the Annotations dialog box to link annotations to objects and/or to find out which annotations
are linked to the objects.
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When you click Annotations in the Status bar, the Annotations dialog box appears.

Note:

The annotations linked to the selected object are displayed in the Annotations Information
Box in the Status Bar. If you have more than one object selected, a '?' will be displayed in the
Annotations Information Box and next to the linked elements in the Annotation dialog box.
If you then want to know which annotations are linked to each separate object, you should
select the object. However, if all of the selected objects have the same annotations, the linked
annotations will also be displayed.

Key Line

You can always link a key line to a selected object in your job by clicking the Key Line toggle button.

Bar code

You can link a bar code to a selected object in your job by clicking the Bar code toggle button.

If you have a bar code in your job that is generated by the system, the Bar code annotation is locked and

can consequently not be changed. In that case, the -icon appears next to the locked bar code.

Die Cut

You can link a die cut to a selected object in your job by clicking the Die Cut toggle button.

If you have a die cut in your job that is generated by the system, the Die Cut annotation is locked and

can consequently not be changed. In that case, the -icon appears next to the locked die cut.

Registration Mark

You can link a registration mark to a selected object in your job by clicking the Registration Mark toggle
button.

If you have a registration mark in your job that is generated by the system, the Registration Mark

annotation is locked and can consequently not be changed. In that case, the -icon appears next to
the locked registration mark.

Trap
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You can link a trap to a selected object in your job by clicking the Trap toggle button.

If you have a trap in your job that is generated by the system, the Trap annotation is locked and can

consequently not be changed. In that case, the -icon appears next to the locked annotation.

8.15.9.  Colors (Window menu)

In the Color Palette you define, add or modify colors, vignette colors and patterns to be applied to
objects.

1. Colors
2. Patterns

Color Palette tab sheet
 

 

In the Color Palette you define, add or modify colors or vignette colors to be applied to objects.

To define a color using the Color Factory:

1. Double-click a color swatch.

The Color Factory appears.
2. Define the color that you want to use.

The color you create displays immediately in the selected color swatch of the Color Palette.
3. Close the Color Factory.

To change a color or to define a vignette color with the Color Factory:

1. Select the color swatch that you want to change in the Color Palette.

A rectangle appears around the selected color swatch.
2. Double-click the selected color to display the Color Factory or choose Color Factory in the Paint

menu.

The Color Factory displays the currently selected color.
3. Modify the color according to your needs.
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The color is automatically updated in the Color Palette.

To delete an unused color from the Color Palette:

1. Choose Inks from the Paint menu.

The Inks dialog box appears.
2. Click the Clean Up Colors and Inks button.

The unused color disappears from the Color Palette.

Tip:

When you click in a color swatch of the Color Palette with the right mouse button, you can
select or deselect objects by color.

Tip:

When you select a colored object while the Style bar is displayed and the Measure Plug is
activated, the corresponding color swatch in the Color Palette is automatically selected.

Tip:

You can apply the current color to the fill attribute of the selected objects by pressing shift
+ left click.You can apply the current color to the stroke attribute of the selected objects by
pressing ctrl + left click.

Color swatches
To define, add or modify colors or vignette colors to be applied to objects.

When you click a color swatch to add a color, it is automatically filled with an empty color (white).

Note:

You can also resize the Style Bar horizontally, to display more color swatches.

Color Name input box
To define a "work" name for the selected color swatch in the Color Palette, to help you to identify the
color for a category of objects.

Example: You created a drawing with a blue color for the sky and a blue color for the ocean. For the first
blue color, you can enter the name "sky" and for the second blue color, you can enter the name "Ocean".

When you select the name, the color with that name becomes selected in the Color Palette.

Attention:

The name you enter in the Color Name input box is job related and is only a tool to quickly
retrieve colors. It is NOT a designer ink that you create here.

Vignette
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To change the selected color from a plain color to a vignette color or vice versa. The vignette options
display in the Color factory. For more information about the vignette options, we refer you to the
Vignette Color Factory. The highlighted button indicates that a vignette color is active for the selected
color swatch in the Color Palette.

Attention:

White, which is the empty color that automatically appears in the color swatches when you
click them, is also a color. When making a vignette from a color to the empty color white, be
aware that white is 100% opaque.

Vignette Color Factory

To create color vignettes.

When you select an (empty) color swatch in the Color Palette and then click the vignette button, the
Vignette Color Factory appears. The Vignette Color Factory is an extension of the Color Factory.

Vignette Points and Curve
To determine how the color will be averaged between the colors assigned to the points on both sides.

• The vignette points are used to determine the color for the vignette, and the vignette curve is used
to determine how the colors (between two or more points) will be graded.

• Two curves (and their corresponding points) are displayed by default for the vignette. You may
add curves and points by clicking the intersecting points and dragging the points to the top of the
vignette curve, or by dragging and dropping additional colors to the intersecting points.

• Delete colors from the vignette by clicking the point that represents the color you want to delete
and dragging it downward, outside of the Vignette dialog box.

Vignette Type
You can select linear, rectangle, elliptical, or circular as the type of vignette.

Vignette Envelope
The envelope in the vignette Color Factory contains the Color Factory or the Ink Factory.

Smooth Vignette Button
Essentially, the smooth vignette button activates an automatic mechanism that determines the course
of the colors in such a way that banding is no longer visible in the vignette.

If a vignette - either complex or simple - consists of more than 2 color combinations banding may
occur.

Note:

If you open the Vignette Color Factory, the Smooth Vignette Button is by default not activated.

You are working in the inactivated mode.  Click also this button if you want to
deactivate the Smooth Vignette Button, after you activated it.

Click  to activate the Smooth Vignette Button.
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Note:

When activating the Smooth Vignette Button, the system basically only displays a linear
vignette without the intersection points. Note, however, that this is not visible on the film. The
best possible calculation will be done at rip time.

Vignette Curve
Enter a numeric value in the Vignette Curve input box to change the Vignette Curve.

The default is 50 for intersecting points and 100 for starting and ending points. The intersecting point
remains between 13 and 87.

The icon  before the input box will change, depending on the vignette point you clicked on, into an
intersecting point or a beginning or ending point.

Transparency
Determine the transparency of the vignette point by entering a value in the Transparency input box.

Vignette Direction
Click the arrow to indicate the starting and ending point for the vignette in the job. The point you
click first is the point where the vignette starts. The second point you click is the point where the
vignette ends. The points can be selected and replaced. If you replace the points within the vignette
the color for this vignette will also be adapted. Consequently also, the color swatch in the Color Palette,
displaying the vignette color, will be adapted.

Vignette Reverse
Reverse the direction of the vignette by clicking Reverse in the Vignette dialog box.

Locate Color
When the Locate Color toggle is activated and an object's color is selected, the corresponding color
patch is selected.

 

 

Pattern Palette tab sheet
In the Pattern Palette tab sheet, you define, add or modify the patterns to be applied to objects.
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Note:

You can resize the style bar horizontally to display more pattern boxes at the same time.

 

 

To define a pattern

1. Double-click an empty pattern input box in the Pattern Palette or choose Pattern from the Paint
menu.

The Pattern dialog box appears.
2. Create the pattern that you want to apply to the selected object.

The pattern you create automatically displays in the selected pattern input box.

To assign a pattern to an object:

1. Select the object.
2. Drag and drop a pattern from the Pattern Palette to the pattern box in the Fill Style section of the

Style box.

The pattern appears in the object when the Apply Plug is activated.

To modify an existing pattern in the Pattern Palette:

1. Select the pattern that you want to change in the Pattern Palette.

A rectangle appears around the pattern input box.
2. Double-click the pattern input box.

The Pattern dialog box appears.
3. Modify the pattern.

The modification that you apply is updated immediately in the selected pattern input box.

To delete a pattern from the Pattern Palette:

1. Drag and drop an empty pattern input box on the pattern that you want to delete.

Tip:

If you select an object with the Style bar open and the Measure Plug (in the Style bar) activated,
the corresponding pattern box in the Pattern Palette is automatically selected.
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Pattern Boxes
To define, add or modify patterns that you want to apply to objects.

Pattern Name
To define a "work" name for the selected pattern box in the Pattern Palette, to help you identify the
pattern for a category of objects.

The list of names is displayed if you click the arrow to the right of this input box.

8.15.10.  Effects (Window menu)

The Effects window allows you to add more advanced transparency settings to an object from the
database. In the Fill and Stroke tab entry you can apply transparency settings on the fill and stroke
attribute of the selected objects from the document, in the Object tab entry (or Group tab entry when a
group or combi-object is targeted) you can apply transparency effects to the object or group itself.

 

 

 

 

Fill and Stroke tab entry contain the same options. The Object/Group tab contains specific
transparency options for PDF Transparency
groups

Changing the Opacity Gradient
The Opacity Gradient offers a wide range of opacity gradients to be applied to the object, fill and/or
stroke attribute of an object. The Opacity value lets you vary the transparency with a constant value,
but the Opacity Gradient tool allows you to set varying levels of transparency.

The Opacity Gradient dialog still contains the alpha modes that were available in PackEdge 5.0 and
earlier versions, but make them clearly visualized by a small thumbnail preview: linear, linear updown,
conical, conical updown, elliptical, elliptical updown, elliptical eccentric, elliptical updown eccentric,
rectangle, rectangle updown, rectangle eccentric, rectangle updown eccentric, parallellogramic,
parallellogramic updown, parallellogramic eccentric, parallellogramic updown eccentric, edge,
softmask and CT mask.
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Creating and Editing PDF Opacity Masks
The Opacity Gradient dialog allows you to create and edit PDF Opacity Masks. Any object in a document,
even linked files, can be used as a mask for another object. The mask overlays the selected object,
covering entirely where the mask is solid or partially showing through based upon the shades of colors
on the mask. The level of opacity is based on the difference of the luminance from the colors of the
mask and the object: white is 100% opaque, black is 100% transparent and grays (colors change to
grayscale on a mask) have varying levels.

 

 

Create a PDF Opacity Mask by double-clicking on the Opacity Gradient icon in the Effects dialog to
open the Opacity Gradient dialog. Select the opacity mask into a green selection and the object on

which the opacity mask has to be applied into the red selection. Press the Opacity Mask button ( ) to
apply the green selected object as an opacity mask to the targeted object(s).
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The result is one PDF Opacity Mask object where the green object is used as a mask for the red object.
On places where the mask object is 100% black the object becomes fully transparent, for 0% black the
object is non-transparent. Gray values for the mask have varying transparency levels for the object.

You can set some options for the Opacity Mask object in the Opacity Gradient dialog:

 

 

 

 

The Clip checkbox makes an opacity mask
double as a clipping mask, which caused the
masked objects to be invisible outside the
boundaries of the masking object.

The Invert Mask checkbox reverse the luminosity
values of the masking object, which reverse the
opacity of the masked object. For example, areas
that are 15% transparent become 85% transparent
after inversion.

 

532



8PackEdge

 

By using the Transform Opacity Gradient tool ( ) you are able to transform the mask object. The
mask object can be moved to another position relative of the masked object, scaled and transformed.
Press a tool from the Toolbar dialog to stop modifying the Opacity Mask transformation (or press the
spacebar to make the selection tool active).

Release the Opacity Mask from an object by selecting the object mask object into the red selection
and clicking on the Release Opacity Mask button in the Opacity Gradient dialog. The Opacity Mask
object will be put into the green selection.

Edit the Opacity Mask by first releasing the Opacity Mask from the masked object. After you have
modified the masked object, you have to recreate the Opacity Mask by clicking on the Opacity Mask
button to apply the green selected object as an opacity mask to the red selected object(s).

Note:

when an object having an opacity mask is transformed (moved, scaled, rotated, shear) in the
document, you have the choice to determine how the opacity mask has to behave:

• Check the Scale Vignette toggle in the Transform Tool options dialog ( ) to apply the same
transformation on the mask object.

• Uncheck the Scale Vignette toggle to only transform the masked object. The mask object
will not be transformed

Applying Advanced Transparency Effects on Transparency Groups
The Object/Group tab entry in the Effects dialog has some more advanced transparency options that
can be applied on transparency groups.

Isolate Blending checkbox (Object tab entry) prevents blending modes applied to objects within a
group from being applied to objects beneath the group. This option is only useful when used on groups
that contain at least one object with a blend mode other than Normal applied to them or when used on
individual objects that have a blending mode other than Normal applied on the stroke and fill attribute
of the object.

Opacity & Mask Define Knockout Shape checkbox keeps a knockout effect proportional to the
masking object's opacity. The knockout effect will be strong in areas of the mask that are close to
100%; the knockout effect will be weaker in areas with less opacity.

Inherit Knockout Group from Parent checkbox (Object tab entry) checked on when you want to group
objects without interfering with the knockout behavior determined by the enclosed layer or group.
When checked off and the Knockout Group checkbox enabled prevent transparency from revealing
underlying objects within the group. When checked off and the Knockout Group checkbox disabled
when you want to ensure that a layer or group of transparency objects will never knock each other out.
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Object A and B are
grouped and placed
on object C. A has a
blend mode 'Darken'
with opacity 60%. B
is an opaque object
with density 40%.
The overlap will be
composed of 60% of
A and 40% of B.

With the Isolate
Blending option
enabled on the group
object the blend mode
'Darken' of object A
is only applied on the
overlap with object
B and not for the
background of the
object C outside the
group.

With the option Knockout
Group enabled on the group
object the color of the
overlap will be composed of
60% of object A and 40% of
object C. In this case there is
no interfering with the color
of object B in the overlap.

The option Opacity
and Mask enabled
for object A is only
applicable when
this object has a
blend mode other
from 'Normal', has an
opacity less than 100%
and is inside a group
with option Knockout
Group enabled. The
overlap is composed of
60% of object A, 24%
of color B and 16% of
color C (60% of 40 is
24%, 40% of 40 is 16%)

8.15.11.  Flattener

The flattener allows you to remove blend modes and overprints from your document while keeping its
appearance intact.

 

 

Image Resolution

When images are created during flattening, these images will use the defined resolution.

Maximum Image Resolution

When flattening images, PackEdge will by default use the images’ original resolution. You can limit the
resolution of the resulting images by entering the maximum resolution to use here.

Vignette Noise
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Vignettes that are converted to images may have tone jumps in the final result. To reduce this banding
effect, noise is applied on the image. The amount of noise can be specified in the Vignette Noise field.

Flatten Overprint

Enable this option to flatten overprints (and not only objects containing blend modes). This ensures you
will get a correct preview in Acrobat.

Convert Vignette to Images

With this option you can convert Vignettes into images while flattening.

8.15.12.  Guides (Window menu)

Allows you to lock the guides.

When the guides are locked, you cannot modify them.

Tip:

It is possible to create guides out of the displayed rulers by simply clicking one of the rulers and
dragging a guide to the desired position.

8.15.13.  Info (Window Menu)

The editor generates information about the job.

Warnings are displayed in orange, errors are red.

You can define the Info window's behavior. Click the black arrow and a the different possibilities pop up.

• Always pop up Info window
• Pop up info window only for errors/warnings
• Pop up info window only for errors.

8.15.14.  Layer Browser (Window menu)

In the Layer Browser dialog you are able to manage grids, mark ups and the layers of the document
(Create, Remove, Rename layers), and to investigate the document's object hierarchy with the Object
Browser functionality.
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You can move, rename or delete layers, grids or markup grids after they have been inserted into a job.

Tip:

You can select the appropriate object within a layer by selecting an object from the list in the
Status bar (see Objects and Object Name (Status bar) on page 591).

You can also use the Layer Browser to select object(s) from a document. You may have to click on
the toggle arrow ( ) to expand a layer or group of objects. To select an object, click on the object's
selection column (on the right near the circle). A red square is displayed when the object is selected in
the document. A small red square indicates that only a part of the group or layer is selected.

Click on the locate object button ( ) to find the selected object(s) from the document in the object
list. The first selected object is expanded and shown on top of the list. Clicking again on the locate
object button brings the next select object in the visible part of the object list.

Identifying transparency effects:

The Layer Browser helps you to keep track of how transparency is applied to objects and groups.

• A shaded circle ( ) displayed to the right of the object name indicates that transparency is applied
to the object.

• A double ring ( ) indicates the object is targeted (or is the current active): the Style and Effects
dialog show the properties of the object that is targeted.

Layer Browser Options

You can enter the object name in the edit field by clicking the selected object, or you can click 'Options'
from the flyout menu.The options dialog box allows offers you the possibility to switch on or off the
'Show' and 'Lock' icons.
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All objects with a name can have a SmartMark applied to it. This way, they automatically become
Named Objects. It also works the other way around as every Named Object that is created via the
SmartMarks dialog box will be visible in the Layer Browser.
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Collapse All will collapse all expanded layers or layer items.

 

 

Example: The 'Compound contour' “esko star” is selected in the document. The shaded circle in
the 'compound contour' row in the Layer Browser indicates that a transparency is applied on this
compound contour. In the Fill group of the Style dialog we see that a “Color Burn” blend mode is applied.

Selecting a group versus all components of a group

Selecting a group:

Selecting the 'group' by clicking on the object’s
selection column selects all components of the
group in the document.

The double ring on the row of the 'group' object
indicates that the 'group' object is targeted.
Applying a transparency effect in the Object/
Group tab entry of the Effect dialog or Style
dialog will apply the transparency on the group
and not on the individual objects.

In this case the group is treated like a single
object relative to the underlying objects.
The individual objects retain their applied
transparency effects relative to other objects in
the group.

Selecting the components of a group:

Selecting all objects of the 'group' individually
by pressing the shift button and clicking on the
object’s selection column of each object is not
completely the same as selecting the 'group'.

The document still contains the same objects
in the selection, but in this case all individual
objects have a double ring and are thus
targeted: applying a transparency will apply the
transparency on all objects and not to the 'group'.
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Note:

Clicking on the object name in the Layer Browser does not select the object in the document,
but selects the object in the list from the Layer Browser.

• The drag and drop functionality to move object to another position or into another group
works on the objects selected in the list.

• Clicking the remove button will delete the objects selected in the list and not the objects
that are selected in the document.

8.15.15.  Links (Window Menu)

The Links window lists all embedded and linked files in the current document.

 

 

1. List of embedded and / or referenced files.
2. Zoom to: the editor zooms automatically to the selected file.
3. Image Properties: displays the Image Properties window the selected image.
4. Opens the Image Plane Map window for the selected window.
5. Extra options: lists the editor's relevant Image functions, also offer several group, sort and

thumbnail possibilities.

8.15.16.  Memory (Window menu)

Displays the Memory dialog.

The Memory window is used to store numeric values that you frequently need.

Up to 8 numeric values can easily be used over and over by 'dragging and dropping' them into any of the
input boxes.The maximum value that can be entered into each input box depends on the settings. If
you enter a number that contains too many digits to display, an arrow displays beside the input box.
Alpha characters are not accepted.

The number of decimal point positions you may enter is defined in Preferences.
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Note:

The numeric values in the Memory dialog box are reset to 0 when you exit.

8.15.17.  Numbers (Window menu)

To open the Numbers dialog box for numeric feedback.

 

 

1. Measure plug If you do not want to display the values related to the selected object(s) automatically,
you deactivate the Measure plug.

Wind/rewind buttons  To move back and forth through the values that have been
displayed. The winding/rewinding is restricted to 50 steps.

 Reset button To reset all values.

Memory  To let appear the Memory dialog box. It offers an easy way to store and retrieve
frequently used values.

Dialog display selector  To define which part of the Numbers dialog box appears on the
screen: the relative value part, the absolute value part or the complete box.

2.

 Vertical / horizontal distance from the top / left border or the crosshair To represent
the distance between the object bounding box and the top /left border. If the cross- hair toggle is
activated, the distance relates to the center of the crosshair.

Vertical / Horizontal dimension  To represent the vertical / horizontal dimension of the
object bounding box. If the locking between vertical and horizontal dimension is enabled, changing
one value will also change the other, keeping the size proportional.

3.

Diagonal dimension  To represent the diagonal dimension of the object bounding box.

Rotation angle  To represent the rotation angle of the object bounding box. If the crosshair
toggle is activated, the rotation angle relates to the center of the crosshair.
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Contour length  To represent the actual contour length of the selected object(s), not the
dimensions of the bounding box.

Crosshair toggle  When the crosshair toggle is activated, all values relate to the center
of the crosshair.

4.

Vertical/Horizontal Move  To move in vertical/horizontal direction.

Vertical / horizontal Stretch  To stretch an object vertically/horizontally. As it is a factor, a
value smaller than 1 results in a smaller object, whereas a value larger than 1 enlarges it.

Scale  To scale (or resize) an object proportionately. As it is a factor, a value smaller than 1
results in a smaller object, whereas a value larger than 1 enlarges it.

Vertical / Horizontal Shear  To specify an angle to shear an object vertically/ horizontally.

Rotate  To specify an angle to rotate.
5. Keep Once To keep the selected object in its original place or shape the first time you transform it

in any way. The option is automatically deactivated when the transformation has been finished.

Keep To keep the selected object in its previous place or shape for every transformation you do.

Extrapolate To create objects by repeating a set of transformations, starting from (a) selected
object(s), where the transformation of each new object is calculated according to the values in the
Numbers dialog box and is applied to the last created object.

Local Origin To transform a selection of different objects together, in relationship to the local origin
of each one of the objects instead of using one common origin for all the selected objects.

You can

• Move all the local origins of a selection of different objects over the same distance and in the
same direction by dragging the local origin of one object of the selection.

• Move the local origin of each object individually by selecting object per object.

You can also use Local Origin in the Transform Rosette Envelope when working manually.

The following examples show the use of a local origin when rotating:

• Example 1: Rotation, using local origin, after having moved all the local origins of the selection
over the same distance and in the same direction.

 

541



8 PackEdge

 

• Example 2: Rotation, after having moved each local origin individually.

 

 

8.15.18.  Pages (Window menu)

To open the Pages dialog box to manage pages.

 

 

The active page is displayed in magenta. The white pages are unused. The arrows on the left and on the
right allow you to scroll through the bar. To activate another page, click the corresponding number in
the scroll bar. By dragging and dropping you can move a page to another location in the scroll bar.

Add new page  You can drag this icon to the scroll bar and drop it between two existing pages. The
new page is marked by a question mark.
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Page number  This input box displays the number of the active page. In the case of
reader spreads, two page numbers are displayed. You can activate another page by typing its number.

Trash  If you want to delete a page, you can drag it to the trash icon.

First page/last page  Displays first and last pages of a multi page document. You can
modify the numbers in the input boxes. When modifying results in the removal of pages (for instance,
when you fill in a lower number for the last page), the system will ask for confirmation.

Renumber  When you change the page order in the scroll bar, the original numbering is
initially kept. By clicking the renumber icon the pages are numbered according to their actual position.

Navigating with the status bar 

In the status bar you can navigate through a multi page document. For documents with single (that
is, non-reader's spread) pages, only one page number is displayed (odd numbers on the right, even
numbers on the left). For reader s spread documents both pages have a number. By clicking the arrows
you can move one page back or forward. When you press [Alt] and click the arrows, you move 10 pages
at once. When you click the icon, it becomes an input box in which you can fill in the number of the
page you want to activate.

8.15.19.  Pan Window (Window menu)

To get an overview of the whole image and the current viewport.

 

 

You can program views that you intend to use more than once with this job. The job is represented as
a thumbnail over which lies a representation of the viewport rectangle. If you select another job that is
on the screen, the dialog box will be updated.
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Viewport rectangle (selection of the thumbnail view) The viewport rectangle lies over the thumbnail
view.

You can see the viewport rectangle in the image window and follow its movements in the thumbnail
view. The viewport rectangle will be updated each time you make a change to your window view, and
conversely, if you move this small viewport rectangle over the Pan box thumbnail view, the view within
your current window will be updated at the same time.

To move the viewport:

• Press the arrow keys on the keyboard.

• Press the buttons that appear in the envelope.

• Drag the viewport rectangle in the thumbnail view of the image.

If you click and hold the cursor over the thumbnail view, the viewport rectangle follows the point of
the cursor until you release the mouse button and drop the viewport rectangle at the desired part.

• Or click the program buttons (if they have already been programmed).

Program buttons To preset some view selections for each image on the screen. These settings will be
saved, to reuse them during your current session. The settings are kept as long as the image for which
they were programmed stays on the screen.

Repaint To refresh the thumbnail view. If you moved the viewport rectangle in the thumbnail view and
you click Repaint, the thumbnail view is resized until it contains the complete viewport rectangle and
the image in total view. Use the Repaint plug to automatically repaint the thumbnail view each time
your job changes.

Tip:

You can use the mouse wheel to pan the document vertically.

8.15.20.  Style (Window menu)

To display the integrated Style window.
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The Style dialog allows you to add a color for the fill and stroke and to apply some transparency effects
to the Fill and Stroke attribute. Additional stroke options can be set when the Stroke group is expanded
in the user interface. New in the Style dialog is the possibility to apply a blend mode or opacity to an
object or group. With the latter you create the so called PDF Transparency groups. A PDF transparency
group is a group of objects that have a transparency effect (blend mode or opacity). These PDF
transparency groups are treated as a single object relative to underlying objects.

A shaded circle in the title bar of the groups indicates when a Fill, Stroke or Object has a transparency
applied. Double click his icon to show the Effects Dialog in which you can apply more transparency to
the object.

Specifying default settings for transparency features: if you change transparency settings when no
objects are selected, the settings are applied to newly created objects.

Note:

When 2 or more objects in the document with a different value for the same attribute are
selected, an unknown state is displayed in the user interface. In this example 2 objects with
a different blend mode for the fill are selected in the document. Also the title bar shows an
unknown state because one of the selected objects still has the default transparency settings
(blend mode "Normal"), while the other object has a blend mode different from "Normal".

Fill
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The shaded circle indicates that certain attributes have a transparency applied.

1. Toggle the Fill attribute on or off.
2. Select a blend mode from the list.
3. Put the fill in overprint by selecting the toggle.
4. The Fill patch, double click it to open the Color Factory on page 308.
5. Pattern patch, double click it to open the Pattern... (Paint menu) on page 317 window.
6. The Image Plane Map patch, double click to open the Image Plane Mapping... on page 258 window.
7. Clipping Path
8. Adjust the opacity, click the arrow to adjust the transparency using a slider.

Tip:

Clicking the arrows  expands or contracts specific parts of the Style window.

Tip:

Double clicking the Style title bar opens the Effects (Window menu) on page 530.

When you activate the Style bar in the Windows menu, the Style bar appears.
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8.16.  Help Menu

8.16.1.  Contents...

Opens the complete on-line help.

Click  at the bottom of the left help frame to know how to work with Help.

8.16.2.  About

Informs you about the installed version of the Esko application.

8.16.3.  Presentations

Presentations are dedicated to one subject:

• What's new
• SmartMarks
• ColorStitch (Trapping)
• Transparency and Blend Modes
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9.  The Toolbar
Initially at start-up the toolbar appears at the top left side of the screen. The toolbar is dockable.

 

 

 

 

Select

 

 

Transform

 

 

Digitize
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Modify

 

 

Polygon/Ellipse

 

 

Crosshair

 

 

Create Text

 

 

Edit Text

 

 

Spread

 

 

Blend

 

 

Viewport

 

 

Pan

 

 

Measure Point

 

 

Densitometer

 

 

Thin Parts Fixer
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Notes tool

 

 

Trap to Objects on page 577

 

 

Trap to All on page 581

 

 

Trap Select Edge

 

 

Warp

 

 

Vectorize and Clean

 

 

3D Guides. See Studio Designer on page 78

9.1.  Select (toolbar)

To select the objects to which you want to apply an option.

Use the space bar to switch between the current tool and the Select tool. Select objects to manipulate
and modify with the application. When multiple objects are selected, the objects can be manipulated
as a single unit.

The display color of an object indicates the action that can be taken when using the object. Objects
displayed in black are not selected. Objects displayed in red can be manipulated or modified.

Tip:

You can use the keyboard arrows to move your selection.
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Tip:

Select in combination with Numbers.

If the Select tool is activated, you can measure an object by selecting it, or you can drag a
selection anywhere on the screen to measure the dimensions you would like to know. All items
are dimmed.

9.2.  Transform (toolbar)

To modify selected objects manually or by entering a step value.

 

 

Use the Transform rosette to:

• Move, scale, and stretch objects
• Rotate objects
• Shear objects
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• Use two-point positioning

You can transform an object manually or numerically. In the latter case, you work with the Numbers
dialog box. When transforming objects manually, you can display the Numbers dialog box for numerical
feedback.

When transforming a selection of different objects together, you can apply these transformations in
relationship to one common origin or to the local origin of each one of the objects.

To use the numeric keypad as a shortcut, press the numeric key on the keypad that corresponds to the
numeric layout of the Transform rosette (the [NumLock] key must be ON).

To use the arrow keys as a shortcut, press the appropriate arrow key to transform the selected object
(based on the step size entered in the Transform rosette).

Note:

When you modify objects (with the Transform tools) the values that appear or that you define in
the Numbers dialog box, are based on the following:

• Move is based on distance (for example, millimeters or inches, depending upon the unit of
measure you selected in the Document Setup).

• Scale is based on factors (for example, 2 = 200%; 0.5 = 50%).

• Shear is based on angles (for example, 20 = a 20 degree angle).
• Rotate is based on angles (for example, 10 = rotate 10 degrees in a clockwise direction; and

-10 = rotate 10 degrees in a counterclockwise direction).

Click the Transform button from the toolbar to display the Transform Rosette. The Transform Rosette
appears.

9.2.1.  Transform Rosette

Move and Scale

To move an object horizontally, vertically, and to scale or stretch objects, relative to the origin.

Vertical Move

To move an object in a vertical direction.

Horizontal Move

To move an object in a horizontal direction.

Scale
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To scale (or resize) an object, relative to the selected object's point of origin.

Vertical Stretch

To stretch an object vertically, relative to the selected object's point of origin.

Horizontal Stretch

To stretch an object horizontally, relative to the selected object's point of origin.

Rotate

To rotate an object, relative to the selected object's point of origin.

Vertical Shear

To shear an object vertically, relative to the selected object's point of origin.

Horizontal Shear

To shear an object horizontally, relative to the selected object's point of origin.

Two-Point Positioning

To modify an object based on the position of two clicked points. The selected objects will be
automatically scaled proportionately and rotated, depending on how you use these options.

Step input box
To enter a step value. The step value determines how much the object is modified each time you press
the arrow keys.

Envelope

Times
To enter the number of objects you want to create while Extrapolate or Keep are activated.

Keep Once
To retain a copy of the original object during the first transform action that you perform after activating
the Keep Once toggle box.
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Keep
To retain a copy of the original object every time you perform a transform action on an object.

Extrapolate
To extrapolate (or create multiple) objects based on the objects in the Transform reference box.
The newly created objects are positioned according to the numeric entries in the input boxes of the
Numbers dialog box.

Local Origin
To transform a selection of different objects together, in relationship to the local origin of each one of
the objects instead of using one common origin for all the selected objects.

You can

• Move all the local origins of a selection of different objects over the same distance and in the same
direction by dragging the local origin of one object of the selection.

• Move the local origin of each object individually by selecting object per object.

You can also use Local Origin in the Numbers menu when working numerically.

The following examples show the use of a local origin when rotating:

• Example 1: Rotation, using local origin, after having moved all the local origins of the selection over
the same distance and in the same direction.

 

 
• Example 2: Rotation, after having moved each local origin individually.
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Stroke, Vignette, Text, Pattern
To define whether or not the stroke, vignette or pattern are scaled together with the object.

Defines also whether or not the text is scaled together with the text box.

Note:

These settings overrule the settings in the Preferences dialog box.

Vertical Mirror
To mirror (or flip) an object vertically relative to the object's origin.

Horizontal Mirror
To mirror (or flip) an object horizontally relative to the object's origin.

Mirror On Guide or Crosshair
To mirror (or flip) an object on a guide or on a crosshair.

9.3.  Digitize (toolbar)

To draw an object freehand, to insert points in an existing object and to retrace an object.

 

 

Tip:

Digitize in combination with Numbers.

If the Digitize tool is activated, you can measure points or move points manually, while the
values are displayed dimmed. No numeric input is possible.
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Click Digitize  on the toolbar. The Digitize Rosette appears. The highlighted button indicates
which Digitize tool is activated.

You can activate another Digitize tool in the Digitize Rosette by clicking the tool you want to work with
or by pressing the corresponding numeric keypad key (with [NumLock] activated).

The active Digitize tool appears on the toolbar.

You can hide the Digitize Rosette while the Digitize tools remain active. To toggle between displaying
and hiding the Digitize Rosette press the [Enter]key.

Tip:

• Choose the numeric keypad key 0 (with [NumLock] activated) if you want to switch between
the Modify and the Digitize toolbar functions.

• Choose the numeric keypad key 1 (with [NumLock] activated) to change the drawing
direction when working with the Digitize tools.

• Choose the numeric keypad key 2 (with [NumLock] activated) to close an unclosed object
by line when working with the Digitize tools.

• Choose the numeric keypad key 3, 4, 5, 6, 7, 8 and 9 (with [NumLock] activated) to activate
the different Digitize tools and to create new objects. While drawing, you can always
interrupt using one specific Digitize tool by selecting another one or by pressing twice the
space bar and then selecting another tool.

Tip:

If you want to connect 2 selected objects with the Digitize tools, click on the ending points of
both objects.

Tip:

Activate Direction Point in the Modify rosette (numeric keypad 2) to display all of the object's
handles and the starting point of the object.

The handles display in red, and vary, depending on the Digitize tool that was used to create the
segment.

9.3.1.  Digitize Rosette

Add Segment

To create or add straight or curved segments (using the Bézier drawing method) by adding anchor
points.
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Add Curve

To create or add a curved segment to an object by adding control points.

Note:

Adding curves may impact previously added curves.

Add Line

To create straight lines by adding corner points.

Note:

Depending on the previous point, the first line might be a curved line.

Tip:

You can use Add Line to close an object or to connect two objects.

Add Arc

To create or add an arced segment to an object. You can define the drawing direction, the angle (90
degrees maximum), and the radius of the arc segment (the drawing may be a curved line).

Full Circle

To create a circular object by means of 3 points.

Arc

To create an arced segment by means of 3 points.

Change Direction Points

To change the direction points of the object.

557



9 PackEdge

Close by line

To close the starting and ending point of an unclosed object (Segment, Curve, Line, Arc) by a straight
line.

Note:

This function does not only work during the first draw of an unclosed object. You can also
use this function if you stopped drawing an unclosed object to draw something else and if
afterwards you want to continue with this drawing. Click first on the starting or ending point of
the object to continue drawing, if you still want to continue to draw. Apply afterwards the Close
by line function.

Close by curve
To close the starting and ending point of an unclosed object (Segment, Curve, Line, Arc) by a curve. The
curve will be drawn between the tangent line of the starting point and the tangent line of the ending
point of the object.

Note:

If you want to apply close by curve on a line, a straight line will be drawn instead of a curve.

This function does not only work during the first draw of an unclosed object. You can also
use this function if you stopped drawing an unclosed object to draw something else and if
afterwards you want to continue with this drawing. Click first on the starting or ending point of
the object to continue drawing, if you still want to continue to draw. Apply afterwards the Close
by curve function.

Free (drawing)

To create objects by keeping the stylus or mouse button pressed and moving it over a surface.

Note:

You can achieve a smoother result if you use the stylus.

Switch to Modify functions

To switch to the Modify functions.
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9.4.  Modify (toolbar)

To determine the modification you want to execute.

Tip:

Modify in combination with Numbers.

If the Modify tool is activated, you can move points numerically. In the absolute value part, only
the input boxes for vertical, horizontal and diagonal distance and for rotation are present. In
the relative value part, the values for diagonal distance, rotation and vertical and horizontal
move are present. All Modify actions are performed immediately (no Apply).

Tip:

Move points using the arrow keys.

If the Modify tool is activated, you can move points using the arrow keys. The setp can be filled
in in the numeric edit field in the Modify toolbox. Using the arrow keys while holding down the
CTRL key will move points by 1/10th of the step distance.

Click Modify on the toolbar. The Modify Rosette appears. The highlighted button indicates which Modify
tool is activated.

Click another Modify tool in the Modify Rosette or press the corresponding numeric keypad key (with
[NumLock] activated) to activate the desired Modify function.

You can hide the Modify Rosette while you are working with Modify. To toggle between displaying and
hiding the Modify Rosette press the [Enter] key while Modify remains activated.

• Press z to convert to Bézier mode
• Press x to convert to free curve mode
• Press c to convert to frame mode

9.4.1.  Modify Rosette

Move Point

 

 

To move points and anchor points on a segment or an object. When you
move the points, you can change the size and shape of the segment or
object.

Slide Anchor

  To slide anchor points along the lines of a frame (on a curved segment), or
along a line (on a line).
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Trim Line

 

 

To move the segment, if you are working in frame mode. The corners with
the adjacent segments remain the same.

Cut by Cursor

 

 

To divide a segment or object. The divided pieces of the segment or object
can be manipulated or modified individually.

Attention:

• You must click a point on the segment or object, not a point on
the frame or bounding box.

• The newly created objects have no properties.

Make Corner Smooth

 

 

To change a curve into a corner, and vice versa.

Attention:

When you click a point, it toggles between Make Corner and Corner
Smooth.

Delete Point

 

 

To delete points from a segment or object. By deleting the points, you can
change the shape of the segment or object.

Change Start

 

 

To change the starting point and the direction for a segment or object.
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Direction Points

 

 

To display all handles on the selected segment or object when you use the
Modify tools.

Handles can be displayed (in red) to enable you to easily move and
manipulate the tension of the curve.

The type of handle depends upon the Digitize tool that was used to create
the segment.

For example:

• If you created the segment with Add Segment, anchor points and
handles display.

• If you created the segment with Add Arc or Add Curve, only points
display.

• In frame mode extra handles appear on the frame to manipulate the
tension of the curve.

Curvature Lines

 

 

To display perpendicular lines (90 degrees from the tangent) on a curve. The
lines can be used to verify the curve for extreme changes in diameter.

Switch to Digitize functions

 

 

To switch to the Digitize functions.

9.5.  Polygon/Ellipse (toolbar)

To determine the shape you want to create, and the number of sides or points for the shape.

Tip:

Polygon/Ellipse in combination with Numbers.

If the Polygon/Ellipse tool is activated, you can create an ellipse or a polygon numerically. In
the absolute value part, the values for vertical and horizontal distance and dimensions and
rotation can be modified. All the other items are dimmed. In the relative value part all the items
are dimmed. Click Apply to perform the Polygon/Ellipse action.

Click Polygon/Ellipse on the toolbar.

The highlighted button indicates which tool (ellipse or polygon) is activated.
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You can hide the Polygon/Ellipse rosette while you are working with Polygon/Ellipse. To toggle between
displaying and hiding the Polygon/Ellipse rosette press the [Enter] key while Polygon/Ellipse remains
activated.

To Toggle between Polygon and Ellipse: Press [Enter] to display the Polygon/Ellipse rosette (if
necessary) and click Polygon or Ellipse.

To Enter the Number of Points for the Polygon or Ellipse: Enter the number in the Polygon/Ellipse input
box (any number of points).

Note:

The number of points you enter in the Polygon/Ellipse input box determines the number of
sides for a polygon, and the number of points that can be modified with the Modify tools (for
both ellipses and polygons). The default is 4 points.

9.6.  Crosshair (toolbar)

To display the crosshair rosette.

Note:

Manual crosshair manipulations, such as moving and rotating, are also possible whenever one
of the following tools is activated: Select, Transform, Modify, Measure, Spread, Edit text, Blend
and Warp.

Tip:

 Crosshair in combination with Numbers. If the Crosshair tool is activated, you can move
or rotate the crosshair numerically. In the absolute value part, the values for vertical and
horizontal distance and rotation can be modified. In the relative value part, the values for
vertical, horizontal and diagonal move and the rotation angle can be modified.

Note:

The rotation angle strictly refers to the rotation of the crosshair itself and is in no way related
to the distance by nor to the direction in which it was moved.

Click Apply to perform the Crosshair action.

Tip:

To rotate the crosshair use the rotate crosshair button OR left-click + Alt and rotate the
crosshair.

Tip:

Press Ctrl and use the keyboard arrows to move the crosshair in vertical or horizontal direction.
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Tip:

Press Shift and use the keyboard arrows to position the crosshair relative to the 9 key
positions. In case multiple objects have been selected, the crosshair will be positioned relative
to the bounding box of the selection.

When you click the Crosshair on the toolbar, the Crosshair Rosette appears.

9.6.1.  Crosshair Rosette

Move

When you click this button, you can move the crosshair manually. You can move the vertical or
horizontal axis by clicking and dragging either one of them. If you want to move the crosshair vertically
and horizontally at once, you click and drag the center. If you click the left mouse button anywhere in
your job, the center of the crosshair jumps to that point. With the right mouse button you can rotate
the crosshair manually by clicking and dragging it. If you click the right mouse button anywhere in your
job, the crosshair is rotated to that point.

You can align the crosshair on a rotated object (in this case, NOT on the bounding box of the rotated
object). To align the vertical axis, you click a point on the object with the left mouse button. To align the
horizontal axis, you click a point on the object with the right mouse button.

Note:

Even if the object is not selected, there is gravity.

Rotate

When you click this button, you can rotate the crosshair manually by clicking and dragging it. When you
click anywhere in your job, the crosshair will be rotated to that point.

9.7.  Create Text (toolbar)

To create a single line of text, to create text on objects or to create text in a text box.

Tip:

Create Text in combination with Numbers.

If the Create Text tool is activated, you can create a text box numerically. In the absolute
value part, the values for vertical and horizontal distance and dimensions and rotation can be
modified. All the other items are dimmed. In the relative value part all the items are dimmed.
Click Apply to perform the Create Text action.
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Choose Create Text on the toolbar. The highlighted Create Text button indicates that the Create Text
tools are activated.

Create a single line of text

Create Text on Objects:

Use the selection tools in combination with Create Text to create text on (a) object(s).

Text is positioned according to each selected object's starting point in the direction in which the curve
has been created, and can be entered from the keyboard or Font Window or imported from a file.

Note:

Each object can still be manipulated and modified individually.

Create a Text Box manually.

Create a Text Box numerically.

Use Numbers in combination with Create Text to create a text box numerically.

Text is entered from the keyboard or Font Window or imported from a file.

9.8.  Edit Text (toolbar)

To activate the Edit Text mode.

In the Edit Text mode you can select text (that has not been contourized) to be formatted, manipulated,
or modified.

You can select with the mouse, or select all text characters within a text box or within a text line.

Select Edit Text from the toolbar. The highlighted Edit Text button indicates that the Edit Text tools are
activated.

To select text characters with the mouse:

• Position the cursor where you want to select the text, and click, hold and drag# to select the text.#

The selected text is highlighted in gray and can be manipulated and mod fied.

To select all text within a text box or a single text line:

• Use Select All (page 244) from the Text menu or press Alt and click in the text# box.#

To select a paragraph with the mouse:#

• Press [Ctrl] and click in the paragraph you want to select.#

To select a word with the mouse:#

• Double-click the word you want to select.
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Note:

For converting PostScript files there are two possibilities: if you click in the text, it is converted
to single line text; if you drag a rectangle, the text in the rectangle is converted to one text box.

Tip:

When you select text to modify the text's paragraph settings (for example to modify# alignment
and leading), all text within the paragraph in which the cursor is positioned is# modified.#

The text characters do not have to be highlighted to be affected.

Attention:

If you select text to be contourized, all the text in the text box or text line will be# contourized,
even if some of the text is not selected.

9.9.  Spread (toolbar)

To spread or reduce a red selected object or to interspread a red selected object inside a green
selected object.

 

 

Choose Spread from the toolbar. The highlighted button indicates that Spread is activated.

9.9.1.  Spread dialog box

Distance
To enter the amount by which you want to spread or reduce the objects in the Distance input box.

A positive value spreads the object, and a negative value reduces the object. This value is based on the
measuring unit defined in the Document Setup dialog box.
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Note:

If you are using the mouse to spread or reduce, the amount you are spreading or reducing the
object displays in the Distance input box. Moving the cursor inward from the edge of the object
reduces the object, and moving the cursor outward spreads the object.

Keep
If Keep is activated while you click Apply, you create additional objects when you spread or reduce
objects.

Apply
To execute the spreading or reducing of the object.

Each time you click Apply, the object is spread or reduced accordingly.

Interspread
To create a new object from the points where the enlarged (red selected) object intersects the green
selected object.

Note:

If different objects are linked, the overlapping spreads will smoothly run into one another.

Spread envelope
To define the rounding and the sharpness of the corners.

Stroke Corner Type
Click the Stroke Corner Type that represents the type of corner you want for the stroke of the selected
objects:

•
 Sharp corner

•
 Rounded corner

•
 Beveled corner (refer also to the Miter input box)

Miter

To determine how sharp the corner has to be angled to have a beveled corner.

9.10.  Blend (toolbar)
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To create editable blends between two objects or spread blends for single objects.

When you choose the Blend button, the dialog box for Blend between objects appears. You can either
blend between two red-selected objects - in which case the last created object will be on top - or
between a red and a green-selected object - in which case the red-selected object will be on top.

When you modify the original contour(s), this will influence the contours in between.

9.10.1.  Blend between objects

 

 

Blend between objects/Spread blend switch

You can switch to the dialog box settings for Spread blend by clicking the right icon.

Steps
To define or modify the number of steps between the two contours.
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Stroke growth factor

To define a growth factor for stroked blends. For example, if you define 1 as stroke width, the last
created contour of the blend will be as big as the first one; if you choose 5 as stroke width the last
created contour will be five times as big as the first one.

In this example, the growth factor was three. The outer contour is three times as big as the inner
contour.
 

 

Reverse arrow
To reverse the direction of the blend.

Point mapping

These icons become highlighted when you have applied a blend between two objects. You can modify
the way the two objects are blended by adding points to your objects, these points form a line, and that
line is used to calculate the way the objects are blended. When you activate the right icon, the created
reference line can be removed by clicking it.

Apply
To create the blend according to the defined settings. A new color swatch containing a vignette is
automatically added to the color palette.

Note:

Dashes are taken into account. Patterns are ignored.

Change blend direction
To reverse the direction of the blend.
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To contours
To convert all steps to real contours, each containing a different color. Separate boxes for each new
color are automatically added to the color palette. This is a final choice: the contours replace the
editable blend.

Envelope

Autoclose
To close open objects. Can be activated or deactivated at any time.

Note:

The original objects are not changed; only the contours in between are closed.

Show Steps
To display steps dimmed. Can be activated or deactivated at any time.

Difference
If you click 'To Contours', every step of the blend will be contourized. If you select 'Difference' only the
visible parts of the steps are contourized.

Example: This blend has been made with 'Difference'. You can clearly see that only the visible part was
contourized.
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9.10.2.  Spread blend
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Blend between objects/Spread blend switch
You can switch to the dialog box settings for Spread blend by clicking the right icon.

Steps
To define or modify the number of steps.

Stroke width
To define a growth factor for stroked blends. For example, if you define 5 as stroke width, the last
created contour of the blend will be 5 times as big as the first one.

Objects having an anisomorph stroke width i.e. different horizontal and vertical stroke width, are
prefixed with a ~ (tilde) in the Stroke Width edit box. When you fill in a new value in the Stroke Width
edit box the stroke will get a constant stroke width again.

Distance
To define the distance between the first and last step of the blend.
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Apply
To create the blend according to the defined settings.

Note:

Dashes are taken into account. Patterns are ignored.

Change blend direction
To reverse the direction of the blend.

To contours
To convert all steps to real contours, each containing a different color. Separate boxes for each new
color are automatically added to the color palette. This is a final choice: the contours replace the
editable blend.

Envelope

Stroke Corner Type
Click the Stroke Corner Type that represents the type of corner you want for the stroke of the selected
objects:

•
 Sharp corner

•
 Rounded corner

•
 Beveled corner (refer also to the Miter input box)

Miter

To determine how sharp the corner has to be angled to have a beveled corner.

Autoclose
To close open objects. Can be activated or deactivated at any time.

Note:

The original object is not changed; only the contours in between are closed.

Show Steps
To display steps dimmed. Can be activated or deactivated at any time.

Rasterize
Enable the option "Rasterize" to create a rasterized image of the blend object. This rasterized image
is saved into the file and is used in the RIP to ensure the same data is used for the visualization in
the editor and on the RIP. Enabling this option will increase the file size of the document and the
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performance of the visualization while working with the editor. By disabling the option "Rasterize" the
blend object is preripped in the RIP.

Difference
If you click 'To Contours', every step of the blend will be contourized. If you select 'Difference' only the
visible parts of the steps are contourized.

This blend has been made with 'Difference', you can clearly see that only the visible part was
contourized.
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9.11.  Viewport (toolbar)

 Shortcut: [F8]

To zoom into a portion of one of the windows.

Click Viewport on the toolbar to zoom into a portion of one of the windows.

Place the cursor at one of the corners of the area you want to zoom, and press the mouse button while
dragging the cursor to create a rectangle around the chosen area.

A box displays to indicate the area that will be zoomed (viewport). The active window is zoomed relative
to the size of the viewport.

Tip:

• Press F8 to select the option in red (the option can be used once); click the Viewport button
once or press F8 twice to select the option in blue (the option can be used repeatedly until
it is deactivated); when pressing F8 three times you return to the tool you were previously
working with.

A blue selected option is deactivated by selecting an option from the toolbar, by selecting
other options from the View or Select Menus, or by selecting another option in blue.

• In Viewport mode it is still possible to zoom in (click left mouse button) or zoom out (click
right mouse button). The clicked point will be the center of the zoom area.

Note:

To display the view in all of the layout windows at the same time (if multiple layout windows are
being used), activate Same Zoom in the View menu.

9.12.  Pan (toolbar)

 Shortcut: [F7]

To pan the active window to navigate through the active window.

Click Pan on the toolbar to pan the active window to navigate through the active window.

Just click and drag in the window you want to pan. The display will follow the movements of your
mouse.
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Tip:

Press F7 to select the option in red (the option can be used once); click the Viewport button
once or press F7 twice to select the option in blue (the option can be used repeatedly until it is
deactivated); when pressing F7 three times you return to the tool you were previously working
with.

A blue selected option is deactivated by selecting an option from the toolbar, by selecting
other options from the View or Select Menus, or by selecting another option in blue.

Note:

To display the view in all of the layout windows at the same time (if multiple layout windows are
being used), activate Same Zoom in the View menu.

9.13.  Measure (toolbar)

To measure a selected object (left icon) or a point (right icon).

Tip:

Measure in combination with Numbers. Click the left icon to measure objects. Here the
Measure tool combined with Numbers does exactly the same as Transform, but the objects
cannot be dragged manually. In the absolute value part, the values for vertical and horizontal
dimensions and rotation can be modified. All the other items are dimmed. In the relative value
part, all values can be modified. Click the right icon to measure points. Here the Measure tool
does exactly the same as Modify, but the points cannot be dragged manually. In the absolute
value part, the values for vertical and horizontal distance, diagonal, vertical and horizontal
move and rotation can be modified. In the relative value part, the values for vertical and
horizontal move, distance and angle can be modified. All Measure Point actions are performed
immediately (no Apply).

Click Measure on the toolbar to display the Measure Rosette  together with the Numbers
dialog box.

In case of an object, you can measure :

• the distance of a selected object from the borders (top left) or the crosshair.

• the vertical, horizontal and diagonal dimensions of a selected object and its rotation. All this can be
measured either with respect to borders or crosshair, or with respect to the previous position of the
object.

In case of a point, you can measure :

• the distance between two points of an object (or between two objects).
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You can measure the vertical and horizontal distance (including negative values), the distance
between two points, and the angle between two points. The measurement is based on the
differences between the first point clicked and the second point clicked.

• the distance between a point on an object and the center of the crosshair or the borders (top left).
You can measure the vertical distance, horizontal distance, the shortest distance between a point
and the center of the crosshair, and the angle between the point on the object and the crosshair.

• the perimeter of an open or closed object.

9.14.  Densitometer

Allows you to measure the ink percentages of the color at a specific position or area.

Activating this tool opens the Densitometer dialog box and your cursor changes into the shape of the
tool.

9.14.1.  Densitometer dialog box

Purpose

Displays the ink density of the measured point or area.

 

 

Click on a point in the drawing window of the document; or click and drag a rectangular area to
measure the density on a point or in the selected area. The patch at the top of the dialog box
represents the single point or area that has been measured.

Each separation is represented by its name and a color patch. Clicking an area or color in your job
measures and displays the percentages for each separation. When you click and then drag the
densitometer, you find that the percentages update accordingly.

The percentages for each separation are the percentages of the final films.

TAC (Total Area Coverage) is the sum of the dot percentages of the different inks that will be found on
the paper after printing. Technical Inks are shown in the list, but NOT calculated in the TAC.

To close the Densitometer dialog, click the close button top right or select another tool.
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Tip:

Clicking  opens a dialog box which gives you the possibility to 'Show' or 'Hide' Ink names.
You can also define the accuracy: 'Exact' (e.g. 92.2%, measures in step of 1/255 units) and
'Rounded' (e.g. 92%, measures in integer values).

This toggle  adapts the size of the Densitometer dialog box to the size of your list.

Note:

When you change the order of the inks in the Inks dialog box, the densitometer dialog updates
accordingly.

9.15.  Fix Thin Parts

Using the Fix Thin Parts tool, you can manually select what Thin Parts you want to fix. See Fix Thin
Parts tool on page 58

9.16.  Notes Tool

Using the Notes tool, you can view and edit PDF Notes in PackEdge. See Notes on page 210

9.17.  Trap to Objects

The Trap to Objects tool enables you to do full or partial interactive trapping of objects to other
objects.

You can use it for more complex trapping, for example when part of an object has to spread to another
object, while another part has to be choked by a third object.

9.17.1.  Setting trapX-i Parameters

The trapX-i dialog contains trapping parameters to be used with the Trap to Objects or the Trap to All
tool.

1. Click the Trap to Objects or the Trap to All tool to open the trapX-i dialog.
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2. Set the trap Distance.
3.

Choose how to Truncate your traps’ endings: On center  (as in the left picture below) or On edge

 (as in the right picture below).
 

 
4.

Choose how you want the Corners of your traps to be: Round  (as in the left picture below) or

Mitered  (as in the right picture below).
 

 
5. Choose what you want to do when your file contains white objects.

• Leave Trap to White Objects enabled to be able to trap colored objects to white objects / a
white background.
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• Disable Trap to White Objects if you don’t want to trap colored objects to white objects / a white

background. This will prevent you from accidentally trapping to white objects (and will give a
warning when you do).

Note:  You can always trap a white object to another object, as the trap will not be visible.
 

 

9.17.2.  Trapping an Object to Another Object

• To spread an object to another object:
a) click into the object to spread,
b) drag the cursor (that draws an arrow) into the other object (across the boundary between the

two objects) and click.
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• To change the trapping direction (from spread to choke), hold Alt while dragging the cursor’s arrow.

Note:

To cancel a trap while you are dragging the arrow, use Escape.

To cancel a trap after dragging the arrow, use Ctrl + Z.

Attention:

The two objects you want to trap must have a common edge.

When trying to trap two objects that appear to be touching but don’t actually have a
common edge, you will get a warning message.

 

 

This is the case for example when there is a small gap, or a third object like a stroke, in
between the two objects.

9.17.3.  Trapping an Object to Several Other Objects

• To spread an object to several other objects:
a) click into the object to spread,
b) click the background and hold the mouse down to drag a rectangle around the other objects.

 

 

Note:

This traps all objects in the rectangle you drag in the same direction (in the example above,
the purple star and the orange circle are both choked by the green rectangle).
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• To change the trapping direction (from spread to choke), hold Alt while dragging the arrow.

9.17.4.  Trapping Several Objects to One Object

• To spread several objects to one object:
a) drag a rectangle around the objects to spread,
b) drag the arrow into the object to spread them into and click.

 

 

Note:

This uses the same trapping direction for all objects in the rectangle you drag.

• To change the trapping direction (from spread to choke), hold Alt while dragging the arrow.

9.18.  Trap to All

The Trap to All tool enables you to do fast, simple interactive trapping of objects to all adjoining
objects in the background / foreground. The background is everything under the object (flat paint,
images, other objects...), the foreground is everything on top of it.

You can use it to trap a single object, or several similar objects (e.g. letters of a text block).

You can set trapping parameters in the trapX-i dialog (see Setting trapX-i Parameters on page 577).

9.18.1.  Trapping an Object to All Adjoining Objects

• To spread an object to the background and the foreground (to all objects under it and on top of it),
click in it.
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• To choke it instead of spreading it, hold Alt while clicking in it.
• To spread an object to the background only (to all objects under it), hold Shift while clicking in it.

 

 
• To choke it with the background, hold Alt and Shift while clicking in it.

Note:

The Trap to All tool treats an object and its stroke as two different objects.

Therefore it will not trap the fill object to the background as the stroke object is between the fill
object and the background.

9.18.2.  Trapping Several Objects to All Adjoining Objects

• To spread several objects to the background and foreground (to all objects under or on top of
them), drag a rectangle around these objects.
 

 
• To choke several objects with the background and foreground, hold Alt while dragging the rectangle

around the objects.
• To spread several objects to the background only (to all objects under it), hold Shift while dragging

the rectangle.
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• To choke several objects with the background, hold Alt and Shift while dragging the rectangle.

Note:

The Trap to All tool treats an object and its stroke as two different objects.

When spreading a fill object and a stroke object to the background, the Trap to All tool will only
spread the stroke object to the background, as it is between the fill object and the background.

It will not spread the fill object to the stroke object, as the stroke object is on top of the fill
object in the file.

 

 

9.19.  Warp (toolbar)

To warp graphic objects onto or inside objects.

Warping can be done with contones as well as linework.

You first have to select in red the graphic that you want to warp. Select in green the base object(s) on
which you want to warp.

The starting point is very important since this is the basis of the projection. With Change Start in the
Modify tool the starting point can be displayed and changed if necessary.

Warp is a dynamic option. At the left-hand side of the dialog box you find the different warp settings
that can be selected. If you click one of the settings, the options according to the selection appear in
the right-hand side of the dialog box.

After accepting the options, a summary of the settings appears at the right-hand side of the dialog
box.

Accept and Cancel will change into Vector and Spline.

You can use the preset buttons to hold frequently used warp function combinations.
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When you click the Warp button on the toolbar, the warp dialog box appears.

9.19.1.  Warp dialog box

Grid type

Grid type: warping can be performed on different grid types

Between
object(s)

To warp the red selected objects between two green selected objects or inside one
green selected object. The different objects can be closed or open objects.

Attention:

The first drawn line will act as the base line. If the first drawn line is the top
line the warped result will be rotated.

Scale to fit To adapt the red selection proportionally to the length of the green selected
destination both horizontally and vertically if the alignment mode is set to Fit.

If the alignment mode is set to Left, Center or Right the red selection will be placed
left, center or right on the green curve.

Note:

• Performing a warp on a closed base line with Scale to fit causes the
beginning and the end of the warped selection to meet.

• When Scale to fit is selected, a horizontal line appears in the red
selection which can be moved interactively or placed numerically in the
Options/Reference line input box. This line will be mapped on the green
curve.

Stretch to fit To enlarge the selection in the horizontal direction. In this it can be projected over
the length of the base line. The selection keeps its original height if the alignment is
set to Fit.

If the alignment mode is set to Left, Center or Right the red selection will be placed
left, center or right on the green curve.

Note:

• Performing a warp on a closed base line with Stretch to fit causes the
beginning and the end of the warped selection to meet.

• When Stretch to fit is selected, a horizontal line appears in the red
selection which can be moved interactively or placed numerically in the
options/reference line input box. This line will be mapped on the green
curve.

Backwarp To warp any shape into another shape by defining an input grid and an output grid.
You can warp a circular shape straight. The selection can contain both line art
objects and halftone images.

External To import externally defined grids.
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Grid type: warping can be performed on different grid types

File... If you click File, the External grids dialog box appears.

Alignment

Alignment: to specify the position of the warped object, relative to the starting point of the base
line

Left To position the red selected object(s) on the left side of the base line at the starting
point.

Right To position the red selected object(s) on the right side of the base line at the end point.

Center To position the red selected object(s) at the center of the base line.

Fit To enlarge the red selected object(s) to fit on the base line. In this way the red selected
object(s) can be projected over the entire length of the base line. Depending on the
selected grid type, the objects will be stretched or scaled.

Note:

The starting point is the point where the creation of the contour started. From there on the
warped object will be positioned clockwise.

Repetitions

Repetitions: to repeat the red selected object on the baseline

Repetitions Indicates how many times you want to position and/or repeat the red selected
objects on the base line. The system proportionally divides the remaining
space on the base line, depending on the chosen alignment mode (left, right,
center or fit). The red selected objects are positioned once by default.

Note:

When you want to repeat the red selected objects as many times
as possible on the base line, enter the value 0 (zero). The system
computes the correct value taking into account the defined
minimum distance between the repetitions. When Alignment Fit is
selected, the system proportionally divides the remaining space on
the base line.

Space (mm) Indicates the minimum distance to be respected between the positioned
objects.

Fixed spacing Always keeps the indicated spacing, even when scaling the object. If the
Fixed spacing is off, the objects will not be scaled but moved further apart.
Different warnings will help you.
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Distortion

Distortion: warping can be performed with or without distortion

Bend To position the red selected objects with distortion.

Map points Only the existing points in the red selected objects will be mapped; no new points
will be added.

Transform To position the red selected object without distortion. Different transformations or
a combination of transformations are possible with this function.

• Move: to position the red selected objects on the base line without any rotation
or scaling, provided that rotate and scale are deactivated.

• Rotate: to rotate the red selected objects. The objects will be positioned
perpendicular on the base line. This means that the rotation angle is depending
on the position of the object on the base line, provided that rotate and scale are
deactivated.

• Scale: to scale the red selected object, depending on the selected grid type,
provided that rotate and scale are deactivated.

Options

Options: the quality of the result after warping depends on several options

Draw grid To warp objects, the warp function is using an internal grid. The red selected
objects will be mapped onto this grid. The finer the grid, the better the result of the
distortion will be. The fineness of the grid can be defined with entering a number of
rows and columns. Draw grid displays the grid that will be used for this specific warp.

Note:

When a fine grid is defined the drawing of the grid will take a lot of time and
it has already been proven that in some cases a finer grid may not give a
better result.

Precision Precision is very important in combination with Spline. Perform will first generate a
vector object and immediately convert this object into editable spline objects. The
number in this input field is the maximum deviation between the vector object and
the finally created spline object, after reducing. The deviation you have to use is also
depending on the dimensions of the objects. A maximum deviation of 0.1 mm will
have less effect on a big object than on a very small object.

Rows Defines the number of rows used of the internal warp grid.

Columns Defines the number of columns of the internal warp grid.

Accept/Cancel
To accept the settings in the dialog box. Cancel to return to the previous settings.
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Vector/Spline
Vector to create the warped object in vectors. Spline to convert the warped object to splines.

External grids dialog box
Allows you to activate the type of the external grid file and to select the grid filename.

DTL Programs
Activate DTL Programs if the selected file contains a program which will be executed by and is
supposed to define a Destination grid.

Autoload: Activate Autoload to load the DTL programs automatically.

GRD files
Allows you to create grid files manually.

Edit: To edit the grid files.

Mirror horizontally: To mirror the grid files horizontally.

Mirror vertically: To mirror the grid files vertically.

Creator Grid files
In Creator you can save grids used to deform the image. These files (.warp) can be imported in to be
used as destination grid for the warp.

List of the external grids
The list of the external grids used appears in the bottom part of the dialog box.

9.20.  Vectorize and Clean (toolbar)

To cut, connect and clean contours.

Click Vectorize and Clean in the linework toolbar to cut, connect and clean contours.

• Use the three tools of the top row to cut a contour and keep one or all the resulting pieces.
• Use the first two tools of the middle row to retrace a part of the contour and the third tool to split

the contour manually into two pieces.
• Use the three tools of the bottom row to connect contours, to split or connect contours with a

rectangle and to select dust contours.
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You can activate the tools in the Vectorize and Clean rosette by clicking the tool with the mouse or by
pressing the corresponding key on the numeric keypad (NumLock must be on).

9.20.1.  Vectorize and Clean dialog box

Cut Smallest
To cut away the "smallest" part of the contour.

Cut Largest
To cut away the "largest" part of the contour.

Cut and Keep
To cut the contour and to keep all the resulting pieces of the contour.

Retrace Smallest
To cut away the "smallest" part of the contour and to add the contour segment(s) that you draw to the
"largest" part.

Tip:

When you want to put an intermediate point of your line or curve segment near a contour, click
the middle mouse button instead of the left mouse button, to prevent that contour from being
affected.

Retrace Largest
To cut away the "largest" part of the contour and to add the contour segment(s) that you draw to the
"smallest" part.

Split
To split one contour into two pieces and to connect the points that you clicked with the contour
segment that you draw. The new segment will be common for both contours.

Connect two contours
To connect two different contours with an intermediate piece of contour.

Split or Connect
To split one contour or connect two different contours using a rectangle.

Note:

The rectangle you drag is only an instrument to split or connect. It is not kept.

Select dust contours
To select green contours of a defined size in red, so that they can be deleted.

Size input box
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To define the size of the contours that you want to delete.

Note:

The size you enter in the input box is the sum of the height and the width of the# bounding box
of the contour.

Note:

The unit of the value you enter in the input box is the unit that was selected in the# Document
Set-up dialog box on page 187. This can be millimeters or inches.

Reapply
The Reapply button is only available when working with the cut and retrace buttons. You can use it for
example when you have executed a cut or retrace operation and discover that you clicked the wrong
button. To solve the problem, click the cut or retrace button you actually wanted and then click reapply.
The action is executed immediately without having to click two points on the original contour.

Tip:

Click Reapply to compare the changed contour with the original contour.
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10.  The Workspace

10.1.  Status bar

Initially at start-up the horizontal Status bar appears at the right side of the screen below the layout
window(s).

 

 

You can hide/activate the Status bar by (de)activating Status bar in the Windows menu.

1. Pages
2.

  Layers
3.

 Objects and Object Name
4.

 Annotations

10.1.1.  Pages (Status bar)

 

 

To navigate through a multi page document.

For documents with single (that is, non-reader's spread) pages, only one page number is displayed (odd
numbers on the right, even numbers on the left).

For reader's spread documents both pages have a number.

Choose Pages in the Status bar.

By clicking the arrows you can move one page back or forward.

When you press [Alt] and click the arrows, you move 10 pages at once.

When you click the icon, it becomes an input box in which you can fill in the number of the page you
want to activate.

See also:
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• Pages (Windows menu)

10.1.2.  Layers (Status bar)

 

 

To select another layer, grid or markup grid to work with.

In the Layers combo box of the Status bar you see the name of the layer, grid or markup grid you are
currently working on and you can select another layer, grid or markup grid from the dropdown list.

The status bar provides additional info, this info reflects the status of the layers and (markup) grids in
the Layers dialog box:

• : You can choose whether you want to output a layer.

Note:

You cannot output a grid or a markup grid, so the icon will always be the same.

• : A layer/(markup) grid may be invisible.
• : You cannot modify a locked layer/(markup)grid.

Note:

You can use Select Layer from the Select menu to select and display in red all objects within
the currently active layer.

See also:

• Manipulate Layers
• Use Grids

10.1.3.  Objects and Object Name (Status bar)

 

 

To identify the object you selected. Not all objects have names, but you can enter one. If an object has
no name, the Object Name field will read 'Untitled'. All the job's named objects appear in the Object
name dropdown list.

3 ways to create Named Objects

1. Select the object in red and type a name in the 'Object Name' field in the Status Toolbox.
2. Select the object. The SmartMarks dialog highlights 'Untitled'.
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Click and hold this item, the field will become editable, enter a new name.
3. Select the object. Add a SmartMark immediately, as marks can only be added to named objects, the

system will ask you to specify a name for the object.
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Note:

Names have to be unique, if a name conflict arises (when copying a named object for instance),
the system will add asterisks:
 

 

Note:

Names can only be assigned to one single item (one object or a group of objects). When
multiple objects are selected, a confirmations dialog will pop up saying that the objects will be
grouped before assigning a name.
 

 

10.2.  View Bar

Select the View Bar in the Windows Menu > Toolbars

 

 

1.
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To see or change the display mode for the active window.

There are four different display modes:

•  the Contours mode: in this mode, only the contours of the objects are displayed.

•  the Filled mode: in the earlier Filled mode, indexes were used to display images. For each
used color, there was an index. If different colors were used in an image, their indexes were
added up. The new Filled mode no longer works with indexes but translates all overprint modes
into opaque. Use this mode if you want to work fast. Note however that the overprint modes are
visualized incorrectly: the overprints will all be visualized as Opaque overprints.

•
 the Preview mode: in this mode, you can see the inks and colors of each separate object.

First, the color of each object is converted to RGB and afterwards these RGB values are mixed
to get a final result. Use this mode if you want to work fast. Note however that the overprint
modes are visualized incorrectly: the overprints will all be visualized as Darken ('Esko overprint')
overprints.

•  the Extended Preview mode: in this mode, which is of a higher quality, all inks and colors
are displayed the best possible way, resulting in a job that is the best possible approach of the
printed result. First, the inks of the different objects are mixed in their original separations.
Afterwards, the mixed ink values are converted to RGB. Note however that this mode is slower
than the Preview mode. When visualizing inks, the Extended Preview mode uses the ink order for
opaque inks.

The real image data of images are always loaded to generate the preview for the visualization on
screen. Documents having images with a lot of image data might visualize slow in the Extended
Preview Mode. Also loading the real image data from a slow (remote) disc will considerably slow
down the visualization.

Tip:

Use the Preview Mode (3) to speed up the visualization.

2. To monitor or modify the zoom percentage in the active window.
3.

 View Page Borders and Guides  View Crosshairs
4.

To display or change the Preset Grouping Level.

Choose the Status bar's Preset Grouping Level input box.

To change the Preset Grouping Level:

• Enter the appropriate grouping level in the Preset Grouping Level input box.

-OR-

Use the UP and DOWN arrow keys, or the PAGE UP and PAGE DOWN keys to navigate to the
appropriate level.

Note:

The default Preset Grouping Level is 1.
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5. Current Grouping Level

10.3.  Style bar

To apply functions of the Color Palette and the Pattern Palette, as well as style settings to the selected
objects and to measure or modify the color properties of an object.

The Style bar contains:

• The Color Palette tab sheet
• The Pattern Palette tab sheet
• The Fill Style section
• The Stroke Style section

Measure plug If the plug beside Measure is activated, the color properties automatically display when
you select the object you want to measure (you do not need to click Measure).

Measure To measure a selected object's color properties. In case no object is selected, the uppermost
object is measured. The color properties assigned to the object display in the Color box. If you select
the object one by one, the color properties of the last selected object appear. If you select a few
objects with a rectangle, the color properties of the highest object appear.

Apply plug Activated, the Apply plug automatically applies the settings in the Style bar to any of the
selected objects.

Apply When the Apply plug is deactivated, click Apply to apply the settings of the Style bar to the
selected objects.

10.3.1.  Fill Style section

To define or modify

• the fill color
• the fill pattern
• the plane mapping of a selected CMYK CT
• the fill overprint mode
• the fill mask setting

of a selected object in your job.

Fill toggle box
To apply the Fill Style settings to the selected object, activate the Fill toggle box.

Fill color swatch
To define or modify the color of a selected object click, hold and drag the appropriate color swatch
from the Color Palette to the Fill color swatch.

The Fill color swatch reflects the color of the selected object if the Measure plug is activated.

Tip:  When you double-click the Fill color swatch, the Color Factory displays, where you can
create the Fill color you want to apply. The color is automatically added to the Color Palette.
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Fill pattern box
To define or modify the pattern of a selected object click, hold and drag the appropriate pattern box
from the Pattern dialog box or from the Pattern Palette to the Fill pattern box.

To remove a pattern from the selected object, drag an empty color swatch from the Color Palette onto
the pattern box.

The Fill pattern box reflects the pattern of the selected object if the Measure plug is activated.

Image Plane Mapping box
To define or modify the plane mapping of a selected Image.

Open the Image Plane Mapping dialog box by double-clicking the Image Plane Mapping box and drag the
colors with which you want to replace the separations from the image from the Color Palette to the
boxes in the right column of the plane mapping dialog box.

Note:  You can also choose Image Plane Mapping in the Paint menu to define the plane
mapping of a selected image.

Note:  When you applied plane mapping to a image in your file, the Image Plane Mapping box

changes from  to .

To remove the plane mapping from the selected image, drag an empty color swatch from the Color
Palette onto the plane mapping box.

If the Measure plug is activated, the Image Plane Mapping box lights up if plane mapping has been
applied to the selected image, and in the Color Palette, the colors used for the plane mapping are
marked by a black rectangle.

Fill Mask
To let one object act as a clipping path for other objects.

To mask the fill color:

1. Select the objects you want to use as the mask, and the objects to be masked, and group them.

Tip:  Refer to Select Linework Objects on page 38.

2. Send the selected object behind the objects you want to mask.

Tip:  Refer to To Back (Arrange menu) on page 249 or Backward (Arrange menu) on page 250.

3. Activate Fill Mask.

The objects (or portion of the objects) that are contained within the clipping path are displayed and
printed.

Tip:  You can also mask objects by using Cut (Edit menu) on page 205 and Paste Inside (Edit
menu) on page 209. In this case, the objects are grouped.

Example:

1. Create two overlapping rectangles.
2. Fill the upper rectangle with a Y and the lower with M.
3. Select the Yellow rectangle and choose Cut from the Edit menu.
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4. Select the Magenta rectangle and choose Paste Inside from the Edit menu.
5. The Yellow and Magenta rectangle are grouped and the bounding box of the (original) Magenta

rectangle masks out the (original) Yellow rectangle.

Fill Overprint
To define or modify the overprint Mode of the fill color.

For a given object, the overprint mode defines a composition formula between the foreground color
and the background color. The foreground color is the color of the given object. The background
color is the result of the composition of the colors of all the objects lying behind the given object. The
Overprint Mode applies for each separation independently.

As colors (or paints) are made up from (printing) inks, common inks are placed in one separation or
don't appear because the color to which the ink belongs is knocked out by a color that lies on top.

Another element to consider in overprint is transparency. The overprint modes Opaque and Darken
('Esko overprint') behave differently when transparency comes in.

Note:  These overprint modes are also applicable to the stroke color in the Stroke Style section
and the fill color of text in the Character Style dialog box.

Tip:  For a correct preview of the overprint modes, use the Extended Preview Mode.

The dropdown list offers you 4 overprint modes:

• Opaque (default mode)

In the Opaque overprint mode, for each separation, the fill color of an object knocks out all objects
underneath.

The formulas to calculate the Opaque overprint mode are the following:

• No transparency is defined:

Opaque overprint mode: F

Where, for each separation, F means Foreground or the value (in %) displayed in the foreground,
knocking out everything that lies underneath.

• Transparency is defined:

Opaque overprint mode: #*F/100 + (100-#)*B/100

Where # represents the transparency value defined in the Style bar, for each separation,
F represents the value (in %) displayed in the foreground and B represents the value (in %)
displayed in the background.

• Darken ('Esko overprint')

When two objects have a color that contains 1 ink that is identical for both objects, but in a different
percentage, for each separation, Darken overprints the ink with the highest percentage, even when
that ink lies in the background.

The formulas to calculate the Darken ('Esko overprint') mode are the following:

• No transparency is defined:

Darken ('Esko overprint') mode: Max (F,B)

Which means that, for each separation, the highest % is overprinted, independent of its position
in the Foreground or in the Background.
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• Transparency is defined:

Darken ('Esko overprint') mode: Max(B,#F/100+(100-#)*B/100)

Where # represents the transparency value defined in the Style bar, for each separation,
F represents the value (in %) displayed in the Foreground and B represents the value (in %)
displayed in the Background.

• PostScript

When two objects have a color that contains 1 ink that is identical for both objects, for each
separation, PostScript overprints the ink of the object that lies on top, even when that ink has the
lowest percentage. PostScript does not take transparency into account.

The formula to calculate the PostScript overprint mode is the following:

If (F>0) then F, otherwise B.

In this formula, for each separation, F represents the value (in %) displayed in the Foreground and B
represents the value (in %) displayed in the Background.

If the above color does not contain an ink that is present in the color below, then it will overprint in
regards to this separation.

• Add

The identical inks of the different objects that overlap are added up (from background to
foreground).

The formula to calculate the Add overprint mode is the following:

B + (100-B)*F/100

In this formula, for each separation, F represents the value (in %) displayed in the Foreground and B
represents the value (in %) displayed in the Background.

Example: When two objects have a color that contains 1 ink that is identical for both objects, but in
a different percentage, for example, object 1= 60% Cyan, object 2= 30 %, taking into account that
an ink can fill a maximum of 100%, the sum of the inks in the overlapping area will be calculated as
follows: (calculating from background to foreground)

• Object 1 lies underneath object 2
• From the 100% Cyan that can be used, object 1 takes 60%, which leaves 40%.
• From that 40% (of empty space that is left to be filled up), object 2 takes 30%, being 12%.
• The total ink coverage for Cyan will be 72%.

The maximum of 100% for an ink will only be reached when one of the inks in the overlapping area is
defined as 100%.

Fill Style envelope
To open the Fill Style envelope, where you can define the opacity (or transparency) of the fill color and/
or local vignettes.

10.3.2.  Fill Style envelope

To define the opacity (or transparency) for the fill color to be assigned to the selected objects.

The Fill Style envelope contains:
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Fill Transparency Type
To define the opacity (or transparency) type for the fill color that you want to apply to the selected
objects.

The opacity/transparency type can be:

• Solid:

Same transparency percentage for the entire object.

• Vignetted:

• Linear, Linear Updown
• Elliptical, Elliptical Updown, Elliptical Eccentric, Elliptical Updown Eccentric
• Rectangle, Rectangle Updown, Rectangle Eccentric, Rectangle Updown Eccentric
• Smooth Parallelogramic, Smooth Parallelogramic Updown, Smooth Parallelogramic Eccentric,

Smooth Parallelogramic Updown Eccentric
• Conical, Conical Updown

• Circular
• Edge:

The transparency only affects a strip with a certain width alongside the edges of the object.

• Softmask:

Applied to a CT, it has the same effect on its mask as Edge, but combines the color of the mask with
the transparency.

• CT:

To load a monochrome CT and use it as a transparency mask.

To create a uniform transparency effect, use the Fill Transparency slider or enter a value in the Fill
Transparency Percentage input box.

To define any of the other transparency effects, use the Fill Transparency arrow.

Note:

• If you have multiple selected objects, the transparency is applied to each of the objects
(even though the arrow displays only on the object that was selected first).

• You may apply transparency by using both the slider and the transparency arrow together.
To delete the transparency arrow from the display, select Solid as the Transparency Type.

• In the Fill Transparency dialog, some options are not available for all Fill Transparency
Types, for example when you choose circular the Angle input box is dimmed.

Fill Transparency Arrow

To create a vignetted transparency effect.

A transparency arrow displays on the selected object and the Fill Transparency dialog box appears.

Tip:

You can also determine the transparency manually and numerically. To do so, click, hold and
drag the transparency arrow to the appropriate position or enter numeric values in the Fill
Transparency dialog box on page 600.
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Fill Transparency slider
Click, hold and drag the Fill Transparency slider to interactively define the percentage of transparency
or click the spin box beside the Fill Transparency slider to modify the transparency by a step value.

Fill Transparency Percentage
Enter a value in the Fill Transparency Percentage input box to define the percentage of transparency.

Fill Local Vignette
To define a local vignette for the selected object of your job.

The Fill Local Vignette settings of the Fill Style envelope overrule the vignette settings of the Vignette
Color Factory.

If a vignette color was created from the Color Palette dialog box, the toggle button is automatically
activated. Deactivate the toggle button to modify the Vignette options.

Fill Local Vignette Type
Select a Fill Local Vignette Type to define the local vignetting for the fill color to be assigned to the
selected objects.

You may select Global (same transparency percentage for the entire object), linear, rectangular,
elliptical, circular, or edge (creates an embossed effect).

Note:

• If you have multiple selected objects, the vignette is applied to all of the objects (even
though the arrow displays only on the object that was selected first).

• Some Vignette options are not available for all Fill Local Vignette Types.

Fill Local Vignette Arrow
To locally modify a vignette for the fill color that has been applied to the selected object.

A vignette arrow appears on the selected object and the Fill dialog box appears.

Tip:

Click, hold and drag the vignette arrow to the appropriate position to manually determine the
vignette or enter numeric values in the Fill dialog box to determine the vignette.

Fill Transparency dialog box
To numerically define a vignetted transparency effect.

When you click the Fill Transparency arrow in the Style dialog box (with the Fill envelope open), the Fill
Transparency dialog box appears.

Angle
Enter the angle (degrees) of the transparency.

Width
For edge vignettes the H input box becomes a Width input box.
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Offset
For Softmask transparency vignettes, it determines the position of the transparency vignette with
regard to the edge of the mask.

Noise
Enter a value (%) to determine how much grain is applied to the vignette color. The higher the value,
the more grain applied to the color. Entering a value means that a CT will be generated at output. This
overrules a possible noise value in the Output options (File menu) dialog box. If no value is entered (0),
no CT will be generated at output, except when it concerns an edge vignette or a ghosted color. If the
value is 0, the system looks for the noise value in the Output options dialog box. In the case of normal
vignettes (not on edge, no transparency) a value 0, combined with a value 0 in the Fill dialog box, will
result in banding. This means at least a value of 2 or 3 is necessary to prevent banding.

Begin
Enter a value (%) to determine the transparency to be applied where the arrow begins (0-100).

End
Enter a value (%) to determine the transparency to be applied where the arrow ends (0-100).

Note:

• If you have multiple selected objects, the transparency is applied to all of the objects (even
though the arrow displays only on the object that was selected first).

• You may apply transparency by using both the slider and the transparency arrow together.
To delete the transparency arrow from the display, select Solid as the Transparency Type.

• Some Transparency options are not available for all Fill Transparency Types.

Fill dialog box
To numerically modify a vignette that has been applied to an object.

When you click the Fill Local Vignette arrow in the Style dialog box (with the Fill envelope open), the Fill
dialog box appears.

Angle
Enter the angle (degrees) of the vignette.

Width
For edge vignettes the H input box becomes a Width input box.

Noise
Enter a value (%) to determine how much grain is applied to the vignette color. The higher the value, the
more grain is applied to the color. Entering a value means that a CT will be generated at output. This
overrules a possible noise value in the Output options (File menu) dialog box. If no value is entered (0),
no CT will be generated at output, except when it concerns an edge vignette or a ghosted color. If the
value is 0, the system looks for the noise value in the Output options dialog box. In the case of normal
vignettes (not on edge, no transparency) a value 0, combined with a value 0 in the Fill dialog box, will
result in banding. This means at least a value of 2 or 3 is necessary to prevent banding.
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Note:

• If you have multiple selected objects, the vignette is applied to all of the objects (even
though the arrow displays only on the object that was selected first).

• Some Vignette Options are not available for all Vignette Types.

10.3.3.  Stroke Style section

To define or modify

• the stroke color
• the stroke pattern
• the stroke dashing
• the stroke mask setting
• the stroke overprint mode

Of a selected object in your job.

Stroke toggle box
To apply the Stroke Style settings to the selected object, activate the Stroke toggle box.

Stroke color swatch
To define or modify the Stroke color of a selected object click, hold and drag the appropriate color from
the Color Palette to the Stroke color swatch.

The Stroke color swatch reflects the stroke color of the selected object if the Measure plug is
activated.

Tip:

When you double-click the Stroke color swatch, the Color Factory displays, where you can
create the Stroke color you want to apply. The color is automatically added to the Color Palette.

Stroke pattern box
To define or modify the Stroke pattern of a selected object click, hold and drag the appropriate pattern
from the Pattern dialog box or from the Pattern Palette to the Stroke pattern box.

The Stroke pattern box reflects the pattern of the selected object if the Measure plug is activated.

Note:

To display the Pattern dialog box, choose Pattern in the Paint menu or double-click the stroke
pattern box.

Stroke dashing box
To define or modify the stroke dashing of a selected object, open the Dashes dialog box by double-
clicking the dashing box and fill in the appropriate parameters.
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Note:

You can also display the Dashes dialog box by choosing Dashes in the Paint menu.

The Stroke dashing box lights up if a dashed stroke has been applied to the selected object if the
Measure plug is activated.

Stroke Mask
To use one object to act as a clipping path for other objects.

To mask the stroke color:

1. Select the objects you want to use as the mask, and the objects to be#masked, and group them.

Tip:

Refer to Select Objects.

2. Send the selected objects behind the object you want to mask.

Tip:

Refer to To Back or Backward.

3. Activate Stroke Mask.

The objects (or portion of the objects) that are contained within the clipping path are displayed and
printed.

Note:

You can also mask objects by using Cut (Edit menu) on page 205 and Paste Inside (Edit menu)
on page 209.

Stroke Overprint
To define or modify the overprint Mode of the Stroke color.

For an extended explanation of the Stroke Overprint Modes, refer to Fill Overprint Mode in the Fill Style
Section of the Style bar.

Stroke Width
Enter the width of the stroke in the Stroke Width input box, or use the spin boxes to increase the stroke
width.

The width will be reflected in millimeters or inches depending on the information entered in the
Document Setup dialog box.

10.3.4.  Stroke Style envelope

To define the opacity (or transparency) for the stroke color to be assigned to the selected objects.
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Stroke Transparency Type
Select a Stroke Transparency Type to define the opacity (or transparency) for the stroke color to be
assigned to the selected objects.

The Transparency can be:

• Solid:

Same transparency percentage for the entire object.
• Vignetted:

• Linear, Linear Updown
• Elliptical, Elliptical Updown, Elliptical Eccentric, Elliptical Updown Eccentric
• Rectangle, Rectangle Updown, Rectangle Eccentric, Rectangle Updown Eccentric
• Smooth Parallelogramic, Smooth Parallelogramic Updown, Smooth Parallelogramic Eccentric,

Smooth Parallelogramic Updown Eccentric
• Conical, Conical Updown

• Circular
• Edge:

The transparency only affects a strip with a certain width alongside the edges of the object.
• Softmask:

Applied to a CT, it has the same effect on its mask as Edge, but combines the color of the mask with
the transparency.

• CT:

To load a monochrome CT and use it as a transparency mask.

To create a uniform transparency effect, use the Stroke Transparency slider or enter a value in the
Stroke Transparency Percentage input box.

To create a vignetted transparency effect, use Stroke Transparency arrow.

Note:

• If you have multiple selected objects, the transparency is applied to all of the objects (even
though the arrow displays only on the object that was selected first).

• You may apply transparency by using both the slider and the transparency arrow together.
To delete the transparency arrow from the display, select Solid as the Transparency Type.

• Some Transparency options are not available for all Stroke Transparency Types.

Stroke Transparency Arrow
To create a vignetted transparency effect.

A transparency arrow displays on the selected object and the Stroke Transparency dialog box displays.

Click, hold and drag the transparency arrow to the appropriate position# to manually determine the
transparency.#

-OR-

Enter numeric values in the Stroke Transparency dialog box to determine# the transparency.

Stroke Transparency slider
Click, hold and drag the Stroke Transparency slider to interactively define the percentage of
transparency or click the spin box beside the Stroke Transparency slider to modify the transparency by
a step value.
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Stroke Transparency Percentage
Enter a value in the Stroke Transparency Percentage input box to define the percentage of
transparency.

Stroke Local Vignette
To modify the vignette type, deactivate Stroke Local Vignette.

To delete the arrow from the display, activate the toggle button.

If a vignette color was created from the Color Palette dialog box, the toggle button is automatically
activated. Deactivate the toggle button to modify the Vignette options.

Stroke Local Vignette Type
Select a Stroke Local Vignette Type to define the local vignetting for the stroke color to be assigned to
the selected objects.

You may select Global (same transparency percentage for the entire object), linear..., rectangular...,
elliptical..., circular, or edge (creates an embossed effect).

Note:

• If you have multiple selected objects, the vignette is applied to all of the objects (even
though the arrow displays only on the object that was selected first).

• Some Vignette options are not available for all Stroke Local Vignette Types.
• If you apply a vignette to a stroke, the stroke automatically becomes edged.

Stroke Local Vignette Arrow
To locally modify a vignette for the stroke color that has been applied to the selected object.

A vignette arrow displays on the selected object and the Stroke dialog box displays.

Click, hold and drag the vignette arrow to the appropriate position to# manually determine the
vignette.

-OR-

Enter# numeric values in the Stroke dialog box to determine the vignette.

Stroke Line Cap Type
Click Stroke Line Cap Type that represents the type of line cap you want for the stroke of the selected
objects:

•
 But caps (squared caps that are perpendicular to the line),

•
 Round caps (circular caps that have the radius of the line divided in half),

•
 Projecting caps (the stroke continues beyond the line's endpoint by a thickness that is half

the thickness of the stroke).

Stroke Corner Type
Click Stroke Corner Type that represents the type of corner you want for the stroke of the selected
objects:
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•
 Sharp corner

•
 Rounded corner

•
 Beveled corner (refer also to the Miter input box)

Miter

Enter a value in the Miter input box to determine how sharp the corner has to be angled to have a
beveled corner.

Stroke Transparency dialog box
To numerically define a vignetted transparency effect.

When you click the Stroke Transparency arrow in the Style dialog box (with the Stroke envelope open),
the Stroke Transparency dialog box appears.

Angle
Enter the angle (degrees) of the transparency.

Width
For edge vignettes the H input box becomes a Width input box.

Noise
Enter a value (%) to determine how much grain is applied to the vignette color. The higher the value,
the more grain applied to the color. Entering a value means that a CT will be generated at output. This
overrules a possible noise value in the Output options (File menu) dialog box. If no value is entered (0),
no CT will be generated at output, except when it concerns an edge vignette or a ghosted color. If the
value is 0, the system looks for the noise value in the Output options dialog box. In the case of normal
vignettes (not on edge, no transparency) a value 0, combined with a value 0 in the Fill dialog box, will
result in banding. This means at least a value of 2 or 3 is necessary to prevent banding.

Offset
For Softmask transparency vignettes, it determines the position of the transparency vignette with
regard to the edge of the mask.

Begin
Enter a value (%) to determine the transparency to be applied where the arrow begins (0-100).

End
Enter a value (%) to determine the transparency to be applied where the arrow ends (0-100).
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Note:

• If you have multiple selected objects, the transparency is applied to all of the objects (even
though the arrow displays only on the object that was selected first).

• You may apply transparency by using both the slider and the transparency arrow together.
To delete the transparency arrow from the display, select Solid as the Transparency Type.

• Some Transparency options are not available for all Stroke Transparency Types.

Stroke dialog box
To numerically modify a vignette that has been applied to an object.

When you click the Stroke Local Vignette arrow in the Style dialog box (with the Stroke envelope open),
the Stroke dialog box appears.

Angle
Enter the angle (degrees) of the vignette.

Width
For edge vignettes the H input box becomes a Width input box.

Noise
Enter a value (%) to determine how much grain is applied to the vignette color. The higher the value,
the more grain applied to the color. Entering a value means that a CT will be generated at output. This
overrules a possible noise value in the Output options (File menu) dialog box. If no value is entered (0),
no CT will be generated at output, except when it concerns an edge vignette or a ghosted color. If the
value is 0, the system looks for the noise value in the Output options dialog box. In the case of normal
vignettes (not on edge, no transparency) a value 0, combined with a value 0 in the Fill dialog box, will
result in banding. This means at least a value of 2 or 3 is necessary to prevent banding.

Note:

• If you have multiple selected objects, the vignette is applied to all of the objects (even
though the arrow displays only on the object that was selected first).

• Some Vignette options are not available for all Vignette Types.

10.4.  The Text Style bar - Text menu

To define text box settings, paragraph settings and character settings.

Text Box settings
Story Name

To name the text box in order to easily identify it.

Enter the name for the text box in the Text Style bar. The text box name displays at the top of the
currently selected text box and/or linked text boxes.

For placed text, the original file name is automatically filled in.
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Orientation

To define the orientation (Horizontal, Vertical LR, Vertical RL) for the text within the text box. Click the
appropriate Orientation.The default is Horizontal.

Vertical Quadding

To define the vertical positioning (Top, Bottom, Centered, or Justified) for the text within the text box.
Click the appropriate Quadding. The default is Top.

Paragraph settings
When you modify paragraph settings, all text within the paragraph in which the cursor is positioned is
modified. The text characters do not have to be highlighted to be affected.

Horizontal Quadding

To define the horizontal positioning (Left, Right, Centered, or Justified) for the text within the text box.
Click the appropriate Quadding. The default is Left.

Leading

To define the leading (or distance from base line to base line) for the text. Select from the list (beside
the input box), or type in your selection in the Leading input box.

The default is Auto. Auto applies the leading of 120% of the font size.

Note:

Even if the leading changes, the character height of 75% is always maintained, as well as the
25% height of the lower character part (for example for a 'p' or a `g').

Character settings
Font

To define the font for the text. Select from the list (beside the input box), or type in your selection in the
Font input box.

The default is Helvetica.

Font Weight

To define the weight for the text. Select from the list (beside the input box), or type in your selection in
the Weight input box.

The default is Roman.

Style

To determine whether the text is upright or italic. Select from the list (beside the input box), or type in
your selection in the Style input box.

The default is Upright.

Size

608



10PackEdge

To determine the point size for the text. Select from the list (beside the input box), or type in your
selection in the Size input box.

The default is 12 pt.

Slant

To obtain an italic effect. In the input box you can specify an angle, for example 15, will slant the
selected characters with an angle of 15 degrees.

Distort

To define the distortion percentage to modify the width of text characters. Type in your selection in
the Distort input box. A negative value decreases the width of text characters, and a positive value
increases the width of text characters.The default is 0%.

Kern

To define the amount to increase or decrease the white space between character pairs (for example,
LT, VA, etc.) to enhance their appearance.Insert the I-beam cursor between the two text characters for
which you want to adjust kerning, and type in your selection in the Kern input box.The default is 0%.

Note:

When you use keys to adjust kerning, the I-beam disappears temporarily.

Track 

To define the amount to increase or decrease the white space (equally) between multiple selected text
characters. The tracking value is based on a percentage of an EM-box. Type in your selection in the
Track input box.The default is 0%.

Note:

When you use keys to adjust tracking, the I-beam disappears temporarily.

Color swatch

To define the color style for the text. Apply the color style from the Color Style dialog box.

Superscript 

To position characters in superscript.

Note:

The default values are 50% of the font size, and 75% for base shift (also based on the font size).

Subscript

To position characters in subscript.
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Note:

The default values are 50% for vertical scale, 50% for horizontal scale, and 21% for base shift.

Open the envelope to determine the base shift for the superscript.

Underscore

To underline the text.

10.4.1.  Character Style envelope

Base Shift

To move characters above or below their base lines. Type in the value in points, millimeters, or
percentage of the current size. A positive value moves the characters upward, and a negative value
moves the characters downward. The default is 0.



To create ligatures (such as , , ff, fi, or tl). Ligatures combine certain text characters into a single
text character for certain pairs. If you change the kerning or the tracking for the text characters, the
ligatures will be changed to normal text characters.

Smallcaps

To use small caps.

Leader Distance

To indicate the distance between two leader characters. Type the distance in a percentage value of the
EM-box in the input box.

1 2 3

To define the type of numeric digits (Normal, Tabular, or Mediaeval). Select from the list (beside the
input box), or type in your selection in the Numbers input box. This option is only visible if your font
contains these characters.The default is Normal.

Hyp

To define the hyphenation language for the text to determine how text will be hyphenated. Select from
the list (beside the input box), or type in your selection in the Hyphenate input box. The default is Off. If
you select Off, no hyphenation will be applied to the text.

Remap
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If you want to edit a text in a remapped font (such as Russian or Greek Adobe Type 1 font), you can use
this tool.

10.4.2.  Box Style envelope

Icon Name Explanation

 

 

Columns To define the number of columns for the text box. Type in your
selection in the Columns input box.

The default is 1.

 

 

Column Width To define the width of the columns for the text box. Type in your
selection in the Column Width input box.

When you enter a value (other than Auto), the size of text box will be
adjusted automatically.

The default is Auto.

Note:

When Auto is applied, the system automatically calculates
the width of the columns, based on the width of the text
box, the number of columns, and the gutter.

 

 

Gutter To define the distance between the columns. Type in your selection
in the Gutter input box.

The default is 20 pt.

10.5.  The Text Style bar

To define text box styles, paragraph styles and character styles.

10.5.1.  Character Style

To display or modify the parameters of the character style, selected in the Character style input box,
with the Character Style dialog box.

Character style input box
The Character style input box displays the active or selected character style.
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Character style arrow
To display the list of existing character styles. You can select the desired style from the list.

10.5.2.  Paragraph Style

To display or modify the parameters of the paragraph style, selected in the Paragraph style input box,
with the Paragraph Styles dialog box on page 270.

Paragraph style
The Paragraph style input box displays the active or selected paragraph style.

Paragraph style arrow
To display the list of existing paragraph styles. You can select the desired style from the list.

10.5.3.  Text Box Style

To display or modify the parameters of the text box style, selected in the Text Box style input box, with
the Text Box Style dialog box.

Text Box style
The Text Box input box displays the active or selected text box style.

Text Box style arrow
To display the list of existing text box styles. You can select the desired style from the list.

10.5.4.  Tab Style

To display or modify the parameters of the Tab style, selected in the Tab style input box, with the Tab
Style dialog box.

Tab style
The Tab style input box displays the active or selected Tab style.
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Tab style arrow
To display the list of existing Tab styles. You can select the desired style from the list.

10.5.5.  Character Style envelope

Use the upper envelope in the Text Style bar to change additional parameters in a text box. Refer to
Character Style for additional information about entering the settings for the leader in the Character
Style dialog box.

10.5.6.  Text Box Style envelope

Use the lower envelope in the Text Style bar to change additional parameters in a text box. Refer to Text
Box Style for additional information about for example the vertical position of the first line, in the Text
Box Style dialog box.

10.6.  The Tab Status bar - Text menu

To move, change, add and remove tabs in the text where the cursor is in.

Move tabs
To move a tab by clicking it and dragging it to the desired position.

Change the type of a tab
To change a tab's type. For example by repeatedly double-clicking a left aligned tab, its type changes to
right aligned, centered and back to left aligned.

Add a tab
To create a new left aligned tab by double-clicking an empty position on the Tab bar. Now you can
double-click the new tab to convert it to the desired type.

Remove a tab
To remove a tab by dragging it outside the Tab bar.
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10.7.  Align dialog box

To align a file or selected objects based on the crosshair or reference points or based on two clicked
points or to position a selected object or place a file within another object.

10.7.1.  Align and Distribute objects

 

 

Using the Align & Distribute Objects tab of the Align dialog, you can align or distribute objects.

Using the buttons in the Align dialog, or the menu items in Arrange > Align and Arrange > Distribute,
you can

• align objects horizontally on the left side, center or right side.
 

 

• align objects vertically on the top, center or bottom.
 

 

• Distribute objects horizontally, based on the left side, center or right side
 

 

• Distribute objects vertically, based on the top, center or bottom side
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10.7.2.  Align by Crosshair

 

 

Select Align by Crosshair to align selected objects or groups of objects horizontally, vertically,
centered, based on the crosshair, or a combination of these.

You can click any of the 9 buttons to position the selected object(s) with respect to the crosshair.

Align by Crosshair positioning buttons

 

 

If you click the first button (default), you will be able to define the position of the object(s), both
vertically and horizontally. If you click the second button, you will only be able to define the position
vertically. If you click the third button, you will only be able to define the position horizontally.

Move as 1 group

Activate Move as 1 group to align multiple selected objects as a single entity.

If you select more than one object and Move as 1 group is deactivated, each object will be aligned
individually, resulting in objects positioned on top of each other.
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Tip:

If Move as 1 group is deactivated and you are working with multiple groups of objects, set the
appropriate Preset Grouping Level in the status bar to maintain the grouping structure.

The default is 1 (a single object will be manipulated and the grouping structure will be ignored).

10.7.3.  Align Crosshair by object

 

 

Select Align Crosshair by Object to align the crosshair horizontally, vertically, centered, based on the
selected object(s) or groups of objects, or a combination of these.

You can click any of the 9 buttons to position the crosshair with respect to the selected object(s). The
picture shows you a preview.

 

 
Align Crosshair by object buttons

If you click the first button (default), you will be able to define the position of the crosshair, both
vertically and horizontally. If you click the second button, you will only be able to define the position
vertically. If you click the third button, you will only be able to define the position horizontally.

10.7.4.  Align by Reference Points
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Select Align by Reference Points to align files based on their reference point(s).

The files can be placed with their reference point(s) on the center of the crosshair. In place mode, a
file can be placed internally or externally. If a file is placed internally the reference point(s) of the file
will not be remembered. If a file is placed as an external file the location information of the reference
point(s) will be remembered. When you put the external file in the clipboard and paste it afterwards, the
location information of the reference point(s) will also be remembered.

10.7.5.  Align by Two Points

 

 

Select Align by Two Points to align selected objects (or files) based on two clicked points. The objects
(or files) will automatically be rotated and scaled when you use this option.

Note:

You can also use Transform on the toolbar for interactive two-point positioning.

Align by Draw

• Click Draw to start indicating the two points to be used for the alignment.
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• Click the two points or position the cursor by clicking the mouse (without releasing the mouse
button), and dragging the cursor to the appropriate position.

The alignment arrow displays to indicate the two clicked points.

Align by Reference

To align the selected object on the alignment arrow, based on a reference level.

Percentage input box
Enter a value to determine the placement of the selected object (on the alignment arrow) in the
Percentage input box.

For example, the object will be positioned half above and half below the alignment arrow if you enter
50, and 70% above and 30% under the alignment arrow if you enter 70.

Map on arrow

Position the top left corner of the source object's bounding box to the starting point of the alignment
arrow, and map the bottom right corner to the alignment arrow's endpoint (creating non-proportional
scaling).

Align on arrow

Position the object on top of the alignment arrow.

If no reference points are assigned to the source object, the object will be positioned on top of the
alignment arrow.

If the source object has reference points (created with the Transform tool), the object will be
positioned according to the reference points (point 1 will be positioned on point 1, and point 2 will be
positioned on point 2).

10.7.6.  Align Inside
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Select Align Inside to position a selected object or place a file (source object) within a four-sided
polygon (destination box). The source object is automatically scaled and rotated, to fit within or on top
of the destination box.

The four corners of the source object's bounding box are mapped onto the four corners of the four-
sided polygon. If the polygon is rotated, the source object will be rotated as well.

Attention:

You must use a four-sided polygon that has four corners (at 90 degree angles) as the
destination box. No other shape of object can be used. For example, you cannot use and ellipse
or triangle.

Note:

Refer to Warp (Warp with Grid type Between Objects) for information about using objects other
than a four-sided polygon.

Note:

You can use a CT (even if the CT has been rotated) as the destination box to easily replace a CT
with another CT (for example, to replace a low resolution CT with a high resolution CT). If the
CT you are replacing has a mask (and the mask is not selected), the mask will be applied to the
replacement CT.

Replace

To position the source object (the red selected object or placed file) inside of the destination box, and
delete the destination box.

Apply

If the Apply Align plug is deactivated click Apply to execute the alignment (based on the selected
alignment options).

Keep

To align a copy of the selected object (the red selected object or placed file), and keep the original
object as it was before the alignment.
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10.8.  Flatten dialog box

To replace all blend modes and transparencies by "normal" objects, maintaining the final result.

Image Resolution
When images are created during flattening, these images will use the defined resolution.

Flatten Overprint
If the Flatten Overprints is on, not only objects containing blend modes will be flattened, but also
objects containing overprint.

Anti-alias
This option allows to apply anti-aliasing when creating an image while flattening. Anti-aliasing
smoothens the staircase effect you get in the generated images of lineart objects that need flattening.

Convert Vignette to Image
With this option you can convert Vignettes into an image while flattening.

Vignette Noise
Vignettes that are converted to images may have tone jumps in the final result. To reduce this banding
effect, noise is applied on the image. The amount of noise can be specified in the field Vignette Noise.

10.9.  Numbers dialog box

To display the numeric feedback or to perform actions numerically.

The Numbers dialog box looks different depending on the tool you have selected from the toolbar. You
obtain the dialog box in its most complete variant when you open it by activating the Measure tool.

General
Measure plug

If you do not want to display the values related to the selected object(s) automatically, you deactivate
the Measure plug.

Wind/rewind buttons

To move back and forth through the values that have been displayed. The winding/rewinding is
restricted to 50 steps.

Reset button 

To reset all values.

Memory 
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To let appear the Memory dialog box. It offers an easy way to store and retrieve frequently used values.

Dialog display selector 

To define which part of the Numbers dialog box appears on the screen: the relative value part, the
absolute value part or the complete box.

In the absolute value part:

Vertical distance from the top border or the crosshair 

To represent the distance between the object bounding box and the top border. If the cross- hair toggle
is activated, the distance relates to the center of the crosshair.

Horizontal distance from the left border or the crosshair 

To represent the distance between the object bounding box and the left border. If the crosshair toggle
is activated, the distance relates to the center of the crosshair.

Vertical / Horizontal dimension 

To represent the vertical / horizontal dimension of the object bounding box. If the locking between
vertical and horizontal dimension is enabled, changing one value will also change the other, keeping
the size proportional.

Diagonal dimension 

To represent the diagonal dimension of the object bounding box.

Rotation angle 

To represent the rotation angle of the object bounding box. If the crosshair toggle is activated, the
rotation angle relates to the center of the crosshair.

Contour length 

To represent the actual contour length of the selected object(s), not the dimensions of the bounding
box.

Crosshair toggle 

When the crosshair toggle is activated, all values relate to the center of the crosshair.

In the relative value part:
The values in the relative part are important if you want to do a transformation of an object in function
of its original position or size.

You can combine values from different input boxes, thus applying different transformations at the
same time.

Values, apart from the ones that have to do with scaling, can be positive or negative. In the first case,
the move will be clockwise. In the second case it will be anti-clockwise.
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Vertical/Horizontal Move 

To move in vertical/horizontal direction.

Vertical / horizontal Stretch

To stretch an object vertically/horizontally. As it is a factor, a value smaller than 1 results in a smaller
object, whereas a value larger than 1 enlarges it.

Scale

To scale (or resize) an object proportionately. As it is a factor, a value smaller than 1 results in a smaller
object, whereas a value larger than 1 enlarges it.

Vertical / Horizontal Shear

To specify an angle to shear an object vertically/ horizontally.

Rotate

To specify an angle to rotate.

Keep Once

To keep the selected object in its original place or shape the first time you transform it in any way. The
option is automatically deactivated when the transformation has been finished.

Keep

To keep the selected object in its previous place or shape for every transformation you do.

Extrapolate

To create objects by repeating a set of transformations, starting from (a) selected object(s), where the
transformation of each new object is calculated according to the values in the Numbers dialog box and
is applied to the last created object.

Local Origin

To transform a selection of different objects together, in relationship to the local origin of each one of
the objects instead of using one common origin for all the selected objects.

You can

• Move all the local origins of a selection of different objects over the same distance and in the same
direction by dragging the local origin of one object of the selection.

• Move the local origin of each object individually by selecting object per object.

You can also use Local Origin in the Transform Rosette Envelope when working manually.

The following examples show the use of a local origin when rotating:

• Example 1: Rotation, using local origin, after having moved all the local origins of the selection over
the same distance and in the same direction.
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• Example 2: Rotation, after having moved each local origin individually.

 

 

Times

To enter how many times you want to repeat the manipulation(s).

10.10.  Memory dialog box

To store numeric values that you frequently need.

Up to 8 numeric values can easily be used over and over by 'dragging and dropping' them into any of the
input boxes.

The maximum value that can be entered into each input box depends on the settings. If you enter
a number that contains too many digits to display, an arrow displays beside the input box. Alpha
characters are not accepted.

The number of decimal point positions you may enter is defined in Preferences.

Note:

The numeric values in the Memory dialog box are reset to 0 when you exit.

623



10 PackEdge

10.11.  Guides dialog box

To work with the different types of guides.

 

 

Horizontal Guide

To display the horizontal guide. If this box is filled, the unfixed guide is displayed. If this box is unfilled,
no unfixed guides are shown.

Horizontal Guide Position

Enter the vertical distance relative to the Crosshair center in this input box to create an unfixed
horizontal guide.

Vertical Guide

To display the vertical guide. If this box is filled, the guide is displayed. If this box is unfilled, the guide is
hidden.

Vertical Guide Position

Enter the horizontal distance relative to the Crosshair center in this input box to create an unfixed
vertical guide.

Circular Guide

To display the circular guide. If this box is filled, the guide is displayed. If this box is unfilled, the guide is
hidden.
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Circular Guide Position

Enter the numeric value of the radius relative to the Crosshair center in this input box to create an
unfixed circular guide.

Diagonal Guide

To display the diagonal guide. If this box is filled, the guide is displayed. If this box is unfilled, the guide
is hidden.

Diagonal Guide Position

Enter the angle relative to the horizontal Crosshair line in this input box to create an unfixed diagonal
guide.

Numeric

Click Numeric after you have entered the value in a Guide input box to make the guide fixed.

Note:

Fixed guides are saved in the file and remain unmoved when you move the crosshair.

Perpendicular

Click Perpendicular after you have clicked the point on a selected object to create a fixed
perpendicular guide.

Tip:

Two perpendicular guides on the same arc intersect in the origin of the corresponding circle.

Tangent

Click Tangent after you have clicked the point on a selected object to create a fixed tangent guide.

Delete All

When you no longer need the guides click Delete All to delete all guides.

Note:

When guides are deleted, the numeric position of the last created guide remains in the Guide
Position input box. You can display the last created guide again by activating the toggle box
beside the Guide Position input box.

Delete

Click Delete before you click on the Guide you want to delete.

10.12.  Layers dialog box

To manage layers, grids and markup grids.
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This is an overview:

Tip:

The selected layer, grid or markup grid is highlighted in white. This icon  indicates the layer
in which you are currently working.

Icon/name Explanation

 

 

Allows you to choose which layers are to be printed or exposed. You can deselect

by simply clicking, the  icon will change to .

 

 

To display/hide all layers, grids or markup grids.

If the display option is activated all objects of all layers are displayed. All grids
display dimmed and all markup grids display in blue.

 

 

To lock/unlock all layers, grids and markup grids.

When a layer, grid or markup grid is locked, no modifications can be made to the
layer, grid or markup grid.

 

 
 

•
: If you activate One Window, the settings are applied to the active layout

window only.

626



10PackEdge

Icon/name Explanation

 

•
: If you activate Two Windows, the settings are applied to the two layout

windows.

 

 

When you click , a new dialog box opens:

• Merge all layers
• Merge visible layers

 

 

Allows you to add another grid.

Adding a grid opens the Grid dialog box. See also Use Grids.

 

 

Allows you to add another markup grid.

If you select a markup grid type layer, the Markup dialog box opens. In this dialog
box you can modify the markup grid settings.

 

 

This icon indicates that gravity is activated and that objects will snap to the grid or
markup grid.

To deactivate gravity, click . The icon will change to .

 

 

Allows you to add another layer.

Note:

The layer is automatically assigned the next sequential number (higher
than the current active layer when the layer was created).

 

 

Allows you to delete a selected layer, grid or markup grid.

Attention:

The contents of the layer, grid, or markup grid are also deleted.

 

 

Allows you to automatically resize the Layers dialog box

To move a layer, grid or markup grid
If you want to move a layer, you open the Layers dialog box and you simply click the layer you want to
move and drag it to the new position.

To rename a layer, grid or markup grid
If you want to rename a layer, grid or markup grid, you select a layer and you simply click the old name
of the layer in the Layer dialog box. You will be able to edit the name.
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